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Introduction

F)r many reasons, AutoCAD is much different from most applications
that you will ever use. The main reason goes back some 20 years to
when AutoCAD was first introduced as a low-cost CAD solution on micro-
computers. (CAD stands for Computer-Aided Drafting or Computer-Aided
Design, depending on whom you ask.) Most CAD applications back then ran
on very large and expensive mainframe computers, not something that you
could take on-site with you.

With the introduction of AutoCAD, CAD wasn’t as foreign of a topic as it
once was, but it still had an uphill climb against the wide use and adoption
of drafting boards. A drafting board, you might be asking yourself? Yes, prior
to computers and CAD, all designs were done with pencil and paper; if you
were really good, you used ink and paper. Today, paper still plays a role in
distributing designs, but most designs are now done in a CAD application
that allows you to do much more complex things that were not possible
with board drafting.

As times and drafting practices have changed, AutoCAD has either led in
setting the pace for change or has forced change with some things. Some of
these changes have helped to usher in the era of improved design collabora-
tion across the Internet and better electronic file sharing with non-CAD
users. Since all objects in a drawing are electronic, AutoCAD allows you to
quickly manipulate and mange them without the need to break out the
eraser shield and eraser as you would on a board. Autodesk continues to
improve the way you can visualize designs and concepts through improve-
ments in 3D modeling and other features.

AutoCAD 2007 gives you the tools you need to create accurate 2D and 3D
designs, but isn’t very easy to just pick up and become productive right
away. This book helps you get up to speed faster so that you can be produc-
tive in all main areas of the application — which include 2D and 3D drafting,
printing and sharing designs, and customizing and programming.

About This Book

The AutoCAD & AutoCAD LT All-in-One Desk Reference For Dummies gives you
an understanding of all the main features that you need to know in order to be
productive with AutoCAD and AutoCAD LT. The All-in-One Desk References For
Dummies are much different from other For Dummies books you may have
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Foolish Assumptions

read; more information is crammed between the two covers, and the content
is more in-depth. This book is laid out to focus on individual topics and
allows you the freedom of moving around between its minibooks. We recom-
mend that if you are not familiar (or somewhat familiar) with AutoCAD that
you read through Books I and Il before moving on to the other minibooks.

After you read this book, don'’t let it run too far from your desk — you will
find it helpful as a reference whenever you might need it.

Foolish Assumptions

We expect that you know how to use the Windows operating system and
understand the basics of navigating folders and starting applications. To
take advantage of everything that AutoCAD offers and what is contained in
this book, we assume that you have at least an Internet connection — dial-up
at least, but a high-speed cable or DSL connection would be best. As long as
you have AutoCAD or AutoCAD LT installed on the computer in front of you
and a connection to the Internet, you are ready to get started.

Conventions Used in This Book

Text that you would type at the command line or dynamic input tooltip, in a
text box, or any other place you enter text appears in bold typeface. Examples
of AutoCAD prompts appear in a special typeface.

At times, you may see something like the phrase “choose Filec>Save As.” The
small arrow (=) in this example indicates that you are to choose the File
menu and then choose the Save As command.

How This Book Is Organized

The following sections describe the minibooks that this book is broken into.

Book 1: AutoCAD Basics

Book I familiarizes you with the AutoCAD interface and the basics of working
with drawing files. It provides some background on AutoCAD and AutoCAD
LT, and lists which versions are compatible with each other. It explains how
to start the application and sends you on a guided tour of the interface. You
also see how to interact with commands using dialog boxes and the com-
mand line, and how to get help when you need it from the application. You
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also get a brief rundown on creating and modifying some of the basic 2D
objects, and using a few of the viewing commands. The last two chapters of
the minibook show how to use some of the general object and drawing format
properties and settings, as well as the different drafting aids that help you
create accurate 2D and 3D drawings.

Book 11: 2D Drafting

Book Il covers many of the commands that are used for creating and working
with 2D designs. The first part of the minibook focuses on creating 2D objects
that range from lines, circles, and arcs to more complex objects, such as
ellipses. Then you see how to select and modify objects that have been cre-
ated in a drawing. Modifying objects is one of the main tasks that you per-
form in AutoCAD, next to viewing and creating new objects in a drawing.

Book 11I: Annotating Drawings

Book Il covers how to create an annotation in a drawing that explains a fea-
ture or shows the measurement of an object. Annotation in AutoCAD
includes text, dimensions, leaders, and hatch. For example, you see how to
create single and multiline text objects and tables. The chapter also includes
formatting specific characteristics of text and tables, performing spell check-
ing, and doing a find-and-replace on text strings.

Book 1V: LT Differences

Book IV focuses on AutoCAD LT and how it is different from AutoCAD, along
with using it in the same environment as AutoCAD and expanding AutoCAD
LT through customization and other means. This minibook also explains
what to watch out for when you use both AutoCAD and AutoCAD LT in the
same office.

Book U: 3D Modeling

Book V covers how to create, edit, view, and visualize 3D objects. You get the
basics of working in 3D, and see how to specify coordinates and adjust the
coordinate system to make it easier for you to create and modify objects
above the x,y plane. This minibook also tells you how to navigate and view

a 3D model in AutoCAD and AutoCAD LT.

Book VI: Advanced Drafting

Book VI covers the advanced drafting features that go beyond 2D drafting,
which include working with blocks, external references, and raster images.
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Icons Used in This Book

Book VII: Publishing Drawings

Book VII covers generating a hard copy (paper copy) or an electronic ver-
sion of a drawing that can be viewed without AutoCAD or AutoCAD LT. You
see how to use page setups to define how part of a drawing should be
printed, and how to create floating viewports and layouts to help output a
drawing. You also discover sheet sets, and how you can use them to manage
and organize sets of drawings. Sheet sets provide ways to open drawings,
keep data in sync through the use of fields and views, and output a number
of drawings. This minibook also shows how to create plot configurations and
plot styles, and how to plot and publish a drawing layout or layouts to
create hard copies or electronic versions of drawings.

Book VI1I: Collaboration

Book VIII covers some advanced topics that include CAD standards and file
sharing, as well as how to use electronic files for project collaboration. You
gain an understanding of the concepts behind CAD standards, as well as how
to use the available CAD standards tools to help maintain and enforce CAD
standards.

Book IX: Customizing AutoCAD

Book IX covers techniques that are used to customize AutoCAD and AutoCAD
LT, which allows you to reduce the number of repetitive tasks and steps that
you might have to do to complete a design.

Book X: Programming AutoCAD

Book X covers extending AutoCAD through some of the different program-
ming languages that it supports. Programming AutoCAD is different from
customizing it, but the goal of reducing repetitive tasks and steps that you
have to do to complete a design are the same.

Icons Used in This Book

A\\S

This book uses the following icons to denote paragraphs that may be of spe-
cial interest:

This icon indicates information that may save some time or help you not to
fall too far from the path to success. For the most part, Tip paragraphs are
designed to help guide you through some of the overwhelming parts of
AutoCAD and to give you at times what might not always be the most obvi-
ous way to get to the desired end result faster.
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These paragraphs give insight into the inner workings of AutoCAD or some-
thing that you won'’t typically need to know to use the program, but may find
interesting. As you read through the book the first time, you might want to
think of the Technical Stuff paragraphs as bonus material and not as required
reading, so feel free to skip over them.

This icon helps you to stay away from the deep-end of AutoCAD and helps
you to keep out of trouble. Failure to adhere to the message may result in an
undesired side effect to your design.

This icon helps to give the gray matter an extra nudge here and there for
things that we talked about earlier in the book. AutoCAD is a large program,
and it takes a bit of time to put all the pieces together, so we give you some
friendly reminders along the way.

This icon helps those who are using AutoCAD LT to know what features
are missing from AutoCAD LT that are in AutoCAD. At times, you may not
know the differences between the two programs, and these paragraphs
can help you determine whether you should be using AutoCAD instead of
AutoCAD LT.

This icon highlights what’s new in AutoCAD 2007.
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Chapter 1: Drawing on
(and in) AutoCAD

In This Chapter

v+ Using CAD in the drawing office

v+ Understanding the origins of AutoCAD
1+ Getting to know AutoCAD file formats
v Familiarizing yourself with AutoCAD LT

v Getting the lowdown on the newest of the new features

Welcome to AutoCAD & AutoCAD LT All-in-One Desk Reference For
Dummies, your one-stop shop for AutoCAD users of every skill level.
If you've read this far, we assume you know a thing or two about the world’s
most popular computer-aided drafting program — enough, at least, to know
that computer-aided drafting usually goes by the much friendlier acronym
of CAD. (And if you're a brand-new user, you might also cast an eye at this
book’s companion volume, AutoCAD 2007 For Dummies.)

The AutoCAD & AutoCAD LT All-in-One Desk Reference For Dummies is
aimed at AutoCAD users in every discipline — architecture, mechanical
design, mapping and GIS, product design, survey and civil engineering,
diagramming . . . whatever your field, you'll find useful information here.
We cover the entire CAD workflow process, not forgetting that 90 percent
of the time, what you need to produce at the far end of the workflow is a
clear and well laid-out paper drawing.

Using CAD in the Drawing Office

Personal computers revolutionized the drafting trade in the 1980s. Before
that, some drafting was computerized, but the computers were mainframes
or minicomputers (equivalent to the Stanley Steamers and Baker Electrics of
the early days of motoring), well beyond the price range of most small archi-
tectural or engineering firms.

As aresult, even as recently as 30 years ago, virtually all drafting was done
by grizzled veterans wearing green eye-shades in smoke-filled back rooms.
And not on computers!



10

\\J

Understanding AutoCAD Files and Formats

In the old days, apprentice drafters (who were called draftsmen — or even
draughtsmen — for it was a male profession) started their careers on the
boards as tracers. Hard to believe, but there was a time before mechanical
reproduction when every copy of an engineering drawing had to be traced,
by hand, from an original. If you’re being forced to learn AutoCAD, you may
grumble, but you should be thankful you don’t have to go through a proce-
dure like that!

Today, your job is much easier because of AutoCAD. Maybe your boss is
making you use AutoCAD, or you have to pass a course. But there are other
reasons to use it — some of which may help you pass that course or get
home from the office a little earlier. Here are some CAD advantages:

4+ Precision. AutoCAD is capable of precision to 14 significant digits (ask
your math prof or your counselor why one digit should be more signifi-
cant than another). That’s way more precise than the best manual
drafter could ever be.

4+ Appearance. AutoCAD-produced drawings are cleaner, easier to read
when reduced, and more consistent than manually drafted drawings.

4+ Reuse. It’s easy to copy and paste parts of drawings into other drawings
for use in new projects.

4+ Scalability. You draw things full-size in AutoCAD on an infinitely large
drawing sheet. This not only eliminates the possibility of scaling errors
as you draw, it also lets you print your drawings at any scale.

4+ Sharing work. Drawing files can be shared with consultants and con-
tractors who can add their own information without having to redraft
the whole drawing.

4+ Distributing work. No more running dozens of prints and having them
couriered to clients — using AutoCAD you can electronically transmit
drawings via e-mail or upload them to shared Web space.

4+ 3D benefits. You're not limited to 2D space; AutoCAD’s drawing space is
three-dimensional so you can create models of your projects and gener-
ate drawings from them.

Understanding AutoCAD Files and Formats

Like every other computer program under the sun, AutoCAD has its own digi-
tal file format. Unlike a Paint program, where the image is created by series of
dots, CAD programs store the locations of objects in a database format. Every
object in a drawing file — every line, arc, circle, dimension, and so on — is
located in the 2D or 3D drawing space using a Cartesian coordinate system.
For more on coordinate systems in AutoCAD, see Book VI.
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AutoCAD is a backward-compatible program. This doesn’t mean you can open
drawings backward or upside-down. It simply means that files created in any
version of AutoCAD can be opened in a same or newer version of AutoCAD.
For example, if you have AutoCAD 2007, you can open a file created in any
version of AutoCAD since the very first one. If you are working with an older
version — say, AutoCAD 2002 — you can open files created in that version
and older, but you can’t open files created in AutoCAD 2004 or newer.

Unless we indicate otherwise (for example, with an AutoCAD LT icon), when
we say AutoCAD 2007, we include AutoCAD LT 2007 as well. There are some
differences — but more similarities — between the two programs. In the
next section, “Seeing the LT,” we take a closer look at LT differences.

Table 1-1 lists AutoCAD and AutoCAD LT versions together with their file
formats.

Table 1-1 AutoCAD & AutoCAD LT Versions & File Formats
AutoCAD Version AutoCAD LT Version Release Vear DWG File Format
AutoCAD 2007 AutoCAD LT 2007 2006 AutoCAD 2007
AutoCAD 2006 AutoCAD LT 2006 2005 AutoCAD 2004
AutoCAD 2005 AutoCAD LT 2005 2004 AutoCAD 2004
AutoCAD 2004 AutoCAD LT 2004 2003 AutoCAD 2004
AutoCAD 2002 AutoCAD LT 2002 2001 AutoCAD 2000
AutoCAD 2000i AutoCAD LT 2000i 2000 AutoCAD 2000
AutoCAD 2000 AutoCAD LT 2000 1999 AutoCAD 2000
AutoCAD Release 14 AutoCAD LT 98 & LT 97 1997 AutoCAD R14
AutoCAD Release 13 AutoCAD LT 95 1994 AutoCAD R13
AutoCAD Release 12 AutoCAD LT Release 2 1992 AutoCAD R12

Remember, newer versions can open older files, but older versions generally
can’t open newer files. However, all recent versions of AutoCAD give you the
option of saving back two versions. For example, in AutoCAD 2007’s File
menu, you can use the Save Drawing As command to save the drawing file
back to AutoCAD 2004 format (which is also used by AutoCAD 2005 and
AutoCAD 2006) so that anyone with that version can open your drawing.

AutoCAD 2007 saves all the way back to the AutoCAD R14 file format used by
AutoCAD Release 14 as well as AutoCAD LT 97 and LT 98.

avjomny
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If you're using AutoCAD 2007, you can save drawing files that were created
by Release 14, as long ago as early 1997. If you're using AutoCAD 2006 or ear-
lier, you're limited to two file formats back. On the off chance you need to go
back farther than that, go to www.autodesk.com/dwgtrueconvert and
download a copy of the Autodesk DWG TrueConvert — a batch-conversion
program that does not need AutoCAD or AutoCAD LT to be installed — and
use it to save back to AutoCAD R14 DWG format.

Seeing the LT

As most people learn quickly, AutoCAD is an expensive program. To soften
the blow, several years ago Autodesk introduced a slightly reduced-function
version of the program called AutoCAD LT. There used to be an old rule
called the 80-20 rule. The deal was, you got 80 percent of the functionality of
AutoCAD for 20 percent of the price. Nowadays, the 20 percent is more like
40 percent of the price of AutoCAD, but it’s still a good deal if you're unlikely
to use all the features of the full program.

Mostly, this means if you never do (or never plan to do) 3D work in
AutoCAD, you may — emphasis on may — be able to get away with LT and
save a bundle. In other parts of this book, we tell you more about AutoCAD
LT. Watch for the icons in the margins and read the LT-specific notes to see
whether you're in that category. From personal experience, we can safely
say that if you've never used AutoCAD before, you’ll never miss the features
that aren’t carried over from full AutoCAD to LT. However, if you're a profi-
cient AutoCAD user, and you find yourself in a new office that has LT rather
than the full program, there may be dozens of features that you’ll sorely
miss.

We tell you much more about working with AutoCAD LT in Book IV.

Using AutoCAD’s Latest-and-Greatest Feature Set

When we say using AutoCAD’s feature set, we mean really using the program’s
features. It’s all too common for offices to introduce new versions of AutoCAD
to the drawing office without giving training or even demonstrations of new
features to the people who have to use it. As a result, many drafters continue
using the latest version in exactly the same way they learned 5 or 10 years
ago. Through lack of interest (and since you’re reading this book, we're sure
you don'’t fall into that category) or — more likely — lack of time, many
AutoCAD users simply bypass features that can make them more efficient.
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For example, it’s very common to read the AutoCAD newsgroups and see
questions from people asking how to turn off this or that feature — often
features like the right-click shortcut menus that specifically relate to the
command being run.

In this book we're going to focus on some of the major new and enhanced
features of recent releases such as sheet sets (new in AutoCAD 2005) and
dynamic blocks (which first appeared in AutoCAD 2006). We’re also going to
make a strong pitch for paper space dimensioning, which was introduced
way back with AutoCAD Release 11, but which only became really useable
with AutoCAD 2002.

AutoCAD 2007 is the version to gladden the hearts of 3D mavens. Although
there are a few new features for 2D users, the bulk of the new feature set
takes off up the z-axis. AutoCAD 2007 at last makes working in 3D a relatively
straightforward — even enjoyable — prospect. Here’s a brief rundown of
what’s new:

4+ Enhanced 3D object creation and editing options, including the Dynamic
User Coordinate System (DUCS) and the ability to select subobjects
such as one face of a solid for editing.

+

Easier creation of sectioned 3D objects.

4+ Enhanced 3D grid and 3D support for traditional drafting modes like
polar tracking, object snap tracking, and Ortho mode.

<+

Lighting and a library of materials for working in 3D.

+

Saveable visual styles, including “realistic” and “conceptual” modes.

4+ “First Person Navigation” — interactive motion through your 3D models
using the 3DWALK and 3DFLY commands.

4+ Animated drawings — you can define and save a motion path within a
drawing viewport. (They haven’t figured out how to make it work on a
printed drawing, though!)

4+ Workspaces have been around for a release or two, but they’re really
central to the full version of AutoCAD 2007. New workspaces are custom-
tailored for 3D modeling and 2D drafting. (The latter is called “AutoCAD
Classic.”)

4+ The Dashboard is a new interface feature that blends the functionality of
toolbars and menus.

Alas, LT still doesn’t do 3D, so all those nifty new features are not part of the
package. There is a new LT-only feature, however (it’s LT-only because the
full version already had it): AutoCAD 2006’s dynamic blocks feature has been
ported to LT. Now you can create as well as manipulate dynamic blocks.

avjomny
(u1 pue) uo buimesq



14

Using AutoCAD’s Latest-and-Greatest Feature Set

There are still some goodies available to both full AutoCAD and LT, however:

4+ LT users have lamented the lack of full AutoCAD’s Express Tools for

years. The Express Tools package still isn’t an option in LT, but all of per-
haps the most useful subset — the layer tools — have been incorpo-
rated into the core program. And that means they’re available to LT as
well as to the full version.

Both AutoCAD and AutoCAD LT sport a new way of working with exter-
nal references: There’s a new External References palette where you
attach, detach, and otherwise manage not only external reference
(DWG) files, but image files and DWF underlays as well.

DWF Underlay provides a third type of “external reference.” You can
load a DWF as a base drawing in much the same way that you use exter-
nal reference drawings.

Both AutoCAD 2007 and AutoCAD LT 2007 can output to Adobe PDF
format.

You can find more details on all these features throughout the rest of the
book.



Chapter 2: Navigating the
AutoCAD Interface

In This Chapter

v~ Starting AutoCAD

v+~ Taking a quick tour around the AutoCAD window
v Talking (and listening) to AutoCAD

v Taking command

v+ Exploring program options

v~ Calling for Help

ll H ow do I start thee? Let me count the ways . ..” (with apologies to
Elizabeth Barrett Browning).

So, let me count the ways. . . .

Starting the Application

As with all good Windows programs — and AutoCAD is a very good
Windows program — you can make your drawings appear on-screen in
numerous ways.

For a start, there’s the . . . er, Start button, the one that Mick and the Rolling
Stones sang about way back when Bill Gates launched Windows 95 on an
unsuspecting world. To get to AutoCAD 2007 (or AutoCAD LT 2007), you click
Start>Programs=>Autodesk>AutoCAD 2007=>AutoCAD 2007. (You can tell
you're at the end of the line because the last AutoCAD 2007 has a unique pro-
gram icon rather than a generic folder icon beside it.) Figure 2-1 shows the
Windows XP Classic Start menu gradually revealing AutoCAD’s program icon.

The Start button works, but one thing that working in Windows has taught us
is to be efficient, and click-click-click-click-clicking is not the most direct way to
go about opening the drawing editor. Wouldn’t you know it — Microsoft and
Autodesk between them have come up with several alternatives called — what
else — shortcuts.
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Creating Start menu shortcuts

If you're using Windows XP and the new XP-style Start menu (as opposed

to the Windows NT/2000-style Classic Start menu), you may have a large
AutoCAD 2007 button in the left column — the top-level menu in Windows
XP parlance — that lets you click once to start the program (see Figure 2-2).

This section of the Start menu has room for six shortcuts. Supposedly, the
programs you use the most inhabit these six slots, but somehow or other,
most of them seem to be from Microsoft. You can remove these icons by
right-clicking them and choosing Remove from This List.

To add an AutoCAD shortcut to the top-level Start menu, right-click an exist-
ing AutoCAD shortcut icon and choose Pin to Start Menu. If you're using the
Windows 2000 or Windows XP Classic Start menu, you can still put a short-
cut to AutoCAD on your Start menu by dragging a shortcut icon to your Start
button (see Figure 2-3).
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Starting the Application
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By default, AutoCAD creates a shortcut on your desktop when you install the

program. If you’d like more control over where AutoCAD opens — that is,
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where it’s going to save your files, or where it will look for files to open —
you can modify the desktop shortcut so that it directs AutoCAD to a specific
Start In folder. The following steps explain how:

1. Right-click the AutoCAD icon on your desktop.

All recent versions of AutoCAD create a desktop icon by default. Unless
you've renamed it, yours will say “AutoCAD 2007” (or earlier).

2. Choose Properties from the shortcut menu.

A Properties window for the desktop icon appears, with the Properties
tab current and a highlight in the Target field.

3. Press Tab to place the highlight in the Start In field, and then type the
path to your chosen folder.

By default, the Start In folder is identified as “UserDataCache,” which
actually points to your possibly overcrowded My Documents folder. If
you’re like us, a simple top-level folder (for example, C:\DRAWINGS)
makes a lot more sense. Note that the folder must exist before you can
modify the shortcut.

4. Click OK to save the changes to the icon’s properties.

The icon is now configured to open in — and save to — the specified
folder, but there’s another thing you have to do from inside AutoCAD.

5. Double-click your new icon and start AutoCAD.

AutoCAD starts, but it’s still wired for the My Documents folder. You
need to modify a system variable to rewire the program.

6. Type REMEMBERFOLDERS and press Enter, and then type 0 and press
Enter to change the setting of 1 to 0.

When REMEMBERFOLDERS is set to 1 (the default), AutoCAD ignores the
Start In folder specified in the desktop shortcut.

P You can copy your desktop icon multiple times and set a different Start In
folder for each one. Using a Start In folder is helpful when you’re working
on a couple of projects and you’d like to avoid switching back and forth
between the folders where your projects are stored while opening and
saving files.

Accessing files from Windows Explorer

If you need to work on drawings from multiple projects that may be in differ-
ent folders all over your hard disk, sometimes it’s easier to find the files in
Windows Explorer than in AutoCAD’s Open Drawing dialog box. (Okay, we
find Windows Explorer handier than the My Computer window because you
can more easily move from folder to folder.) Simply double-clicking a draw-
ing file will open that file in AutoCAD.
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Touring the AutoCAD Interface

As far as Windows programs go, AutoCAD 2007 is about average in complex-
ity. In fact, compared with its first Windows version (Release 12 for Windows),
it’s a marvel of simplicity. If you have a nodding familiarity with other Windows
programs, you won’t have difficulty navigating AutoCAD’s interface.

Title bars

19

There are three levels of title bars in AutoCAD (and in most other programs
as well). The program itself has a title bar, each drawing window has a title
bar, and individual toolbars and palettes have their own title bars. Figure 2-4

gives you a sampling.
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All three levels of title bar have more or less the same functions:

<+

The program title bar tells you the name of the program, which you know
already

4 The drawing title bar tells you the name of the drawing file you’re work-

ing on and, optionally, its full path on your computer

4+ The toolbar or palette title bar tells you the name of a collection of tool

buttons

Similarly, you can control all three elements — program, file, toolbar, or
palette — through similar actions on the title bars. For example:

<+

<+

Double-click the program title bar to toggle between a maximized or win-
dowed application window

Double-click the drawing title bar to switch a windowed drawing file to
maximized within the application window (this, of course, is a one-way
trip, as once the file is maximized, it no longer has a title bar)

Double-click a toolbar or palette title to toggle between docked or float-
ing locations. (To float a docked toolbar, double-click the handles at the
left side or top.)

Place the mouse pointer over an edge or corner of any unmaximized
window or toolbar, or any undocked palette, to resize it.

Click the X button at the top left (sometimes top right for palettes) to close
the palette, toolbar, drawing window or AutoCAD itself. Of course, if you've
made any changes to a file, you’ll be prompted to save your work first.

AutoCAD menus

AutoCAD 2007, like all Windows programs, uses a standard menu interface.
To open a menu, click the menu label (for example, File, Edit, or View) in the
menu bar, and then run your mouse pointer down the menu to select a com-
mand. The first five or six menus are common to most Windows programs,
although each program has unique as well as common items.

Because the menus occupy a finite space within the AutoCAD menu, not all
commands are accessible this way. You may have to pick a toolbar button,
or even (oh, the horror!) type a command.

AutoCAD’s menus are arranged as follows:

<+

<+

File. Create new or open existing files; print or publish drawings; add
plotters or plot styles; access utility commands; close the program

Edit. Undo/redo; cut/copy/paste; select objects; erase objects; find text
in the drawing
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Oddly enough, AutoCAD’s editing commands are not located on the Edit
menu — you’ll find them on the Modify menu. Watch out especially for
Copy, as there’s one on each menu, and they do different things!

View. Refresh the display; pan and zoom; create viewports; set view-
points for 3D drawings; set render options

Insert. Add blocks, raster images, and external references; insert objects
from other programs; create hyperlinks

Format. Establish layers, colors, linetypes, and lineweights; set appear-
ance properties for text, dimensions, and tables; establish drawing limits

Tools. Open dialog boxes or palettes to control system settings; edit
blocks; use CAD standards; access customization tools

Draw. Create primitive and complex objects; add text and hatching;
define blocks and tables; create 3D surface and solid models (not in
AutoCAD LT)

Dimension. Add dimensions; format dimension styles

Modify. Edit . . . er, modify existing drawing objects; check or match
object properties

Express. Additional tools and commands for creating and modifying all
types of drawing objects

The Express menu is added as an option during program installation. We
strongly recommend that you install the Express Tools when you install
AutoCAD. Both Typical and Custom install options prompt you to install
the Tools. If you blink and miss that option, you’ll need to rerun AutoCAD
2007’s Setup routine. The Express Tools are available in the full version
of AutoCAD only — not in AutoCAD LT.

If you're using the full version of AutoCAD, we hope you've installed the
Express Tools. We tell you more about the Express Tools in Book IX.

Window. Cascade or tile open drawing windows; manage workspaces;
lock down interface; select other open drawings

Help. Access AutoCAD’s built-in Help system; run Info Palette and New
Features Workshop; access help on the Web

AutoCAD toolbars

AutoCAD 2007 has 39 toolbars (not including the Express Tools toolbars),
most of which by default are closed. When you start AutoCAD for the first
time and choose “AutoCAD Classic” as your workspace, you see the Standard,
Styles, Layers, and Properties toolbars docked at the top of the screen,
between the menu bar and the drawing area. Docked at the left is the Draw
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toolbar, and at the right, the Modify and Draw Order toolbars. Finally, the
Workspaces toolbar is floating somewhere near the top of the drawing area.
Assuming you installed the Express Tools, you also see the three Express
Tools toolbars floating near the top of the drawing area (see Figure 2-5).
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Unlike the menu system, the toolbars contain virtually all of AutoCAD’s com-
mands. Toolbars can easily be customized — we show you how in Book IX —
and are a highly efficient way of working with the program.
You already know how to close toolbars. (Hint: It starts with an X.) The easi-
est way to open toolbars is to put your mouse pointer over any tool button
and right-click. (Don’t left-click or you’ll run the command.) AutoCAD dis-
plays a menued list of all toolbars; just click the one you want to open.
A\

To save constantly opening and closing toolbars, or having so many toolbars
open that you can’t see your drawing, you can open a bunch and then save
them as a workspace. We tell you how in Book IX.



23

Touring the AutoCAD Interface
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You open and close palettes by clicking their tool buttons on the Standard
toolbar, or use the Ctrl+key combination indicated in the following list.
AutoCAD’s tool palettes consist of the following:

4+ Properties. List all properties of selected objects, including layer, color,
coordinates, style, and so on. (Ctrl+1). We fill you in on object properties
in Chapter 5 of this minibook.

4 AutoCAD DesignCenter. Use to copy objects from one drawing to
another (Ctrl+2). We tell you more about DesignCenter in Book VI.

4+ Tool palettes. Use to access frequently used blocks, hatch patterns, and
commands (Ctrl+3). For more on tool palettes, see Book VI.
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4+ External References. The old Xref Manager and Image Manager dialog
boxes have been combined into a new palette called, simply, External
References. The new DWF Underlay feature is also managed from this
palette. We give you the scoop on working with external reference draw-
ings, raster images, and DWF underlays in Book VI.

4+ Sheet Set Manager. Set up drawing sets by project for printing and elec-
tronic distribution (Ctrl+4). We tell you all about sheet sets and the
Sheet Set Manager in Book VIL.

4+ Info Palette. Get Quick Help in the middle of commands; lock topics so
they stay open as you follow the steps (Ctrl+5). For more info on the Info
Palette, see “Using the Info Palette” later in this chapter.

4+ DBConnect Manager. Connect AutoCAD drawings with external data-
base files (Ctrl+6). This is a pretty esoteric area of AutoCAD, and we
don’t cover it in this book.

4+ Markup Set Manager. Review electronic markups of DWF files and incor-
porate necessary changes (Ctrl+7). Check out Book VIII for more on this
feature.

4+ Calculator. Just like the one in your desk drawer, only it works with stuff
you’ve drawn as well as numbers (Ctrl+8). We cover AutoCAD’s nifty
built-in calculator in Book VI.

A great new feature in AutoCAD 2007 is anchorable palettes. (Docked
palettes? Anchored palettes? Could there be some sailors at Autodesk?) An
anchored palette is a combination of a docked palette that doesn’t keep
moving around on you, and an auto-hide palette that rolls out of the way
when you’re not using it. To anchor any palette, right-click its title bar and
choose Allow Docking. Then right-click the title bar again and choose
Anchor Left < or Anchor Right >. The palette scrolls shut and anchors its
title bar at the left or right edge of the display.

Okay, at this point you're probably dying to know what Ctrl+9 and Ctrl+0

do, so go ahead and try them. And don’t panic when parts of your screen
disappear — remember, these are toggles, so just press Ctrl+9 again to bring
back the command window, and Ctrl+0 to restore all your toolbars, title bars,
and other screen components. We tell you about the command window a
couple of paragraphs ahead.

Pressing Ctrl+0 issues a command called CLEANSCREENON, which maxi-
mizes the program window, and turns off the program title bar and all tool-
bars, and hides the Windows taskbar. This gives you the largest possible
drawing area on-screen, but leaves you with only the menu system and the
keyboard to work with. Press Ctrl+0 again to run the CLEANSCREENOFF com-
mand (aren’t you glad you don’t have to type command names?) to bring all
those things back again.



Figure 2-7:
The model
space
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If you've tried out AutoCAD 2007’s 3D Modeling workspace, you’ll have Book |
encountered a brand-new interface item called the Dashboard. The Chapter 2

Dashboard is a combination tool palette and super-toolbar that’s configured
for working in 3D. We cover the Dashboard (and 3D in general) in Book V.
There are several new palettes — Lights, Materials, Visual Styles, and
Rendering — that we also cover in Book V rather than in this introductory
section, which deals with 2D drafting.

agepaju| qyJoIny

Drawing area

That big black (or maybe white) area that occupies almost 90% of your
AutoCAD window is the drawing area. Everything you draw goes here. There
are actually two such drawing areas, and they’re known as model space and
paper space.

Keeping with the space theme, you can think of the model and paper spaces
as parallel universes. We tell you a lot more about these two spaces in
Chapter 5. At this time, you just need to recognize this part of the screen.
The double-headed arrow figure at the lower-left corner of the screen (see
Figure 2-7) is called the UCS icon. When it looks like this, you’re in model
space. And that’s where you should be when you’re drawing your buildings,
valves, or bridges.

'
i

..

WA F MY Model fLayoutl fLayoulZ

Command: LINE

@pecify first point:

448457, 25,0663, 0.0000

If your UCS icon looks like the one in Figure 2-8, you're in the other space —
paper space. This is where you put your drawing’s title block and add notes
and such. If your screen looks like Figure 2-8 instead of Figure 2-7, click the
tab that says Model at the bottom left of the drawing area to switch to model
space.

Crosshairs

The on-screen mouse pointer takes on at least two different appearances
when you’re working in AutoCAD. When you move the mouse outside the
drawing area, it looks like the standard arrow pointer you see everywhere

ay) bunebiney
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Figure 2-8:
The paper
space UCS
icon.

else in Windows. When you’re inside the drawing area, it turns into a pair of
lines that intersect at right angles, with a small square box (called the pick-
box) where they cross. You can change the length of the crosshairs in the
Options dialog box.

W4T p [ Model } Layout 1

Command: <Switching
[Fegenerating layout.

jcommand :

I8 IE, 0-11316". 040 SNAP

You also see the pickbox — without the crosshairs — when you’re selecting
objects. Many users find the default size (3 pixels square) too small, and we
concur. To change the size of the pickbox, type PICKBOX, press Enter, and
then set a new value. We find a 5-pixel-square pickbox a good compromise.

The floating command window

The command line — also known as the command prompt — is one of the
things that makes AutoCAD AutoCAD. It’s a throwback to earlier days, before
dialog boxes, toolbars, and pull-down menus were a glint in Bill Gates’s eye.
The command line lives inside the command window, that area of text near
the bottom of your screen.

AutoCAD is one of the few graphics programs where you still type. Not just
numbers and distances, but actual command names and options. Unlikely as
it may seem (but obvious to grizzled AutoCAD old-timers), communicating
with AutoCAD through the keyboard is one of the more efficient ways of
using the program.

When you’re new to AutoCAD, though, it’s not an obvious thing to remem-
ber. That’s why most CAD classrooms have a sign in big red letters that says
Watch the command line! AutoCAD 2006 made a slight lurch into the twenty-
first century with something called dynamic input. When enabled, AutoCAD
displays interactive tooltips near the cursor; these show you a lot — but not
all — of the command line information. You may still need to look down at
the bottom of the screen to get the whole story. And if you're using AutoCAD
2005 or an earlier version, WATCH THE COMMAND LINE!
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In AutoCAD 2006 and later you can turn the command window off and on Book |
with the Ctrl+9 toggle. We've even seen books that recommend that you turn Chapter 2
it off, but we think this is a bad idea. The dynamic input tooltips do not show
you everything that the command window does, so even if you're using =
AutoCAD 2006 or later, and at the risk of repeating ourselves . . . watch the Sﬂ' n<z=
command line! B&
=
We tell you a bit more about the command window a couple of paragraphs g‘?,
from here. So you can stop watching it until then. o a
@

The status bar

At the bottom of the application window is the status bar. The status bar
contains three elements. At the left side is the coordinates display, which
shows the x-, y-, and z-values of wherever your crosshairs happen to be at a
given moment. By default, the coordinates constantly update as you move
your mouse around. Also by default, the coordinate values display as deci-
mal numbers with four places of precision. If you change to a different type
drawing unit (we describe units in Chapter 5 of this minibook), the format of
the coordinates changes to match the new unit’s type.

To the right of the coordinates readout is a set of buttons where you can
easily toggle a range of drafting modes such as snap, grid, object snap, and
so on. We tell you more about these modes in Chapter 6 of this minibook.

Finally, at the right end of the status bar, comes the status bar tray. You
should see anywhere from three to eight icons here; their functions are
listed in Table 2-1.

Table 2-1 Status Bar Tray Icons

Button Function Description

Communication Center Connects to Autodesk’s Web site
and shows articles, tips, and
software updates.

Lock/Unlock toolbars/windows Allows or prevents moving tool-
bars, palettes, and command
window.

Associated standards file Visible if CAD standards checking

N

is enabled; compare drawing prop-
erties (such as layer names, styles,
and so on) with associated draw-
ing standards file. We discuss
standards checking in Book VIII.

(continued)
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Table 2-1 (continued)

Button Function Description

Manage xrefs Visible if external reference draw-
ings are attached to a current
drawing, and indicates if xrefs
need updating. We tell all about
xrefs in Book VI.

<

] Plot/Publish Signals the end of the plot or pub-
; E lish job and indicates errors (if
any).
Performance Tuning Changes the way your computer
E performs when working in the 3D

environment.

Clean Screen Toggles the Clean screen func-
D tionality as shown earlier.

Trusted Autodesk DWG Displays DWG files that were
ﬁ.‘ created by an Autodesk product
or licensed real DWG.

You will see the Performance Tuning icon (the wrench) only from the time
you first open AutoCAD 2007 until the first time you look at the Performance
Tuning Log by clicking the icon. It will reappear if either Performance Tuning
or the Communication Center needs to alert you of an update.

Communicating with Your Software

So now you know what everything is . . . but what do you do with it? You saw
at the beginning of this chapter that there are a few ways to start AutoCAD.
Now you’re about to discover that you can do just about anything in multi-
ple ways in AutoCAD, beginning with how you speak AutoCADese.

The command line

Not to be confused with the LINE command, the command line is the place
where AutoCAD talks back to you (see Figure 2-9). Sometimes it just echoes
what you type (it’s easy to assume that it’s not very bright), but more often
it engages you in a helpful — if occasionally cryptic — dialog box.

Typically, you start your conversation with AutoCAD by issuing a command.
If you want to draw something new, AutoCAD usually starts by asking where
you’d like it to start. You pick a point, and then AutoCAD asks how big you
want it. You tell AutoCAD, and the program draws the object.



Figure 2-9:

The LINE
command
on the
command
line in the
command
window.
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If you want to edit something that’s already there, you issue a command —
for example, MOVE. AutoCAD asks you to select the objects to move. You
select them and press Enter to confirm your selection. The command now
starts prompting — for example, the MOVE command prompts for a base
point (a from point) and a second point (a to point).

You can switch off the display of the command window, but we think that’s a
bad idea. There’s just not enough feedback from dynamic input on its own.

Dynamic input

Not that we're badmouthing dynamic input. In fact, it’s a great addition to
AutoCAD, but it is one of those things that will probably be easier for the
newbies to adjust to than it will for the old-timers.

When dynamic input is enabled (by choosing the DYN button on the status
bar), AutoCAD displays tooltips near the crosshairs whenever a command is
active. When AutoCAD is expecting you to pick a point, the tooltip displays a
constantly updating coordinate readout (x- and y-coordinates only). If AutoCAD
needs more information, for example, the radius of a circle, you can type the
numbers into the tooltip.

Dynamic input mode is highly configurable. Right-click over the DYN button
and choose Settings to display the Dynamic Input tab of the Drafting Settings
dialog box. You can turn options off and on here and further refine them by
clicking the Settings buttons under Enable Pointer Input and Enable
Dimension Input.

Dialog boxes

AutoCAD has two different types of dialog boxes — modal and modeless.
Modal dialog boxes are the regular, old dialogs you see in every Windows
program. They pop up whenever you save an unnamed drawing, or want to
format your units, or make some drawing settings. Modal dialog boxes like
Save, Open, Plot, and so on, take command of AutoCAD. You can’t do any-
thing else while one of these dialog boxes is open.

Book |
Chapter 2
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Modeless dialogs can stay open while you do other things in AutoCAD.
They’re so unique, in fact, that they're not even called dialog boxes. They're
called palettes, and you’ve already learned a thing or two about them. There
are a half-dozen and more modeless dialog boxes — or palettes — in AutoCAD,
and we’ll highlight their importance at appropriate places in the text.

Running AutoCAD Commands

Even when you use the menus or toolbars to execute commands, there are
still significant differences between AutoCAD and other Windows applica-
tions that you might be familiar with.

Grasping the AutoCAD Difference

The fundamental difference with AutoCAD is that AutoCAD expects you to
take part in a conversation. When you tell the program you want to move
something, AutoCAD asks what do you want to move, where do you want to
move it from, and where do you want to move it to?

Most of this conversation takes place in dialog boxes and the dynamic input
tooltip. We can’t give you a standard format for this dialog. One of the delights
of AutoCAD is the number of different ways the program has of doing what
you ask it to do. All we can do at this point is refer you to the chapters to
come (starting with the early chapters of Book II).

Repeating a command

Oftentimes in AutoCAD, you want to perform the same action on different
objects. You might, for example, want to move a bunch of linework to a dif-
ferent layer, and then move a bunch of text to a third layer.

Pressing Enter or pressing the spacebar at a blank command prompt repeats
the last command. You can also right-click and choose the last command
from the top of the shortcut menu.

A nifty feature was added to AutoCAD 2004’s Options dialog box, and you can
use it in any 2004 or later version of AutoCAD or AutoCAD LT. On the User
Preferences tab, Windows Standard Behavior area, click the Right-Click
Customization button. In the dialog box, check the Turn on Time-Sensitive
Right Click box. Click Apply and Close, and then click OK. Now, if you right-
click within a quarter-second (the default value in the dialog box), you get a
carriage return, just as if you’d hit the Enter key or spacebar. If you keep the
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right mouse button pressed down for longer than a quarter-second, then you Book |
get whatever Windows shortcut menu is appropriate to the current command. Chapter 2
P « >
Canceling a running command Sz
To cancel a command, simply press Esc. If you're a long-time user of AutoCAD, %E
and have been away for . . . well, a long time, you may be used to the Ctrl+C = g'
combination that issued a Cancel in all DOS versions of AutoCAD. If you’re not 8
one of those grizzled old-timers, you know very well that Ctrl+C copies selected ‘n? 3
@

objects to the Windows Clipboard. Whatever your origins, remember that Esc
cancels whatever’s going on at present.

Invoking transparent commands

Most AutoCAD commands are meant to be run without interruption. You
wouldn’t, for example, start drawing a line and then decide in the middle of
the line sequence that you wanted to draw a circle. Well, maybe you would,
but trust us, it’s not very efficient.

There are other times, however, when it is efficient to run one command
inside another. For example, you might be placing a very long linear dimen-
sion, and you’d like to be able to zoom in closely on one end of the object to
be dimensioned, and then zoom in closely again on the other end.

You can do this with AutoCAD’s display commands, as well as some of

the drafting settings, because these commands can be run transparently. A
transparent command is one that can be executed in the middle of another
command.

You may, for example, be in the middle of creating a linear dimension. You
realize you're zoomed too far out to be able to pick the defining points accu-
rately, so you go to the Standard toolbar and pick one of the Zoom com-
mands. You execute your zoom, and when you’re done, AutoCAD takes you
back to the command you were running. Same thing happens with toolbars —
just click a tool button, and your top-level command is suspended while the
secondary command executes.

You can mimic this behavior at the command prompt by typing an asterisk
before the command. The asterisk is a sign to AutoCAD that what follows is
to be executed transparently. Of course, not all commands can be run trans-
parently, but many can, including most of the display commands. Go ahead
and experiment: Just type an asterisk, and then a command, and see what
happens.
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AutoCAD system variables

Not everyone uses AutoCAD the same way.
Despite its hundreds of commands, there are
still specific ways that users want those com-
mands to operate. AutoCAD accommodates
with an array of system settings — called
system variables — that cover nearly all the
bases. Many system variables are toggles —
they have a value of either 0 or 1, meaning they
are either enabled or disabled. For example, the
system variable MIRRTEXT controls what hap-
pens to text when a group of drawing objects is
mirrored. If MIRRTEXT is enabled (that s, set to

1), then any textin the group is also mirrored —
it reads backward on the screen. If MIRRTEXT is
set to 0, the objects, including the text object,
are all mirrored, but the text itself is not mir-
rored, so it reads right-way around.

Other system variables can have different set-
tings (more than simply off and on), and still
others can store values that remain intact until
they're replaced with new values.

For a blow-by-blow of most of AutoCAD’s
system variables, go to the online help.

Reaching for AutoCAD Help

We hope that the AutoCAD & AutoCAD LT All-in-One Desk Reference For
Dummies will answer most of your questions about using AutoCAD. Never-
theless, there are going to be times when you want to go to the horse’s
mouth. Here are some ways of accessing the AutoCAD Help System:

4+ Enter a ? at a blank Command: prompt to display the AutoCAD Help

System.

4 From the Help menu, choose Help.

4+ Press the F1 function key at any time.

4 From the command line type HELP

Using built-in Help

Most of the time, AutoCAD’s Help system is context-sensitive. If you're in the
LINE command and press F1 (or choose Help=>Help), the Help system will
launch and take you to information about the LINE command.

A\

You can get context-sensitive help at the command line, too, by entering an
apostrophe and then a question mark (that is ’?).
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Using the Info Palette

This one is for newbies. If you turn on the Info Palette (click Info Palette on
the Standard toolbar, choose Info Palette from the Tools menu, or use the
Ctrl+5 key combination), you can see persistent help for whatever command
you’re working with. If it’s a complicated sequence, you can click the pad-
lock icon at the top of the palette. When it’s “locked,” the contents stay visi-
ble on-screen.

Finding online resources

Much as we’d like to think this book is all you’ll ever need, we recognize that
there are millions of one-off requirements that no book can possibly cover
comprehensively. One of the best resources available is Autodesk’s own dis-
cussion groups. Go to www.autodesk.com and click Discussion Groups to
find your way to a shopping list of discussion groups based on AutoCAD (or
AutoCAD LT version).

Book |
Chapter 2
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Chapter 3: All about Files

In This Chapter

+* Reviewing AutoCAD'’s file types
1~ Starting a new drawing

v Saving your drawing

v Saving to different file types

1 Opening existing drawings

v Closing windows

v~ Passing File Management 101
1+ Backing up

A utoCAD not only needs hundreds of files to keep itself going, it also
generates more files than you can shake a stick at. All of these files are
important, but none is more important than DWG — the drawing file itself.

In this chapter we cover all of the important files that you're likely to run
into — and one or two that you're not very likely at all to run into, but just
in case, you should know what they are.

It’s also important that both AutoCAD and you be able to find the files you
both need to work together. AutoCAD can usually take care of itself; after it’s
initially installed, all the files the program needs are in appropriate places.
But you need to be able to find your drawing files too, and AutoCAD by itself
isn’t much help there. Left alone, it will save all your drawings in the
Windows My Documents folder. It’s up to you to organize your storage
space, and we give you some ideas at the end of the chapter.

File Types in AutoCAD

AutoCAD'’s drawing (DWQG) files contain everything that you draw, and a bit
more besides. In addition to all those lines, arcs, circles, text, and dimen-
sions, your DWG files also contain:
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4+ Style definitions for things like your dimensions and text

4+ Properties associated with your drawing objects, such as color, layer,
and linetype

4+ Layer definitions, each and every one of which includes such things as
default color, linetype, plot style, whether the objects on the layer print
or not, and so on

Not contained within the DWG file itself, but necessary for it to display prop-
erly, are associated files that define the fonts used by the text and dimension
styles, hatch and linetype patterns, plot styles, and more. We cover those
associated files in more detail a few paragraphs from now.

So obviously, there’s a lot of file interaction going on when you work in
AutoCAD. A very important aspect of drafting in AutoCAD — or any CAD
system — is having a good version of your drawing to fall back on, just in
case bad things happen to it. Luckily for us, AutoCAD by default creates
backup versions of our drawing file every time we save the drawing. When
you click the Save tool button (or whatever your preferred method of inter-
acting with the program), AutoCAD makes a copy of your drawing (let’s call
it FOO.DWG) and renames the copy as FOO.BAK. After it’s done that, it takes
all the changes that you’'ve made and stored in memory, and spoons them
into the drawing file. When it’s finished remembering everything, it saves a
new version of FOO.DWG.

Not all programs will do this for you, but AutoCAD does, as long as you don’t
tell it not to. We cover that a bit more later on in the chapter.

One of the things that puzzles new users to AutoCAD is the fact that not all the
data needed to generate a drawing is included in the drawing file. Problems
don’t arise if you only ever open your drawings on your own computer, but
they can crop up if you ever have to send your drawings to someone else. If
that someone else — a client, a contractor, your teacher, or boss — doesn’t
have all the same files on her computer that you did on your computer when
you made the drawing, then the drawing is not going to look the same as it did
for you when you drew it.

Here are some of the files that are external to your DWG file that must be
available on every computer on which the drawing will be opened:

4+ Fonts (SHX and/or TTF files). AutoCAD comes with over 70 “vector” font
files (SHX extension). These fonts are installed in AutoCAD’s own sub-
folders within the Program Files folder (usually) on your C: drive. AutoCAD
can also use TrueType (TTF) fonts, which are part of Windows itself, and
which live in the Fonts folder of your operating system. We tell you lots
more about fonts in Book III.
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Be very careful about using non-standard fonts — either SHX fonts

that didn’t come with AutoCAD, or TTF fonts that didn’t come with the
Windows operating system. If you have to send your drawings to some-
one whose computer doesn’t have the fonts you used, they won'’t see
your drawing accurately.

Hatch patterns (PAT files). Hatch pattern files (by default, AutoCAD uses
a file named acad.pat; AutoCAD LTI’s version is named acadlt.pat, or
aclt.pat in pre-2007 versions) are used to generate the cross-hatching
that indicates objects cut in sections or specific areas on maps or plans.
Hatching is also covered in depth in Book III.

Linetype patterns (LIN files). AutoCAD’s default linetype patterns are
defined in a file named acad.lin (acadlt.lin or aclt.lin in AutoCAD LT).
This file defines non-continuous linetypes such as center, dashed, and
hidden used in standard drafting. We talk about linetypes in Chapter 5.

The acad and acadlt hatch pattern and linetype definition files are for
use with imperial units. If you're working in metric, use the acadiso.pat
(acadltiso.pat) and acadiso.lin (acadltiso.lin) files. If you start your
drawings correctly, these files are available automatically.

Plot style tables (CTB or STB files). Plot styles are collections of set-
tings that tell your output device (a highfalutin way of saying printer)
what color of drawing object corresponds to what thickness of printed
line, or what printed properties are to be assigned to what drawing
objects. (Don’t worry about printing for now — we cover it in much
greater depth in Book VII. You can worry about it then!) Plot style tables
are the files where all the plot styles live, and AutoCAD needs to find
them or your drawing won’t print properly.

Image files. AutoCAD can display and print raster images that are placed
in drawing files, but the files do not become part of the drawing file
itself. If AutoCAD can’t find them (say, you forget to send them with the
drawing file), then you get a rectangle showing the name of the missing
file instead. We cover image files in Book VI.

Other DWG files. You can attach drawings to other drawings so you
don’t have to keep redrawing the same things over and over again.
Those attached drawings are called external references (or xrefs for
short). The idea is that if you change something in a referenced drawing,
it automatically changes in all drawings to which it’s attached. It’s a
really useful feature, but it’s complicated (don’t worry — we tell all in
Book VI!). The point here is that if AutoCAD can’t find the referenced
drawing file, you get another one of those missing file messages.

Book |
Chapter 3
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To sum up, if you're sharing drawings with others outside your office:

4 You usually don’t have to worry about the font, hatch pattern, or line-
type files if you're using the standard fonts and patterns that come with
AutoCAD.

4 You may have to worry about plot style tables if you're using custom
ones.

4+ You usually do have to worry about images and external references,
since those are files that you create yourself, and are not part of
AutoCAD.

Starting a New Drawing

Figure 3-1:
Selecta
template to
start a new
drawing.

If all that information seems a little daunting at this point, don’t worry — all
will be revealed within these pages. In the meantime, it’s just possible that
you want to actually get down and dirty and draw something. So let’s look at
a trio of ways to start a new drawing in AutoCAD.

If you're using AutoCAD 2005, 2006, or 2007 out of the box (AutoCAD veter-
ans call this the “out-of-the-box experience”), when you click the QNew
button on the Standard toolbar, you get a Select Template dialog box (see
Figure 3-1).
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It may look like a “New” button, but it actually runs a command called QNEW.
Who knew? Here’s what QNEW can do for you. If you don’t change any settings
in AutoCAD, clicking QNEW will always display the Select Template dialog box.
Now, if you always start a drawing using the acad.dwt template (not the best
idea, but read on), you have to click Acad.dwt, and then click OK. That can get
a bit tedious. But if you go into the Options dialog box and click Files, you can
identify a specific template file (maybe even Acad.dwt). Doing so will tell
AutoCAD to start a new drawing using the specified template every time.

A further wrinkle in starting a new drawing occurs if a system variable called
STARTUP is enabled. By default, STARTUP is disabled or set to 0; for more on
system variables, see the sidebar “AutoCAD System Variables” in Chapter 2 of
this minibook.

If STARTUP is enabled (or set to 1), the first time you start AutoCAD you see
a Startup dialog box (see Figure 3-2).

3 Startup 2%
= AN se a Template
@ [ O Use a Templ
Sond amedt e -
— Hcad named plot styles3d dwt
Acad dwt
Figlll’e 3'2: iﬁi:?:;rcc plot styles.dwt
The Startup | [icssae o =2 .
d|a|0g box Template Description Bowse.. )
you see g::;:l Engish fieet and inches) crawng template. Uses Color Dependent ot
if STARTUP 5
=1
From this dialog box, you can choose to open an existing drawing or start a
new drawing in one of three different ways: starting from scratch, using a
template, or employing a wizard. Once the first drawing in an AutoCAD ses-
sion has been opened using any of these methods, subsequent clicks of the
QNew button will display a Create New Drawing dialog box. This dialog box
looks suspiciously like the Startup dialog box — it gives you the same three
choices for starting a new drawing, but the icon for opening an existing
drawing is grayed out.
Q&N\BER The STARTUP system variable must be set to 1 in order for the Startup and
< . .
& Create New Drawing dialog boxes to appear when you start AutoCAD or

when you click the QNew button. If you only ever see the Select Template
dialog box on either starting AutoCAD or clicking QNew, then your STARTUP
variable is disabled.

Book |
Chapter 3
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We suggest you leave STARTUP set to 0, as the other options for starting a
new drawing — that is, from scratch or using a wizard — are much less effi-
cient, as we explain now.

Starting from scratch

When you start a new drawing from scratch, you're starting AutoCAD with
no preconfigured settings. There are no layers in the drawing other than
Layer 0, nor are there any text styles, or dimension styles other than STAN-
DARD. There are no table styles, and no predefined layouts. When you
choose this option, you really do start from scratch, and you must spend a
fair old whack of time making settings that you could easily make once and
save in a template. For simple sketching, or working out design ideas, it’s
okay to start from scratch, but once you're into working drawing production,
it’s a lot more efficient to use a template. But even starting from scratch is
better than using a wizard.

Using a Wizard

Wizard, schmizard — what do they know? Not much, when it comes to set-
ting up drawings in AutoCAD. We don’t mean to disparage all wizards —
there are a few useful ones in AutoCAD — but the one that offers to start a
new drawing for you is not one of them.

There are two kinds of wizard to choose from: You can run a Quick Wizard or
an “Advanced” one (see Figure 3-3).

3 Startup 2%
3 M~y Use a Wizard
@ 00 R
Select a Wizard:
,r- 4 Set B —— |
i s
J "‘\V_.
—— Wizard Descption
- Sets the units and area for your new drawing. Based on the template acad dwt.
Figure 3-3:
Pick your
wizard.

The problem with the wizards — both of them — is that the settings that
they make for you are not very useful. Both wizards will set these values:
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4+ Units. Choose the format and precision for your linear drawing units Book I
(see Figure 3-4). Regardless of the format you choose, the units are Chapter 3
based on inches if you live in the U.S.A, or millimeters if you live outside
the U.S.A.
=
:
QuickSetup %] g
=]
» Uit b Select the unk of measurement, §
s E_ O Decimal
& O Engneerng
— ) (&) Architectural
Figure 3-4: = O Fractiondl
Both ' e
wizards (this
is the Quick
one) ask you
to select the
units type. (o> ) [ Conce |

4+ Area. Specify the drawing area by its length and width. You arrive at the
correct figures by multiplying the intended plot scale of the drawing by
the dimensions of the paper on which it will be plotted.

In addition to units and area, the Advanced wizard also sets these values:

4+ Angular Units. Choose the format and precision for angular measure.
The default type of angular measure (and the easiest by far for most
people to work with) is decimal degrees.

4 Angle Measure. Specify where in the circle 0 degrees lies. By default,
0 degrees lies due east. If you don’t have a compass handy, you can
also think of this direction as 3 o’clock, or to the right, in a dead
horizontal alignment.

4+ Angle Direction. Specify whether angles are measured in a clockwise or
counterclockwise direction. By default, angles are measured in a counter-
clockwise direction, so if 0 degrees lies on an east-pointing horizontal axis,
then 90 degrees is straight up, 180 degrees is horizontal pointing west
(9 o’clock for you clock watchers), and 270 degrees is straight down.

Nearly all major industries go with the AutoCAD defaults for angular
measure — that is, 0 degrees is on an easterly horizontal axis, and angles
are measured in a counterclockwise direction. One exception to this rule is
in surveying, where 0 degrees usually points north, and angles are measured
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in a clockwise direction. But if you’re not a surveyor (and maybe even if you
are), don’t change the settings for angular measure from their defaults, as it
can make editing the drawing a nightmare.

So why are we so down on the wizards? The settings they make are just not
practical for most real-world drafting applications. By far your best bet is to
use one of the templates that AutoCAD provides. You can modify any of those
templates to make them even more efficient, and we tell you how to do that
in Chapter 5.

Using a template

Templates are drawing files with collections of settings already made. You
should regard the settings that come with AutoCAD as starting points; some
of them may be very close to what you want, but you need to add the other
5 or 10 percent yourself.

Templates are drawing files — the only difference is the last letter of the file
extension: DWG for regular drawing files, DWT for drawing templates. By
default, AutoCAD is configured to place templates in a special Windows-
generated folder under C:\Documents and Settings, although you can tell
the program to look in another place.

AutoCAD comes with no fewer than 66 templates, but don’t worry, you're not
going to have to go through them all to find a useful one! Nearly all of them
come in two versions, one configured for color-dependent plot styles, and one
for named plot styles (we explain more about these two options in Book VII).

Unless you’re told otherwise by your boss or teacher, you should probably
choose the color-dependent plot-style versions of the template files. Color-
dependent means the colors of the objects in the drawing determine how
thick the linework will be plotted. Named plot styles, on the other hand, are
independent of object color, and are specific properties applied to those
objects. The reason we recommend you stick with color-dependent plot
styles is that this is basically the system used by AutoCAD since the 1980s
to plot drawings. But we have more to say about all of that in Book VII.

The templates break down as follows:

4+ ANSI templates. (American National Standards Institute) Designed for
drafting in Imperial units; templates for ANSI sheet sizes A, B, C, D, and
E; if you work outside the United States or Canada, you can probably
forget about these.
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4+ DIN templates. (Deutsches Institut fiir Normung). Original European
standards very similar to and slowly being replaced by ISO; designed for
metric drafting; templates for metric sheet sizes A0, Al, A2, A3, and A4.

4+ Gb templates. Follow British Standards Institute criteria; templates for
metric sheet sizes A0, Al, A2, A3, and A4.

4+ ISO templates. (International Organization for Standardization). Inter-
national, European-based standard for metric system; templates for metric
sheet sizes A0, Al, A2, A3, and A4.

4+ JIS templates. (Japanese Industrial Standards). Based on the ANSI
system, adapted for metric drafting.

4+ Miscellaneous templates. These include Acad.dwt (imperial) and
Acadiso.dwt (metric), as well as “architectural” and “generic” templates.
Most are not based on specific sheet sizes. Unless these templates are
specifically named otherwise, assume they’re all set up for color-
dependent plotting.

Which template should you use? If you’re working in feet-and-inches in North
America, the ANSI templates are a safe bet. If you're working in other parts
of the world, figure out the metric templates that are closest to home (that
is, European, British, or Japanese) and go with those. Remember that the
supplied templates are just starting points, and you’ll need to do some cus-
tomizing of them to make them truly useful time-savers.

Saving a Drawing

\\3

We don’t have to tell you that it’s important to save often (at least, we hope
we don’t!). Everyone has their own little formulas for saving: every hour,
every 15 minutes, on the solstices and equinoxes (and we sincerely hope
you're not in the last category?!).

Okay, let’s get serious for just a moment. How often should you save your
work? A really great mantra to keep in mind — or maybe even print out and
pin to the wall over your desk — is, “How much work am I prepared to lose?”
You may have just completed a complicated polar array of a kazillion objects,
but it’s still three minutes away from your quarter-hourly save. Forget the
clock — hit that Save button right now! That’s how often you should save.

Saving files in AutoCAD can be a little complicated. (By now, you were proba-
bly expecting that, right?) There are three different commands for saving
files: SAVE, SAVEAS, and QSAVE, but they all fall naturally to hand (or to tool
button, to be more accurate).

Book |
Chapter 3
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Save

AutoCAD does have a command called SAVE, and the Windows-standard
Ctrl+S key combo works here too. But doing a Ctrl+S or hitting the Save
button on the Standard toolbar doesn’t run the SAVE command. It runs one
of two other commands: SAVEAS, which displays the Save Drawing As dialog
box, or the QSAVE command, which doesn’t display anything.

Save As

If your drawing is unnamed (and if the title bar says [Drawing 15.dwg], it’s
unnamed), entering a Ctrl+S or clicking Save on the Standard toolbar runs
the SAVEAS command. SAVEAS opens the Save Drawing As dialog box (see
Figure 3-5), and here you can enter three different pieces of information:

4+ Save in. Use this drop-down list to navigate to the folder where you
want to store the drawing. The list box below the Save in list shows all
drawings stored in the current folder

4+ File name. Enter the drawing name. We’ll have more to say about
naming files at the end of the chapter.

+ Files of type. You want to save a drawing, right? Well, there are draw-
ings, and there are drawings. You can save your work as a DWG in the
current format, or go back up to three DWG versions. If you have to go
back farther than that, you can save in Release 12 DXF format. Finally,
you can save your drawing as a template (DWT) file, or a Drawing
Standards (DWS) file.

We're not talking about saving back two AutoCAD versions — you can save
back up to three DWG versions. The current DWG version is AutoCAD 2007
DWG. The prior one was AutoCAD 2004 DWG, which was used by AutoCAD
2004, 2005, and 2006. The one before that was AutoCAD 2000 DWG, used by
AutoCAD 2000, 2000i, and 2002. And before that came AutoCAD R14.dwg
(used by that version only). So, if need be, you can save your work in a
DWG format that can be read by a version of AutoCAD first released in
1997. For more on file formats and versions, see Table 1-1 in Chapter 1 of
this minibook.

OSAVE

After all those Save and Save As options, QSAVE should come as a relief,
because there are no options at all. As noted earlier, if a drawing is unnamed,
clicking the Save button or issuing a Ctrl+S runs the SAVEAS command, dis-
playing the Save Drawing As dialog box, and presenting a plethora of options.
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DXF: The Neutral Format

DXEF, for drawing interchange format, is the offi- ~ Create DXF files through the Save Drawing As
cially sanctioned method for exporting dialog box. In the Files of type drop-down list,
AutoCAD drawing data to other CAD or graph-  there are four flavors of DXF to choose from:
ics programs, or for importing vector graphics  AutoCAD 2007, AutoCAD 2004, AutoCAD 2000/
from other programs into AutoCAD. Autodesk LT 2000, and AutoCAD Release 12/LT 2. You can
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Once the drawing is named, clicking Save or doing a Ctrl+S runs the QSAVE
command. QSAVE has no dialog box; in fact, it may look as if nothing hap-
pened. QSAVE simply resaves the named drawing file in the same location,
with the same file name, and as the same type of file, all without any addi-
tional input from you. Any guesses what the Q in QSAVE stands for?

Opening an Existing Drawing

Figure 3-6:
Select files
to openin
the...er,
Select File
dialog box.

Opening an existing drawing doesn’t present quite so many possible alterna-
tives as creating a new one does. All you have to know is where the drawing
is, and if you practice good file-management techniques, that shouldn’t be a
problem.

Open command

Clicking the Open button on the Standard toolbar, or using the Ctrl+O key
combination displays the Select File dialog box, as seen in Figure 3-6.
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The default file type in the Files of type drop-down list is DWG. Unlike the
Save As dialog box, which gives you a number of optional DWG versions,
there’s only one DWG listed in the Select File dialog box. This is because

AutoCAD can open any current or older version DWG.

Your other choices of file types to open through the Select File dialog box are:
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Opening an Existing Drawing

4+ Standards (*.dws). A DWS file is a regular drawing file that contains set-
tings and properties that you want to use as a base standard for a project
or for all your drawings. You can use the CAD Standards options on the
Tools menu to configure a DWS file, and to review your current drawing
to make sure it complies with the standards.

4+ DXF (*.dxf). Autodesk’s neutral and non-proprietary version of the DWG
format used for transferring drawing data into and out of AutoCAD. For
more information, see the sidebar “DXF: The Neutral Format.”

4+ Drawing Template (*.dwt). A DWT file is a regular drawing file that con-
tains settings, properties, and drawing objects that you want to use in all
the drawing files of a project. Using a template means you don’t have to
keep making these settings or drawing those objects over and over again.

Be careful when opening DWT files, as you may inadvertently make unwanted
changes that will show up whenever you try to start a new drawing based on
that DWT.

Can’t find that drawing file? Funny . . . you knew where it was yesterday, right?
Luckily, AutoCAD has a dandy, but well-concealed, utility hidden in the Select
File dialog box. To find Find, click the Tools button on the Select File dialog
box’s toolbar, and choose Find from the menu; the Find dialog box opens.
Enter a file name, or a partial file name, and lickety-split, AutoCAD will turn up
files that meet your criteria (see Figure 3-7). (If lickety-split doesn’t happen, try
changing the Look in location to the root folder.) Highlight the file you're after
in the list and click OK. The Select File dialog box reappears with the selected
file in the File name box, ready to open.

™ Find: Files named *map*.dwg

Name & Location | Date Modfied
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MName In Folder Size | Type Modfied
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8 Junkmap1.dwg [\ Dramings 75KB  AutoCAD Draw...
™ Jurkmzn2.dwg D-Drawings 31IKE  AutoCAD Draw...
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£ Map to Adtisan Square bak dwg D \Drawings KB AutoCAD Draw...
F8 Map to Adizan Square-4 01.dwg D-\Drawings 44KB  AutoCAD Draw...
3 Map to Aisan Square-4 dwg D:\Drawings 43KE  AutoCAD Draw...
] Map to Atisan Square.dwg DDrawings 3KE  AutoCAD Draw 05/
:_'-'l ET Map 1o Atisan Square 01dwg D \Drawings\RLA I7KB  AutoCAD Draw.. 10/02/0512:41..
F8 ET Map to Aisan Square-4 0l.dwg D:\Drawings'\RLA 44KB  AutoCAD Draw... 10/02/05 12:41..

11 files found.
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Using Windows Explorer

When you can’t quite remember where you put that danged drawing, the Find
function in AutoCAD’s Select File dialog box works well, but not many people
know about it. Fveryone, however, knows Windows Explorer, and the Search
tool on the Windows Start menu. If the drawing was created in AutoCAD 2006
or later, you can even search on words that are part of drawing text. This is
not the place to explain Windows XP’s or 2000’s Search function — if you
don’t know how to use it, click Help on the Start button.

Once you have searched and found, you can open your file and start
AutoCAD at the same time.

And a double-click to open

You can always use Windows Explorer to open your drawings. Simply
double-click to open them in AutoCAD.

One potential drawback of double-clicking in Explorer arises if you have
more than one version of AutoCAD on your computer. If you're a one-person
shop, that may sound unlikely, but lots of big organizations will have two
versions of AutoCAD on their systems while they’re transitioning from one
release to the next. Such a company might have seats of both AutoCAD and
AutoCAD LT, or “vanilla” AutoCAD alongside a Desktop product such as
Architectural Desktop, Mechanical Desktop, or Land Desktop. When you
double-click a drawing file in Explorer, the drawing opens with the last-used
version of the software, and that may not be what you want at all. If you've
only got one single version of AutoCAD, then no problem, but if you have
access to several versions, don’t do the double-click thing — start your
AutoCAD of choice first, and then use the Open dialog box.

Perhaps a better way of using Windows Explorer with AutoCAD is dragging
and dropping files into an already-running instance of AutoCAD (especially if
you've more than one version on your system).

Be careful where you drop though. If you drag and drop a drawing from
Explorer into an open AutoCAD drawing, the dragged-and-dropped drawing
will be inserted into the already-open drawing as a block. If you want to open
a drawing from Explorer by dragging, make sure you do the dropping in an
empty gray part of the graphics area, as shown in Figure 3-8.

Partial opening

You can speed up the loading of very large drawings through the technique
of partial opening. Doing a partial open of a drawing loads only the specified
layers and/or view area. If you need to add more of the full drawing’s data to
a partially open drawing, you can do so using partial loading.
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You can access partial opening through the Select Files dialog box that
appears when you use the Open tool button (see Figure 3-9). To add bits and
pieces of the same drawing, choose Partial Load from the File menu, or enter
PARTIALOAD at the command line.
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You can only partially open a drawing if the drawing has been saved with
either a layer index, or a spatial index, or both. Create these indexes in the
Save As dialog box by clicking Options, and then on the DWG options tab,
selecting the desired index type from the drop-down list.

The Multiple-Drawing Environment

All twenty-first-century versions of AutoCAD support multiple documents.
Big deal, you say — every Windows program can open multiple documents.
Well, it is a big deal if you're a grizzled old-timer, because for several
releases, AutoCAD was one of the few Windows programs that did not sup-
port multiple documents.

Having several drawings open at once means you can easily copy objects
from drawing to drawing by using the Windows Clipboard. AutoCAD’s
Window menu lets you arrange several drawings within the graphics area,
either by cascading them in an overlapping array, or tiling them so each
drawing window is visible.

P If you're like us, you prefer to have as much of your drawing visible as possi-
ble. In AutoCAD, just like in other Windows programs, you can have several
drawings open and maximized at once. To switch between them, use the
Ctrl+Tab key combination.

There are a few add-on programs for AutoCAD that can’t handle multiple
documents; they will only function if one and only one drawing is open at a
time. AutoCAD has a system variable named SDI (Single Document Interface)
that you can enable if you have one of these ornery add-ons. Set SDI to 1 to
disable multiple drawings, or to 0 to allow multiple drawings. Note that it’s
highly unlikely that you’ll need to change this variable, and if you do, the
add-on’s documentation should tell you so.

Closing Windows

Closing AutoCAD windows is just like closing files in other applications. All
the window types that we looked at in Chapter 2 have Close buttons on their
title bars. You can simply click the Close buttons to toolbars and palettes to
shut them down.

‘x\gN\BEIf To open toolbars, right-click over a button — doesn’t matter which — in any
& open toolbar to see a shortcut menu of all AutoCAD toolbars. If you're after

one of the Express Tools toolbars, you need to right-click in an empty part of

the docked toolbar areas to display a higher-level shortcut menu showing all
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loaded menus, not just the AutoCAD one. Click Express from this menu for a
submenu of the Express toolbars. To open a palette, go to the Tools menu
and select the one you want. After you’'ve been working with the program a
while, try to learn the Ctrl-key shortcuts; it’s much more efficient toggling
Ctrl+1 to open and close the Properties palette, for example, than to keep
opening the Tools menu.

If you click the Close button on a drawing window, or the Close button on
the AutoCAD title bar, and you’ve made unsaved changes, the program will
display an alert box like the one in Figure 3-10. Click Cancel to go back and
save your changes, click No to close the drawing without saving changes, or
click Yes to save the changes and then close the drawing. If your drawing is
unnamed, the Save Drawing As dialog box appears.

AutoCAD %]

:!/ Save changes to Drawing2. dwg?

[ Yes ] [ No ] [ Cancel

File Management for AutoCAD

Now that you know what all those files are, how to create new drawings, how
to open existing ones, and how to close everything down, you need to think
about effective file management. When you want to open an existing drawing
file, the Find utility in the Select File dialog box is all very well, but it’s not
very efficient. It’s much better if you know where you put those drawings, so
you don’t waste time looking for them. It’s a lot like having all those papers
that are neatly stored in file folders in your filing cabinet stacked up in piles
on your desk.

The best approach here is to have a comprehensive organizational scheme
that covers both naming and storage.
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Naming drawing files

If you’re working on your own, and you produce your own hard-copy versions
of one-off drawing files, you can name your drawings pretty well anything you
like. If you’re an employee in a design or engineering firm, however, or are a
student taking a course, you’ll probably need to pay attention to the file-
naming conventions in your organization.

Typically, drawings are seldom one-off — it’s rare that something can be man-
ufactured or constructed using a single drawing. When you start dealing with
drawing sets, you really need to pay attention to a naming scheme that keeps
all associated files together in your file folders. Individual companies may
have their own system. In the United States, professional organizations, such
as the American Institute of Architects and the Construction Specifications
Institute, produce non-mandatory guidelines for naming CAD files. Following
the AIA file naming specification may give you drawing names like A-FP01 or
C-SP04, but even if you don’t know the system, a quick check in the guidelines
will tell you that you’re looking at the first sheet of Architectural Floor Plans,
or the fourth sheet of Civil Site Plans.

For more information on these and other file-naming protocols, visit these
Web sites:

4 American Institute of Architects. (www.aia.org)
4+ Construction Specifications Institute (www.csinet.org)

4+ National CAD Standard (www.nationalcadstandard.org)

Storing your files

Files go in folders, and it makes as much sense to name your folders sensibly
as it does to name your files in a useful way. If you belong to an organization,
then the file storage protocols will already be set up. You'll probably be
saving to a network — in predefined folders that you may not be able to
modify.

If you are on your own, then come up with a system that will help you find
files quickly. Obviously, storing files by project is a sensible first step. If
you’re really busy (lucky you!) you might consider having the year as a
top-level folder, and then individual projects down a level. Using a similar
subfolder structure can really help you find those files, even if it does entail
drilling down a bit. For example, if you design houses you might have a
standard series of folders named SITE PLANS, FLOOR PLANS, ELEVATIONS,
SECTIONS, and DETAILS residing under each project (see Figure 3-11).
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... but losing a file you've spent two days working on is even harder. It’s not
a matter of if you ever need to call on your backups, it’s a matter of when.
Hardware is pretty reliable these days, but disks do fail. Remember that IBM,
or Dell, or HP, or whomever it was that you bought your computer from,
chose the lowest bidders as their suppliers.

We’re not talking about your BAK files now, the ones we explained at the
beginning of this chapter. AutoCAD’s own backup files are all well and good,
but they’re not adequate for a backup system.

The likeliest thing to go is your hard disk, and luckily, that’s what backup
solutions are meant to protect. Invest in backup hardware; there’s lots to
choose from out there, so fire up your trusty search engine and see what you
can find on the Web. Among your choices:

4+ External hard drives. Especially practical if you have more than one
computer. Some drives are especially designed as backup units and
come with software that lets you schedule and automate backups.

You can also use the built-in Backup utilities that come with Windows XP
and Windows 2000. If you're using Windows NT (which means you’'re
using AutoCAD 2005 or prior) or something even older, you’ll need to
invest in backup software.

4+ Tape drives. Tape is fairly obsolete now, and we don’t recommend
buying a new tape backup unit. But if it’s all you have, it’s better than
nothing!

Book |
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4+ Removable disks. The best known of these devices is lomega’s Zip
Drive; the drives themselves can be internal or external, and the propri-
etary disks come in 100, 250, and 750 MB capacities.

4+ CD-Rs and DVD-Rs. Compact Disc-Recordable and Digital Versatile Disc-
Recordable disks are cheap and efficient means to backing up data up to
700 or so MB. Most computers purchased in the last five years come
with CD-RW drives, so the investment here is minimal.

4+ USB memory keys. A great idea, and now amazingly cheap: penknife-
sized devices that plug into a spare USB port and are seen by Windows
XP as just another drive.

How often should you back up your hard drive? It’s worth revisiting that ear-
lier question: “How much work do I want to lose?” Now, we’re not suggesting
that you run a full system backup every 15 minutes, but once a day, at the
end of the day, is not excessive. If your hard drive does crash on you at

your afternoon coffee break, you might have lost your day’s work, but you
can always use yesterday’s backup.

If you have one.
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Chapter 4: Basic Tools

In This Chapter

v+ Drawing lines

v Drawing circles

v+ Changing viewpoints by panning and zooming
v+~ Erasing and unerasing objects

v+ Undoing and redoing actions

In this chapter, we look at some of AutoCAD’s primitive drawing objects.
That’s not an insult; by primitive we mean basic drawing elements like
lines, arcs, and circles. There are also complex drawing objects such as
polylines, mtext objects, and dimensions, which we’ll get to in good time.

The purpose of this chapter is to show you how to draw stuff as simply as
possible. Remember that the purpose of a CAD drawing is to convey techni-
cal information accurately and precisely (and those two words don’t mean
the same thing!). This chapter shows you how to draw primitives, but don’t
get into the habit of drawing everything the way we show you here. In real
drawing, you need to pay attention to object properties such as color, line-
type, and layer, as well as precision.

Drawing Lines

Lines are the second most basic object you can have in AutoCAD. Lines are
geometrically defined in any AutoCAD drawing by the coordinates of their
endpoints. The only thing simpler than that is the point object, which is
defined by a single set of coordinates. (Don’t be too concerned about coor-
dinates at this point — we tell all in Chapter 6 of this minibook.)

Lines are the fundamental building blocks of most types of drawing, espe-
cially if you work in architecture or general building design. If you do
mechanical drafting, you may well draw as many circular shapes as straight
ones (in that case, do we have a paragraph coming up for you — hang on
tight!). If you do civil-engineering drawing or mapping, you're probably
lucky if you see a straight line once every six months. But whatever kind of
drafting you do, at some point you're going to need to draw lines.
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You would think that a line is a line is a line, wouldn’t you? But not much is as
simple as that in AutoCAD. What looks like a line may or may not be a line —
meaning a line object. Straight, linear-looking thingies on your drawing screen
may also be polyline objects, or components of a multiline object. It may even
be part of a table object. We cover all the various types of lines later in the
book, but for now, what we’re interested in is the primitive line object.

You draw primitive line objects with a command called . . . wait for it . . .
LINE! You can start this command in a number of ways:

4+ Draw menu. Click Draw on the menu bar, and then move your mouse
pointer down to Line and click.

4 Draw toolbar. Click the Line tool on the Draw toolbar.

4+ Keyboard input. Type LINE (either uppercase or lowercase, it doesn’t
matter which; as we explain in the Introduction, we show proper com-
mand names in all upper case in this book). When you finish typing,
press Enter.

4+ Command alias. More typing (actually, less typing). Press L and press
Enter.

4+ Tool palettes. You'll find the LINE command (and a few others) on the
Command Tools tab of the Tool palettes. If you don’t see the tab, right-
click the Tool palettes title bar and choose either Sample or All Palettes.

AutoCAD has several dozen command aliases that provide alternative short-
cut keyboard methods for issuing commands. L is the alias for the LINE com-
mand, so typing either LINE (the full command name) or L (the command
alias) and then pressing Enter both do the same thing: they run the LINE
command. You can probably figure out a lot of aliases for yourself: C for
CIRCLE, A for ARC, Z for ZOOM, and so on. For a complete list of AutoCAD’s
command aliases, choose Tools, Customize, Edit Program Parameters
(acad.pgp) to open the program parameters file in Windows Notepad or
your configured text editor.

The following procedure uses the Draw menu to start the command and
draws a line from between two random points on the display.
1. From the Draw menu, choose Line.

AutoCAD starts the LINE command. The command line and the dynamic
input tooltip (if DYN is enabled) prompt you this way:

Command: _line Specify first point:

2. Specify the first point of the line by clicking a point on-screen.



Figure 4-1:
Primitive
lines (you
have to
start some-
where).
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AutoCAD starts drawing a line from the point you pick. As you move the
cursor, a temporary line segment (see Figure 4-1) joins the first point with
the crosshairs. AutoCAD prompts:

Specify next point or [Undo]:

The second prompt displays a command option inside square brackets.
Most AutoCAD commands have options, and the standard way of pre-
senting them at the command line is to enclose them in square brackets.

To enter an option, type the uppercase letter of the option. In this case,
typing U and pressing Enter runs the LINE command’s Undo option; this
command removes the previous line segment and backs up AutoCAD to
the line’s start point.

b

Specify additional points by clicking them on-screen.

Notice that AutoCAD does not end the LINE command after you've
drawn a single line. You can keep clicking points on-screen, and
AutoCAD will keep adding line segments to your drawing.
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After you click a third point, the command line changes slightly:
Specify next point or [Close/Undo]:

Two options appear inside the command line’s square brackets. The
Undo option is still available, but a Close option appears, as well.

4. Press C and then press Enter to close the shape.

AutoCAD locates the next point on the original start point, making a
closed triangular or polygonal shape. AutoCAD ends the LINE command
and returns you to a blank command line.

Figure 4-1 shows the command in process; notice the command line and
the dynamic input tooltip, both showing command options.

When you enter C to close the group of lines and end the command, what
you end up with is a series of separate line objects. If you click your mouse
pointer on top of any line segment, you’ll see that only that part of the shape
highlights as being selected. In Book II, we look at another entity type called a
polyline, where all the line segments are joined into a single AutoCAD object.

Creating Circles

Figure 4-2:
You can
draw circles
six different
ways.

Circles, like lines and every other drawing object in AutoCAD, are mathemat-
ically defined. Lines are defined by the coordinates of their endpoints. Circles
are defined by the coordinates of the center point and a specified numeric
value for the radius.

The default method of drawing circles in AutoCAD is by selecting a center
point on-screen and then entering a number for the radius. But there are a
half-dozen different ways to draw circles. Figure 4-2 shows these options on
the Draw menu.

Arc g |
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The options are

4+ Center, Radius. Select a center point on-screen, and then either enter a
value for the radius or drag a second point from the center point to indi-
cate the radius. This is the default method for drawing circles.
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QgNﬁh
& In this case, default means what happens when you simply click the Book |
Circle tool button or enter CIRCLE at the command line, without specify- Chapter 4

ing any options.

4+ Center, Diameter. Select a center point on-screen, and then either enter a
value for the diameter or drag a second point from the center point to indi-
cate the diameter. Because it’s a diameter distance that you're dragging,
the second point is twice as far from the center as the circumference.

s|0o] aiseg

4+ 2 Points. Specify two points on-screen; the two points are treated as
endpoints of the diameter of the circle.

<+

3 Points. Specify three points on-screen; a circle is drawn through them.

4+ Tan, Tan, Radius. Select two existing objects, and then enter a value for
a radius. AutoCAD draws a circle tangent to the two selected objects
with the specified radius (assuming such a circle is possible).

4+ Tan, Tan, Tan. Select three existing objects and, geometry permitting,
AutoCAD draws a circle tangent to all three of them. This one’s not really
an option of the CIRCLE command, but a special macro accessible only
from the Draw menu. You can’t do the tan, tan, tan at the command line.

Any of these options will get you a circle, but which one you would choose
depends on the drawing geometry and the information you have. For exam-
ple, if you're given the requirement for a circle of diameter 29.57137, it’s
easier to use the CIRCLE command’s Diameter option than it is to dig out
your calculator and divide 29.57137 by 2 to get the radius.

The following steps use the Circle tool button on the Draw toolbar to draw a
circle using the Diameter option:

@ 1. Click the Circle button on the Draw toolbar.
AutoCAD starts the CIRCLE command. The command line prompts you:

Command: _circle Specify center point for circle or
[3P/2P/Ttr (tan tan radius)]:

“@N\BER If you want to use one of the available options, enter 3P for 3 point

& circle, 2P for a 2-point circle, or T to use the Tan, Tan, Radius option. You
need to type the uppercase letters of the command option you want. For
2-point and 3-point, you press P after the 2 or 3, or AutoCAD thinks you
are trying to enter a numeric coordinate location.

2. Specify the center point.

AutoCAD places the center of the circle and drags a rubber-band line
between the center point and the crosshairs; AutoCAD prompts:

Specify radius of circle or [Diameter]:
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If you simply pick a point or enter a value at this point, AutoCAD inter-
prets the input as the radius. If you want to use the Diameter option, you
must let AutoCAD know.

3. Press D and then press Enter.

Entering D here lets AutoCAD know you want to use the Diameter option
of the Circle command. AutoCAD prompts:

Specify diameter of circle:

4. Enter a numeric value for the diameter and press Enter, or drag the
crosshairs out to indicate a length equivalent to the diameter and
click.

AutoCAD draws the circle.

The steps in this and the preceding sections show how to draw two of the
simplest object types in AutoCAD. The procedure for drawing most objects
is basically similar. We look at drawing other kinds of objects in Chapter 1 of
Book II.

Taking a Closer Look

One of the great advantages of AutoCAD is that you work on an infinitely large
drawing sheet — so large, in fact, that you could design a solar system full size!
With a drawing sheet that size, though, you need to be able to get up close to
the drawing objects in order to add detail. Enter the display commands.

There are three broad categories of display command: ZOOM, PAN, and
VIEW. We look at all of them in detail in Book II. Here, we're going to show
you just enough of the basics so you can navigate around your drawing (or
one of AutoCAD’s sample drawings, in case you haven’t actually drawn any-
thing yourself yet).

We begin with the two so-called realtime commands, RTZOOM and RTPAN.
They’re called realtime commands because you can see the change in view in
“real time” as you run the command.

Checking out Zoom Realtime

Zooming in a drawing increases or decreases the magnification of drawing
objects. To make drawing objects appear larger, you zoom in; to make them
appear smaller, you zoom out.
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When you zoom in or out of a drawing, you make drawing objects look larger
or smaller by moving your viewpoint farther away or closer. You are not
changing the objects themselves. When we cover the Modify commands in
Book II, you discover a SCALE command that really does make objects
smaller or larger by changing their geometry.

There are a number of ways to initiate realtime zoom. Perhaps the easiest is
to pick the Zoom Realtime button on the Standard toolbar.

When you start either Zoom Realtime or Pan Realtime, the crosshairs are
replaced by a hand cursor or a magnifying glass cursor. Right-clicking dis-
plays a shortcut menu that lets you switch from Zoom to Pan and vice versa.
There are also three Zoom options on the shortcut menu, as well as a link to
the 3DORBIT command. For the time being, we're in a two-dimensional
world, but we cover 3DORBIT in Book V.

Using Pan Realtime

Panning in a drawing changes the view without changing the magnification.
To initiate realtime pan from a command prompt, click the Pan Realtime
button on the Standard toolbar. A right-click in Pan Realtime displays the
same shortcut menu as Zoom Realtime, although there are no specific pan-
ning options.

To zoom and pan in a drawing, follow these steps:

1. Open one of your own drawings, or a sample drawing such as
\Program Files\AutoCAD 2007\Sample\Blocks and Tables -
Imperial.dwg. Click the Model tab at the lower-left corner of the
graphics area.

Realtime panning and zooming work in layouts as well as the model tab,
but to keep it simple for now, we’ll stay on the model tab. (We cover
model space and paper space differences in the next chapter.)

2. Click the Zoom Realtime button on the Standard toolbar. (It’s the
button with the magnifying glass and the plus-minus sign.)

You can’t use any other command during a realtime zoom or pan. The
command line disappears and is replaced by this prompt:

Press ESC or ENTER to exit, or right-click to display
shortcut menu.

3. Move the magnifying glass cursor to the middle of the screen and then
hold the left mouse button and drag the cursor toward the bottom of
the screen, and then toward the top of the screen.
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Figure 4-3:
The shortcut
menu in real
time.

Taking a Closer Look

Dragging the magnifying-glass cursor upward zooms in closer to the
drawing objects; dragging it downward zooms farther away.

4. Click the right mouse button to display the shortcut menu shown in
Figure 4-3. Choose Pan from the shortcut menu.

The magnifying-glass cursor changes to the hand cursor; you’re now in
realtime pan mode, just as if you’d started the Pan Realtime command
from the Standard toolbar.

Exit

Pan
v Zoom
3D Orbit

Zoom Window
Zoom Original
Zoom Extents

5. Press and drag the left button across the screen to pan the drawing
back and forth around the display.

You can toggle back and forth between realtime panning and zooming by

right-clicking at any time and choosing the other mode.

6. Right-click to display the shortcut menu. Click Zoom Original to
return to the original view of the drawing.

This is a quick way to get back to where you started, in case you get lost
with all the panning and zooming. We describe the other two Zoom
options on the shortcut menu — Zoom Window and Zoom Extents — in
Book II, Chapter 3.

7. Right-click again to redisplay the shortcut menu. Click Exit.

The hand cursor or magnifying cursor is replaced by the standard
AutoCAD crosshairs, and the command line looks like this:

Press ESC or ENTER to exit,
shortcut menu.

or right-click to display

Command :

In this chapter, we only cover very basic panning and zooming using one tool
button. We cover the remaining zoom options — and there are several — in
Book II.
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Editing Objects ool
AutoCAD provides three ways to edit objects:

4+ Start the command first, and then select objects.

4+ Select objects first, and then start the command.

s|0o] aiseg

4+ Grip editing. When you select an object by clicking it, you see one or
more little square blue boxes. These are called grips. You can click one
of these blue boxes (it will turn red) and access a range of editing com-
mands without ever needing to go to a menu or tool button. Book Il is
the place to go for more information on modifying objects with grips.

For now, we're going to stick with the traditional method of editing — choose
the Edit command, and then select the objects. If you only ever learn one of
these three methods, this is the one, because every Edit command is avail-
able this way. Not all commands will work in select-the-object-first mode,
and even fewer work with grips.

Erasing and Unerasing Stuff

The vast majority of the work you do in any AutoCAD drawing consists of
editing things that you've already drawn. Editing means copying, stretching,
rotating — and getting rid of mistakes.

Using the digital eraser

There is a wide range of things you might want to do with objects in your
drawing. You could move them, copy them, rotate them, scale them, mirror
them . . . but maybe they’re just bad objects, and more than anything you
want to remove, delete, expunge, annihilate . . . erase them. Here’s how:

1. Open one of your own drawings, or a sample drawing such as
\Program Files\AutoCAD 2007 \Sample\Blocks and Tables -
Imperial.dwg.

Again, this will go more easily if the Model tab is current.
2. Click the Erase tool button on the Standard toolbar.

AutoCAD prompts:

Command: e ERASE
Select objects:

3. Select two or three objects by clicking each one.



64

SMBER

\\3

Erasing and Unerasing Stuff

4. AutoCAD highlights the objects by displaying them in dashed
linework and prompts as follows:

Select objects: 1 found

Select objects: 1 found, 2 total
Select objects: 1 found, 3 total
Select objects:

AutoCAD continues adding objects that you select to its total.
5. When you finish selecting objects to edit, press Enter.

The selected objects are erased from the drawing.

These steps are typical for any editing operation in AutoCAD. The most
important thing to remember is that you must press Enter when you finish
selecting objects to complete any editing command.

Unerasing objects

Everyone makes mistakes, right? Including erasing objects in a drawing that
really shouldn’t have been erased. The real world doesn’t have unerasers
yet, but you're using AutoCAD now.

Like most Windows programs, AutoCAD has an UNDO command (covered in
the next section). The problem with UNDO is that you can’t selectively skip
over a bunch of stuff to get back to the action that you really want to undo.
Say, for example, you erased a wall and then drew a new wall in a different
place, and then copied some bathroom fixtures, and then zoomed and
panned — and then you realized you never should have erased that original
wall in the first place. AutoCAD will let you undo back to just before that cru-
cial erasure. Unfortunately, it will also undo the pan, the zoom, the copied
bathroom fixtures, and the new wall in a different place that you really
wanted to keep, all before it will undo that erasure.

There’s a little-known command that’s appropriately called OOPS. It’s little
known because it doesn’t have a tool button, and it’s not on any menu. You
have to know it’s there, and you have to type the command into the com-
mand line. OOPS has one single function: It unerases the last thing you
erased. So, in the just mentioned scenario, if you’d entered OOPS instead of
undoing back, you'd have maintained the view you got by panning and
zooming, you'd have retained those copied bathroom fixtures as well as that
new wall, and you’d restored that wall you never should have erased —
because it was the last thing you erased, and that’s exactly what OOPS is for.
Remember OOPS. Write it down and pin it up over your desk. If anyone asks,
you can tell them it’s your mantra.
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Undo. Redo. Undo. Redo . . .

Like all good Windows programs, AutoCAD has Undo and Redo functions.
Typically for AutoCAD, the UNDO command is complex and has a number of
options.

The simplest way to run UNDO is to use the Windows Ctrl+Z shortcut. Or
type U at the command line and press Enter. Or click the Undo button on the

Standard toolbar.

If you enter UNDO at the command line and press Enter, you get the full-
blown AutoCAD UNDO command. The command line looks like this:

Command: UNDO

Current settings: Auto = On, Control = All, Combine = Yes

Enter the number of operations to undo or
[Auto/Control/BEgin/End/Mark/Back]

We have more to say about UNDO in Book II.
Right next door to the Undo button on the Standard toolbar is a Redo

button. In the latest versions of AutoCAD, you can redo multiple undos —
great if you're one of those people who just can’t make up your mind!
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Chapter 5: Setting Up Drawings

In This Chapter

v~ Establishing drawing units

v Understanding systems of measure

v~ Establishing drawing limits

+ Understanding scale and scale factors

v+ Choosing between model space or paper space
+* Working with layers

+ Understanding object properties

v~ Establishing standards

1 Creating templates

A utoCAD is much more than an electronic sketch pad. Technical
drawings — as we’re sure you're aware — need to be accurate,
precise, neat enough to be read easily, and standardized. The next chapter
covers precision drawing techniques. This chapter explains how to set up
drawings and introduces a number of ways to ensure standardization —
ways that help you draw more efficiently.

Choosing Units of Measurement

In this book, when we discuss units of measurement in AutoCAD, we're not
talking about systems of measurement, and it’s important to keep those two
separate.

Globally speaking, there are two main systems of measurement in use today.
Imperial or English measure is based on inches, and metric measure is based
on the meter (or metre, if you live outside the United States).

Several versions back, AutoCAD referred to English units and metric units.
In AutoCAD 2000, the terminology switched — apparently incorrectly — to
Imperial units and metric units. There are slight differences between English
and Imperial liquid measure, although they’re not likely to bother most
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AutoCAD users who deal in linear and angular measure. For example, a U.S.

pint has 16 ounces and a UK pint has 20 ounces, but a foot in both countries
contains 12 inches. Come to think of it, maybe it would bother the AutoCAD

user who's just ordered a pint of Guinness!

The metric system has been, or is being, adopted in virtually every country
in the world, but some are taking longer than others to embrace it. The
biggest holdout — wouldn’t you know it — is the United States. Rumor has
it, in fact, that the United States, Liberia, and Myanmar are the last countries
in the world using English (or is that Imperial?) units.

Talking about units in AutoCAD can be confusing. It’s worth establishing
some definitions before we get to the nitty-gritty:

4 Units: Units is a generic term in AutoCAD, and it can cause a lot of confu-
sion to both newbies and experienced users; it’s best if you state specifi-
cally what kind of units you mean.

¢ Real-world units: Real-world units are the units you measure things
with every day. These units may be inches or miles, or millimeters or
kilometers, or yards or nautical miles. Real-world units are established
components of a uniform system of measure such as the metric system.

¢ AutoCAD units: AutoCAD, like all CAD programs, works by crunching
numbers, and numbers generally don’t have real-world units attached
to them — they’re just numbers. AutoCAD units can be formatted so
that they look like real-world units, but internally, they’re just numbers.

4 Unit types: There are two types of AutoCAD unit: linear and angular.

4+ Unit formats: Each of the two unit types can be formatted in one of five
ways, as shown in Table 5-1.

4+ System of measure: Globally, the most widely used system of measure is
the metric system. Locally (if you're a North American, that is), the
English (or Imperial) system of measure is much more widely used.
These are the two systems of measure we focus on in this book, and we
assume the vast majority of our readers are on the same pages.

Table 5-1 AutoCAD Unit Formats

Linear Example Angular Example
Architectural 1-31/2" Decimal degrees 90.000°
Decimal 15.5000 Deg/Min/Sec 90d'0"
Engineering 1'-3.5000" Grads 100.000g
Fractional 15172 Radians 1.571r

Scientific 1.5500E+01 Surveyor NO0d00'00.0"E
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Regarding Table 5-1:

4+ All linear examples are equivalent to one another, and all angular exam-
ples are equivalent to one another.

4 Architectural units in AutoCAD mean feet and fractional inches. Of course,
architects outside the U.S.A. and Canada will have to configure decimal
units if they want to work in metric units.

4 Surveyor units in AutoCAD mean quadrant bearings (for example, North
30 degrees West), but quadrant bearings are used only by American sur-
veyors. Surveyors in other parts of the world work in whole circle bear-
ings in either decimal degrees (for example, 120.000°) or Deg/Min/Sec
(for example, 120d'00"00).

4 The default precision for Angular units is zero places; Table 5-1 shows
the results of setting three places of precision.

Despite the large number of choices, chances are that you’ll be working in
either architectural (feet-and-fractional inches) or decimal linear units, and
decimal degree, or possibly deg/min/sec angular units.

Don’t be fooled by those foot-and-inch marks you see if you configure
AutoCAD to display architectural or engineering units. It’s just a clever
program that sticks the inch mark on every unit, and whenever it reaches

12 of those, adds a foot value and foot mark. It may look like 1'-4 1/2" to you,
but it’s just 16.5000 to AutoCAD.

If you are working in architectural units, remember that the AutoCAD unit
represents an inch. If you want to enter 6", entering 6 is enough. If you want
to enter 6', then you need to include the foot mark. If you don’t use a foot
mark, AutoCAD assumes that you want to use inches.

AutoCAD units

AutoCAD ignores the differences between metric and English/Imperial units
because it doesn’t actually work in either. In AutoCAD, the fundamental unit
is ... the unit. It’s up to you, the AutoCAD user, to determine what kind of
real-world units AutoCAD units represent.

Unless specifically labeled otherwise, AutoCAD’s drawing templates have
their units format (not their units fype) set to decimal units, with four places
of precision. Those decimal units can represent any real-world unit you
want; they could represent decimal inches, decimal meters, decimal

miles — whatever real-world unit you decide to use.
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‘x\g\v\BER When you set units format in the Drawing Units dialog box, you control
& the display of units in the coordinate display on the status bar, and in the
Properties palette, command line, and dynamic input tooltip when you draw
new objects or query existing ones. You are not affecting the display of
dimension values. To see how to format dimension values, see Book III.

Imperial or metric

Despite the previous discussion on AutoCAD units versus real-world units,
you still need to determine up front whether you’re working in metric or
Imperial (or is it English?) units. Remember, as far as AutoCAD is concerned,
a unit is a unit is a unit.

Choosing a metric or Imperial default beforehand can make your drafting
more efficient. Why? Because if you start a drawing with Imperial defaults,
you're automatically configured to use the Imperial hatch pattern and line-
type definition files, and if you start out with metric defaults, you're automat-
ically configured for the metric equivalents.

AutoCAD uses external definition files for its hatch patterns and linetype pat-
terns. For hatch patterns, AutoCAD has two files, acad.PAT and acadiso. PAT.
Similarly for linetype pattern definitions, there are two files named acad.LIN
and acadiso.LIN. (The equivalent files in AutoCAD LT are acadlt.PAT,
acadltiso.PAT, acadlt.LIN, and acadltiso.LIN.) We discuss linetypes
later in this chapter. See Book Ill, Chapter 3 for more on adding hatch patterns
to drawings.

Here’s how to determine whether to start with a metric-defaults drawing or
an Imperial-defaults drawing:

4 Starting with the template acad.DpwT (acadlt.DwT in AutoCAD LT) sets
Imperial defaults; starting with the template acadiso.DWT (acadltiso.
DWT) sets metric defaults.

4+ Starting with any of the ISO templates (DIN, Gb, JIS, or ISO) sets metric
defaults.

4+ Other templates that don’t fall into either of these categories identify by
their filenames whether they are set up for Imperial or metric.

System variables

You need to know about two system variables, especially if you work in both
Imperial and metric systems of measure. If you work exclusively in one or
the other, it still doesn’t hurt to know about them, but you can file them in a
dustier, less-visited part of your brain. (For more on system variables, see
Chapter 2.)
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4+ MEASUREMENT: This variable has a value of either 0 (Imperial units) or
1 (metric units). The MEASUREMENT variable is stored in each drawing,
which means you can work with drawings based in either Imperial units
or metric units.

MEASUREINIT: This variable also has a value of either 0 (for Imperial

units) or 1 (for metric units). MEASUREINIT is stored in the system reg-
istry and determines whether drawings started from scratch (without a
template) call on the acad (acadlt) or acadiso (acadltiso) pattern
and linetype files.

As long as you start your drawings from the appropriate template files (that is,
acad.DWT or acadlt .DWT for Imperial units, or acadiso.DWT or acadltiso.
DWT for metric units), the MEASUREMENT system variable is automatically
set correctly. The value of the MEASUREINIT variable is set when you install
AutoCAD; by default, it’s set to 0 for Imperial units if you live in the United
States, and 1 for metric units if you live anywhere else in the world.

Setting units in your drawing

The following steps show how to set architectural linear units and
Deg/Min/Sec angular units for your current drawing:

1. From the Format menu, choose Units.

AutoCAD displays the Drawing Units dialog box (see Figure 5-1).

M Drawing Units
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2. In the Length area, click the Type list box and then choose
Architectural.
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72 Setting Limits for Your Drawings

The Precision list box and Sample Output display change to show feet
and fractional inches.

3. In the Length area, click the Precision list box and choose the desired
precision format.
BER The acceptable range of values is 0'0" to 0'-0 1/256".
\3
You are not setting dimension format here. You’d never see a drawing
dimensioned to the nearest 256th of an inch, but you might want to see
more precision in the units on-screen as you're drawing.

For now, ignore the list box in the Insertion Scale area; we cover insert
units in Book VI.

4. In the Angle area, click the drop-down list box and choose
Deg/Min/Sec.

The Precision list box and Sample Output display change to show
degrees-minutes-seconds format.

5. In the Angle area, click the Precision list box and choose the desired
precision format.

Setting the maximum precision in the drop-down list formats angular
units to degrees, minutes, and seconds to four decimal places.

Setting Limits for Your Drawings

Well, you don’t want them staying out all night, do you? Or borrowing the
car and leaving it in the impound lot?

Okay, different kind of limits. In AutoCAD, the limits of a drawing defines the
drawing area. But you've already seen in Chapter 1 that in AutoCAD, you
have an unlimited drawing area, so why does it now have limits?

It may not make a lot of sense to pay strict attention to limits when you can
change those limits whenever you want. In fact, limits are a historical artifact
in AutoCAD, and in our view, they're of . . . er, limited use on modern systems.

All the same, it’s not a bad idea to know how big your drawing area is, even
though it can be infinitely large and infinitely flexible. That’s because sooner
or later you're going to want to print that drawing, and that means you're
going to have to fit it onto a piece of paper.

The theory behind limits is that you set your drawing limits according to the
sheet size on which you’ll ultimately plot your drawing. So if you’re drawing
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a mouse pad, you might set your drawing limits to 11 x 8-% inches so that the
limits represent a letter-size sheet. If you're drawing a fax machine, you'd set
the drawing limits to 36 x 24 inches, to represent a D-size sheet.

Here are some other reasons to set limits for your drawing:

4 Defining the grid: AutoCAD can display a grid of horizontally and verti-
cally aligned dots over your drawing area. This grid can help keep you
aware of the relative sizes of what you're drawing and their size on the
printed drawing. We cover the grid in detail in Chapter 6 of this mini-
book, but for now, the key point is that the grid will be displayed over
the area defined by the drawing limits.

4 Zooming: An option of the ZOOM command is All. Issuing a Zoom and
selecting the All option zooms the drawing out so that everything within
the drawing limits is displayed. This can be useful if you want to see
some white space (or black space, depending on your display configura-
tion) around your drawing objects.

4+ Plotting: If you want to plot a drawing from the Model tab (we discuss
the Model tab in the “Lost in Space: Model or Paper?” section later in
this chapter, and we cover plotting drawings in Book VII), one of the
options is Limits. Choosing Limits plots everything within the defined
limits of the drawing.

Pay attention to the order of those values. In AutoCAD, the horizontal dimen-
sion always comes before the vertical, so a 24 x 36-inch sheet would be
aligned in portrait (long side vertical) mode, and a 36 x 24-inch sheet would
be aligned in landscape (long side horizontal) mode.

So far so good, but it gets a little more complicated when you start drawing
things that won't fit on a sheet of paper at their full size — no matter how big
the paper is. For more on scaling, see the “Understanding Drawing Scale”
section a bit later on in this chapter.

You specify the drawing limits by entering coordinates for the lower-left and
upper-right corners of the drawing area. The following procedure shows you
how to set your drawing’s limits:

1. Choose Format->Drawing Limits, or type LIMITS and press Enter.

AutoCAD does not provide a tool button for this command, nor is there
a dialog box; you must use the menu or the keyboard. AutoCAD prompts
you as follows:

Reset Model space limits:
Specify lower left corner or [ON/OFF] <0.0000,0.0000>:
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74 Understanding Drawing Scale

2. Press Enter to accept 0,0 as the lower-left corner.

\3
P It’s a good idea to accept the default value (0,0) for the lower-left limit.

0,0 is the origin of the coordinate system. Chapter 6 covers the coordi-
nate system in detail.

AutoCAD then prompts:
Specify upper right corner <12.0000,9.0000>:

3. Enter a new value in coordinates for the upper-right corner of the
drawing limits, and then press Enter.

Understanding Drawing Scale

Just now, we were talking about drawing mouse pads and fax machines,
objects you can carry around easily, and which will fit on a letter-size or
D-size drawing sheet. Most of the time however, you're going to be drawing
things that won't fit very well, or won't fit at all, on a sheet of paper. In order
to make your drawing objects fit on the sheet, you're going to have to use a
scale factor.

You know that AutoCAD has an infinitely large sheet of virtual paper at its
disposal. You've just learned that if your virtual drawing sheet isn’t big
enough, you can just make it bigger by altering the drawing limits. This is a
great system — until you have to produce hard copy of your drawing.

Scaling on the drawing board

In manual drafting, you're given a sheet of paper on which to lay out a draw-
ing. Assume that it’s an ISO Al sheet that measures 841 x 594 mm. By the
time you’ve taken margins and room for a border and title block into
account, you're left with a drawing area of, say, 550 x 475 mm.

Now suppose that you’ve been given a floor plan to draw. The building meas-
ures 45 meters by 70 meters. Obviously, you're not going to draw that build-
ing full size on an Al sheet. You need to figure out a reduction factor that lets
you draw your detailed plan of the building to an approved drafting scale
and fit it on the sheet. You decide that the floor plan will fit on the sheet at a
scale of 1:20. So you dig out your drafting scale, flip it around to the 1:20
scale, and start laying out your sheet.

When drawing manually, you scale everything down as you draw. Otherwise,
things won't fit on the page.
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Scaling in AutoCAD

You already know that in AutoCAD, you draw things full size, so that’s how
you’'ve drawn your 45 x 70-meter floor plan. You're also given an Al sheet on
which to produce your drawing.

In AutoCAD, you have two ways to produce your drawing, which (you have
calculated) needs to end up at a scale of 1:20 on the paper drawing:

4+ Plot from model space. When plotting from model space, you tell the
PLOT command to print the drawing at a scale of 1:20. Most of the time
you’ll be plotting from a layout, so don’t worry too much about this
method.

4+ Plot from a layout. A layout represents a blank, physical sheet of paper
on which you lay out your drawing sheet. You create a viewport — in
effect, a hole in the drawing sheet through which you can view your
floor plan in model space. You apply a scale of 1:20 to the viewport. You
then tell the PLOT command to plot the drawing at 1:1.

Is your head hurting? We've just tossed you a bunch of terms you may not
have come across before: model space, layout, and viewport.

Don’t worry — we cover the differences between model space and layouts
(paper space) in the next section of this chapter. All we wanted to get across
here is the different methods of scaling between manual and AutoCAD drafting.

Scale factors

What both systems — manual drafting and CAD — have in common is scale
factor. Whichever method you use to end up with a 1:20 scale plotted draw-
ing, there’s a scale factor involved. Now, prepare yourself for your head to
hurt again, because we’re going to do some math. To calculate the scale
factor of any given scale, you take the inverse of the scale ratio itself.

Okay, this calls for some examples. The metric system is about as simple as
it gets, because a drawing with a scale of 1:20 has a scale factor of 20. A scale
of 1:50 has a scale factor of 50, and 1:100 has a scale factor of 100.

It gets a little more complicated with Imperial scales, because we're typically
dealing with scales like 1/4"=1"-0" or 1"=20'". You’ll notice that these scales
have units, and here’s what really messes things up: They have different
units on each side of the equal sign. Before you can calculate the scale
factor, you have to find the scale’s ratio, and for that, you need to make

both sides of the equation have the same units.
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76 Understanding Drawing Scale

As an example, take the drawing scale 1/8"=1'-0". To find the ratio, first con-
vert both sides of the equation to the same units; you arrive at 1/8"=12".
Next, multiply both sides of the equation so that you're dealing with whole
numbers; in this case, multiplying both sides by 8 gives you 1"'=96". The scale
can also be expressed as 1:96, and so the scale factor is 96. (The metric
system is a lot easier, isn’t it?)

Table 5-2 lists some common scales and their corresponding scale factors

(we do the math!):

Table 5-2 Common Scales and Scale Factors
Drawing Scale Ratio Scale Factor
1"=500' 1:6000 6000
1"=200' 1:2400 2400
1"=100' 1:1200 1200
1"=50' 1:600 600
1"=20' 1:240 240
1"=10' 1:120 120
1/16"=1"-0" 1:192 192
1/8"'=1"-0" 1:96 96
1/4'=1"-0" 1:48 43
1/2"=1'-0" 1:24 24
1"=1'-0" 1:12 12
3'=1"-0" 1:4 4
12'=1"-0" 1:1 1
1:100 1:100 100
1:50 1:50 50
1:20 1:20 20
1:10 1:10 10
1:5 1:5

1:2 1:2 2

1:1 11 1

Using scale factors to establish drawing settings

You use the drawing scale factors that you've just worked out to establish a
number of drawing settings. These include
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4+ Drawing limits: Multiply the scale factor by the dimensions of your plot Book I
sheet to arrive at the limits. For example, if you're going to print your Chapter 5
drawing on a D-size sheet (36 x 24") at a scale of 1/4"=1'-0", multiply both
sheet dimensions by the scale factor of 48. This gives you an area of
1728" by 1152", so you would set the upper-right corner of the limits to
1728,1152 (or 144',96").

4+ Dimension scale: All dimension sizes and spaces are set to their actual
plotted size. Text, for example, may be 2.5mm high. But 2.5mm text
would be invisible next to a wall that is 70 meters long. If you’re dimen-
sioning in model space, you set the dimension scale factor equivalent to
the drawing scale factor. We cover dimensions in Book III.
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4+ Text height: Some drawing text goes in model space — and once again,
text that’s specified as 1/8" high will be a speck beside a 200' wall.
Multiply the desired text height times the drawing scale factor to arrive
at a model-space text height that won’t be a speck; in this case, you'd
multiply 1/8" times the drawing scale factor of 48, and tell AutoCAD to
make your text 6" high.

4+ Hatch pattern scale and linetype scale are also based on the drawing
scale factor.

Lost in Space: Model or Paper?

It’s possible to print your drawing from the Model tab, but it’s much more
convenient to print from a layout. To do so, you must understand some of
the differences between model space and paper space, where layouts live.

4+ Model space is the drawing environment that corresponds to the Model
tab. Model space can represent an infinitely large, three-dimensional
area in which you create “real” objects. These objects are referred to as
the “model,” whether they are 2D or 3D. Every drawing entity that repre-
sents a real object is created in model space. Because only one model
space exists, AutoCAD provides only one Model tab. On the Model tab,
you can see only objects in model space.

4+ Paper space (also called a “paper space layout” or “layout space”)
is the drawing environment that corresponds to the Layout tabs.
Although model space represents the “real” 1:1 space where you create
your models, paper space represents the 2D drawing sheet that you
create to document them. Any objects you add to your model to docu-
ment it — for example, border, notes, dimensions, section marks, and so
on — are generally drawn in a paper space layout. (Notable exceptions
are center lines and hatching.) Because you may want to create more
than one drawing sheet from a model, you can have an infinite number
of layouts in a drawing file.
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4+ Layout is the tabbed environment where you create plottable drawing
sheets. The layout represents what will be plotted to paper. In addition to
borders, title blocks, text, and dimensions, layouts include viewports —
windows cut through the paper so you can see the model. A layout can
contain a single viewport, or several viewports that examine different
areas of the model at the same or different scales. On the Layout tabs,
you can see objects in model space and paper space, although you must
select objects in one space or the other — never both at the same time.

Every AutoCAD drawing must have a Model tab and at least one Layout tab.

Create your object geometry on the Model tab. Create your sheet layouts on
the Layout tabs. For more on layouts and viewports, see Book VIL.

A Layered Approach

Layers are your principal tool for controlling information in an AutoCAD
drawing. Layers are like transparent overlays in manual drafting, where you
assemble different combinations of overlays to present different types of
information.

On an architectural drawing, for example, one drawing can contain the walls,
furniture layout, and ceiling grid with light fixtures and diffusers, as shown in
Figure 5-2. If each type of information is on its own layer, you can generate a
floor plan drawing by turning on the walls and furniture layers, and turning
off the ceiling layer. Then you can turn off the furniture layer and turn on the
ceiling layer to generate a new drawing, a reflected ceiling plan.

Figure 5-2:
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Layers are also used to segregate different drawing components. For exam-
ple, dimensions usually go on their own layer, as does text, the drawing
border, and any title-block information.

Layers must be created before they can be used. AutoCAD creates layer names
automatically as you add layers, but it gives them names like Layer 1, Layer
2, Layer 3, and so on. It’s a good idea to give your layers sensible names as
you create them. Layer names can be up to 255 characters long (which is
pretty impractical!), and you can have up to 65,000 layers in a drawing,
which is also pretty impractical.

One process for setting up and using layers in a drawing is as follows:

1. Create the layers you need.

2. Assign color and linetype properties as required.
3. Set the desired layer current.

4. Draw stuff.

Anything you draw from this point on will be placed on the layer you made
current, until such time as you make another layer current.

All AutoCAD drawings contain a layer called 0, which cannot be renamed or
deleted. We recommend that you don’t actually draw anything on Layer 0;
instead, you should create layers specifically for the objects that you’ll be
adding to the drawing. Layer 0 has special properties when you create blocks,
which we go into in Book VI. Another layer that can’t be deleted is a special
layer named DEFPOINTS; this layer is created the first time you add a dimen-
sion to a drawing. We explain dimensions in Book III.

Creating layers

The following steps explain how to use the Layer Properties Manager dialog
box to create layers in any drawing file.

1. Click the Layer Properties Manager tool button on the Standard
toolbar.

AutoCAD displays the Layer Properties Manager dialog box (see
Figure 5-3).

2. Click New Layer to add a new layer definition.
AutoCAD adds a new layer named Layer 1 to the layer list. The layer

name is highlighted, so you can type a new name to replace AutoCAD’s
generic label.
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3. Type a new layer name (for example, WALL), and press Enter.

P Give your layers sensible names. If you’re doing very simple floor plans,
it’s enough to have layers named WALL, DOOR, WINDOW, APPLIANCE, and
so on. Whatever you do, don’t accept the default values of Layer 1, Layer
2, and so on, or you'll have no idea what objects are on which layer!

4. Continue adding layer names as required.
If you keep pressing Enter, you can keep adding (and renaming!) new
layers.
5. Click Set Current to make a layer the current layer.
Only one layer at a time can be current, and anything you draw is
created on the current layer.
Defining layer properties
Once layers are created, you can assign various modes and properties to
them. Setting layer properties properly ensures that objects drawn on a
given layer take on the color, linetype, lineweight, and plot style assigned to
that layer.
@‘“NG! Unless you have a really good reason to avoid doing so, it’s advisable to use

layers to control the appearance of objects. It’s possible to set color and
other properties of individual objects, but it’s usually a bad idea unless you
know what you’re doing and have a good reason up your sleeve. Applying
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explicit colors and other properties to objects can make them difficult to
edit when the need arises, because you can’t tell on which layer the objects
are located.

Layer properties include

4+ Color: When a color is assigned to a layer, objects drawn on that layer
take on that color. Set layer color by accessing the Select Color dialog
box through the Layer Properties Manager.

4+ Linetype: Most AutoCAD objects have the default linetype, which is a
solid, continuous line. However, drafting conventions require the use of
non-continuous linetypes (sometimes called dash-dot linetypes), such as
center lines and hidden lines. You can assign a default linetype to a layer
in the Layer Properties Manager dialog box.

4+ Lineweight: Lineweight refers to the visible width of lines on the draw-
ing screen. When drawings are printed correctly, the hard copy always
shows different line thicknesses — thin lines for dimensions, thick lines
for borders, medium lines for object lines and text, and so on. But on-
screen, objects usually appear with a single line thickness. You can
assign default lineweights to layers in the Layer Properties Manager,
so that everything drawn on specific layers will take on that lineweight
property.

4+ Plot style: If your drawing is configured to use named plot styles, you
can assign an already-existing plot style to a layer. If your drawing is set
up to use color-dependent plot styles, the Plot Style column in the Layer
Properties Manager is grayed out; the only way to change a plot style
here is to change the layer color. Plot styles are a complex topic (espe-
cially named plot styles!), and we cover them in detail in Book VIIL.

You can also access the Select Color, Select Linetype, and Lineweight dialog
boxes by entering their command names at the command line or by choos-
ing Color, Linetype, or Lineweight from the Format menu. But doing those
things does not set a layer property — it does something potentially more
damaging. It sets the default color, linetype, or lineweight of all objects you
draw, regardless of their layer settings, from that point forward.

When objects are allowed to take on the properties of the layers on which
they are drawn, those properties are said to be By Layer.

Setting layer modes

In addition to layer properties, which have a wide range of possible settings,
you can choose from a series of layer modes, which are toggles with only
two possible settings (see Figure 5-4).
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Figure 5-4:
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The four layer modes are

4+ On/Off: Objects on the layer are visible if mode is on (the light bulb is
switched on) and invisible if mode is off (light bulb is switched off).

Strangely enough, the current layer can be turned off; it’s even possible
to draw on a layer that’s turned off, as long as it’s current. So if you start
drawing lines that don’t appear on-screen, check the layer mode!

4+ Freeze/Thaw: Objects are visible if layer is thawed or invisible if layer is
frozen. The difference between Off and Frozen is that frozen layers are
not included when AutoCAD has to recalculate its numeric database. A
glowing sun indicates thawed layers, and a snowflake means a layer is
frozen. You can’t set a frozen layer current.

4+ Lock/Unlock: When a layer is locked, you can see the objects on it, you
can select them, and you can even draw on it. But you can’t edit objects
on a locked layer. A padlock icon indicates whether a layer is locked.

4+ Plot/NoPlot: You can set this layer mode so that objects on the selected
layer are visible but will not appear on a plot or print preview.

Modifying layer settings
You can access the Layer Properties Manager dialog box at any time by click-
ing the Layer Property Manager button on the Layers toolbar, or by typing
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LA and pressing Enter. You don’t have to create all your layers when you
start a new drawing; you can add (or remove) layers at any time in the
drawing’s life.

Nonetheless, the most efficient way of setting up and managing layers in any
drawing is to create them all at once, and make the appropriate property
and mode settings while you're creating them.

Setting layer color

The following steps explain how to modify layer properties and settings in
the Layer Properties Manager:

1. If the Layer Properties Manager dialog box is not already open, click
the LPM button on the Layers toolbar.
AutoCAD displays the Layer Properties Manager.

2. Select the layer whose color you want to change.
To select multiple layers, hold down the Ctrl key as you select them.

3. Click the square color tile in the Color column.

AutoCAD displays the Select Color dialog box (see Figure 5-5).

¥1'Select Color [B]%]

Index Calor Tz Color Color Books
AutoCAD Color Index (ACI):

EEEN
Color:
green

[ ok ][ cancel J[ Hep |

4. With the Index Color tab current, select one of the large color tiles
near the bottom of the dialog box, and then click OK to close the
dialog box.

AutoCAD closes the Select Color dialog box and returns focus to the
Layer Properties Manager. The foreground color of the sample rectangles
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changes to the selected color, and the layer shows the new color and
name under the Color column.

For more information on using color in AutoCAD, see the “Using AutoCAD’s
color systems” section later in the chapter.

Setting linetype

There’s a wrinkle to setting linetypes in an AutoCAD drawing. Unlike colors,
which are always available, non-continuous linetypes are defined in an exter-
nal file that goes by one of these filenames:

4+ acad.LIN: The default linetype-definition file, designed for use with
Imperial units drawings and based on inches.

4+ acadiso.LIN: The default linetype-definition file designed for use with
metric units and based on millimeters.

4+ acadlt.LIN: The AutoCAD LT version of acad.LIN. (Prior to AutoCAD
2007, this file was named aclt.LIN.)

4 acadltiso.LIN: The AutoCAD LT version of acadiso.LIN. (Prior to
AutoCAD 2007, this file was named acltiso.LIN.)

For an explanation of the different linetype definitions, see the “Using
linetypes” section later in the chapter.

You can load linetypes as a separate step, before you create your layers by
choosing Format=>Linetype to display the Linetype Manager dialog box.
Alternatively, you can follow these steps to access Linetype Manager
through the Layer Properties Manager:

1. If the Layer Properties Manager dialog box is not already open, click
the LPM button on the Layers toolbar.
AutoCAD displays the Layer Properties Manager.

2. Select the layer whose linetype you want to change.

3. In the Linetype column, click the word Continuous.

AutoCAD displays the Select Linetype dialog box. By default, only the
Continuous linetype is loaded.

4. Click Load to display the Load or Reload Linetypes dialog box.

Load or Reload Linetypes displays all linetypes defined in the current
linetype definition file (see Figure 5-6).
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5. Scroll through the list and select the linetypes to load, and then click OK.

Hold the Ctrl key to select more than one linetype. Load or Reload
Linetypes closes, and the focus returns to the Select Linetype dialog box.

6. Select the linetype you want to assign to the selected layer in the
Layer Properties Manager, and then click OK.

The Select Linetype dialog box closes, and the selected linetype is
assigned to the layer (see Figure 5-7).
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A Layered Approach

Setting lineweight

Lineweights are like colors — they’re always present and available, unlike
linetypes which have to be loaded into the drawing before they can be
assigned.

Lineweight is a display property that shows a representation of the relative
thickness of different drawing objects. Lineweight works differently in model
space and paper space:

4+ In model space, lineweight is based on a number of pixels, so that no
matter how close you zoom in — or how far you zoom out — linework
always appears to have the same visual thickness.

+

In paper space, lineweight is part of the representation of the paper
drawing. If you put linework on a paper drawing under a magnifying
glass, the lines would appear thicker, and that’s exactly how it works
in paper space — as you zoom in, the lines appear thicker.

The following steps explain how to assign a lineweight to a layer:
1. If the Layer Properties Manager dialog box is not already open, click
the LPM button on the Layers toolbar.
AutoCAD displays the Layer Properties Manager.
2. Select the layer whose lineweight you want to change.
3. In the Linetype column, click the word Default.
AutoCAD displays the Lineweight dialog box (see Figure 5-8).

1 Lineweight %]
Lineweighta:
Default ~
— 0.00mm [
—— 0.05mm
—— 0.09mm
— 013mm
— 015 mm
—— 018mm
H . — 020
Figure 5-8: ey
Scroll to set L
0.35mm v
a default
lineweight Orginal: ~ Defut
fOI’ your New: 0.30 mm
layer. ok ) [ cancel | [ meb |
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4. Scroll down the list to find the desired lineweight. Book |

G STy, Chapter 5
S < Because plotter pens were traditionally sized in millimeters, AutoCAD’s aper

lineweights are also displayed in millimeters whether metric or English
units are configured.

5. Select the lineweight, and then click OK.

shuimeaq
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The Lineweight dialog box closes and focus returns to the Layer
Property Manager.

e&N\BER Assigning lineweights to layers is only half the story. You also need to press
& the LWT button on the status bar to display the lineweights. When the
button is selected, lineweight display is enabled; when the button is not
selected, all geometry appears in the default line width, which is one pixel.

The lineweight property can be applied to hard copy as well as to the visual
representation of drawing objects. We tell you more about that in Book VII.

Setting layer modes

As already noted, the layer modes are toggles that let you control layer visi-
bility, the amount of drawing data that’s included in AutoCAD’s math calcula-
tions, whether a visible layer’s objects can be edited, and whether a visible
layer’s objects will be plotted.

The following procedure runs through the four layer modes in the Layer
Properties Manager dialog box:

1. If the Layer Properties Manager dialog box is not already open, click
the LPM button on the Layers toolbar.
AutoCAD displays the Layer Properties Manager.

2. Select a layer whose mode you want to modify.

3. To toggle a layer’s visibility on or off, click the lightbulb icon in the
On column.

4. To freeze a layer’s data from recalculation and turn off its visibility,
click the Sun icon in the Freeze column. To thaw a layer, click the
snowflake icon.

5. To lock or unlock a layer to prevent or allow its objects to be edited,
click the padlock icon in the Lock column.

6. To prevent or allow objects on a layer to be printed, click the Printer
icon in the Plot column.
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The Layer Control drop-down list

You have to use the Layer Properties Manager dialog box to modify layer
properties, including color, linetype, lineweight, and plot style. You can also
turn layer modes off and on in the Layer Properties Manager, but if the latter
is all you need to do, there’s a more efficient way than opening and closing a

dialog box.
The Layers toolbar contains a drop-down list of all the layers in a drawing
(see Figure 5-9).
Figure 5-9:
Switch layer [ [ ©O% bmwa NEES
modes in Zllea fi: EPPI.IAI-IEE
the Layer / :, E 10 CENTER
Control od |
drop-down E. °0 :'-?.1:$1n%ow
list.
You can click the down arrow (or inside the list box) to expand the list, and
then perform any of the following actions:
4+ Set alayer current by clicking the layer name.
4+ Turn layer visibility off or on by clicking the light bulb.
BE,
‘3‘&“ iy 4+ Freeze or thaw a layer by clicking the sun or snowflake.
&
You can'’t freeze the current layer.
4+ Lock or unlock a layer by clicking the padlock.
After you change the mode, click anywhere outside the Layer Control list to
close the list and return focus to the drawing.
The third icon shows a sun or snowflake superimposed on a rectangle. This
mode lets you freeze or thaw layers in a layout’s viewport. We discuss this
option in greater detail in Book VII.
\“gN\BEH Because the Layer Control drop-down shows a color tile for each layer, you
& might think you could click it to change a layer’s color, but you’d be wrong.

Color is a property, and properties can only be changed in the Layer
Properties Manager.
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Object Properties

In AutoCAD, all objects have properties. Every object in a drawing is created
on a layer. Layers can have a number of properties assigned to them, and
anything drawn on a specific layer takes on the color, linetype, lineweight
and other “by layer” properties of that layer.

In addition to the properties that an object inherits from its layer, an object
can have the following properties:

4+ Color

4+ Linetype

4+ Lineweight
4+ Plot Style

Object properties can be assigned directly (or explicitly) to objects, or they
can be assigned to layers. For example, on a floor plan you might have a
bunch of blue doors. The color blue may have been assigned to each individ-
ual door, in which case the color will be listed as Blue. Or the color blue may
have been assigned to the layer on which the doors were drawn, in which
case the color is listed as BYLAYER.

Is one method better than the other? We certainly think so. For example, you
may draw a floor plan in which you make all the doors blue. Then you decide
they should be green instead. If you changed the doors explicitly, you would
have to go through the drawing and select each and every door, and then
open the Properties palette and change their color to green. Alternatively,
you could just open the Layer Properties Manager and change the color of
the Door layer from blue to green. Obviously, one of these processes is easier
than the other.

When objects do not have explicit colors or other properties set, they take
on the properties of the layers.

We strongly advise you not to change the properties of objects in a drawing,
but instead to leave their color, linetype, lineweight, and other properties set
to BYLAYER. Applying explicit changes to objects can make them difficult to
edit because you can'’t tell on which layer the objects are located.

Using AutoCAD’s color systems

In AutoCAD drafting, color has two main functions, neither of which is pro-
ducing color drawings:

Book |
Chapter 5
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Object Properties

4+ Color helps you differentiate objects on-screen. When you assign colors
to layers, you can tell immediately if something is on the wrong layer if it
doesn’t show up in the color you expect.

4+ Using the traditional color-dependent plotting system, the colors of
objects determine the thickness of the printed linework.

Recent releases of AutoCAD support three color systems:

4+ ACI Color Index: The original and genuine 255 colors that have always
been part of AutoCAD (see Figure 5-5).

4 True Color: A range of over 16 million colors you can set by dragging
sliders or entering RGB (Red Green Blue) or HSL (Hue Saturation
Luminance) values.

4+ Color Books: Select colors using Pantone or RAL colors.

You may use True Color or Color Books colors if you were trying to match
specific material colors. For most drafting purposes, the 255 standard colors
on the ACI Color Index tab are adequate.

Don’t get attached to the idea of using True Color or Color Books colors if
you're using AutoCAD LT. AutoCAD’s lower-cost sibling supports only the 255
ACI Color Index colors.

Using linetypes
The four linetype files (acad.LIN and acadiso.LIN, and their acadlt equiva-
lents) include 45 different linetype definitions, broken down as follows:

4+ Twenty-four AutoCAD standard linetypes: 8 basic patterns (border,
center, dashdot, dashed, divide, dot, hidden, and phantom) each in
three spacing variants; for example, BORDER has normal spacing of
its dash and dot elements; BORDER2’s elements are half the size of
BORDER’s; BORDERX2’s elements are twice the size of BORDER.

4+ Fourteen ISO 128 linetypes conforming to ISO/DIS 12011 specifica-
tion: These are rarely used; we recommend you stick with the 24 stan-
dard linetypes, for Imperial or metric drafting.

4+ Seven complex linetypes: These include symbols or text as well as
dash-dot line patterns. Linetypes include fence lines, railroad tracks,
and batt insulation.

In addition to these 45 linetypes, the acadiso.LIN and acadltiso.LIN files
include an additional 14 JIS linetypes. While all the above linetypes will work
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for either Imperial or metric drafting, the JIS linetypes are for metric work Book I
only. And we still recommend the 24 standard linetypes for most drafting in Chapter 5
metric or Imperial.

Setting Up Standards

In this chapter, we discuss the many settings that you can use to enhance
your AutoCAD drawings. You may have observed that AutoCAD provides a
great deal of settings, and if you're like us, the last thing you want to do is go
through those steps every time you want to create a new drawing.
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The good news is, you don’t have to!

In Chapter 2, we discuss the various file types available in AutoCAD, and we
explain how to create a drawing using a template (DWT) file. We point out
that templates are fine as far as they went, but that you probably want to
add settings (and maybe even objects) in order to make them really useful.

Everything that we discuss in this chapter — from layers, to linetypes, to text
and dimension styles — can be created and saved in a template drawing so
that they’re available to you in every drawing you start from that template.
After going through this chapter, you know that you can add quite a few set-
tings to a template to save yourself a great bit of effort for future drawings. In
the chapters ahead, we look at annotation, inserting blocks, and other fea-
tures that will enhance the usability of your template drawings as well.
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Chapter 6: Precision Tools

In This Chapter

v Defining precision versus accuracy

v+ Understanding coordinate systems

v Entering coordinates

v Using Direct Distance Entry

v+~ Using drawing modes, object snaps, and point filters

1 Using object-snap tracking

rle purpose of creating technical drawings, or drafting, is to convey
enough information to a builder or fabricator so that she or he can con-
struct or manufacture whatever it is that you've just technically drawn . . .
er, drafted.

Manual drawings are as precise as the drafter can make them, which means
as precise as a mechanical pencil dragged against a parallel rule or drafting
machine. They’re good enough to get the job done because the dimensions
are going to confirm sizes and notes.

Dimensioning can be a major job in manual drafting, and luckily, you have an
extra tool at your disposal with AutoCAD: You can add dimensions by clicking
objects or selecting points. AutoCAD extracts the dimension value and adds
the correct text to the dimension. Now, if you are precise in your drafting, the
dimension values will be perfect, but if you are sloppy . . . you may be hearing
from the builder whom you’ve asked to locate a wall 12'-6 29/256" from the
corner!

This chapter tells you how to make use of AutoCAD’s built-in aids to preci-
sion drafting.

Understanding Accuracy and Precision

You probably hear a lot of sloppy word usage in the technical-drawing field.
One of the most common offenses is the idea that accuracy and precision
mean the same thing. They’re different, and here’s how:
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4+ Precision means the degree of fineness of measurement. AutoCAD is
capable of extremely high levels of precision — and can create drawings
much more precisely than, say, a building or a highway could ever be
constructed.

4+ Accuracy refers to the relationship between what is being drafted and real-
ity. You can create the most precise drawings of which AutoCAD is capa-
ble, but if the surveyor got the field measurements wrong, or you read her
field notes incorrectly, your drawing is not going to be accurate to reality.

Although accuracy is important, precision is the order of the day when you
work with AutoCAD. Here’s the skinny on AutoCAD’s precision tools:

4+ Coordinate input: Place drawing objects by specifying the x, y, and z
coordinates that locate them in 3D space.

4+ Direct Distance Entry: Locate new points relative to a point you've just
entered by dragging the mouse pointer to show direction and then
entering a value for the distance.

4+ Grid and snap: Drafting modes you can toggle off and on; grid is a
purely visual aid, but snap is a precision input method.

4+ Ortho and polar: More on/off drafting modes; when turned on, Ortho
mode forces linework to be horizontal or vertical, and polar tracking
guides linework along preset angles.

4+ Object snaps: Locate points that fall at precise locations on existing
objects (such as endpoints and midpoints of lines, or centers and quad-
rant points of circles).

4+ Object-snap tracking: Use object snaps on existing objects to find new
points to create new objects.

AutoCAD LT 2007 finally includes object-snap tracking! Earlier versions did
not include this feature — it was part of the full version of AutoCAD only.

Through a combination of these different precision aids, you can create
drawings far more precise than the most skillful manually drafted drawing.
And what you’ll quickly find as you gain experience is that drawing precisely
is easier than drawing sloppily.

Understanding Coordinate Systems

In an AutoCAD drawing, everything is located in 2D (or 3D) space by a set of
Cartesian, or x,y (-z), coordinates. Cartesian coordinates are named after the
French philosopher Rene Descartes, who’s probably better known for his
saying, “I think, therefore I am.”
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Descartes believed that you could tease out the meaning of anything Book |
through a system of reasoning modeled on the certainty of mathematics. Chapter 6
One of the side benefits of his mathematical thinking (arguably a more useful
one than the system of reasoning) was the coordinate system named after
him. Described simply, everything in 3D space can be located from a prede-
fined origin by counting the number of units in each of the three directions
between the object and the origin.

$]00] uoIsIdalg

The 2D coordinate system — for the time being, we’ll stick with 2D to keep
things simple — is defined by a horizontal and a vertical axis. By convention,
the horizontal axis is called the x axis, and the vertical axis is called the y
axis. The x axis and y axis intersect at the origin of the coordinate system.
The two axes define a plane called, naturally enough, the xy plane. The
coordinates of any point are its distances from the origin along the x axis
and the y axis, and the coordinates are expressed in the form x,y. For exam-
ple, the coordinate pair 5,4 would indicate a point lying 3 units to the right
of the origin along the x axis, and 2 units above the origin along the y axis.

The 3D coordinate system adds a third axis, the z axis (which is pronounced
zed-axis outside the United States). The z axis also passes through the origin,
and is perpendicular to the xy plane. We have more to say about the z axis in
Book V.

The x and y axes divide the xy plane into four quadrants. Points located in
the two quadrants to the right of the y axis have positive x coordinates;
points to the left of the y axis have negative x coordinates. Points located in
the two quadrants above the x axis have positive y coordinates, and points
in the quadrants below the x axis have negative y coordinates. Figure 6-1
illustrates the 2D coordinate system.

o

*

®

]

-5.4 5.4
o0 .
X-axis
Figure 6-1:
The
Cartesian v 54 3.4
coordinate
system.
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Understanding Coordinate Systems

UCS? We C U!

You can create multiple User Coordinate
Systems in a drawing, and the WCS is always
there, too. But only one coordinate system can
be current, so there's only going to be one
origin active at a time.

The Tools menu and UCS toolbar provide access
to the many methods of creating your own User
Coordinate Systems. Since these are more often
associated with working in 3D, we’ll cross that
bridge when we come to it in Book V.

A\

To keep coordinates simple, most drawings are created in the upper-right
quadrant. This locates the origin (0,0) at the lower-left corner of the drawing
area so that all coordinate values can be positive numbers.

The World Coordinate System

Everything you draw in AutoCAD is created in an infinitely large drawing
space, and can be located by x and y coordinates. The default coordinate
system in AutoCAD is called the World Coordinate System, or WCS. Many
AutoCAD users spend their whole careers drafting in the WCS. Unless you're
working in 3D, there’s little reason to change the WCS to a user-defined coor-
dinate system (or UCS), but it can be done if necessary. For more on working
in 3D and user coordinate systems, see Book V.

The icon in the lower-left corner of the drawing area in Figure 6-1 is the UCS
icon, and it’s a handy device for recovering your bearings if you ever lose
them. Figure 6-2 shows several variations in the icon’s appearance. The box
at the intersection of the two arrows means you’re in the WCS.

If the UCS icon is set to display at the origin, it will move around the screen
as the drawing is panned and zoomed. If the icon is set to display off the
origin, it will always appear at the lower-left corner of the drawing area.

For the last several releases, AutoCAD has displayed the UCS icon at the
origin. This can be distracting if you're only working in the WCS. The follow-
ing steps explain how to control the UCS icon’s display:

1. Choose Viewr>Display=>UCS Icon.

2. Select On to turn the display of the icon off and on.

3. Select Origin to move the icon to 0,0,0 in the drawing, or to the lower-
left corner of the drawing area.
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The third item on the UCS Icon menu is Properties. Selecting this option
opens (surprise!) the Properties dialog box. Here you can control the
appearance and size of the UCS icon. If you're a nostalgic type, you can even
make the icon look the way it did in AutoCAD 2000 and earlier versions.

World Coordinate System, icon located at origin

‘ User Coordinate System, icon located at origin

v

..

v Y
1—% X L X
y
|
|

User Coordinate System, icon off origin

World Coordinate System, icon off origin

Entering coordinates
The standard way of feeding coordinates to AutoCAD is by typing them into
the command line and pressing Enter. There are five types of coordinate
entry commonly used in AutoCAD:

4+ Absolute xy coordinates

4+ Relative xy coordinates

4+ Relative polar coordinates

Book |
Chapter 6
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4 Spherical coordinates

4 Cylindrical coordinates
The first three types work in both 2D drafting and 3D modeling. The last
two — spherical and cylindrical coordinates — are alternative ways of

entering 3D coordinates and work in 3D only. These two coordinate-input
methods are covered in Book V.

Entering absolute XV coordinates

You enter absolute coordinates as pairs of numbers separated by a comma,
like this: x,y. No spaces, just the comma (this is AutoCAD, not English punc-
tuation!). The x value is always expressed first, and then the y value is repre-
sented. If you see a third value — for example, X,y,z — the z coordinate is
representing a 3D point.

To draw a square using absolute xy coordinates, follow these steps:

1. Click the Line tool on the Draw toolbar to start the LINE command.
AutoCAD prompts:
Command: _line Specify first point:
2. Type 3,3 and press Enter.
AutoCAD prompts:
Specify next point or [Undo]:
3. Type 6,3 and press Enter.
AutoCAD prompts:
Specify next point or [Undo]:

4. Type 6,6 and press Enter, and then type 3,6 and press Enter, and then
type C and press Enter.

The command line appears as follows:

Specify next point or [Undo]: 6,6
Specify next point or [Close/Undol: 3,6
Specify next point or [Close/Undo]: C

You might use absolute coordinates if you're working on a site plan, and the
surveyor has supplied you with coordinates of parcel corners. Drawing this
way satisfies the need for precision, but you’d have to do a lot of calculating
to figure out the absolute coordinates of every point in the drawing. It’s
much handier to use relative coordinates.
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Entering relative XV coordinates Book |
Where absolute coordinates are always based on the origin of the drawing Chapter 6
(that is, 0,0), relative coordinates are based on the last point entered. Input
of the coordinates themselves is the same as for absolute xy coordinates, ]
but you tell AutoCAD the location you're entering is based on the last point 8
by typing an @ symbol before the coordinates — for example, entering @5,4 g
makes a new point 5 units to the right and 4 units above the last point, not 3'
the origin. g_
«»

To draw a square using relative xy coordinates, follow these steps:

1. Click the Line tool on the Draw toolbar to start the LINE command.
2. At the Specify first point prompt, type 5,5 and press Enter.
AutoCAD prompts:
Specify next point or [Undo]:
3. Type @5,0 and press Enter.

The @ symbol tells AutoCAD the next point is relative to the point you
just entered rather than the origin. From this point, AutoCAD draws a
line 5 units in the x direction and 0 units in the y direction.

AutoCAD prompts:
Specify next point or [Undo]:

4. Type @0,5 and press Enter, and then type @-5,0 and press Enter, and
then type C and press Enter.

Create vertical or horizontal lines by specifying 0 as the relative y or x
coordinate. Draw lines to the left of or below the last point by specifying
negative coordinate values.

The command line appears as follows:

Specify next point or [Undo]: @0,5
Specify next point or [Close/Undo]: @-5,0
Specify next point or [Close/Undo]: C

In our experience, this method of coordinate input is rarely used. Luckily,
there’s another way of entering relative coordinates, one that makes much
more sense than either of the preceding two: relative polar coordinates.

Entering relative polar coordinates

Relative polar coordinates are like relative xy coordinates in that both use
the @ symbol to tell AutoCAD to draw that line from the last point, not from
the origin. They’re different from relative xy coordinates in that the two
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values are distance and angle, rather than offsets along the x and y axes.
AutoCAD knows you’re entering polar coordinates because instead of a
comma, you type a left angle bracket (also known as the less than symbol).
It’s easy enough to remember because it’s on the same key as the comma
you use for xy coordinates; you just need to also remember to hold down the
Shift key.

For example, entering @5,30 at a LINE command prompt tells AutoCAD to
draw a line segment 5 units in the x direction and 30 units in the y direction
from the last point. Entering @5<30 tells AutoCAD to draw a line 5 units long
at an angle of 30 degrees. Obviously, the results are going to be very differ-
ent, so if you want polar, don’t forget to Shift!

To draw a square using relative polar coordinates, follow these steps:

1. Click the Line tool on the Draw toolbar to start the LINE command.
2. At the Specify first point prompt, type 9,9 and press Enter.
AutoCAD prompts you as follows:
Specify next point or [Undo]:
3. Type @7<0 and press Enter.

Remember, the @ symbol means relative to the last point. Type the dis-
tance, and then — remember that Shift key! — the left angle bracket, the
angle, and press Enter.

AutoCAD draws a line 7 units long, at an angle of 0°.

Chapter 3 explains that by convention in AutoCAD, 0° lies in the direc-
tion of the positive x axis, and angles are measured in a counterclock-
wise direction.

AutoCAD prompts:
Specify next point or [Undo]:

4. Type @7<90 and press Enter, and then type @7<180 and press Enter,
and then type C and press Enter.

With relative polar coordinates, you're always entering positive values.
The command line appears as follows:

Specify next point or [Undo]: @7<90
Specify next point or [Close/Undo]: @7<180
Specify next point or [Close/Undo]: C

Most users find that relative polar coordinates are the most logical method
of coordinate entry in AutoCAD. You don’t need to calculate displacements
in the x and y directions; distances are actual distances.
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So far so good, but AutoCAD has one more little trick up its sleeve that
makes polar coordinates even easier. Read on . . .

Direct Distance Entry

An elaboration (actually a simplified method) of relative polar coordinates is
called Direct Distance Entry, or DDE. When you enter relative polar coordi-
nates, you specify distance and angle, typing no fewer than four keystrokes,
two of which also require that you hold down the Shift key.

When using DDE, you enter the distance only. You specify the angle by drag-
ging the mouse pointer on the screen. Not much hunting-and-pecking, and
no holding down the Shift key.

“Waaaaait a minute,” you say. “How precise can dragging the mouse pointer
to specify an angle be?” The answer, of course, is not very precise at all, if
you're simply dragging the mouse pointer without using the precision aids
that AutoCAD provides. Ortho mode and polar tracking (both discussed
shortly) help here: Ortho forces the mouse pointer to move at angles of 0°,
90°, 180°, and 270°. Polar tracking is like a loosened-up Ortho mode; you can
specify any angle you like. Also, it doesn’t force the crosshairs to follow
those preset angles; it jumps to a specified angle and displays a tooltip to
show you're tracking (see Figure 6-3).

To draw a square using Direct Distance Entry, follow these steps:

1. Click ORTHO on the status bar to turn on Ortho mode.

Ortho mode forces any lines you draw to be precisely horizontal or ver-
tical. We discuss Ortho mode in the following section.

2. Start the LINE command as in step 1 above.

Book |
Chapter 6
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3. At the Specify first point prompt, type 15,15 and press Enter.
AutoCAD prompts you:
Specify next point or [Undo]:
4. Drag the crosshairs to the right, then type 9 and press Enter.

It doesn’t matter how far you drag the crosshairs — you’re showing
AutoCAD the angle, not the distance. AutoCAD draws a horizontal line to
the right, 9 units long.

AutoCAD prompts:
Specify next point or [Undo]:

5. Drag the crosshairs toward the top of the screen, type 9, and press
Enter. Then drag to the left, type 9, and press Enter. Finally, type C
and press Enter.

With relative polar coordinates, you always enter positive values.
The command line appears as follows:

Specify next point or [Undo]: @7<90
Specify next point or [Close/Undo]: @7<180
Specify next point or [Close/Undo]: C

When you can use it, DDE is a terrific keystroke-saver.

Dynamic input and coordinate entry

We introduce dynamic input (DI) in Chapter 2 of this minibook. DI was new
in AutoCAD 2006, and at this time, we’re all getting used to it. For reasons
best known to themselves, Autodesk’s programmers decided to do away
with the long-standard method of using the @ symbol as a prefix to indicate
relative coordinates, and no prefix at all to indicate absolute coordinates.

If you turn off DYN mode, AutoCAD still accepts input the traditional way,
but if you’re using DI, the no prefix at all now indicates relative coordinates.
And if you want to enter absolute coordinates using DI, you have to use the #
symbol as the prefix.

Setting Grid and Snap

AutoCAD’s grid, while sometimes helpful to get your bearings in the drawing,
is not (strictly speaking) a precision aid. As we explain in Chapter 5 of this

minibook, AutoCAD can display a non-plotting grid of horizontally and verti-
cally aligned dots over your drawing area. This grid can help keep you aware
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of the relative sizes of what you're drawing — and their size on the printed
drawing. It also gives you a visual cue when you’re drawing outside your
sheet limits.

If you're working in Isometric mode, the grid adjusts itself to a 30-60-90 angu-
lar alignment rather than horizontal and vertical. We do not cover isometric
or other forms of 2D pictorial drafting in this book.

You can toggle the grid off and on with the GRID button on the status bar or
by pressing the F7 function key. You can set grid spacing at the command
line, but it’s easier to use the Drafting Settings dialog box, as we describe in
the next section.

If you're zoomed way out in a drawing and turn the grid on, you may see this
message:

Grid too dense to display

This message is not an error — it just means the grid spacing is too small for
AutoCAD to display at the current zoom ratio. Either zoom in closer (if you
need to see the grid), or change the grid spacing (as we explain in the next
section).

Snap constrains all crosshairs movement to specific increments; when snap
is enabled, the crosshairs can no longer move freely about the graphics area
but jumps to points on an invisible grid. Snap, like grid, is toggled off and on
by clicking the SNAP button on the status bar, or pressing the F9 function
key. Also like the grid, snap can be set to isometric mode. And finally, there’s
a polar snap that’s available when you have polar tracking turned on. (We
discuss polar tracking in the next section.)

The following steps explain how to specify settings and enable snap and grid
in the Drafting Settings dialog box.

1. Move the crosshairs around on the screen and look at the coordinates
readout on the status bar.

If the SNAP button on the status bar is not selected, the crosshairs move
freely, and coordinate values show their location to four decimal places
of random numbers.

2. Click SNAP and GRID on the status bar so both buttons are pressed in.

The grid turns on (it may be a little hard to see) and the crosshairs now
jump from location to location. The coordinates readout shows that they
move in constant increments.

Book |
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Figure 6-4:
Setting snap
and grid in
the Drafting
Settings
dialog box.

3.

Right-click either the SNAP or GRID button and choose Settings.

It doesn’t matter which button you right-click; choosing Settings on
either button’s shortcut menu opens the Drafting Settings dialog box at
the Snap and Grid tab (see Figure 6-4).

4 Drafting Settings %]
Snap and Grid | Polar Tracking || Object Snap | Dynamic Input

[#] Snizp On (F9) [#]Gnd On F7)

(%) Gnd snap
e [ Display gid beyond Limits
O}
G A [C] Fallow Dynamic UCS
) lsometric snap
O PolarSnap
Optiens, OK | | Cancel | | Help |

Snap spacing Grid spacing

Snap X spacing: 0.5000 Grid X spacing: 0.1250

Snap Y spacing: Girid ¥ spacing: p.1250

BEgual X and Y spacing Magor line everny: 5 =
Polar spacing Grid behaviar

[#] Adaptive gnd

[[] Mlow subdivision below grid
Snap type spacing

. In the Grid area, enter values for the x (horizontal) and y (vertical)

spacing of the grid.

Entering the x spacing first causes the same value to appear in the
y-spacing box. For different x and y spacing, enter a new value in
the y-spacing box.

. To configure rectangular snap, in the Snap area, enter values for the

x and y spacing.

As with setting grid spacing, entering a value for x spacing causes the
same value to appear as the y spacing.

. To change the snap angle, or to move the snap origin from the default

0,0,0, enter the appropriate values in the Snap area.

Snap can be rotated to any angle; doing so also rotates the grid to the
same angle.

To set up snap and grid for isometric drawing, select Isometric snap in
the Snap type & style area.

When isometric snap is enabled, both grid and snap adjust from hori-
zontal and vertical to 30-60-90 angles.
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8. If you’re using polar tracking, select PolarSnap in the Snap Type &
Style area.

Selecting PolarSnap disables the settings in the Snap area and enables
the Polar spacing area in which you can enter a polar distance.

9. Click the Snap On or Grid On check boxes to enable snap or
grid mode.

After you create all the appropriate settings, select the check boxes to
enable the feature.

It’s not actually necessary to open the Drafting Settings dialog box to toggle
snap and grid off and on — just use the status bar buttons or F7/F9 function
keys.

Understanding Ortho and Polar Tracking

\

NG/

Ortho mode and polar tracking are two precision drafting aids that force
linework to specific angles. Ortho mode has been part of AutoCAD since the
very beginning. When Ortho is on, you can draw lines or pick points horizon-
tally or vertically only. This is handy as far as it goes, but most drawings
could use some consistent angular guidance beyond 90° increments.

Using Ortho mode

Ortho mode could hardly be simpler. There are no settings to make; it’s
either on or it’s off. If you find yourself drawing lots of horizontal and verti-
cal lines, it’s a boon to creating perfect right-angled linework. To toggle
Ortho mode off and on, click the ORTHO button on the status bar or use the
F8 function key.

Using polar tracking

It’s a rule in AutoCAD (and in life!) that with flexibility comes complexity.
Polar tracking is a lot more flexible than Ortho mode, and polar tracking has
a ton more options than Ortho mode (hey, one more option would be a lot
more!).

Sometimes AutoCAD makes things more complex and even confusing than
necessary by using the same words for features that seem similar but are
actually different from one another. Tracking is one of those words. In this
section we’re describing polar tracking, where AutoCAD displays “tracking
vectors” to show you when you're on a preset polar tracking angle. At the
end of this chapter we discuss object-snap tracking (after we’ve told you
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what object snaps are, of course!). With object-snap tracking, you use points
on existing objects to find new points.

Simple stuff first: To enable polar tracking, click POLAR on the status bar or
press the F10 function key.

Where Ortho mode forces you to draw horizontal and vertical lines and noth-
ing else, polar tracking gently guides you along the right path by displaying a
tooltip and a tracking vector to verify that you're heading the right way. All in
all, polar is a kinder, gentler — and did we say more flexible? — version of
Ortho mode.

The default angle setting for polar tracking is 90° which means you can use it
instead of Ortho mode. Having polar turned on with the default setting
means you can draw at any angle, but you’ll see a tooltip when you’re on a
horizontal or vertical path.

Polar tracking and Ortho mode can’t both be on at the same time; enabling
one disables the other. If you're like many experienced drafters, you may
consign Ortho mode to the virtual trash can.

The following steps explain how to configure and use polar tracking:
1. In a blank drawing, click the POLAR button on the status bar until it’s

not pressed in.

2. Start the LINE command, pick a start point, and then move the
crosshairs around the screen.

There’s no restriction or input on where you pick the next point of the
line.

3. Right-click the POLAR button and choose Settings.

AutoCAD displays the Drafting Settings dialog box with the Polar
Tracking tab current (see Figure 6-5).

4. In the Polar Angle Settings area, select Increment angles (angles and
their multiples that you want to track on screen) from the drop-down
list.

Standard subdivisions of 90° appear in the drop-down list. AutoCAD also
recognizes multiples of Increment angles; for example, if you select 45°
from the list, AutoCAD also locks on 135°, 225°, and 315°.

5. Check the Additional angles box, and then click New to add addi-
tional angles to polar tracking mode.
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4 Drafting Settings 2% Book I
Snap and Gnd | Pols Tracking | Object Snan | Dyname Input Chapter 6
[#] Petar Tracking On (F10)
Polar Angle Setfings Object Snap Tracking Settings -
Increment angle (O Track edhagonaly only a
| ){Track vsna 2l pols 3ngle setina g
[ Addtiend angles o
= S
ar Angle measurement g
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Figure 6-5: () Relative to last segment
Configuring
polar
tracking in
the Drafting
Settings
dialog box. [ Opers... | ok |[ cancel |[ Ree |
Vg“\\l\m/
S AutoCAD does not track multiples of Additional angles you enter; if you

enter 16.87°, polar tracking will recognize that angle only, not 33.74° or
other multiples of the original.

6. In the Object Snap Tracking Settings area, choose which tracking vec-
tors you want to appear when using object snap tracking to find
points.

Select Track Orthogonally Only to display only horizontal and vertical
tracking vectors, or Track Using All Polar Angle Settings to display all
the Increment and Additional angles you specified in the Polar Angle
Settings area. Note that this only has an effect if the OTRACK button is
pressed in. We cover OTRACK at the end of this chapter.

Although object-snap tracking settings appear on the same tab as polar
tracking angles, they’re actually independent of one another. Regardless
of whether you choose track orthogonally only or track using all angles,
when you're drawing stuff, all tracking angles show up. The object-snap-
tracking settings only kick in if you're actually tracking from one object-
snap point to another — that is, the OTRACK button on the status bar is
selected. Are you lost yet? Don’t worry; we discuss object snaps in the
following section, and object-snap tracking at the end of the chapter.

7. In the Polar Angle measurement area, choose how the polar angles
are to be measured.

Selecting Absolute is the least likely to get you lost, because the tracking
angles are the same as the angular measure you set up in the Units
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dialog box; that is, 0° is to the right, 90° is straight up, and so on.
Selecting Relative to last segment would display a vector at, say 45° to
the last line, which will probably not be the same as the absolute angle
of 45°.

When you’re familiar with the system, of course, it’s fine to temporarily
set Polar Angle measurement relative to the last segment. But we think
it’s a Really Good Idea to remember to reset it to Absolute when you're
finished.

8. Click the Polar Tracking On check box to enable polar tracking.

After you make all the appropriate settings, select the check box to
enable the feature.

Clicking the Options button in the Drafting Settings dialog box takes you to
the Drafting tab of AutoCAD’s Options dialog box. For the time being, you
don’t need to change any settings here — the defaults all work fine. We cover
the Options dialog box in detail in Book IX.

Working with Object Snaps
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Up until now, you’ve been relying on AutoCAD’s coordinate system to locate
points and draw objects. That’s fine, but if calculating and entering coordi-
nates were the only way of drawing accurately, you’d probably run screaming
back to your drawing board. After you use coordinates to get some objects
drawn, you can start using another very important AutoCAD feature:

object snaps.

Object snaps let you pick a precise point on an existing object; the point you
pick depends on which Object Snap mode you select.

Object Snap modes are different from object to object, depending on the
object type; for example, lines have endpoint and midpoint object snaps,
circles have center and quadrant object snaps, and arcs have endpoints,
midpoints, centers, and quadrants.

New users often get confused by snap and object snap. Snap is a status bar
toggle that forces the crosshairs to jump from preset snap interval to inter-
val. Snap is available whether there are objects in the drawing or not. Object
snap is an aid to precision that lets you find exact points on existing objects;
for example, the center of a circle or the insertion point of a piece of text.
Snap doesn’t need objects, but object snaps do.
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There are two ways of using object snaps: They can be on and available all Book |
the time, in which case they’re referred to as running object snaps, or you can Chapter 6
select the ones you want from a toolbar, menu, or the command line, for one
click only. Those ones are referred to as single object snaps, or object-snap

o
overrides. Since there are some extra wrinkles involved in setting up running a
object snaps, we're going to deal with object-snap overrides first. g:
o
=
Table 6-1 lists the Object Snap modes and how they’re used. st
(=]
7
Table 6-1 Object Snap Modes
Button Function Description
Temporary Track point Sets temporary point using object snap
—0 tracking. (Object-snap tracking is cov-

ered at the end of this chapter)

FROM Sets temporary reference point from
which you specify an offset

ENDpoint Locates precise endpoints of lines, arcs,
elliptical arcs, splines, or polyline
segments

MIDpoint Locates precise midpoints of lines, arcs,
elliptical arcs, splines, or polyline
segments

INTersection Locates precise intersection of two or
more objects

APParent INTersection Locates visual intersection of two
objects on different planes but appear to
intersect on-screen

LI IAN AN !

EXTension Projects a temporary vector from the end
of a line, arc, elliptical arc, or polyline
segment along which you can pick a
point

CENter Locates the precise center of a circle,
arc, elliptical arc, or polyline arc
segment

QUAdrant Locates the precise quadrant points of a
circle, arc, elliptical arc, or polyline arc
segment

TANgent Locates the point of precise tangency on
circles, arcs, elliptical arcs, splines, or
polyline arc segments

PERpendicular Locates a point precisely perpendicular
to an object

=EiEie

(continued)
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Table 6-1 (continued)

Button Function Description
PARallel Lets you draw a line parallel to another
/ line through any point
INSertion Locates the precision insertion point
% of text, block insertions, or external
references
NODe Locates a point object
o
NEArest Locates the point precisely on an object
/CB closest to where you select the object
NONe Temporarily disables all running object
ﬁ, snaps for one selection
o
- OSNAP settings Displays Object Snap tab of Drawing
nu Settings dialog box

Some Object Snap modes require two picks to set and therefore can’t be
used as running object snaps. For example, you can find a point midway
between two unconnected points using Mid Between 2 Points (M2P or MID2)
using the shortcut menu or keyboard, but you can’t set it as a running object
snap.

Hardcore typists can use the keyboard to set object-snap overrides by enter-
ing the capitalized letters in the table. To find the apparent intersection of
two objects, for example, you could enter APPINT.

AutoCAD LT 2007 includes all the object snap modes listed here; however
AutoCAD LT 2006 and earlier are missing some features, including Temporary
Track Point and the Extension and Parallel object-snap modes. We cover
AutoCAD LT in more detail in Book IV.

Using Point Filters

Sometimes it’s useful to use part of a location’s coordinates to locate a point
in a drawing. You can find the center of a circle using object snaps. But, say
you wanted to find the precise middle point of a square. Squares and rectan-
gles don’t have “centers” in the same way that circles do.

Using point filters (also known as dot filters or xy filters), you can locate a new
point by combining the x coordinate from one point with the y coordinate
from another (and, if you're working in 3D, the z coordinate from a third). It’s
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omplicated system, and it takes some practice, but if you're feeling like

taking The AutoCAD Challenge, follow these steps to draw a circle at the
center of a rectangle:

1.

2.

Open a drawing containing a rectangular area in which you want to
draw a circle, or draw a rectangle in a blank area of the screen.

Right-click the OSNAP button on the status bar to display the Drafting
Settings dialog box, and make sure that Midpoint object snap is
selected.

. Start the CIRCLE command.
AutoCAD prompts:

_circle Specify center point for circle or [3P/2P/Ttr
(tan tan radius)]:

. Hold down the Shift key and right-click. On the shortcut menu that
appears, click Point Filters to open the point-filters list shown in
Figure 6-6.
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5. Click X.

AutoCAD prompts you as follows:
.X of

6. Move the crosshairs over a horizontal side of the rectangle and click

when you see the Midpoint object-snap marker.
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7.

The prompt changes to
.X of (need yz):

Move the crosshairs over a vertical side of the rectangle and click
when you see the Midpoint object-snap marker.

AutoCAD locates the center point of the circle at a new point generated
from the x coordinate of the first picked point, and the y coordinate of
the second.

Working with Object Snap Tracking Mode

No,

OTRACK is not the name of the Irish railway system. Sure and begorrah,

OTRACK is much more useful than that. OTRACK is short for object-snap
tracking, an AutoCAD feature that lets you locate new points based on object-
snap points on existing objects.

Object snap tracking automates the point-filter process we described earlier.
For example, here’s how you’'d use object-snap tracking to place a circle in
the exact center of a rectangle:

1.

2.

Open a drawing containing a rectangular area in which you want to
draw a circle, or draw a rectangle in a blank area of the screen.

Right-click the OTRACK button on the status bar to display the
Drafting Settings dialog box, and make sure that Midpoint object snap
is selected.

You can also right-click the OSNAP button to display the Object Snap tab
of the Drafting Settings dialog box.

. In the Drafting Settings dialog box, select the Object Snap On and

Object Snap Tracking On checkboxes, and then click OK.

. Start the CIRCLE command.

AutoCAD prompts:

_circle Specify center point for circle or [3P/2P/Ttr
(tan tan radius)]:

. Move the crosshairs to the middle of a horizontal side of the rectangle.

The Midpoint object-snap marker appears.

. Rest the crosshairs over the object-snap marker for a moment, but

don’t click yet.
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When you move the mouse, you should see a tracking vector passing
through the object-snap marker.

7. Without clicking, move the crosshairs to the middle of a vertical side
of the rectangle.

8. When the object-snap marker appears, rest the crosshairs over it for a
moment.

Now when you move the mouse, you should see two tracking vectors,
one running through each of the midpoints.

9. Move the mouse until the two tracking vectors are aligned vertically
and horizontally (see Figure 6-7), and then click to set the center point
of the circle.

If DYNamic mode is enabled, you also get confirmation that you’re on
the money in the dynamic input tooltip.

=

bl Fiis
: Midpoint: < 270°, Midpoint: < 180°

,&c,I\D Lr

Although object-snap tracking has been part of the full version of AutoCAD
for several releases now, it’s just been introduced to AutoCAD LT 2007. It’s
not included in AutoCAD LT 2006 and earlier versions.
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Chapter 1: Drawing Objects

In This Chapter

v Input methods

v Using drawing tools

v Creating primitive objects

v+ Understanding construction objects

v+ Drawing complex objects

Welcome to Book II. It’s time to get primitive! No, we're not asking you
to move into a tree in the backyard and howl at the moon. In this

chapter, we introduce AutoCAD’s primitive objects and the drawing com-
mands for creating them. Primitive objects include geometric entities like
lines, arcs, circles, and points.

After we explore the primitive heart of AutoCAD, we look at some of its
more complex object-creation tools. These include polylines, multilines
(double lines if you're using AutoCAD LT), and some obscure entities like
traces and 2D solids.

As we explain in Book I, you can interact with AutoCAD in several ways.
You can start most drawing commands from the Draw toolbar or the Draw
menu, or by typing the command name (or its short-form alias) at the key-
board. In nearly all cases, using any of these methods to start a command
initiates a dialog with AutoCAD.

Locating and Using the Drawing Tools

Table 1-1 tells you where to find all the drawing commands AutoCAD pro-
vides, as well as what you can do with these commands. We don’t cover the
commands in this order; just think of this table as a handy reference chart.
In the interests of fairness and democracy, Table 1-1 lists commands in
alphabetical order by command name, not by popularity or frequency of
use. LINE, ARC, and CIRCLE are the most frequently used commands.
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Table 1-1 AutoCAD’s 2D Drawing Tools
leon Draw Draw Command Alias  Function
Toolbar Menu Name
Arc Arc ARC A Draws circular arc
f/. objects.
— Block, Define  ATTDEF ATT Defines attributes to
Attributes be included in block
definition. Attributes
are covered in Book VI.
Make Block, BLOCK B Defines a block from
% Block Make drawing objects. Blocks
are covered in Book VI.
— Boundary BOUNDARY  BO Creates polyline or
region from edges of a
closed area. For more
on Boundary, see
Book III.
@ Circle Circle CIRCLE C Draws circle objects.
— Double Line DLINE DL Draws double parallel
lines (AutoCAD LT only).
— Donut DONUT DO Draws circular polyline
object specifying inside
and outside diameter.
: Ellipse Ellipse ELLIPSE EL Draws ellipse objects.
Gradient Gradient GRADIENT GD Applies gradient fill
m pattern to closed
areas. Gradients are
covered in Book Il1.
Hatch Hatch HATCH H Applies solid or regular
i pattern to closed
areas. Hatches are
covered in Book Ill.
Line Line LINE L Draws straight line
/ objects between two
points.
— Multiline MLINE ML Draws multiple parallel
lines (AutoCAD only).
Multiline Text, Multiline  MTEXT MT Draws multi-line anno-
A Text Text tation text objects. Text

is covered in Book IlI.

(continued)
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Ieon Draw Draw Command Alias  Function
Toolbar Menu Name
Polyline Polyline PLINE PL Draws connected
) linear or arc segment
objects.
Point Point POINT PO Draws point objects.
]
Polygon Polygon POLYGON POL Draws regular closed
O polygonal polylines.
Ray Ray RAY — Draws infinite-length
construction line start-
ing from single point.
Rectangle Rectangle RECTANG REC Draws closed rectan-
D gular polyline objects.
Region Region REGION REG Creates a single closed
@ object from nested
objects.
Revision Revision REVCLOUD — Draws revision clouds.
Q Cloud Cloud
— — SKETCH — Draws freehand
sketches as polylines
or multiple line objects.
— — SOLID SO Draws 3- or 4-sided
solid-filled shapes. Not
related to 3D solids.
Spline Spline SPLINE SPL Draws freeform spline
(\} curve objects.
Table Table TABLE B Draws table objects
@ specifying rows and
columns. Tables are
covered in Book Ill.
— — TRACE — Draws single-segment
lines with width.
Construc-  Construc- XLINE XL Draws infinite-length
‘,"' tion Line  tion Line construction line

through specified
points.

\\J

If a command can be executed only by typing its name (that is, it has no tool

button or menu item), it’s not going to be used that frequently; SKETCH,
SOLID, and TRACE all fall into this category.
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In this chapter, we’re not going to cover every single drawing command in
extensive detail — that’s what the online Help system is for. The Command
Reference has an alphabetical listing of every command and details about
each command’s options. To access the Command Reference, choose Help>
Help or press the F1 key. Click the Contents tab, and then click the plus sign
beside Command Reference.

Sometimes you have to dig pretty deep in the Help system for the last word
on a command or feature. On many Help pages, there’s an almost invisible
little blue hyperlink that says, “Display all hidden text on this page.”
Remember it’s there and look for it!

Let’s Get Primitive

AutoCAD’s primitive object types are lines, circles, arcs, and points. Each of
these object types takes very little geometric data to define it in the drawing
database. A line is defined geometrically by its two endpoints, arcs and circles
by their center points and radii, and points by a single set of coordinates.

In this section, we look at the four commands that create these four primitive
object types. The commands are (surprise!) LINE, CIRCLE, ARC, and POINT.

Keeping to the straight and narrow

The LINE command creates a line object. In AutoCAD, a line object is a single
entity drawn between two endpoints. You use the LINE command to draw
straight lines from point to point to point. The LINE command continues
prompting for points until you explicitly end the sequence by pressing Enter
or Esc. Whichever method you choose to start the command, AutoCAD
prompts as follows:

Command: LINE
Specify first point:

Pick a point on-screen, or use an object snap (see Book I for more informa-
tion on using object snaps) to find a precise point on an existing object, or
type a pair of x,y coordinates to locate the starting point of your line
sequence. After you pick the first point, AutoCAD prompts:

Specify next point or [Undo]:

Specify the second and third points using the methods just described. If you
make a mistake, or change your mind after you pick the second point, press
U (for Undo) and press Enter to undraw the previous line segment. As you
continue to add line segments, you can press U at any time to undo the last
segment you added.
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<« Command options appear inside square brackets. To select a command
option, type the uppercase letter in the option and press Enter.
Specify subsequent points in the same manner as the first points. After you
pick the third point (that is, after you have two line segments), the command
prompt changes once more:
Specify next point or [Close/Undo]:
There are now two options, Undo and Close. After you've drawn two line seg-
ments, you can create a closed shape by pressing C and pressing Enter. If
you’re using dynamic input, you can select Close from the dynamic display
(see Figure 1-1). This will end the line sequence at the original starting point.
To end the sequence, press Enter or Esc or the spacebar, or right-click and
choose Enter from the shortcut menu.
o B

Figure 1-1:

Drawing

lines

dynamically.

P In Book I, we talk about relative coordinates and how AutoCAD interprets the

@ symbol as relative to the last point you picked. You can use the @ symbol

by itself to tell AutoCAD you want to use the last point you picked on-screen
or entered using coordinates. For example, if you enter @ at the Specify first
point prompt, AutoCAD starts the line at the last point entered.

Going around in circles

Circles are pretty basic geometric elements, although you may not create
them quite as often as you create arcs. We're going to talk about circles
before we talk about arcs because circles are simpler to draw. Even so, there
are five ways to create circles — six, if you use the pull-down menu. Figure 1-2
shows the pull-down menu with all six options.
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Figure 1-2:
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W futoCAD 2007 - [Drawing? dwg] ===
(5 File Edit View Inset Formal Tools | Draw  Dimension  Madily Express Window Help oo x
DHEH2RRDE | =B Modzling "EERSAE B | &[mred v s DS
=[Va% Do # Line B2 i | || o vl Bl 4] — H]
/By

e  Construction Line s
s Multilina b
= 5 Falyline -‘w"
[a] . a0 Folyline 5:
= & rFolygon 51}
r T Rectangle 3
@ o Helg 4]
S : nl
~ Cirda * [(9) Center, Badius N [i%
=1 @ Deaut @ Center, Diameter =
? ~ ?III:; e , & 2 Faints .
o Ellpze ) 3 Paints =]
3 Block 4 [l
s = Table... @ if:' 1?:' _?Z: = o

i Faint et i
o 1# Herch... .
[ W Gradient... -

@ 12 goundary... =
A [By Region I-'
wiipeout bl

A ) mevision Cloud L]

L=

I Text *
= X
WAk [ H]Y Mads feyet [ Layould [
_help
< 3
Cirmakms & cichs wsing & spechisd redus: CIRCLE

The first Circle option on the Draw menu — Center, Radius — is the default
method for drawing circles, and this is the method you get if you click the
Circle tool on the Draw toolbar, or enter CIRCLE or its alias C at the keyboard.

If you start the command using the default option, AutoCAD prompts as
follows:

Command: CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan tan
radius)]:

At this point, you can either locate the center point by picking a point
on-screen or entering coordinates for the center point, or you can choose
one of the three options inside the square brackets.

If you specify a center point, AutoCAD prompts:

Specify radius of circle or [Diameter]:
Another choice to make! You can either enter a value for the circle’s radius or
pick a point on-screen to specify the radius, or you can press D to choose the

diameter option. If you enter a value or pick a point, AutoCAD draws the circle
and returns you to the command prompt. If you press D, AutoCAD prompts:



Figure 1-3:
Eleven ways
to draw

an arc.
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Specify diameter of circle:

If this is the first circle you've drawn in this session, the command line is
blank. If you've drawn a previous circle, a default value (the last-entered
radius) is shown inside the angle brackets.

You can also draw circles by specifying two points that represent the end-
points of a line representing the diameter of the circle, or by specifying three
points that lie on the circumference of the circle. You also can draw circles
by selecting two objects your circle should be tangent to, and then entering
a radius.

The Draw menu offers a sixth method that actually invokes a macro; instead
of prompting you to enter a radius after you've selected the first two objects
for tangency, AutoCAD asks you to select a third object.

Ares of triumph

If you thought a half-dozen different ways of drawing circles was a lot, you
ain’t seen nuthin’ yet! There are no fewer than 11 ways to draw arcs. Worse,
the default method — 3 points — is the construction method for creating
arcs that you're least likely to encounter. Figure 1-3 shows the Arc command’s
options available through the Draw menu.
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While you're getting familiar with the program, it’s easiest to use the Draw
menu to choose the option you want. The nine central options on the Draw
menu are all based on start points and center points, and then each has vari-
ations of end point, included angle, direction, length, or radius.

Choosing Draw=>Arcw>Start, Center, End, for example, presets the command
options so that the three points you enter are indeed interpreted by
AutoCAD as the start point, the center point, and the end point.

One little gotcha is that by default, AutoCAD draws arcs in a counter-clockwise
direction. Figure 1-4 shows how you control the way your arcs are drawn.

1. PICK START 3. PICK END

'} AY

—2. PICK CENTER
3. PICREND
I

i

’
X

o (><
2. PICK CENTER —

Figure 1-4: J
Arc 1. Flok START —
direction by
dEfaTt is \ CONTROLLING ARC DIRECTION
counter- WITH start, Center, End OFTION.
clockwise.
[ (E
v?\‘\\NG! You’re probably aware that pressing Enter or the space bar, or right-clicking

and choosing Enter, repeats the last command. What it doesn’t do is repeat
the last command options you chose. Instead, it repeats the command with
its default options. In the case of ARC, that will give you a 3-point arc, where
the three points you pick are the start and end points and a random point
somewhere along the arc itself. Most of the time this is not what you want.

The point of the exercise

After all that arcane arc knowledge, you're probably ready for something
simple. You're in luck — the simplest of all AutoCAD objects is at hand.
Points are geometrically defined in the drawing database by their x-, y-, z-
coordinate location.



Figure 1-5:
Style your
points in the
Point Style
dialog box.
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Although we’ve been talking about x,y coordinate pairs, in fact every object
in an AutoCAD drawing is located by an x- y- z-coordinate triplet. In most
cases for 2D drafting, the value of the z coordinate is 0.

Although we’re dealing with 2D objects in this part of the book, your point
object is pretty one-dimensional (kind of like some engineers we know).
Since points have no length or width, they can be pretty small and hard to
see. The default appearance for the point object is a single pixel, but you can
change the appearance to something a little more visible by following these
steps:

1. Choose Format=>Point Style.
AutoCAD displays the Point Style dialog box (see Figure 1-5).

2. Select one of the point styles by clicking its icon in the dialog box.

The selected style will apply to all current and future point objects in the
drawing.

3. Specify the size of the point objects, and then click OK.

Set the point size as either a percentage relative to the screen size or in
absolute units. If you set point size in absolute units, the point objects
appear larger or smaller as you zoom in or out; if you set point size rela-
tive to screen size, point objects stay the same size.
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-
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w
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o
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EEEE
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Port Size: | 5.0000

(%) Set Size Relative to Screen
() Set Size in Absolute Uits

[T‘[ Cancel ] Help

As we mentioned earlier, the default point style is a single pixel. Click the top-
left icon in the Point Style dialog box to select it. The next icon to the right is
no display at all — that’s right, you can create point objects that you can’t
see. Frankly, we don’t see the point.
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Creating Construction Geometry

A\

In spite of snap, Ortho, polar, and object snaps, many AutoCAD drafters use
the software the same way they drew things with pencils and t-squares — they
draw temporary construction geometry to line things up and project drawing
features from one view to another. AutoCAD has a couple of construction
geometry tools that help with this process: construction lines and rays.

Xlines for X-men

Construction lines (commonly known as xlines) are created with the XLINE
command, by default the second button down on the Draw toolbar. Xlines
(and rays) are unlike any other object in AutoCAD in that they have infinite
length.

Create a separate layer for your construction lines so you can easily turn
them off and on when you want to see your drawing geometry without all
the visual noise. Construction lines and rays will plot, so be sure to turn off
the layer before you print your drawings.

Although xlines look a lot like lines, they don’t have endpoints, so you have
to construct your xlines accordingly. The following steps explain how to
create a series of vertical xlines, as shown in Figure 1-6:

1. Turn on appropriate object snaps.

This is a very important step; because you’re going to be aligning your
xlines with existing drawing objects, it’s important that you place them
precisely.

2. Start the XLINE command using the Draw menu, Draw toolbar, or the
keyboard.

AutoCAD prompts:

Command: XLINE
Specify a point or [Hor/Ver/Ang/Bisect/Offset]:

3. Type the uppercase letter of the option you want. In this case, type V
and press Enter.

When you respond to the prompt, it doesn’t matter whether you type an
uppercase or lowercase letter. AutoCAD prompts:

Specify through point:

4. Use the appropriate object snap mode and pick a point on the drawing
geometry through which you want the xline to pass.

AutoCAD continues to create xlines until you press Enter or Esc.
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If you want to lay down a whole bunch of xlines at different angles, don’t
select a command option first. Your new xlines will pass through the point
you pick but you'll be able to set the angle by picking on-screen. This is an
especially efficient method of laying out construction lines for a drawing if
you have polar mode turned on and the correct object snaps enabled.

A little ray of sunshine

The most significant difference between a ray and a construction line is that
a ray has one endpoint and extends infinitely away from that endpoint. A
construction line, on the other hand, has no endpoints and therefore
extends infinitely in both directions.

The following steps explain how to create rays:

1. Turn on the appropriate object snaps and enable Ortho or Polar modes
as necessary.

As noted already, construction lines and rays need to be created precisely
to be of any use.
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2. Start the RAY command using the Draw menu or the keyboard.
By default, there is no Ray tool on the Draw toolbar. AutoCAD prompts:

Command: RAY
Specify start point:

3. Use the appropriate object snap mode and pick the point in the draw-
ing where you want the ray to start.

AutoCAD prompts:
Specify through point:

4. Again, use an appropriate object snap mode and pick a point on the
drawing geometry through which you want the ray to pass.

AutoCAD will continue creating rays from the original start point until
you press Enter or Esc.

When should you use rays and when should you use xlines? Xlines are easier
to construct, since they only need a through point, whereas rays need a start
point and a through point. Really, the only advantage of rays is having slightly
less clutter on your screen — they only disappear off one side of the screen
instead of two.

For more on construction lines and rays, check out the User’s Guide in the
Online Help system. Choose Help=>Help=>User’s Guide, and then navigate to
Create and Modify Objects=>Draw Geometric Objects>Draw Construction
and Reference Geometry=>Draw Construction Lines (and Rays).

Without a Trace

Because the AutoCAD & AutoCAD LT All-in-One Desk Reference For Dummies

is nothing if not comprehensive, we're going to cover the TRACE command.
As Table 1-1 shows, TRACE has no tool button or alias, and is nowhere to be
found in the menu system. The TRACE command, which creates trace objects
(is that pattern settling in yet?) is a prime example of AutoCAD’s attic. It’s
really hard to throw anything away, even though it’s been 15 years since you
last used it.

Traces had a function once. They were used in the preparation of printed cir-
cuit boards (or PCBs). Traces are more or less like lines with one significant
difference: traces, like one or two other object types we’ll get to shortly, can
have width. As with the LINE command, you can keep picking points and
AutoCAD will continue making traces, automatically cleaning up the intersec-
tions as it goes.

Traces offer no benefits over polylines (we’ll get to polylines a bit later).
Traces can’t have curved segments (polylines can). The TRACE command



Figure 1-7:
Sketching
with
Picasso
(and some
traces).
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lacks Close and Undo options like those in the LINE command. You can’t
even see traces as you draw them.

We’'re not going to tell you not to experiment with TRACE — who knows, you
may find a unique use for that cast-off in AutoCAD’s attic. For a very brief
description of the command, look up TRACE in the index of the online Help
system. Figure 1-7 shows you some sample traces.

TRACE SKETCH

(4 TRACE ENTITES) (122 LINE ENTITIES)

A Bit Sketchy

Another antique tool from the attic is the SKETCH command. Like TRACE,
you won'’t find an alias or a tool button or a menu item for SKETCH. You have
to type out the whole command name to run it. The SKETCH command does
not create its own entity type; the end product of a SKETCH sequence is
either a polyline or a whole bunch of teeny lines.

In its earliest days, AutoCAD had no commands for freehand sketching.
Enter the SKETCH command. Unless you use it every day (and we can’t
imagine many people do that), SKETCH takes some getting used to because
it works unlike any other AutoCAD command. Follow these steps and you’ll
see what we mean:

1. Type SKETCH and press Enter to start the command.

The first cryptic message appears at the command line:

Command: SKETCH
Record increment <0.1000>:
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Unlike with LINE, ARC, or CIRCLE, you don’t have to select or enter
points while you're sketching — simply moving the mouse creates the
sketched entities. The prompt is telling you that any mouse movements
greater than 0.1 units will be recorded. Change this value now if you want
longer or shorter mouse motions to be turned into drawing entities.

2. Press Enter to continue.
AutoCAD prompts (even more cryptically, if that’s possible):
Sketch. Pen eXit Quit Record Erase Connect .
“Sketch” is an order, from AutoCAD to you!

3. Click the left mouse button to start sketching. Click again to stop
sketching.

Clicking the left mouse button toggles Sketch mode between <Pen down>
and <Pen up>. Simply moving the mouse a minimum of 0.1 units (or
whatever record increment you specified) creates sketched entities. The
SKETCH command ignores object snaps, and it ignores the right mouse
button.

The system variable SKPOLY determines whether SKETCH creates polyline
objects or kazillions of separate lines. The default value of SKPOLY is 0
which will generate many many many lines. Setting SKPOLY to 1 tells
AutoCAD to create polylines from the connected sketch segments.

Drawing Parallel Lines

If you're drawing something like the floor plan of a house, you need parallel
lines to represent the walls. The LINE command gives you a single line,
which you then need to offset or copy to get a pair of lines that can repre-
sent a wall. Both AutoCAD and AutoCAD LT have commands for drawing par-
allel lines, but they’re different in each program.

AutoCAD LT provides a command called DLINE that enables you to draw
double lines. You specify a thickness, or separation distance, and then draw.
The DLINE command creates pairs of line objects that can be edited or
erased separately. The DLINE command is not included in the regular ver-
sion of AutoCAD 2007. For more on using DLINE, see Book IV.

Multilines (which are not included in AutoCAD LT) are multiple parallel lines
that can have different properties from one another. A multiline can have up
to 16 elements. You create multiline objects with the MLINE command and
edit them with a special set of tools. We cover editing multilines in the next
chapter.



Figure 1-8:
One
multiline
object
makes a
foundation
plan.
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Multilines definitely belong in the ranks of AutoCAD’s complex objects. To

use multilines effectively, you'll need to be able to create and edit the multiple-
line styles that format the multiline objects. And you’ll need to be able to edit
them in the unique way that they require. It has to be said that many AutoCAD
users don'’t like using multilines because of their perceived inflexibility.

Making multilines

Figure 1-8 shows one example of a multiline object. Using the LINE command,
it would take 24 separate lines (and a lot of editing) to get the same result.

The following steps show you how to create a simple multiline shape.

1. Choose Draw>Multiline or type ML to start the MLINE command.
AutoCAD displays the MLINE options at the command prompt:

Command: MLINE

Current settings: Justification = Top, Scale = 1.00,
Style = STANDARD

Specify start point or [Justification/Scale/STyle]:

2. If you want to change justification from the current value, type J.

Justification is either Top, Zero, or Bottom, and refers to where the multi-
line elements are located relative to where you pick your locations. Zero
justification centers the multiline elements on the points you pick. If
Justification is Top, and you draw your multilines from left to right, the
points you pick will be at the top element of the multiline. If you draw a
closed shape with multilines, drawing clockwise with Top justification
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places the outermost element on the pick points. Logically, choosing
Bottom justification does the reverse.

P If you find the MLINE command’s justification labeling as confusing as
we do, you'll probably have better luck if you choose one justification
(for example, Top) and one direction (for example, clockwise), and
stick to it.

3. To change Scale from the current setting, type S.

The default value of 1.0 draws multilines exactly as specified. So if your
multiline style has two lines with a 1-inch separation, that’s how far
apart they’ll be in your drawing. If you wanted to use this multiline style
to represent a 6-inch wide wall, you’d change the scale factor to 6.

P Rather than try to do everything with a single multiline style, consider
creating styles for real objects using real dimensions. For example, if
you want a 6-inch wide wall, define the wall style so that the lines are
6 inches apart. That way you don’t have to even think about the Style
option.

4. Type ST to switch the current multiline style to another style.

The new style must already exist in the drawing; you can’t create a new
multiline style from the MLINE command prompt.

5. Pick a start point or enter coordinates.

The remaining prompts are identical to those for the LINE command.
AutoCAD continues drawing multiline segments until you press Enter or
Esc to terminate the command. After the second pick, there’s an Undo
option, and after the third pick, a Close option.

Because multilines are single objects, they must be created according to a
defined multiline style. By default, every AutoCAD drawing contains a multi-
line style definition called Standard. The default Standard style is used to
create pairs of continuous parallel lines.

That’s how you create multilines and multilines. As for why you may want
to use multilines, we leave that up to you but offer the following list of
multiline shortcomings:

4+ A sequence of multilines, such as the foundation drawing example, is a
single AutoCAD object, and therefore difficult to edit; frequently users
create geometry with multilines and then explode them to individual
lines (we discuss the EXPLODE command in the next chapter).

4+ Multilines can’t have curved segments; if you're laying out a floor plan
and need curved walls, you have to exit the command and draw the
curved segments with regular lines and arcs.
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4+ Multiline styles can’t be modified if there are any multiline objects
drawn with that style in the drawing. If you want a slightly different
style, you have to create a similar-looking multiline style and then
re-create the lines.

4+ You can’t change the style of an existing multiline object in the
Properties palette as you can with other object types defined by styles.

4+ Editing multilines requires a specialized set of tools and its own dialog
box (although in AutoCAD 2005 and later you can use some regular edit-
ing commands on multilines).

4 It can be non-intuitive — not to say, downright tricky — to define multi-
line styles. Book Il
Chapter 1

Complex Curves

Splines are smooth curves that pass near or through a series of control
points. A spline object in AutoCAD can form either a closed or open shape.
An ellipse is a symmetrical, oval shape that can be either closed or open (if
it’s open, technically it’s an elliptical arc, but AutoCAD still classifies it as an
ellipse). Ellipses are defined by a center point, a major axis, and a minor
axis. In its early days, AutoCAD could only approximate spline curves and
ellipses by creating polyline objects (we say more about polylines a little
later). More recent versions have acquired the math skills to create what are
known as Non-Uniform Rational B-Splines — or NURBS to their friends.

s)oalqQ Buimelsqg

Lucy, you got some splining to do!

AutoCAD can create two different types of splines; one type is the spline-fit
polyline, which we discuss in the next section. Industrial designers use
splines to give form to organic shapes. Splines are created with the SPLINE
command and are defined by an arbitrary number of control points.
Depending on your needs, you can either eyeball your splines, or calculate
the coordinates of their control points for absolute precision.

The following steps show you how to create splines and describe the
options of the SPLINE command.

1. Click the Spline tool on the Draw toolbar, or choose Draw=Spline, or
type SPLine to start the SPLINE command.
AutoCAD prompts as follows:
Specify first point or [Object]:
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Figure 1-9:
Afit
tolerance
for your
splines.

2. Pick a point on-screen, or enter coordinates to specify a precise start

point for the spline.

If you type O at this prompt, you can select a spline-fit polyline to con-
vert to a NURBS spline.

. Pick another point on-screen, or enter coordinates for the second point.

After you pick the second point, AutoCAD prompts:

Specify next point or [Close/Fit tolerance] <start
tangent>:

. Type F to specify a Fit tolerance.

Fit tolerance determines how closely the spline object comes to the
points used to define it (see Figure 1-9). The default value of 0 forces the
spline to pass precisely through the control points. Values greater than 1
allow the curve to pass that point within that tolerance value.

FIT TOLERANCE = C

FIT TOLERANCE = C.B

FIT TOLERANCE =1

5. To create a closed spline, type C and press Enter.

AutoCAD makes its best guess at closing the spline shape, but needs one
more piece of information from you. The command prompt reads:

Specify next point or [Close/Fit tolerance] <start
tangent>: C
Specify tangent:

You can either pick a point on screen to set the tangency direction, or
simply press Enter to accept the default tangent direction.
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6. To create an open spline, press Enter to accept the default choice and
specify a start tangent direction.

AutoCAD prompts:
Specify start tangent:

Specify end tangent:

For each prompt, pick points on-screen, enter coordinates, or simply
press Enter to accept the default tangency directions.

Solar Ellipses

Ellipses, like splines, are created as NURBS curves. Unlike splines, ellipses
are closed, symmetrical shapes. Elliptical arcs are similar to ellipses, except
that they’re open.

Drawing ellipses

AutoCAD provides two methods for drawing ellipses. You can define the
ellipse by locating the two endpoints of its first axis and one endpoint of its
second. Or, you can locate the center of the ellipse, and then one endpoint
on each of its axes. The following steps show you how to create an ellipse:

1. Choose Ellipse from the Draw toolbar or Draw menu, or type EL to
start the ELLIPSE command.

AutoCAD prompts:
Specify axis endpoint of ellipse or [Arc/Center]:

2. To draw an ellipse based on its center, pick a point or enter coordi-
nates to specify the first endpoint of the first axis.

AutoCAD prompts:
Specify other endpoint of axis:

3. Pick a second point or enter coordinates for the second endpoint of
the first axis.

AutoCAD prompts:
Specify distance to other axis or [Rotation]:

You have three choices here: You can specify a point by picking or
typing a coordinate pair (the default method); you can specify a dis-
tance (that is, the length of the second axis); or you can use the Rotation
option to specify an angle between the two axes.

Acceptable angle values range between 0 and 89.4°. The higher the rota-
tion angle, the flatter the ellipse, and a 0° rotation will generate a circu-
lar ellipse.
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4. To draw an ellipse using the default method, pick a third point above

or below the first axis, or enter a coordinate pair.

AutoCAD draws the ellipse.

Elliptical arcs

Drawing elliptical arcs is almost the same as drawing ellipses, except there
are two additional inputs needed at the end of the process. The following
steps explain how to draw an elliptical arc using the default construction
method.

1. On the Draw toolbar, click the Elliptical Arc tool.

Use the toolbar button for the most direct route to this function, which
is actually an option of the regular ELLIPSE command, as the command
prompt shows:

Specify axis endpoint of ellipse or [Arc/Center]: _a
Specify axis endpoint of elliptical arc or [Center]:

The Elliptical Arc tool is actually a command macro that’s programmed
into the tool button to automatically choose the Arc option of the ELLIPSE
command. The second line takes you to the first step of drawing a regu-
lar ellipse.

If you're really attached to the menu system, you can choose Draw=>
Ellipsec>Arc to run the same command macro (see Figure 1-10). But if
you’re a dedicated keyboarder, you must type the A (for Arc option)
yourself. Sometimes AutoCAD makes you work so hard!

. Pick points on-screen to specify the first and second endpoints of the

first axis, and the endpoint of the second axis.
AutoCAD prompts as follows:

Specify other endpoint of axis:
Specify distance to other axis or [Rotation]:

The final prompts allow you to set the internal angle of the elliptical arc.

. Pick points on-screen to specify the start and end points of the ellipti-

cal arc.
AutoCAD prompts:

Specify start angle or [Parameter]:
Specify end angle or [Parameter/Included angle]:

For information on the Parameter option (which doesn’t do much that
simply picking endpoints can’t handle), refer to the ELLIPSE command on
the Index tab of the online Help.



Figure 1-10:
Elliptical
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Complex Objects and Shapes

The last selection of commands and objects covered in this chapter are
somewhat more complex than most of those covered previously. Some, like
polylines, are extremely useful. Others, like 2D solids, are a lot less so.

2D Solids

The first thing to be said about 2D solids is that they’re not three-dimensional
solid objects. We talk about working in 3D in Book V. Here we deal briefly
with another ancient AutoCAD entity type, the 2D solid. Solid here refers to a
solid-filled 2D outline.

Along, long time ago, AutoCAD was not able to solid-fill a closed area. If you
wanted the effect, you had to use the SOLID command. A big drawback is
that 2D solids can have only three or four sides — no more. So you might
have had to create dozens of 2D solids to fill a randomly shaped area. The
other problem with 2D solids is that their three or four sides are always
straight.
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138 Complex Objects and Shapes

Ninety-nine times out of 100, you can get the effect you need with the HATCH
command or a wide polyline. (We discuss hatching in Book Il and polylines
in the next sections.) If you still think you need 2D solids, check out the
SOLID Command in the online Help.

Rectang, Polygon, Donut

No prizes for guessing what kinds of things that commands named REC-
TANG, POLYGON, and DONUT make. (Actually you may have to guess, but
we don’t have any prizes for you!)

All three commands make polyline objects. A polyline is a very useful type of
object, which can take almost any shape, as long as each part is connected
to the other.

Rectangles

The RECTANG command creates four-sided closed polylines with horizontal
and vertical sides. Command options allow you to draw rectangles in differ-
ent ways. You can:

4+ Locate two diagonal corners

4+ Locate one corner, and then enter values for area and the length of
one side

4+ Locate one corner, enter values for length and width, and then specify
direction

4+ Locate one corner, specify a rotation angle, and then locate the other
corner

In addition, before you pick the first point, you can

4+ Set chamfer or fillet values so that all four corners are automatically
chamfered or filleted

In drafting, a chamfer is a straight line that forms the transition between

two 2D objects that meet at an angle; one example is a beveled edge at a
corner. A fillet is a curved transition between two 2D objects; an example
is rounded edge at a corner.

4+ Set a width value so the sides of the rectangle have a 2D width

4+ Set elevation and thickness values for the rectangle if you're working in 3D.



A\\S

Complex Objects and Shapes 139

Polygons

Polygons, like rectangles, are closed polyline objects. Unlike rectangles, by
default polygons are regular: They have equal length sides and equal internal
angles.

If you want to draw irregular polygons, use the PLINE command.

AutoCAD’s POLYGON command draws regular polygons of a minimum of
three and a maximum of 1,024 sides. After specifying the number of sides for
your polygon, there are three options:

4+ Edge: Locate an endpoint of the first edge, and then pick or enter a value
to locate the second endpoint.

4+ Inscribed: Locate the center of an imaginary circle, and then specify its
radius. AutoCAD draws the polygon so that the corners touch the cir-
cumference of the circle (the circle is not actually drawn).

4+ Circumscribed: Locate the center of an imaginary circle, and then spec-
ify its radius. AutoCAD draws the polygon so that the sides are tangent
to the imaginary circle.

Donuts

Now for the biggest disappointment of the whole chapter. No, AutoCAD does
not generate snack food when you run the DONUT command. Trust us — it’s
better that way, anyway.

AutoCAD donuts are solid-filled polylines (as opposed to jelly-filled pastries).
When you create donuts in AutoCAD, you specify an inside and an outside
diameter, and then locate them by picking a center point.

A common use for donuts (the AutoCAD flavor, anyway) is in structural engi-
neering drafting where you need to draw round reinforcing steel in a cross-
section. You can specify an inside diameter of 0 to create a solid-filled donut.
Just like asking for “Plain” at the coffee shop.

Polylines

A polyline is a single object that consists of one or (more usefully) multiple
linear or curved segments. You create open or closed regular or irregular poly-
lines with the PLINE command. Just like the LINE command, PLINE will con-
tinue adding line (or arc) segments until you terminate the command. Unlike
the case with LINE, the objects you create with the PLINE command are single
entities. Figure 1-11 shows geometry created with each command. The LINE
command (on the left) created eight connected but separate line objects. The
PLINE command (on the right) created one single object.
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Figure 1-11:
Drawing
polylines
(and lines).
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The following sequence from the command prompt shows how the polyline

in Figure 1-12 was drawn:

Command: _pline

Specify start point: 40,20

Current line-width is 0.0000

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: W

Specify starting width <0.0000>: O

Specify ending width <0.0000>: 2

Specify next point or [Arc/Halfwidth/Length/Undo/Width]:
@4<180

Specify

next point or

[Arc/Close/Halfwidth/Length/Undo/Width] : @4<180

Specify

next point or

[Arc/Close/Halfwidth/Length/Undo/Width]: W

Specify
Specify

Specify

starting width <2.0000>: 2
ending width <2.0000>: 4

next point or

[Arc/Close/Halfwidth/Length/Undo/Width]: @4<180

Specify

next point or

[Arc/Close/Halfwidth/Length/Undo/Width]: W
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Specify starting width <4.0000>: 4
Specify ending width <4.0000>: 0.5

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width] : @8<180

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width]: W

Specify starting width <0.5000>: 0.5
Specify ending width <0.5000>: 0

Specify next point or
[Arc/Close/Halfwidth/Length/Undo/Width]: A

Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second
pt/Undo/Width]: @12<270

Specify endpoint of arc or
[Angle/CEnter/CLose/Direction/Halfwidth/Line/Radius/Second
pt/Undo/Width]: <Press Enter to end the command>

Figure 1-12:
Constructing
a polyline.

I AutoCAD 2007 - [Rats!. dwg) ==
[ File Edit View Insen Foimal Tools  Draw  Dimension Modily  Express Window  Help =8 x
DHHE 2R e =w0d s F - LX X HERIRE B & [y ) [mere e
=[Va® amo vl £ || Ao Cmne [v| 5 i | || orimer || T [ -
s #
7 K]
s A
o &
= s
r +
@ O
5 |
r~ [A
&
2 ¢
) o
3 (]
- -+
= i
w -
- i i
|_1 .
A i,
: L]
N "

L=

Lt ¥
WA Th W] Mok et T JLayout? |

taje ¥ next point or [Aro/Halfwidth/TLength/Undo/Width] I

ify next point or [Arc/Close/Halfwidth/Length/Undo/Hi. e
nand: < )_
38.8615, 5.8675_0.0000 | SNAP| GRID ORTHO| |POLAR [DSNAP OTRACK) DUCS) OYH| LWT)|MODEL 3 d‘lﬂ - D

Book |
Chapter 1

s)oalqQ Buimelsqg



142 ook 11: 20 Drafting



Chapter 2: Modifying Objects

In This Chapter

1~ Setting selection options
v~ Editing objects

v Using object groups

v+ Undoing and redoing

v+~ Editing objects using grips

M ost of the work you do in any CAD drawing file involves modifying
existing objects. You may need to move objects from one part of the
drawing to another, or you may need to copy them from one part of a draw-
ing to another, or even from one drawing to another. “Draw once, reuse as
much as possible” should be your mantra when you work in AutoCAD.

Of course, before you can edit an object, you have to tell AutoCAD which
object you want to work with. Sounds simple enough, but there’s a bewilder-
ing number of methods you can choose from to select objects. AutoCAD’s
Options dialog box is the place to begin setting your choices for object
selection, and that’s where we're going to start with this chapter.

Setting Selection Options

Before we get to selecting and then editing, we need to briefly explore the
Selection tab of the Options dialog box (see Figure 2-1).
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The six settings in the lower-left corner determine how you select objects:

4+ Noun/verb selection. Allows you to select objects for editing before you
start an editing command. Checked by default. See “Object selection
modes” later in this chapter for more information.

4+ Use Shift to add to selection. When unchecked (the default), selecting
items one after another adds them to the selection set; to remove items
from the selection set, hold down the Shift key and select them. When
checked, press the Shift key to add objects to the selection set; clicking
on a selected object removes it from the set.

Selection set refers to any selected objects that are ready to be edited.
There can be only one selection set active at a time, and when you make
a new selection, the old selection set is replaced. A selection set can
contain any number of objects, even including everything in the drawing.
It’s also possible to save a selection set as a named group — see the
later section “Object groups.”

4 Press and drag. When unchecked (the default), you click once to set one
corner of a selection box, and then click again to set the other corner.
(For more on selection boxes, see “Selecting multiple objects” later in
this chapter.) When checked, you use Windows-standard pressing-and-
dragging with the left mouse button to set the selection box.
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4+ Implied windowing. When checked (the default), picking a point away
from any object starts an automatic selection box. Moving the mouse to
the left creates a crossing box, and moving it to the right creates a
window box. We explain the difference in the “Selecting multiple
objects” section.

4+ Object grouping. When checked (the default), clicking one object that
belongs to a defined object group selects every other object in that
group. When unchecked, other group members are not selected when
one member is selected. See “Object groups” for more information.

4 Associative hatch. When unchecked (the default), selecting a hatch
object selects only the hatch. When checked, selecting a hatch object
also selects the boundary used to create it.

Figure 2-1 and this list point out the default selection settings. The following
sections assume that these are the current system settings. If you get differ-
ent results when you try some of these methods, open the Options dialog
box and make sure that the settings jibe with ours.

Selecting Objects

You must decide two things when you see some drawing objects that need
editing:

4+ How many objects do you want to modify? If there are several, are they
adjacent to one another, or are they scattered all over the drawing?

4+ How do you want to modify the objects? Do you want to select them
first, or start the command first? Or would you rather use another
method altogether? (For the last, we're referring to object grips, which
we discuss near the end of the chapter.)

The first thing you have to work out is whether you want to perform an
action on one single object or modify a group of separate objects. Selecting a
single object is (to use some technical language) a no-brainer — you just
click it with the pickbox, and it’s selected.

The little square box at the intersection of the crosshairs is called the pick-
box, and whenever it’s visible, you can use the crosshairs to select objects.
The pickbox disappears from the crosshairs in any command in which
you’re being prompted to select a point. (And the crosshairs disappear from
the pickbox when AutoCAD asks you to select an object.) By default, the
pickbox measures 3 pixels square; you can alter the size by typing PICKBOX
and specifying a new value.
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Selecting multiple objects

If you start your editing process by selecting one of the Modify commands,
AutoCAD prompts you to select objects. Use one of the following techniques
to do so:

4+ To select a single object, click it with the pickbox.

4 To invoke an automatic window selection box, pick a point above and to
the left of the objects you want to select, and then move the crosshairs
down and to the right to create a window box around the objects.

4+ To invoke an automatic crossing selection box, pick a point above and to
the right of the objects you want to select, and then move your crosshairs
down and to the left to create a crossing box around the objects.

4+ To invoke any other option, enter the capitalized parts of the option
name as follows: Last, ALL, Fence, WPolygon, CPolygon, Add, Remove,
and Previous.

Table 2-1 lists all the selection modes provided by AutoCAD. You can invoke
any mode by typing the uppercase letters for the option (for example, F for
Fence, ALL for All).

Table 2-1 AutoCAD's Selection Modes
Mode Description
Window Prompts for the first corner and then the other corner of a rec-

tangular selection window. Only objects completely within the
selection window will be selected. Window boxes are indicated
by continuous border lines and blue shading.

Crossing Prompts for the first corner and then the other corner of a rec-
tangular selection window. Objects either completely within or
crossed by the selection window will be selected. Crossing
boxes are indicated by dashed border lines and green shading.

WPolygon Prompts you to draw an irregular shape around the objects you
want to select by picking points; once you've picked at least
two points, the boundary becomes self-closing. Only objects
completely within the WPolygon boundary polygon will be
selected. WPolygon boundaries are indicated by continuous
lines and blue shading.

CPolygon Prompts you to draw an irregular shape around the objects you
want to select by picking points; after you pick at least two
points, the boundary becomes self-closing. Objects either
entirely within or crossed by the CPolygon boundary are
selected. CPolygon boundaries are indicated by dashed lines
and green shading.

Fence Prompts you to draw a series of line segments through the
objects to select. All objects touched by the Fence line will be
selected.




Figure 2-2:
Picking your
way through
AutoCAD
objects.
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Mode

Description

ALL

Selects everything in the drawing except objects on frozen
layers, and objects in paper space if you are in model space or
objects in model space if you are in paper space. (Refer to Book
| for more information on model and paper space.)

Last

Selects the last object created that’s visible in the current
display. (This may not necessarily be the last object added to
the drawing.)

Previous

Reselects the last selection set. Any selection set can be
recalled using the Previous option, until a new selection set
is created.

Add

Lets you continue to add objects to a selection set. (You can
also add to the selection set by simply picking more objects.)

Remove

Removes selected objects from a selection set. (You can also
remove selected objects from the selection set by holding the
<Shift> key and picking them.)

Figure 2-2 shows the results of selecting objects using Window, Crossing,
WPolygon, CPolygon, and Fence modes.

NFOLYEON

Object selection modes

You can select objects for editing in two ways:

4+ Verb-noun editing: Start the desired edit command, and then select the
objects you want to modify.

4+ Noun-verb editing: Select the objects you want to modify, and then start
the specific edit command.
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748 Selecting Objects

You’re probably wondering if this is AutoCAD or Grade 6 English. Don’t
worry; this is just the terminology that the Autodesk programmers chose to
distinguish the two methods.

The following steps show you how to use each mode. As an example, we’ve
chosen the ERASE command, but the majority of commands work using
either mode.

1.

2.

In a new, blank drawing, draw some lines, circles, or other objects, or
open a drawing containing a number of objects.

Start the ERASE command by clicking its icon in the Modify toolbar,
or choosing Modify=>Erase from the menus, or by typing E and press-
ing Enter.

To use verb-noun editing, select the command first. AutoCAD prompts:
Select objects:

Move the crosshairs so that they’re on top of an object, and then click.

AutoCAD prompts

Select objects: 1 found
Select objects:

. Move the crosshairs until they’re not on top of an object, and then click.

With Implied Windowing turned on (see the previous section, “Setting
Selection Options”), moving the mouse to the left starts a crossing selec-
tion box, and moving it to the right starts a window selection box.
AutoCAD prompts:

Select objects: Specify opposite corner:

. Move the mouse to the right so that the blue window selection box

entirely surrounds an object, or move it to the left so that the green
selection box crosses some objects.

AutoCAD prompts:

Select objects: Specify opposite corner: 2 found, 3
total
Select objects:

. Press Enter to finish selecting objects and complete the command.

AutoCAD continues prompting you to select more objects until the cows
come home. Or until you press Enter to complete the command —
which, we hope, you'll do first.

Still got some objects left to erase? Good! (If not, click the Undo button
on the Standard toolbar to get some of them back.)
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7. Make sure that no command is active, and then use any selection
method you like to choose some objects.

No command is active, but the objects are still added to a selection set.
AutoCAD prompts:

Command :
Command: Specify opposite corner:

8. Start the ERASE command by clicking its icon in the Modify toolbar,
or choosing Modify=>Erase, or typing E and pressing Enter.

AutoCAD erases the drawing objects and prompts:

Command: e
ERASE 3 found
Command :

Object groups

The final object selection topic to mention is object groups. You know that
selection sets can be recalled for subsequent edits, but only until you select
a new object or bunch of objects — then the new bunch will overwrite the
Previous set.

The object groups feature lets you save a selection set with a name so that
you can recall it at any time. You can have as many object groups as you
wish, and individual objects can belong to more than one group at a time.
When object grouping is turned on, selecting one member of a group selects
the entire group; when grouping is off, selecting a group member only selects
the one you picked. You can turn object grouping off and on at the Selection
tab of the Options dialog box (see the previous section, “Setting Selection
Options” for details). An easier way exists, however; holding down the Ctrl
and Shift keys and pressing A toggles object grouping off and on.

The following steps explain how to create an object group:

1. Type GROUP and press Enter.
The GROUP command is available only at the command line. The Object
Grouping dialog box appears.

2. In the Group Identification area, enter a name in the Group Name edit

box, and optionally enter a description in the Description box.

All groups must have a name so that you can select them. The descrip-
tion is optional.
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3. In the Create Group area, check Selectable, and then click New.
AutoCAD prompts:
Select objects for grouping:

Select objects: Specify opposite corner: 2 found
Select objects:

4. When you're finished selecting objects, press Enter.

AutoCAD redisplays the Object Grouping dialog box (see Figure 2-3).

Object Grouping (%]
Group Name Selectable
’WESKE Yes
Group Identfication
Group Name: [TWOBCXES |
Descrigtion: #hc middle two boxes |
[Find Mame < ] [ Highlight < ] [ Include Unnamed

Create Group

Hew < [#] Selactable [] Unnamed

Change Group

Figure 2-3: Fsmave < ][ Add < ][ Rename |[ Re-Order... ]
A ”9W|V'_ Descpion ) [ Bewde ] [ Sekclee |
made object

[ok ] [ Cencal [ el ]
group.

5. Click OK to finish creating the group and close the dialog box.

AutoCAD LT does support groups, but it uses a different, and more limited,
procedure from regular AutoCAD. Instead of the Object Grouping dialog box,

AutoCAD LT does its group work with a Group Manager. For more on working
with groups in AutoCAD LT, see Book IV.

AutoCAD’s Editing Commands

Table 2-2 lists AutoCAD’s most common editing commands and tells you
where to find them and what they do. As with the drawing commands in the
preceding chapter, we don’t cover the commands in this order (which, in
case you're wondering, is alphabetical by command name). You’ll find most
of these commands on the Modify toolbar and menu, as well as a few on the
Standard toolbar and Edit menu. There’s also a Modify II toolbar, which con-
tains some of the more specialized editing commands.
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To display closed toolbars, right-click on any tool button and choose a toolbar
from the shortcut menu. If the toolbar shows a check beside its name, it’s
already open.

We cover an additional set of commands for editing text and dimensions in
Book IIl. We also discuss 3D editing commands in Book V.

Table 2-2

AutoCAD’s Editing Commands

Icon

Toolbar
(Modify U/N)

Menu

Command

(Modify UIN)  Name

Alias

Function

Array

Array

ARRAY

AR

Duplicate objects
in circular or rec-
tangular pattern.

Break at Point
Break

Break

BREAK

BR

Break selected
objects into
separate objects
at selected
points.

Chamfer

Chamfer

CHAMFER

CHA

Apply beveled
corner to inter-
secting objects.

Copy

Copy

COPY

co

Duplicate
selected objects.

Standard, Copy

Edit>Copy

COPYCLIP

Copy objects to
Windows
Clipboard.

& | I @3] | L5 [Ba

Standard, Cut

Edit>Cut

CUTCLIP

Move objects
from drawing
to Windows
Clipboard.

R

Erase

Erase

ERASE

Remove selected
objects.

Explode

Explode

EXPLODE

Break complex
objects into sep-
arate pieces.

Extend

Extend

EXTEND

EX

Lengthen object
by extending to
other selected
object.

(continued)

Book Il
Chapter 2

syaalqQ Buikyipoy



152  AutocAD’s Editing Commands

Table 2-2 (continued)

Ieon Toolbar Menu Command  Alias Function
(Modify U/N) (Modify UIN)  Name
Fillet Fillet FILLET F Apply rounded
[ corner to inter-
secting objects.
- - - GROUP G Create object
groupings.
Join Join JOIN J Connect selected
>4+ discontinuous
objects.
- - Lengthen LENGTHEN  LEN Change length of
open objects.
Standard, Match ~ Match MATCHPROP MA Apply properties
/ Properties Properties of one object to
other objects.
Mirror Mirror MIRROR MI Create mirrored
A|B original or copy.
Move Move MOVE M Relocate
"I" selected objects.
Offset Offset OFFSET 0 Create duplicate
& object specified
distance.
- - 00PS - Unerase the last
erased objects.
> Standard, Paste Editc>Paste PASTECLIP  -- Paste objects
@ from Windows
Clipboard.
Modify I, Object> PEDIT PE Modify geometric
Z ) Edit Polyline Polyline properties of
selected polyline.
% Standard, Properties PROPERTIES PR List and change
A Properties object properties.
Standard, Redo Editc>Redo REDO -- Reverse the
" last Undo.
Rotate Rotate ROTATE RO Rotate selected
i ) object around
base point.
Scale Scale SCALE SC Resize objects

from base point
by a factor.
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leon Toolbar Menu Command  Alias Function
(Modify U/N) (Modify WIN)  Name

Modify I, Object=>Spline  SPLINEDIT ~ SPE ~ Modify geometric
W Edit Spline properties of
selected spline.

A Stretch Stretch STRETCH S Resize objects by
[’X dragging them.

Trim Trim TRIM TR Shorten object by
-/“' cutting with other
selected object.

r Standard, Undo Edit=>Undo U Reverse the last
single action.

: UNDO Reverse a selec-
= :

table series of
actions.

XPLODE XP Break complex
objects into
separate pieces
specifying
properties after
exploding.

Removing stuff

Everybody makes mistakes, and now it’s time to clear away the evidence. We
present the simplest-to-use of all of AutoCAD’s editing commands: ERASE.
We hope it’s not your most frequently used command, but it doesn’t really
matter whether it is or not — you’re not going to rub a hole in your screen
by erasing AutoCAD objects.

Here are some ways to erase stuff from your drawing:

4+ Choose Modify=>Erase, select the undesirables, and then press Enter.
4+ Choose Edit=>Delete, select the undesirables, and then press Enter.

4+ Click the Erase tool in the Modify toolbar, select your objects, and then
press Enter.

4 Select the unwanted objects, choose Modify=>Erase, or Edit=>Delete, or
click Erase in the Modify toolbar.

+

Select the mistakes and then press Delete.

4+ Select the unwanted objects, right-click, and select Erase.
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Relocating and replicating

Most commands require more direction than simply selecting objects and
clicking a tool button. The first set of commands we look at enables you to
relocate and duplicate already existing drawing objects.

MOVE

Moving objects requires three sets of input: the objects you want to move, a
point to move them from, and another point to move them to.

Using noun-verb editing for simple commands like MOVE and COPY saves
keystrokes. You don’t want to overwork those pinkies, do you?

The following steps explain how to move objects using noun-verb editing:

1. Select a single object, or use one of the multiple selection methods

described in the section “Selecting Multiple Objects” to select several
objects.

AutoCAD highlights the objects and displays their grips. Don’t worry
about the grips (all those blue boxes and wedges) — we discuss them
near the end of the chapter.

. Click the Move button on the Modify toolbar, or choose Modify~>

Move, or type M to start the MOVE command.
AutoCAD prompts:
Command: _move 4 found

Specify base point or [Displacement] <Displacement>:

AutoCAD shows you the number of objects that are going to be moved,
and then tells you what to do next — it wants you to specify a base point
(“take these things from here”).

. Pick a point on screen as the base point.

Sometimes you should pick a precise point for the base point, but if
you’re only moving or copying something a relative distance, it really
doesn’t matter where you pick. AutoCAD prompts:

Specify second point or
<use first point as displacement>:

. Pick a second point or enter coordinates for the destination of the

selected objects.

Remember, “second point” means “put it here.” AutoCAD moves the
objects and returns to the command line.
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Even the simplest commands can throw you for a loop. You may get unex-
pected results if you press Enter in response to the Specify Second Point
prompt. Pressing Enter tells AutoCAD to look at the coordinates of the
first point and use those values as the displacement for the second point.
We can pretty well guarantee this is not what you want.

cory

When you use verb-noun editing, editing in AutoCAD is much more obvi-
ously a two-step process: you select the objects, press Enter, and carry on
with the command. This is a good time to show you the difference, since
the MOVE and COPY commands are pretty much the same.

Choosing Modify=>Copy runs the COPY command, which you use for dupli-
cating existing objects within a drawing. Choosing Edit=>Copy runs the
Windows Copy-to-the-Clipboard command, which AutoCAD calls COPYCLIP.
Use COPYCLIP to copy objects from one drawing to another. Don’t confuse
the two.

Use the following steps to copy some objects using the COPY command and
verb-noun editing.

1. Click the Copy button on the Modify toolbar, or choose Modify->Copy,
or type CO to start the Copy command.
AutoCAD prompts:
COPY
Select objects:
2. Select the objects to be copied using any object selection method.
If you choose a window or crossing, AutoCAD prompts:
Specify opposite corner: 4 found
Select objects:
3. Press Enter when you’re finished selecting objects to copy.

The first prompts for COPY are exactly the same as for MOVE. What'’s
different this time around is that we’re copying using verb-noun selec-
tion, and we moved using noun-verb mode. After you press Enter to
finish selecting, AutoCAD prompts:

Specify base point or [Displacement] <Displacement>:

4. Pick a point on-screen as the base point.

Again, use an object snap or other precision aid if you need to. If you're
simply copying objects relative to their current location, it doesn’t
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AN

matter where you pick. Once you’'ve picked the first point, AutoCAD
prompts:

Specify second point or
<use first point as displacement>:

5. Pick a second point or enter coordinates for the destination of the
selected objects.

You can enter relative coordinates, or use Direct Distance Entry (see
Chapter 6) or any precision method (where appropriate), or eyeball a
point. For example, typing @2.85<0 makes a copy of the selected objects
2.85 units to the right of the originals.

AutoCAD prompts:

Specify second point or
<use first point as displacement>: @2.85<0
Specify second point or [Exit/Undo] <Exit>:

6. Continue making additional copies or exit the command.

By default, AutoCAD will continue offering to make copies until you tell
it to stop. You can press Enter, the space bar, or the Esc key, or you can
type E to exit the command.

MIRROR

MIRROR can create a single mirrored version of selected objects, or it can
create a mirrored copy. Instead of picking a base and second point as you do
with MOVE and COPY, with MIRROR you pick two points that are the end of
an imaginary mirror. The selected object is “reflected” on the other side of
the mirror line. The final MIRROR prompt asks if you want to retain or delete
the original.

The following steps demonstrate the MIRROR command in verb-noun mode.

1. Click the Mirror button on the Modify toolbar, or choose Modify=>
Mirror, or type MI to start the MIRROR command.

AutoCAD does its usual “Select objects” thing. By now you know the
ropes — select some objects and press Enter. AutoCAD prompts:

Select objects: Specify opposite corner: 4 found
Select objects: Specify first point of mirror line:

If it doesn’t matter where your objects get mirrored to, just pick a
random point on-screen. Do the same for the second point. More often
than not, though, it does matter. If that’s the case, make use of some

of the precision drafting aids we discussed in Book I. In this example,



Figure 2-4:
Mirroring
objects
precisely.
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the selected objects need to be mirrored precisely about the middle of a
rectangle.

2. Hold down the Shift key and right-click to display the object snap
shortcut menu. Choose Midpoint and pick a horizontal edge of the
rectangle when you see the triangular object snap marker.

AutoCAD prompts:
Specify second point of mirror line:

3. Hold the Shift key and click a second point directly above or below
the first point.

You need to be precise for your second point, too. Holding Shift invokes
a temporary Ortho mode, when you move the crosshairs they will lock
onto horizontal or vertical direction and remain that way until you
release the Shift key (see Figure 2-4). AutoCAD prompts:

Erase source objects? [Yes/No] <N>:

4. Type Y or N to erase or retain the source objects.

N

OFFSET

OFFSET, like COPY, makes duplicates of selected objects, but it’s more
rigorous in where it lets you put those duplicates. It also doesn’t make exact
copies; different object types offset in different ways. Figure 2-5 shows the
results of offsetting different entity types. You can OFFSET lines, arcs, circles,
splines, ellipses, and polylines.
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Figure 2-5:
Offsetting
different
object
types.
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The following steps explain how to use OFFSET in verb-noun editing mode.

1. Click Offset on the Modify toolbar, or choose Modify=>Offset, or

type O to start the OFFSET command.
AutoCAD prompts

Current settings: Erase source=No Layer=Source
OFFSETGAPTYPE=0

Specify offset distance or [Through/Erase/Layer]
<Through>:

2. Optionally, type E to erase the source object, or type L to change

the new object’s layer from the same layer as the source object to the
current layer.

When offsetting objects, you can either specify an offset distance, or
pick a Through point on-screen. Logically enough, choosing Through
point offsets the object through the point you pick. The first time you
run OFFSET in a drawing, the default value is <Through>.

3. Press Enter to use the Through point option.

AutoCAD prompts:
Select object to offset or [Exit/Undo] <Exit>:

If you simply pick a point, without pressing Enter to confirm the
<Through> option, AutoCAD assumes you really want to enter an offset
distance, will prompt you for a second point, and use the distance
between the two points as the offset distance value.
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4. Select a single object to offset.

You can specify only one object at a time; that is, you can’t select a
group of wall lines and offset them all in the same step. If you specified
Through, AutoCAD prompts:

Specify through point or [Exit/Multiple/Undo] <Exit>:

For precise locations, use object snaps when picking through points.
AutoCAD creates a new version of the selected object through the point
you picked, and continues prompting for additional offsets and through
points.

5. When you finish offsetting, press Enter to return to the command line.

If you enter a distance, you need to make an additional pick to show
AutoCAD on which side of the source object you want the new object. The
following steps show the process:

1. Start the OFFSET command.
The command prompts appear as follows:

Command: OFFSET

Current settings: Erase source=No Layer=Source
OFFSETGAPTYPE=0

Specify offset distance or [Through/Erase/Layer]
<Through>:

2. Type an offset distance value and press Enter.
AutoCAD prompts:
Select object to offset or [Exit/Undo] <Exit>:
3. Select the single object you want to offset.

Because there are two possible directions that AutoCAD could offset
the selected object, it wants you to show it which direction you want by
prompting:
Specify point on side to offset or [Exit/Multiple/Undo]
<Exit>:

It doesn’t matter precisely where you pick, just so it’s clearly on one side
or the other of the source object.

4. When you finish offsetting, press Enter to return to the command line.

Figure 2-6 shows the effect of offsetting a set of joined linework. The closed
shape on the left is a single polyline, and the shape on the right is drawn as
separate lines with the LINE command. For this kind of result, it’s obviously
best to use a polyline rather than separate lines — you’ll end up with no
intersection cleanup.
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Figure 2-6:
Offsetting
polylines
and lines.

ARRAY

COPY makes multiple copies of objects by default. If it doesn’t matter where
the copies go, the COPY command is fine. However, if you need your ducks
in rows (and columns, or even in a circle), the ARRAY command is for you.

ARRAY creates regular patterns of selected objects in either Rectangular
(rows and columns) or Polar (circular) arrangements. The following steps
explain how to create a rectangular array:

OO !- Choose Modify=>Array, click Array on the Modify toolbar, or type AR
m]m| to start the ARRAY command.

The Array dialog box appears. Figure 2-7 shows the dialog configured for
rectangular arrays.

2]
©) Boler Aray (3R] selectobrets
0 objects selected
Rows: 4 Caglumng: 4
Offset distance and direction
Row offzet: 1.0000 = fooo
@
Column offset: 1.0000
Angle of am=y: o
Figure 2-7:
. (1) Bydsfauk, i the row offset is negative,
S etti ng a §  rows are added downward. ¥the
column offset is negative, columns are
rectangular o added to the ek [_Concal
arrayina
dialog box. Hep
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Figure 2-8:
Settingup a
polar array.
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2. Make sure that the Rectangular Array radio button is selected, and
then click the Select Objects button.

The dialog box closes, allowing you to select objects to array.

3. Select one or more objects to array, and then press Enter to finish
selecting.

The dialog box reappears.

4. Specify the number of rows and/or columns, the row and column off-
sets, and (optionally) a rotation angle for the array.

If you want a single row or a single column, specify 1 in the appropriate
box. Also, even though you’re making copies of a source object, the
number of rows and columns must include the number of copies you
want plus the source object.

You can also use the buttons beside the Row offset, Column offset, and
Angle of array boxes to specify distances and angles. Clicking any of the
buttons temporarily closes the dialog box and lets you pick points in the
drawing.

5. Click Preview to make sure your ducks are in a row.

The main Array dialog box disappears again, and AutoCAD previews the
results of your settings together with a small dialog box with buttons to
Accept, Modify, or Cancel.

6. Click Accept to finish the command, or Modify to return to the dialog
box, or Cancel to forget the whole business.

Choosing a polar array changes the look of the Array dialog box (see Figure
2-8). To create a polar array, you specify objects to array, and then a center
point, the number of items and angle to fill, and whether the selected objects
should be rotated as they’re arrayed.

T Array o)
© Rectangular Aray @® Polar Aray [I| Select objects
0 objects selected
Cenerpont: X 220000 | v: |12.0000

Method and values

Method:

Total rumber of tems & Angle to fil w [
Total number of fems: 4 =] *
Angle 1o fill 360 @| 0
Angle between items: N

1) Forangletofil. a postive value specifies
9 counterclockwise rotation. Anegative valus

T speciies dockwize rotation "
L Cancel
Rotate tems 2< copled More ¥ Hep .
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Rotating and resizing

The next set of commands modifies objects by changing their size or orienta-
tion in the drawing.

ROTATE

ROTATE spins objects around a base point, either rotating the original or
making a copy and leaving the original in place. You specify the amount of
rotation by entering an angle or using reference geometry. A typical ROTATE
command sequence looks like this:

Command: ROTATE

Current positive angle in UCS: ANGDIR=counterclockwise
ANGBASE=0

Select objects: 3 found

Select objects:

Specify base point: 0,0

Specify rotation angle or [Copy/Reference] <0>: 32

After pressing Enter at the last prompt, the selected objects are rotated.

SCALE

SCALE proportionately resizes selected objects about a base point. You spec-
ify a numeric scale factor, or use reference geometry to specify the new size.
The procedure is very similar to that for ROTATE: Select your objects, spec-
ify a base point, and then specify a scale factor.

Use the SCALE command if you need to convert a drawing done in millime-
ters so that you can work on it in inches, or vice versa. If you scale a drawing
based in inches by a factor of 25.4, the distance values (including the dimen-
sions) will be equivalent to true distances in millimeters. If you have to go
the other way, scale the drawing by a factor of 0.03937.

STRETCH

STRETCH stretches but also compresses. Perhaps it should be called
STRETCHANDSHRINK? STRETCH is one of the trickier commands to get a
handle on because there’s only one way you can select objects for stretch-
ing. It’s also one of those commands that works only in verb-noun mode.

LENGTHEN

LENGTHEN changes the length of lines, splines, arcs, and open polylines.
Start the command by choosing Modify=>Lengthen or typing LEN. Lengthen
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(which can shorten, too) changes object length by the option you specify at
the command line.

Breaking, mending, and blowing up real good

AutoCAD has let you break objects for years and years. And what’s really
great is that you never have to pay for the stuff you break. Recent versions
have also let you fix things (well, a few things, under very particular condi-
tions). But sometimes, there’s just no alternative to blowing things up.

BREAK

BREAK is a tricky command to master because you really, really have to
keep a watch on the command line. The normal function of BREAK is to
remove a chunk of object — say a piece of a line to make two lines with a
gap between, or a piece of a circle to turn it into an arc. The following steps
describe how to use BREAK to create a gap in an object:

1. Select Break (not Break at point) from the Modify toolbar, or choose
Modify=>Break, or type BR to start the BREAK command.

You can use this command only in verb-noun mode. AutoCAD prompts
you to select an object; once you’'ve done so, the prompt reads:

Specify second break point or [First point]: F

BREAK'’s default behavior is to take the point where you selected the
object as the first point of the break. The second point would be the
other end of the break; after the second pick, AutoCAD would go ahead
and break the object and then return to the command line. This is usu-
ally not a very precise way of working, so most of the time you should
use the First point option.

2. Type F to specify the First point option.
AutoCAD prompts:
Specify first break point:

Use your favorite precision technique to pick the exact point where the
break should start. AutoCAD then prompts:

Specify second break point:

Pick again to specify the second break point. AutoCAD removes the por-
tion of the object between the first and second points.

Use the Break at Point button on the Modify toolbar to break an object into
separate pieces without creating a gap between them — the objects would
meet endpoint-to-endpoint. Break at Point is a command macro; you can
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achieve the same result by starting the BREAK command in other ways, but
this way is the easiest.

JOIN

JOIN enables you to combine separate objects into single ones, as long as
some fairly stringent criteria are met. For starters, all objects must lie on the
same plane. Separated lines to be joined must be collinear. Arcs must be con-
centric. JOIN is another command that can be used only in verb-noun mode.

EXPLODE

That stick of dynamite down at the bottom of the Modify toolbar runs the
EXPLODE command. EXPLODE breaks up complex objects into their primi-
tive elements. You can explode polylines, as well as dimensions and blocks.
(We discuss dimensions in Book Il and blocks in Book V1) If you use EXPLODE
on a polyline, the separate entities (that is, lines and arcs) end up on the
same layer as the original polyline.

A related command called XPLODE explodes complex entities and gives you
a range of options you can set for the exploded objects.

Double-barrel commands

Love and Marriage. Horse and Carriage. Trim and Extend . . . Even though
they don’t rhyme, TRIM and EXTEND do work in similar fashion, so we’re

going to discuss them together here. And while we're at it, we’ll talk about
CHAMFER and FILLET, as well.

TRIM and EXTEND

TRIM and EXTEND use existing geometry to modify other geometry. The TRIM
command lets you cut objects by selecting other objects that cross them. The
EXTEND command lets you lengthen objects by selecting other objects that

you want them to reach.

The following steps and Figure 2-9 describe how to use TRIM to shorten and
extend objects:



Figure 2-9:
The long
and short
of TRIM.
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1. Select the Trim button from the Modify toolbar, or choose Modify=>

Trim, or type TR to start the TRIM command.

In this two-part command, you first select the objects you want to trim
with — your temporary pair of scissors. AutoCAD prompts:

Current settings: Projection=UCS, Edge=None
Select cutting edges
Select objects or <select all>:

The first prompt line displays the current command settings. To change
the Projection or Edge settings, use the command options that display
after you've finished selecting your cutting edges. The second line tells
you that the objects you're going to select will be used as the cutting
edges.

. At the Sselect objects: prompt, use any object selection method to

select linework or other drawing objects as the cutting edges, or press
Enter to select everything visible as a cutting edge.
After you finish selecting, AutoCAD prompts:

Select object to trim or shift-select to extend or
[Fence/Crossing/Project/Edge/eRase/Undo] :

On the object that you want to trim, pick a point on the part you want
to get rid of, or choose one of the command options.

TRIM and EXTEND are such close relatives that you can actually run
EXTEND from within Trim, and vice versa. To do so, simply hold down
the Shift key and select objects.
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FILLET and CHAMFER

FILLET and CHAMFER offer methods of finishing off intersecting objects.
CHAMFER creates a straight beveled edge between two non-parallel objects.
FILLET creates a curved transition (actually an arc object) between two non-
parallel objects. FILLET can also create a semicircular connection between
parallel lines. Figure 2-10 shows a typical intersection after filleting and
chamfering.

\\3
Setting the Fillet radius to 0 before you fillet lines or arcs creates a clean
intersection, as shown at the right of Figure 2-10.

Figure 2-10: | ‘ ‘ |

Cornering

your inter- ORIGINAL CHAMFERED FILLETED FILLETED,

sections. LINEANCRK LINENCRK LINENORK RADIUS = O
Specialized commands
Most of the commands we’ve discussed so far can work on any type of
object; for example, you can trim or extend lines, arcs, or polylines. Some
object types are sufficiently complex that they require unique edit tools.
You'll find those tools on the Modify=>Object submenu and the Modify II
toolbar (see Figure 2-11). (To display the Modify II toolbar, right-click over
any tool button and choose Modify II.)

Edit Hatch
Edit Spline
Modify T I x|
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The four tool buttons on the right side of the Modify II toolbar are for work-
ing with block attributes (we discuss those in Book VI). The four buttons at
the left are for modifying graphic objects as follows:

4+ Draworder. Invokes the DRAWORDER command; move objects in front
of or behind other objects.

4+ Edit Hatch. Invokes HATCHEDIT command; modify pattern, scale, and
other properties of existing hatch objects.

4+ Edit Polyline. Invokes PEDIT command; modify width, linetype genera-
tion, curve type, and other properties of existing polyline objects.

4+ Edit Spline. Invokes SPLINEDIT command; modify curve type, vertexes,
and other properties of existing spline objects.

For additional information on these commands, refer to the online Help.

Changing properties

All of the edit commands we’ve looked at so far have involved modifying or
duplicating object geometry in some form or other. But sometimes you may
just want to change an object’s layer, or find out how long something is.

MATCH PROPERTIES

MATCHPROP is AutoCAD’s magic wand. To use it to copy the properties
(linetype, color, layer, text or dimension style, and so on) of one object to
one or more other objects, simply click the source object, and then the
objects you want to change.

PROPERTIES

PROPERTIES displays a window (or, palette) of its own (see Figure 2-12) in
which you see listed every property (editable or not) of the selected object.

The Properties palette is a dockable window. Unlike dialog boxes, dockable
windows can stay open while you're working in the drawing. And by double-
clicking their title bars, you can dock them — that is, anchor them — at the
left or right edges of the display.
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Changing your mind

We introduce you to UNDO in Book I and point out a little-known, but useful,
AutoCAD command called OOPS. Remember: OOPS restores the last things
you erased. UNDO undoes the last operation. Refer to Book I if you need a
refresher on the difference.

Coming to Grips with Grips

QgN\BEH When you select objects, not only do they highlight, they also sprout little
& blue boxes, called grips. You can perform a number of editing operations by
clicking these grips and then following the command line (or the dynamic
input tooltip if you're using it — and if you've forgotten what dynamic input
is, have a look at Book I, Chapter 2).

By default, grips appear as solid blue squares at specific points on selected
objects. Grip locations often correspond with object snap points, but they’re
not the same. To make a grip active, move the crosshairs over the grip and
click. You'll know it’s selected when its color changes from blue to red (see
Figure 2-13).



Figure 2-13:
A gripping
way of
editing.
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Red grip Blue grip

Selecting a grip activates grip-editing mode. The grip turns red to show it is
active. As soon as a grip becomes active, the command prompt is replaced
by a series of five grip-edit commands. When a grip is active, you can choose
the grip-edit commands and options in any of these ways:

4+ Press Enter or the space bar to cycle through the five commands. If you
go past the one you want, keep hitting Enter until it reappears. To select
an option, type its capitalized letter.

4+ Right-click and choose the command or option from the shortcut menu.

4+ If dynamic input is enabled, you can use the down arrow on your key-
board to choose an option, although you must choose the grip-edit com-
mand by right-clicking or pressing Enter or the space bar.

If you're using the keyboard, activating a grip replaces the command line
with the grip-edit commands. They look like this:

** STRETCH ** <Stretch to point>/Base point/Copy/Undo/eXit:

** MOVE ** <Move to point>/Base point/Copy/Undo/eXit:

** ROTATE ** <Rotation angle>/Base
point/Copy/Undo/Reference/eXit:

Book Il
Chapter 2

syaalqQ Buikyipoy



170 Coming to Grips with Grips

** SCALE ** <Scale factor>/Base
point/Copy/Undo/Reference/eXit:

** MIRROR ** <Second point>/Base point/Copy/Undo/eXit:

**% STRETCH ** ... and round and round you go.

Each grip edit command has options to change the base point or make
multiple copies. The **ROTATE** and **SCALE** options also let you use
reference options.

Grips also have an automatic object snap; as soon as you move your cursor
close to a grip, it jumps to the precise control point.



Chapter 3: Managing Uiews

In This Chapter

v Zooming in and out of your drawings
v Panning around your drawings

+* Going back to where you were with named views

men you draw things in AutoCAD, you draw them full size. If you're
drawing the cross section of a 2 x 4 (or a 38 x 89 for our metrically
inclined friends), you can look at it full size, so that the screen width is the
same as the width of the actual piece of lumber. If your monitor is big enough,
you could even view a 2 x 12 (38 x 286) on your screen at its real size. Sooner
rather than later, though, it becomes uneconomical to keep getting a bigger
monitor as you need to draw bigger things.

Luckily, the ZOOM command lets you increase or decrease the magnification
of your drawing objects through a number of options, which we discuss in
this chapter. In addition to zooming in and out of drawings, another couple of
display commands will come in handy in your drawings: PAN and VIEW. PAN
lets you move around in the drawing without changing the magnification.
The VIEW command displays a dialog box in which you can save and restore
named views.

Table 3-1 lists AutoCAD’s 2D display commands in alphabetical order, together
with locations for finding them and general descriptions of what they do.
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Table 3-1

AutoCAD’s 2D Display Commands

leon Toolbar

View Menu

Command
Name,
Option

Alias

Function

Aerial View

DSVIEWER

Displays the Aerial
Viewer window. (See
later in this chapter
for details.)

Standard,
Pan

%

Pan

PAN

Moves around the
drawing dynamically
without changing
magnification.

Pan=>Point

-PAN

Moves around the
drawing by clicking
two points.

Redraw

REDRAW

Refreshes the screen
display.

REDRAWALL

RA

Refreshes the
screen display in all
viewports.

Regen

REGEN

RE

Recalculates the
drawing database,
and then redraws
the graphics.

Regen All

REGENALL

REA

Recalculates the
drawing database,
and then redraws
graphics in all
viewports.

REGENAUTO

Enables or disables
automatic regenera-
tions.

View,
@ Named

Views

Named Views

VIEW

Displays the View
Manager dialog box to
add or modify named
views or set them
current.

VIEWRES

Controls visual
smoothness of
curved objects.

+| Standard,
O\ Zoom

Realtime

Zoom, Realtime

Z00M,
Realtime

Starts Realtime option
of ZOOM command.




Figure 3-1:
A menu
to view.
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A Zoom of One’s Own

leon Toolbar View Menu Command Alias Function
Name,
Option
Standard  Zoom Z00M z Displays full Zoom
Q (Zoom flyout toolbar.
= flyout)
Standard, Zoom, Previous Zoom, z Replaces current
@ Zoom Previous drawing view with
Previous previous view.

As you see from the table, there aren’t individual aliases for each option of
the ZOOM command. Without custom programming (unavailable in
AutoCAD LT), the quickest keyboarding options are to type Z, press Enter,
and then type the key letter for the option and press Enter again.

As you can see in Figure 3-1, there are many more commands on the View
menu. These others are 3D viewing commands, and we discuss them in Book V.

View Insert Format Tools Dra
. Redraw
Regen
Regen All
Zoom + L Realtime
Pan 4 R bﬂ
3D Orbit , x Previous
- @, Window
# 3D Walk @4, Dynamic
& 3D Walk_ Settings... @, scale
Aerial View & Center
Clean Screen CTRL+0 @& Object
Viewports » @& In
&5 Hamed Views... @, Qut
) 30 Views 4 @\ All
[ Create Camera @_ Extents
P Hide
Shade r
Render »
@ Motion Path Animations...
Display r
Toolbars...

A Zoom of One’s Own

Zooming in closer and zooming out farther away should be simple enough,
right? But this is AutoCAD, where little is as simple as it seems. There’s a
host of options for the ZOOM command (some simpler than others), and
Table 3-2 sets them out for you.
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Table 3-2 Z00M Command Options
Icon Option Description
Window Pick two corners to define a rectangular view window.

AutoCAD zooms in to the defined rectangular area.

Dynamic Combine both pans and zooms (like Realtime Pan &
Zoom). Somewhat difficult to master, and probably made
obsolete by the Realtime options.

Scale Specify zoom factor relative to current display, to entire
drawing, or to paper space scale (usually 1:1).

Center Pick a point or enter coordinates for center of view, and
then enter a magnification value.

Object Select an object; display zooms in so object fills screen.

In Zoom in closer on drawing by preset factor (default is
2x). Same as using ZOOM Scale and entering 2x as the
scale factor.

Out Zoom farther out of drawing by preset factor (default is
.bx). Same as using ZOOM Scale and entering 0.5x as
the scale factor.

All Zooms out to predefined drawing limits. If drawing
objects fall outside the limits, zooms to show those
objects (that is, same as ZOOM Extents).

Extents Zooms out to display all drawing objects on non-frozen
layers in current drawing space.

| N Pt Pt W N Pt

ZOOM Previous, another command option, has its own button on the Standard
toolbar. Most ZOOM options are available from the Zoom flyout tool button on
the Standard toolbar (see Figure 3-2). There’s also a separate Zoom toolbar,
but unless you've got acres and acres of screen real estate, it’s probably more
space-efficient to use the flyout.

In case you haven’t encountered them before, flyout tool buttons are distin-
guished by tiny — and we do mean tiny — black arrows in their lower-right
corner. Clicking any tool button that has one of those arrows displays a
subset of tool buttons that run command options. Figure 3-2 shows the effect
of holding down the Standard toolbar’s Zoom button. To choose a command,
run your mouse pointer down the tool buttons to the one you want, and
then release the button.



Figure 3-2:
Hidden
treasures —
the Zoom
flyout
buttons.
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Zoom Extents

You can zoom in and out of your drawings by using one of three methods:

4+ Wheel mouse. The simplest method of all: Just scroll the mouse wheel

forward or back to zoom in or out of your drawing. By default, scrolling
the wheel away from you zooms in, and scrolling the wheel toward you
zooms out.

Realtime zoom (and pan). Start the command from a right-click menu or
the Zoom Realtime or Pan Realtime button on the Standard toolbar. Press
and drag to change the view visually on-screen.

Regular ZOOM command options. Choose a specific command option
from the View=>Zoom submenu or the Zoom toolbar or flyout. The regu-
lar options do not zoom in real time — you have to complete the com-
mand before the view changes.

Wheeling through your drawing

Although there are lots of powerful options of the ZOOM command, both
regular and realtime, sometimes simple is good. We honestly can’t imagine
anyone using AutoCAD without a wheel mouse. If you don’t have one, drop
what you’re doing and go get one now!

Here are some of the reasons we like wheel mice:

4+ You can adjust the rate at which you zoom in and out as you scroll your

mouse wheel with the ZOOMFACTOR system variable. The default value
is 60, which means each detent you scroll through zooms you 60% closer
in or farther out.

4+ Starting with AutoCAD 2007, you can reverse your wheel mouse’s default

scroll direction in the Options dialog box. On the 3D Modeling tab, check
the box beside Reverse mouse wheel zoom. This works for 2D drafting as
well as 3D modeling.
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Figure 3-3:
Zooming in
real time.

4+ Press down on the wheel and move the mouse to pan around the drawing.

4+ Double-click the scroll wheel to zoom out far enough to show everything
in the drawing. (This is called a ZOOM Extents in AutoCAD and is cov-
ered later in this chapter.)

Before you start scrolling to zoom in, move the crosshairs to the part of the
drawing you’re most interested in seeing. As you scroll, that location will be
the center of the zoomed-in view.

Realtime zooming

Realtime zooming and panning are two halves of the same command. (We
cover PAN Realtime in the following section.)

The following steps explain how to move around a drawing using this
command:

1. Open a drawing that contains some objects that you might want to
have a closer look at.

If you're really new at this and don’t have any suitable drawings yet, you
could open one of the sample drawings from the C: \Program Files\
AutoCAD 2007\Sample folder.

2. Click Zoom Realtime on the Standard toolbar (it’s the button with the
magnifying glass and the plus/minus sign).

The crosshairs change to a magnifying glass cursor with plus/minus
signs as shown in the middle of Figure 3-3.
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Figure 3-4:
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A Zoom of One’s Own

Hold down the left mouse button and drag the magnifying glass cursor
toward the top of the screen.

As you drag up-screen, you zoom closer into your drawing.

. Press and drag again, this time moving the cursor toward the bottom

of the screen.
Your view of the drawing zooms back out.
The command line reads:

Press ESC or ENTER to exit, or right-click to display

shortcut menu.

. Take the third choice: Right-click to display the shortcut (cursor)

menu (see Figure 3-4).

Exit

Pan
v Zoom
3D Orbit

Zoom Window
Zoom Original

Zoom Extents [

6.

Choose one of the menu options or select Exit to end Realtime zoom-
ing and return to the command line.

The shortcut menu (shown in Figure 3-4) presents the following options:

<+

Exit. Exit from the Realtime Pan & Zoom commands and return to the
command prompt.

Pan. Press the left mouse button and drag to move around the drawing
without zooming in or out.

Zoom. Press and drag to zoom into or out of the drawing.

3D Orbit. As its name suggests, this one is for viewing a 3D model from
different viewpoints. We talk about it more in Book V.

Zoom Window. When you select Zoom Window from the Realtime short-
cut menu shown in Figure 3-4, the cursor icon changes to an arrow and a
box (see Figure 3-5). Press and drag to create a rectangular window; the
display will zoom in to the area defined by the rectangle.
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Figure 3-5:
Zoomme a , Y .
real-time i g-4
window. s
P
4 Zoom Original. If you change your mind about that Realtime Zoom
Extents you just performed, Zoom Original will undo it for you, restoring
the previous view.
4+ Zoom Extents. Zooms far enough out so you can see all of the objects in
the drawing.
P PAN and ZOOM can be run as transparent commands. A transparent com-

mand can execute in the middle of another command; for example, you
might start drawing with the LINE command and realize the next point is off
the screen. Without leaving the LINE command, you can click PAN or some of
the ZOOM tool buttons and change your view. When you close the PAN or
ZOOM command, the LINE command resumes where you left off. You can
run PAN and ZOOM transparently from the command line by typing an apos-
trophe (’) before the command name.

Pan in a Flash

The PAN command lets you change the view of your drawing without chang-
ing the magnification. PAN and ZOOM go hand in hand, but since PAN is the
simpler, we talk about it first. There are four ways to pan around in your
drawing — that is, to look at different parts of your drawing at the same
magnification or elevation:

4+ Realtime panning. Pressing and dragging with the PAN Realtime com-
mand active lets you visually set your new viewing location.

4+ Panning by displacement. The old-style PAN command, where you pick
a base point for your view change on-screen, and then pick a second



Figure 3-6:
Give us a
hand with
this pan.

Pan in a Flash
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point in the drawing that you want to see in the picked-point location.

This one’s as hard to use as it is to explain!

4+ Scroll bars. As in every Windows program; drag the slider bar, click

either side of it, or click the arrows at the end of the scroll bars.

Realtime panning

There are a number of options (there are always a number of options, aren’t
there?) for starting real-time panning. The following steps explain them:

1. Open a drawing that contains some objects that you might want to

have a closer look at, and zoom in on them.

Obviously, panning isn’t going to achieve much if you're zoomed all the
way out in a drawing!

2. Click Pan Realtime on the Standard toolbar (it’s the button with the
disembodied hand in the blue sleeve and clean white cuff).

The crosshairs change to the hand cursor, as shown in the middle of

Figure 3-6.
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3. Press the left mouse button and drag the hand icon around the screen.

The display pans in real time (meaning you can see it change as you
move the mouse).

4. Right-click to display the Realtime shortcut menu and choose Exit.

AutoCAD returns to a blank command line. Note that you can also

switch from real-time panning to real-time zooming with this menu.
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Alternative ways to start real-time panning are

4+ Type P and press Enter.

4+ Press and drag with the mouse wheel (or, middle mouse button, if you
have a three-button mouse).

4+ With no command active and nothing selected, right-click anywhere in
the drawing. Choose Pan from the default shortcut menu.

Be sure that no objects are selected and no command is active if you try
this last method — otherwise the Zoom and Pan options will not appear on
the menu.

Name That View

So if panning and zooming are that powerful and flexible, what more do you
need? Why should you learn about named views, anyway?

Imagine you’re on the phone to a subcontractor for your project, and you're
discussing part of a drawing. You both have the same drawing open (you
can tell that from the drawing title!) but you have to refer to a very specific
area that you've spent a long time detailing. The conversation could go
something like this:

“OK, zoom in to the room labeled Seminar Area. No, the one beside the office
corridor. No, the other corridor, the one by the elevators. NO, NOT those ele-
vators, the ones on the other side of the floor. OK, now zoom in on. . ..”

Or, it could go like this:
“OK, restore the view named Seminar Room NE detail.”

You can save a lot of frustration for yourself — as well as for others who
need to use your drawings — if you set up some named views of important
areas.

Creating views

The setup for saving named views has changed in recent versions of AutoCAD
and AutoCAD LT. In AutoCAD 2007, the View dialog box has been promoted to
a corner office and has a new title: View Manager (see Figure 3-7).



Figure 3-7:
The
AutoCAD
2007 View
Manager
dialog box.
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The following steps explain how to save, restore, and modify named views,
beginning with steps that work in all recent versions of AutoCAD:

1. Zoom into and pan around your drawing until you’re looking at the
area you want to save as a named view.

You can define an area without displaying it exactly as you want to see it,
but for now, do the zooming and panning.

2. Choose View>Named views.

In AutoCAD 2006 and earlier, the View dialog box appears. In AutoCAD
2007, the View Manager dialog box appears.

3. Click New.

In all versions, the New View dialog box appears on top of the View or
View Manager dialog box.

4. Type a name for the new view in the View Name list box.
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5.

10.

Set the Current display radio button active.

If you want to define the area of your view within the current view, set
the Define window radio button active. Ignore the other settings for now.

. Click OK to close the New View dialog box.

The View or View Manager dialog box shows the newly created view in
its list box.

. Click OK to close the View or View Manager dialog box.

The location and magnification of the named view are now stored as
part of the drawing file. You can restore the view at any time. Try it with
these next three steps.

. Do a ZOOM Extents to restore the overall view of your drawing.

. Choose View=>Named views.

The View or View Manager dialog box opens.

Select the view you just created from the list box and click Set
Current. Then click OK.

When you close the dialog box, the selected named view is displayed in
the drawing area.

Other view options

In AutoCAD 2005 and later, you can associate layer settings with a named
view. For example, you may want to restore a view of part of a complex
assembly, but only see the objects drawn on certain layers. The following
steps explain how:

1.
2.

Zoom in to the area you want to save as a named view.

Turn on (or thaw) the layers you want to see, and turn off (or freeze)
the ones you don’t.

Set the appropriate layer visibility states before you save the
named view.

. Follow Steps 2 through 5 from the preceding section.

Open the View or View Manager dialog box, and then the New View
dialog box. Give the view a name and make sure the Current display
radio button is selected.

. Check the box beside Store Current Layer Settings with View (AutoCAD

2005 & 2006) or Save Layer Snapshot with View (AutoCAD 2007).

Checking this box means that when you restore this view, the current
layer visibility states will also be restored.
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Storing layer settings (2006 and earlier) or saving a layer snapshot
(2007) are the default settings. Make sure you really want to save the
layer settings before clicking OK, because your previous layer settings
are not restored when you change views.

5. Click OK.

The New View dialog box closes and your newly created view shows in
the View or View Manager list.

6. Click OK again.

View or View Manager closes and you return to the drawing.

You can easily change the boundaries of a view in the View Manager dialog
box (or in the View dialog box in AutoCAD 2005 and 2006). Just select the
view in the list and choose Edit Boundaries. AutoCAD shows you a grayed-
out view of your drawing with the currently defined view highlighted in
white. Then pick two corners to define a new view area.

AutoCAD 2007 replaces the two-tab version of the View dialog box with the
Explorer-style View Manager (see Figure 3-7).

The View Manager lists sheet views as well as regular model views. Sheet
views are named views associated with viewports in drawing layouts as part
of AutoCAD'’s sheet set feature.

The third category of view, after model views and sheet views, is preset
views. These are intended for 3D use and serve no purpose in 2D drafting.
We’ll have more to say about these preset views in Book V.
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Chapter 1: Text: When Pictures
Just Won't Do

In This Chapter

v Types of text in AutoCAD

v+~ Controlling text appearance

1 Creating and using text styles

v~ Using single-line and multiline text
v Editing text

v+ Creating tables

ou know the old saying about a picture being worth a thousand words?
We've done some digging and discovered that with inflation and cost of
living increases, a picture is now worth 3,712 words!

That’s a roundabout way of saying that text is important, too. It’s a lot
simpler — and more precise — to specify a manufacturer and part number
in numbers and letters than it is to try to draw the darned thing from every
angle. And until you can teach your drawings to talk, adding text is a neces-
sary part of drafting in AutoCAD.

In this chapter, we look at creating and editing text in AutoCAD drawings.

Text in AutoCAD

In AutoCAD, very little is as simple as it could be. Take drawing text, for
instance. AutoCAD has not one but two different kinds. You use one if you
want to enter single characters or short lines of text, and the other if you
want to write a novel — or at least some general notes. The first type is
called single-line text, and the second (wait for it . . ) is called multiline text
(Autodesk also refers to the latter as paragraph text.)
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Of course, there are other kinds of text in an AutoCAD drawing as well.
These other kinds include

4+ Leader notes: Leaders are drawing notes that include a line with an
arrow at one end that points to a drawing object. You create leaders
with one of the Dimensioning commands.

4+ Dimension text: Dimension values appear as text and are formatted
according to a text style, but they’re not text objects — they’re an inte-
gral part of dimension objects. (We cover text styles later in this chapter,
and dimensions in the next chapter.)

4+ Attributes: Attributes are pieces of text attached to block insertions.
What makes them different from regular text is that the text is variable
and can be changed for each instance of the block insertion. We cover
blocks and attributes in Book VI.

4+ Tables: Tables are another type of text-like object. Prior to AutoCAD 2005,
you had to construct tables (for example, for bills of material, drawing
lists, and so on) by drawing lines and then carefully filling in the spaces
between them with regular drawing text. Table objects automate the
process; the text part is defined with text styles, just like regular text.

4+ Fields: Fields are placeholders for textual data. You can place fields in
tables or in multiline text objects. Fields contain changeable data such
as filename, date last saved, drafter, and so forth.

We describe each of these different types of text or text-like objects in the
sections that follow.

Getting familiar with text terminology

Before we go on, we need to define some terms:

4+ Text: Text usually refers to an AutoCAD object, either a single line of text
(also called a text string) or a paragraph (called multiline text or mtext
in AutoCAD). TEXT is also an alternate command name for DTEXT, the
command used to enter single-line text.

4+ Style: Style refers to a named definition of the way your text appears
when you place it on your drawing. Included in a style definition are the
font, height, width factor, obliquing angle, and whether it will be drawn
backwards, upside-down, or vertically. STYLE is also the name of the
command used to create text styles. Text justification and rotation are
not defined in a style; they are applied when you start the DTEXT or
MTEXT command.

4+ Justification: Justification refers to the direction that text flows from the
start point, and how subsequent lines of text align below the first line.
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Left-aligned or left-justified text is the default in AutoCAD. We explain
more about the many different justification options later in this chapter.

4+ Font: Font refers to the actual appearance of the letters, numbers, and
symbols. AutoCAD supports two types of font:

¢ AutoCAD vector fonts
e Windows TrueType fonts

We go into more detail on both font types later in the chapter. For now,
understand that you must use a font file to define a style, and you must
have a style before you can create text objects.

If AutoCAD can’t find the font files used to create text, the drawing won’t load
or display properly. A large number of add-on fonts are available for AutoCAD;
however, you should use only the font files that come with AutoCAD or
Windows, in case you ever need to send your drawings to other offices.

Will that be one line or two?

Every version of AutoCAD from the very first right up to (and hopefully,
beyond) AutoCAD 2007 has provided single-line text. The idea is that you
type a line of text and press Enter, and then press Enter again to end the
command. You end up with a single object — the single line of text.

You can create multiple lines of text by simply typing another line after
each press of the Enter key; you end the sequence by pressing Enter on a
blank line.

But picture this scenario. You’ve carefully laid out your drawing sheet, and
you've allowed a four-inch wide space along the right side of the sheet for
your general notes. You add forty or fifty lines of general notes as single-line
text, which means you have forty or fifty individual text objects.

Now your boss comes along and tells you you're going to have to squeeze
those notes into a three-inch wide column so you can add some more details.
Your mission — should you choose to accept it — is to edit each and every
line, removing a word or two from the end of the first line and adding it to the
second, and then removing two or three words from the second and adding
them to the third . . . and on, and on, and on.

There ought to be a better way, and there is, although it didn’t show up until
the aptly numbered AutoCAD release 13. When you create multiline (or para-
graph) text, you define a width for your text block by specifying a value or
picking two points on screen. Multiline text wraps from one line to the next,
just like your friendly word processor.
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There are plenty of differences between single-line and multiline text:

4+ Single-line text has fewer formatting options, so it’s simpler to create
and edit.

4+ Multiline text has many, many formatting options, so it’s much more
complicated to create and edit.

4+ To place single-line text in a drawing, you simply pick a start point
and type.

4+ To place multiline text, you specify two diagonal corners of a temporary
bounding box; the lines of text are placed inside.

4+ Single-line text appears character-by-character as you type. To type a
second line of text below the first, press Enter and continue typing.
Press Enter on a blank line to exit the command.

4+ You enter multiline text in a special dialog box called the in-place text
editor. AutoCAD automatically wraps lines of text based on the width of
the bounding box you specify when you start the command.

4 You create multiline text with the MTEXT command.

4 You create single-line text with the DTEXT or TEXT commands.

Why are there two commands for creating single-line text? Remember that
this is AutoCAD, where nothing is simple. By default, single-line text is
created with the DTEXT command. “TEXT” is now an alias for the DTEXT
command; typing either at the command line runs DTEXT. But the folks at
Autodesk hate to throw anything away, so the old TEXT command is still
there in the latest versions. To run it, put a hyphen in front: -TEXT. Go ahead
and try it, and see why nobody uses it any more!

Single-line text is much more limited than multiline text in its formatting pos-
sibilities. You can define a few properties such as a single font or a preset
height in a text style, but that’s about it. You can go crazy in formatting mul-
tiline text, changing things like font, size, color, and numerous other proper-
ties. Later in this chapter, we explain how to add both types of text, and how
to change the appearance of each.

So how do you choose which type to use? The usual advice is to use single-
line text for things like letters or numbers inside grid bubbles or keynotes,
and for short one-liners such as view titles and scales. Use multiline text for
anything longer — certainly for anything longer than a couple of lines.

Justification

Justification (or alignment) refers to the look of a block of text on a drawing
or page. If you're used to a word processor, you're probably pretty familiar

with the standard text justification options. Most text is left justified, like in



Figure 1-1:
Justifying

single-line
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this book. You may prefer center-justified text for headings and titles. (Not
us, we keep to the left!) Rarely, you even see right-justified text, which means
the right margin of a block of text is neatly lined up, and the left margin is
ragged. Many books (although very few drawings) use fully justified text,
where both right and left margins line up tidily.

All of these word processor options have their counterpart in AutoCAD. But
because AutoCAD is AutoCAD, it can’t leave well enough alone. We have six
justification options that you can apply to single-line text, and nine different
options that you can use with multiline text. Figures 1-1 and 1-2 show you
the choices.

AEFT
RIGHT,
CENTER

MIDDLE
JALIGNERy
s | Ty

Justifying single-line text

The single-line justification options probably make more sense to most
people because the line of text starts (or at least is based on) the insertion
point you pick. Left- and right-justified are plain enough, but the other
options need a bit of explanation:

4+ Center: The point you pick is the middle point of the text’s baseline; the
text flows equally to left and right from this point. Use this option for a
title that you want centered under a drawing view.

4+ Middle: The text you enter is centered both horizontally and vertically
about the point you pick. Use this option if you want to locate a letter or
number in the center of a keynote or grid bubble.

4+ Align: You specify two points for this option, and the text you enter starts
at the first point and ends at the second point. Aligned text maintains
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Figure 1-2:
Nine ways
to multiline.

the height you enter, so characters are stretched or compressed to fill
the space.

4+ Fit: Similar to Align in that you pick two points, but instead of maintain-
ing height and changing proportions, fit text maintains the proportions
of the font, but changes its height in order to fill the space.

If it’s absolutely essential that you have fully justified text (that is, straight
margins at both left and right ends), either Align or Fit is for you. Be aware,
however, that they’re pretty rare in AutoCAD drawings.

These six options are not the only justification choices for single-line text; it
can also be justified to any of the additional nine options described in the
next section, “Justifying multiline text.” However, multiline text can’t be justi-
fied using any of the six options described above.

S/ANCOUVER
ELECTRIC RAILWAY

VANCBUVER
ELECTRIC RAILWAY

VANCOUVER
ELECTRIC RAILWAY

'ANCOUVER VANCQUVER VANCOUVE
LECTRIC RAILWAY ELECTRIC RAILWAY ELECTRIC RAILWA
VANCOUVER VANCOUVER VANCOUVER
ELECTRIC RAILWAY ELECTRIGy RAILWAY ELECTRIC RAILWAY;

Justifying multiline text

Multiline text is treated as a single object, and the insertion point is either a
corner, or the midpoint of a side, or the absolute middle of the bounding
box. Figure 1-2 shows the same block of text with the nine possible justifica-
tion options. Oddly enough, given all the formatting possibilities with multi-
line text, it’s not possible to fully justify a multiline text object.

Where should text go?

In Book I, we introduced the two spaces that exist in every AutoCAD drawing
file. To recap:

4+ Model space is an infinitely large 3D environment where you create the
“real stuff” that you’re drawing. This is where you draw your house
plans or highways full-size.

4+ Paper space, which is accessible in a layout, represents your drawing
sheet, a 2D environment where you add the documentation that
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describes the “real stuff.” This is where you place your border and title
block, general notes, view titles, and symbols like section marks and
north arrows.

These are just guidelines, of course. There are a kazillion drawings out there
(we know because we’ve counted every single one of them) that are drawn
entirely in model space, or that have dimensions and text in model space.

In our humble opinion, most text belongs in paper space. The single,
arguable exception is leader notes because they often point directly to
model space objects and have to move when the objects move.

Although many people like to place leader notes in model space, a potential
for problems exists if you use external references (refer to Book VI for more
on this advanced AutoCAD feature). If you reference an external drawing,
you may want to see only the geometry, and not all the annotations. If you
put your text (or your dimensions, or any other non-“real” stuff) in model
space, you have to play around turning layers off and on before you get the
picture you want. Life is a lot simpler if you keep these items in your layouts,
in paper space.

Scaling text for model space

Another drawback to putting text in model space is the potentially messy
business of scale factors. Say that you've drawn a floor plan, and you want
to put a title under it, with the scale below that, as shown in Figure 1-3. Your
office standard says that titles are 3/16" high, and the scale reference should
be 3/32" high.

BUDDY HOLLY ELEMENTARY SCHOOL

SCALE =" = 10"

H 4 ¢ M|\ Mocel } D-Sze Layouw
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In order to make your floor plan fit on a drawing sheet, you're going to have
to scale it — say, to 1/4"=1"-0". The scale factor here is 48 (refer to Book I,
Chapter 5 for more on how to calculate scale factors). When you print your
drawing, that 8" wall is going to measure a little over 1/8" wide on the page.
So text that’s 3/16" high is going to be a teeny speck. In order to make your
text visible and in conformance with your office standard, you need to multi-
ply 3/16" by the drawing scale factor. In this example, you’d multiply 3/16

by 48 for a result of 9. When entering the text for the view title, you need to
make it 9" high. A similar calculation shows that the scale annotation needs
to be 4-1/2" high.

If you do a lot of this sort of thing, you’ll probably have a cheat sheet table
(like Table 1-1, for example) with drawing scale factors applied to different

printed text heights.

Table 1-1 Scale Factors for Model Space Text Height
Drawing Scale Large Text Small Text
Scale Factor (3/16"/ 5 mm) (3/32"/ 2.5 mm)
1/16"=1"-0" 192 3-0" 1'-6"
1/8'=1'-0" 96 1'-6" 9"
1/4'=1'-0" 48 9" 4-1/2"
1/2"=1'-0" 24 4-1/2" 2-1/4"
1"=1"-0" 12 2-1/4" 1-1/8"
3'=1'-0" 4 3/4 3/8"
12'=1'-0" 1 3/16" 3/32"

1:100 100 500 mm 250 mm
1:50 50 250 mm 100 mm
1:20 20 100 mm 50 mm
1:10 10 50 mm 25 mm

1:5 5 25mm 10 mm

1:2 2 10 mm 5mm

1:1 1 5mm 25mm

Adding text to paper space

Did you say you wanted 3/16" text for your titles and 3/32" text for the scale
annotations? If you put these on your layouts in paper space, the text
heights will always be the same — 3/16" and 3/32" — regardless of the scale
of any views in the layout. Still want to put that text in model space?
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A font is a character set that controls the look of the formatted text. AutoCAD
uses fonts as part of a text style definition (we discuss text styles in the next
section). You have literally thousands of fonts at your disposal. Some come
with AutoCAD; some come as part of the Windows operating system; some
come with different software programs that may also live on your computer.
Remember, though, that you are drafting, not doing desktop publishing or
authoring Web sites. (Or maybe you are doing desktop publishing or author-
ing Web sites, but, if so, you're using the wrong program!) In short, don’t get
carried away with ransom note- or medieval manuscript-style text. Your job is
to present the text data on your drawing clearly.

Types used by AutoCAD

Modern versions of AutoCAD can use two different font types:

4+ Vector ((SHX) fonts: These are the fonts that come with AutoCAD and
work with AutoCAD only. Vector fonts are made up of line segments
(hence the name) and are more efficient than TrueType fonts.

4+ TrueType fonts: These are the fonts that come with Windows. They give
you lots of fancy options but can slow down AutoCAD performance in
common tasks like panning, zooming, and object selection.

Using fonts in drawings

You can go with the default font you get when you start entering text the
first time you open AutoCAD, or you can configure the fanciest TrueType
font on your system. We advocate a middle road, nearer the first option than
the second. Our advice is to keep it simple and stick with AutoCAD’s vector
fonts — preferably the ones that come with the program.

There’s a healthy aftermarket for .SHX fonts, but they nearly always come
with a license that prevents you from distributing the font file to others. The
same also applies to TrueType fonts that you purchase or obtain through
installing other software programs. If your drawing is opened on a computer
that doesn’t have the fonts you’'ve used, AutoCAD starts choosing alternates.

If someone sends you a drawing with text that uses a non-standard font,
when you open the drawing, AutoCAD substitutes an alternate font and
displays a message telling you this at the command prompt.
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Two system variables control this font substitution process. FONTALT speci-
fies a single font to use when AutoCAD can’t find designated fonts. FONTMAP
specifies the name of a mapping file that lists substitute specific local fonts
for missing TrueType, Vector, and Postscript PFB fonts. (AutoCAD supported
Postscript fonts for only one release, but there are probably hundreds of
thousands of drawings out there that use them.) For more information on
how to configure these two variables, see the online Help index.

Working with Text Styles

\\3

A\

Before you can add text to a drawing, you have to have a text style — and
luckily, every AutoCAD drawing contains at least one text style. The default
templates include a basic text style named Standard. Text created with the
Standard style uses a clunky looking font called txt.SHX. It’s defined with a
height of 0, which means you’re prompted to specify a text height at the
command line.

A text style is a collection of settings that’s stored in the drawing file itself. Text
style definitions include a designated font file, a height, and — depending on
the chosen font — some options like width factor and obliquing angle.

Because text styles are created and saved inside drawing files, they’re not
necessarily available in all your drawing files. If you create your new text
styles and save them in a template (DWT) file, they become available in
every new drawing you start from that template. If you've created a nifty text
style and you want to use it in another existing drawing file, you can use
DesignCenter to copy it from one file to the other.

Most people think the default font used by the Standard text style is pretty
darned ugly. Seasoned users modify the Standard style or create new styles
that use more pleasing fonts.

If you're sufficiently seasoned, feel free to modify the Standard style. If you're
new to AutoCAD, we suggest you leave the Standard style alone, and instead
create a new style of your own. That way, if you mess it up badly, you can
always go back to the Standard style and start again.

The following steps explain the process.

1. Choose Format->Text Style to open the Text Style dialog box.

The Text Style dialog box displays the properties of the current text
style (see Figure 1-4).



Figure 1-4:
Get stylin’".
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. Click New and enter a style name (for example, MyNewStandard) in

the New Text Style dialog box, and then click OK.

The New Text Style dialog box closes and you return to the Text Style
dialog box. The new style starts off as a clone of whatever the current
style is set to.

. In the Font area, click the Font Name drop-down list to display a list of

all available fonts.

The list contains all TrueType fonts installed in your Windows Fonts
folder, and all AutoCAD vector fonts.

. Select a font (that is, romans.SHX) from the list.

AutoCAD vector fonts are indicated by a teeny pair of dividers and dis-
play the file extension (.SHX). Windows TrueType fonts show a double-T
icon and no file extension.

The Roman Simplex font (romans.SHX) is probably the most popular
font in AutoCAD because it combines efficiency with a much more pleas-
ing appearance than the default txt.SHX font.

. Click Apply and then Close to save the new text style definition and

set it current.

The Text Style dialog box closes. The new text style is now the current
style and will be used for all text added to the drawing until it’s changed
to a different style.

The remaining options in the Text Style dialog box modify the style defini-
tion in the following ways:

+

Font Style: If a TrueType font has style options (usually Bold, Italic, and
Bold ltalic), they appear in this list. Vector fonts don’t have options, so
the list is grayed out.
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4+ Height: When the height of a text style is defined as 0, you are prompted

to specify a height every time you add text to the drawing. You can save
this step (and help standardize your drawings) by defining a height.

Most of the time, it doesn’t really matter whether you set the text height
as part of the style definition, or leave it at 0 and enter a height every
time. But one situation in which it really does matter is when you define
a text style to use in your dimensions. In this case, the text height must
be set to 0 or your dimension styles don’t work properly. We explain all
about dimensioning in the next chapter.

Use Big Font: “Big fonts” (is that an unhelpful name or what?) are special
vector fonts used in Asian language drawings. Regular font files contain
upper- and (usually, but not always) lowercase letters, numbers, and
most of the symbols you see on your keyboard. Asian languages use
many more characters than that, and big font files contain the defini-
tions. For more information on big fonts, look up Big Font file in the
online help system index.

Upside down and Backwards: (What, no inside out?) These two text
effects are self-explanatory. You might use Backwards if you were going
to print on the back side of one-sided drafting film. We’ve bent over
backwards to figure out when you might want upside down text, but we
haven’t come up with a reason yet.

Vertical: The characters are horizontal, but the text string is vertical,
like a movie marquee. Unless you're designing movie theaters, you're
unlikely to use this option. It’s not available with TrueType fonts, nor
with many vector fonts either.

Width Factor: You can modify the width of text characters by modifying
this factor. Values of less than 1 compress the text, and values greater
than 1 expand it.

If you set the width factor of the text style for dimensions to somewhere
between 0.75 and 0.85, you’ll be able to make dimension text fit between
extension lines that might otherwise be forced outside them. For more
on dimensioning, see the next chapter.

Oblique angle: This is for do-it-yourself italics! You specify an angle to

apply a slope to the characters. Positive angles slope the characters to
the right, and negative angles slope characters to the left. If you do any
isometric drafting, you'll want to use this effect.

Preview: The Preview window shows you a sample of your text style
that changes as you fiddle with the properties. You can highlight the
sample text and replace it with a short text string of your own choosing.
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You don’t need to open the Text Style dialog box if you just want to change text
styles. By default, AutoCAD displays the Styles toolbar, which contains drop-
down listings of text styles, dimension styles, and table styles. Just open the list
and select the style to make a different one current. The tool buttons adjacent
to the drop-down lists open the respective style definition dialog boxes.

\\3

Creating Single Line Text

The following steps show you how to add multiple lines of single-line text to
a drawing.

1. Choose Draw=>Text->Single Line Text.
AutoCAD prompts as follows:

Command: _dtext
Current text style: "Standard" Text height: 0.2000
Specify start point of text or [Justify/Stylel:

At this point, you can change the justification or style of your text input.
To stay with the default justification (aligned left) and style (Standard),
skip to Step 5.

2. To change the text justification, type J and press Enter.
AutoCAD displays this prompt:

Enter an option [Align/Fit/Center/Middle/
Right/TL/TC/TR/ML/MC/MR/BL/BC/BR] :

To change justification from the default (left justified), enter the upper-
cased letter of the option; for example, type M and press Enter to set
your text input to middle-justified in the drawing. You have a lot of

NG/ options here — we discuss text justification later in the chapter.
QNWNG/

R AutoCAD does not retain changes to text justification. If you want to
place a number of middle-justified text objects, you need to specify the
Middle option for each one.

3. To change the text style, type S and press Enter.
AutoCAD displays this prompt:
Enter style name or [?] <Standard>:

The current text style name is shown inside angle brackets. Just press
Enter to keep using the current style. If you want to switch to a different
style and you know its name, type it now and press Enter. The new text
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200 Creating Single Line Text

style must already be defined in the current drawing. (We cover text styles
later in this chapter.)

4. For a list of text styles defined in the current drawing, type ? and
press Enter.

AutoCAD displays this prompt:
Enter text style(s) to list <*>:

The default option is the asterisk wildcard. Press Enter and AutoCAD
lists all text styles defined in the current drawing together with their
style properties.

Text styles:

Style name: "Notes" Font typeface: ArchStencil
Height: 0.0000 Wwidth factor: 1.0000 Obliquing
angle: 0
Generation: Normal

Style name: "Standard" Font files: txt
Height: 0.0000 width factor: 1.0000 Obliquing
angle: 0

Generation: Normal

AutoCAD ends this command prompt sequence by redisplaying the
current text style name and resuming the regular DTEXT command
prompts:

Current text style: "Standard"
Specify height <0.2000>:

5. To specify the text height, either press Enter to accept the default
height, or type a new value for the text height, and then press Enter.

You see the Specify height prompt only if your current text style is
defined with a height of 0 (the default Standard text style is so defined).
You can accept the default or enter a new text height here.

After you've entered the desired text height, AutoCAD displays this
prompt:

Specify rotation angle of text <0>:

6. To specify the rotation angle, press Enter to accept the default value,
or enter a new rotation angle.

Rotation angle refers to the angle of the whole text string, not to the
slant of the individual characters, which is called the obliquing angle
(see Figure 1-5). For horizontal text, leave the rotation angle at 0
degrees. Rotation angle is set when you’re placing single-line or multiline
text; obliquing angle is part of the text style definition.



Figure 1-5:
Rotation

and
obliqueness.
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After a whole lot of prompting, you’re finally ready to start adding text to
the drawing! The crosshairs change to a text box.

7. Type your text.

When you want to break a line and continue on the next line, press Enter
and continue typing. When you’re finished adding single line text, press
Enter on a blank line to return to the command line.

Working with Multiline Text

As if single-line text wasn’t bad enough, multiline text introduces even more
levels of complexity! Many longtime users were slow to adopt multiline text
because of the complexities, and really, you can get most annotation jobs
done with single-line text. So why bother?

A few tasks that you need to do every so often are extremely difficult to
achieve with single-line text. We’ve already talked about word-wrap in multi-
line text, which lets you shift the space required by a block of notes by simply
grabbing the grips of the mtext object and dragging them to a new location.

Nicely lined-up numbered or bulleted lists are pretty hard to create using
single-line text because proportionally spaced fonts (and nearly all AutoCAD
fonts are proportionally spaced) make lining things up virtually impossible.

Book I
Chapter 1

0Q ,uop Isnp
$81N)914 USYAN IX3)



202  Working with Multiline Text

Figure 1-6:
The
multiline
text editor.

Finally, a font’s full character set (that is, non alphanumeric symbols) is
readily accessible in multiline text. Single-line text offers just a very few spe-
cial characters that have to be entered with special codes.

Hopefully the advantages of multiline text encourage you to hang in there
with it. The final bit of advice is this: If you only learn one kind of text in
AutoCAD, make it multiline text!

You create both single-line and multiline text in an in-place text editor. In-
place means the text you create in the editor is going to appear in the draw-
ing in exactly that place at exactly that size when you finish creating the text
and close the editor. For single-line text, the in-place editor is simply a
Windows-style text box, but for multiline text, it’s much more elaborate, con-
sisting of the two components shown in Figure 1-6:

4+ Text formatting toolbar: The toolbar contains a multitude of drop-down
lists and tool buttons that would do a word processor proud. Set justifi-
cation, color, or style; add symbols or fields; or fine-tune character or
line spacing.

4+ Bounding box with ruler: The text you type appears within the bound-
ing box. You can set margin and tab stops in the ruler by dragging the
pointers, just like in a word processor. If you don’t see a ruler atop the
bounding box, click the Ruler button in the top row of the Text
Formatting toolbar.
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Creating Multiline Text

A\

The following steps show you how to add a paragraph multiline text to a
drawing:

1. Choose Draw=>TextoMultiline Text.

The standard crosshairs change to a plain crosshairs and ghosted text in
the current style and height. AutoCAD displays the current text style
name and height at the command line and prompts as follows:

Command: _mtext Current text style: "MyNewStandard"
Text height: 2.6654
Specify first corner:

2. Pick the first corner of the bounding box.

The default multiline text justification is Top Left, so the first point you
pick will be the upper-left corner of the text object. AutoCAD displays
this prompt:
Specify opposite corner or [Height/Justify/Line
spacing/Rotation/Style/Width] :

3. Enter a command option or pick the second corner.

Enter the uppercased letter of the option to change text height, justifica-
tion, line spacing, rotation, style, or the overall width of the text box. To

retain all the default settings, pick the diagonally opposite corner of the

text box. The command prompt disappears, and the in-place text editor

displays the Text Formatting toolbar and bounding box.

The bounding box sets only the width of the multiline text object. It
doesn’t matter how tall you make the box — it will expand as necessary
to include all the text you enter.

4. Type your text.

The text you type flows across the bounding box. When it reaches the
opposite side, it wraps automatically to the next line, just like your
favorite word processor.

Formatting options

The two rows of buttons and drop-down lists in the Text Formatting toolbar
(refer to Figure 1-6) enable you to perform many of the functions of a fully-
featured word processor. You can change the style, font, height, and any
number of other properties of your multiline text object. See the online Help
system for a full description of each formatting option — on the Contents tab,
choose Command Referencec>MTEXT=>In-Place Text Editor.
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vgs\\NG! A multiline text object can be created using only one text style. If you type
S some text, change the style and type some more, the entire multiline text
object changes to the new style. You can get the effect of different styles by
highlighting some text and changing the font, height, color, and so on.

Numbered and bulleted lists

Another advantage of multiline text is that it supports bulleted and num-
bered lists. This feature is especially useful for creating general drawing
notes, as shown in Figure 1-7. AutoCAD automates the process of creating
numbered lists almost completely. Here’s how:

1. Follow Steps 1 through 3 in the previous section, “Creating
Multiline Text.”

2. Type a title; for example, DESIGN CRITERIA.

If you'd like to have your title underlined, click Underline on the Text
Formatting toolbar before you type the title, and then click Underline
again to turn it off.

3. Press Enter to go to the next line and Enter again.
Leave a little more space between the title and the body of the text.

4. Right-click inside the text editing window and choose Bullets and
Listss>"Numbered=>Allow Auto-List=>Use Tab Delimiter Only=>
Allow Bullets and Lists.

The number 1 followed by a period appears on the current line, and the
cursor jumps to the tab stop visible in the ruler at the top of the text
editor’s bounding box.

Numbered places numerals followed by periods in front of items in a list.
Lettered places uppercase or lowercase letters followed by periods in
front of list items. (Bulleted places bullet characters in front of list
items.) Auto-list enables automatic numbering — each time you press
Enter to move to a new line, its number increments. Use Tab Delimiter
Only means you must press the Tab key to move to the tab stop.

5. Type the text corresponding to the current number or bullet.

As AutoCAD wraps the text, the second and subsequent lines align with
the tab stop — that is, the text is automatically indented.

0. Press Enter at the end of the paragraph to move to the next line.

Just like creating numbered lists in your favorite word processor,
AutoCAD automatically inserts the next number at the beginning of the
new paragraph, with everything perfectly aligned, as shown in Figure 1-7.
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7. Type the text corresponding to the next number or bullet, and then
press Enter at the end of the paragraph to move to the next line.

8. Repeat Steps 5 through 7 for each subsequent numbered or
bulleted item.
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Fields, masks, and other multiline text delights
We haven’t exhausted the features of the multiline text editor yet, and two
especially useful ones are fields and background masks. The multiline text
editor also offers a panoply of little functions and utilities that come in
handy from time to time.
P The convention in drafting is that text in a drawing is uppercased at all

times. One way to avoid having to keep the Shift key pressed down is to use
the Caps Lock key. But when you finish your texting and want to log in to
your network, if you forget to turn off Caps Lock, you get an error message.
The multiline text editor has a great solution for you. Right-click inside the
editor and choose AutoCAPS. Everything you type in the text editor is upper-
cased, without benefit of Caps Lock.

Fields

Fields are placeholders for changeable data that updates automatically —
for example, the author of a drawing and when it was created, last saved, or
plotted. This data comes from drawing properties, or some system variables,
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Figure 1-8:

Masking the
background
of your text.

or a sheet set (neither fields nor sheet sets are available in AutoCAD LT). To
display the Field dialog box (see Figure 1-8), right-click inside the multiline
text editor and choose Insert Field. For more information on inserting and
updating fields, refer to the online Help system.

Background masks

Sometimes you just have to place a note on top of drawing objects, and
invariably, it looks bad. If your note is multiline text, you can mask the back-
ground drawing data so the text displays clearly as follows:

1.

2.

In a drawing containing some graphic objects, add some multiline text
on top of the drawn objects.

Right-click inside the text editor and choose Background Mask.

The Background Mask dialog box appears.

. Check Use Background Mask to enable the feature.

The remaining dialog box options become accessible.

4. Set a Border Offset factor.
This value, which must be between 1 and 5, controls the distance
beyond the text object that the mask extends. When set to 1, the mask is
tight to the text object.

5. In the Fill Color area, either check Use Drawing Background Color or
click the drop-down list to select a color for the mask.
If you don’t want bright red rectangles all over your drawing, make sure
you check the Use Drawing Background color box.
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Editing Text
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After you've created either single-line or multiline text, editing it is a pretty
straightforward exercise. As you might expect, there are two different edi-
tors for the two different types of text. So how do you know which editor to
use? Easy — AutoCAD chooses for you if you double-click the text.

Editing single-line text

We've already pointed out all the formatting options available in multiline
text, and if those are what you need, it’s multiline text for you. Your editing
options are fewer with single-line text, but for simple text, they should be
more than ample.

Both types of text use an in-place text editor, where the text appears inside
an edit box at the size and location it will appear in the drawing. Simply
double-click a string of single-line text to display it in the in-place editor. All
you can change here is the value of the text itself. If you need to change
other properties such as style, justification, or height, select the text and
make changes in the Properties palette.

If you're an old hand at AutoCAD and you absolutely hate the new single-line
text editor, you can restore the pre-AutoCAD 2006 Edit Text dialog box by
setting the system variable DTEXTED to 1.

Editing multiline text

Double-clicking a multiline text object also opens its in-place editor, but as
you've already seen, it’s an editor with a lot more bells and whistles. We've
covered most of the options in the earlier sections on creating multiline text.
To change all or parts of the text, select as you would in a word processor
and apply your changes. Then click OK in the Text Formatting toolbar, or
simply click outside the in-place editor.

Single-line text isn’t allowed to have anything that paragraph text doesn’t
also have, so there is also an MTEXTED system variable that lets you revert
to the previous editor. To do so, type MTEXTED and press Enter; then type
OldEditor and press Enter. The old editor still has the same toolbar and
ruler, but the bounding box does not display the selected text at its actual
size or location.

Fiddling with text can be a tedious task, and lots of little-known commands
and functions let you do your tweaking more efficiently. Two such com-
mands let you adjust text height and justification in different ways:

4+ SCALETEXT: Say you have a whole bunch of annotations in your draw-
ing, and you want to reduce the size of all of them. The SCALE command

Book I
Chapter 1

0Q ,uop Isnp
$81N)914 USYAN IX3)



208 Turning the Tables

would require a lot of selecting and moving, but SCALETEXT scales each
text object about its own insertion point, so it stays where it ought to.

4+ JUSTIFYTEXT: If you change the justification of text in the Properties
palette or the multiline text editor, the insertion point stays put and the
text moves. JUSTIFYTEXT lets you change the justification by keeping
the position of the text where it is and moving the insertion point.

Turning the Tables

Table objects were introduced in AutoCAD 2005. Prior to that, if you needed
to add a table — say a bill of materials, or a door schedule, or a drawing list,
or any kind of data that can usefully be presented in rows and columns —
you were in for several hours’ work, drawing lines, adding text, moving lines,
and lining everything up at the end. AutoCAD'’s tables can start at the top
and flow downwards, as they would in most of the examples mentioned.
They can also be anchored at the bottom of a sheet and flow upwards, which
is the typical fashion for things like revision blocks. Tables can contain regu-
lar text, attributes, or fields.

Setting the table with styles
Tables, like text and dimensions, are defined according to styles. Every draw-
ing has at least one table style waiting to be called on; the default templates
contain a table style called (what else?) Standard. The following steps
explain how to create a table style:

1. Choose Format->Table Style.

The Table Style dialog box appears, showing on the left a list of all table
styles defined in the current drawing, and on the right a preview of the
current style settings. You can select existing table styles to set current,
modify, or delete; however, you can’t delete the Standard style.

2. Click New to create a new table style.
The Create New Table Style dialog box appears.
3. Enter a name for the new style; for example, Door Schedule.

If you have more than one style defined, you can use the drop-down list
to select an existing table style as the prototype for the new style.

4. Click Continue.

The New Table Style: Door Schedule dialog box opens, again with a pre-
view of the current settings at the right (see Figure 1-9).
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A table style has up to three parts: the data, the column heads, and the
title. Each of the three has a tabbed panel at the left side of the dialog
box. The panels are identical, except there are check boxes in the latter Book Il
two to turn off their display. In other words, your table can contain the Chapter 1
data only; the data and column heads; the data and a table title; or the
data, column heads, and a title.

5. In the Data tab, configure the text options and fill color. To change
the data format, click the button with the ellipses alongside the
Format entry.

The Preview updates as you change settings in the left panel.
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6. Repeat Step 5 for the Column Headings and Title tabs, or clear the
check boxes to turn off display of headings and title.

7. In the General area, specify whether the table direction should be
Down (the default) or Up.

8. Modify the values in the Cell margins boxes to increase or decrease
the space between the table text and the lines.

You don’t specify row heights or column widths in the table style; spec-
ify these values when you create a table object.

9. Click OK to close the New Table Style dialog box.
AutoCAD returns to the Table Style dialog box.
10. Click Set Current, and then click Close.



210 Turning the Tables

Figure 1-10:
Rows and
columns
for a table.

Creating and editing tables

After the table style is created, use the TABLE command to add a table
object to your drawing. The following steps show how:

1. Choose Drawr>Table.
The Insert Table dialog box appears (see Figure 1-10).
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2. Select a table style from the Table Style Name drop-down list or click

Table Style dialog to create a new table style.
The Table Style Settings area displays the current text height.

3. In the Insertion Behavior area, choose Specify Insertion Point or
Specify Window.

Specify Insertion Point is the preferable option, as it maintains the

height and width settings you set in the table and text styles. Choosing

Specify Window squeezes or stretches the table into the rectangular
area you define. This option also disables the Data Rows value, which

generates as many rows as fit in the window you pick; however, you can

check the radio button to enable it again.
4. Specify the number of columns and data rows.

“Data rows” excludes the rows for the title and column headings.
5. Adjust the column width and row height as required.

One or the other pair of these options is grayed out if you choose
Specify Window in Step 3.
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6. Click OK.

The empty table is placed in the drawing. The Text Formatting toolbar
appears, and the first column cell is highlighted, ready for text input.

7. Enter the table title, column headings, and data.

It’s now a matter of simply filling in the spaces. Now imagine creating a
table like that with the TEXT and LINE commands!

If you just want to create the table frame and come back to input the text
later, just click outside the highlighted cell.

To add table data, or to edit what’s already there, double-click inside the
table cell.

Combine tables and fields to automatically populate a drawing title block or
revision block. Field data updates automatically when the data source
changes.

Table cells can also contain blocks, so you could create a drawing legend
with graphic symbols in one column and a description of what they stand for
in another column.
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Chapter 2: Dimensioning

In This Chapter

v+ Understanding what a dimension is made of
v Types of dimensions

v Using and creating dimension styles

v Creating dimensions

v Editing dimensions

v Leaders

+ Geometric tolerances

Dimensions are a form of annotation that provides information about
how a product should be created or assembled. Typically, dimensions
provide information on how long a part is, the diameter of a hole, or a call-
out in the form of a leader. In this chapter, you find out how to create and
work with dimensions, leaders, and geometric tolerances.

AutoCAD and AutoCAD LT offer a number of dimension-related commands
to help convey your design ideas to the people who are doing the construc-
tion (in the case of a building) or manufacturing (in the case of a machine
part). Just as text styles manage the appearance of text in a drawing, dimen-
sion styles do the same thing for dimensions. Dimension styles allow you to
define visually how dimensions appear in a drawing, but are much more
complex than text styles.

Understanding What a Dimension Is Made Of

Dimensions are one of the most complex objects in AutoCAD and AutoCAD
LT because of the many options that are available to control how they
appear in a drawing. Dimensions are made up of several sub-objects or com-
ponents that define what the dimension looks like. Some of the sub-objects
that define a dimension are extension lines, dimension lines, arrowheads,
dimension text, and origin points.
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Before you begin creating dimensions, you should understand some of the
common terminology for the different parts of a dimension (see Figure 2-1).
Although each of the different dimension types has its own purpose, they do
share some things in common.

Arrowhead  Dimension text Dimension line
|
Figure 2-1: &.0000 | evension
The parts of xtension line
i i Origin point
a dimension.

Here are the five main parts of a dimension:

4+ Origin points: Origin points are used to define the measurement value
for the dimension text and are small non-printing points that are attached
to the dimension. Origin points are typically placed on an object, which
allows you to move or reposition a dimension that might need to be
updated.

4+ Extension lines: Extension lines extend up and away from the object that
is being dimensioned to the dimension line and arrowheads. Extension
lines typically have a gap between them and the origin points of the
dimension object and extend past the dimension line. A gap helps show
that the dimension is not part of the actual object.

4+ Arrowheads: Arrowheads appear at the end of a dimension line and are
used to indicate where a dimension starts and ends. Arrowheads can be
displayed as open or closed arrows, architectural ticks, dots, or user-
defined arrows, among other arrowhead styles.

4+ Dimension line: Dimension lines are displayed typically between the
extension lines and go outward from the center of the dimension object
towards the extension line. Based on where the dimension text is placed,
the dimension line may appear broken or might appear on the outside of
the extension lines.

4+ Dimension text: Dimension text provides the actual value of measure-
ment that the dimension was created with and can be formatted in a
variety of different ways. Some of the formatting options are the units
the measurement is expressed in, the type of decimal separator that
should be used, and how the value should be rounded.

Each of the parts of a dimension can be formatted globally using dimension
styles, or individually using what are known as dimension overrides. We talk
more about dimension styles and dimension overrides later in this chapter.
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Types of Dimensions

Dimensions are a special type of block that AutoCAD treats differently from
the blocks that you can create and insert into drawings; we cover blocks
later in Chapter 1 of Book VI. Because dimensions are a special type of object,
you interact with them differently. Dimensions can be created so that if the
object that was dimensioned is changed, the dimension is updated automati-
cally. Dimensions can also be created so that they are exploded after they
have been created (which is not recommended because you won'’t be able to
quickly update the dimension when the geometry in the drawing changes).
They can also be created so that if the original object that is dimensioned is
modified, the dimension doesn’t update. No matter what type of dimension is
created, they all look the same, but they are edited in much different ways.

Associative dimensions

Associative dimensions are created as a single object — so when you select
any part of the dimension, the entire dimension is selected. An associative
dimension is linked to the original object that was dimensioned, so when the
original object is modified, the dimension is updated accordingly. Modifying
the original dimensioned object by moving, rotating, stretching, or scaling it
causes the dimension to update automatically. Fully associated dimensions
were first introduced in AutoCAD 2002; prior to AutoCAD 2002, associated B
. . . . . . ook Il
dimensions meant that the dimension was all one object and had no associa- Chapter 2
tion with the dimensioned object.

Non-associative dimensions

Non-associative dimensions are created as a single object, just like associa-
tive dimensions are. Unlike associative dimensions however, non-associative
dimensions are not linked to the original dimensioned object and therefore
are not updated when the original dimensioned object is modified. If you
select the dimension when modifying the original dimensioned object, it is
still updated based on the type of modify command that is being used on
both the object and dimension. Prior to AutoCAD 2002, non-associated
dimensions were referred to as associative dimensions because they were

a single object instead of individual objects.

Bujuoisuaung

Exploded dimensions

Exploded dimensions are created as individual 2D objects and are very
hard to update because the original objects have to be deleted each time a
change is made. We recommend that you don’t create exploded dimensions
because it can lead to inaccuracies to the dimensions if the text is not



216 Specifying the Type of Dimension to Create

updated. If you really need to create an exploded dimension, it is best to
create associative dimensions and then use the EXPLODE command on a
dimension.

Specifying the Type of Dimension to Create

To specify whether new dimensions are created as associative or non-
associative dimensions, you can check or uncheck the Make New Dimensions
Associative check box under the Associative Dimensioning section on the
User Preferences tab (see Figure 2-2).

Figure 2-2:

Specifying R

Whether FEOCIENVE Limensioning

n_ew . i) take new dimensions associative

dimensions

should be

created as

associative.
Follow these steps to determine whether new dimensions should be created
as associative or non-associative.

1. From the Tools menu, choose Options.

The Options dialog box is displayed.

2. In the Options dialog box, click the User Preferences tab.

3. On the User Preferences tab under the Associative Dimensioning
section, check or uncheck the Make New Dimensions Associative
check box.

If the option Make New Dimensions Associative is checked, all new
dimensions are created as associative.
QUING/
& The setting to create new dimensions associative is saved in the draw-

ing. When you get a drawing from a vendor or client, be sure that the
setting is set to create new dimensions as associative.

4. Click OK.

The changes are saved and the Options dialog box is closed.
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Using and Creating Dimension Styles

Figure 2-3:
The
Dimension
Style
Manager
dialog box.

Dimensions contain a large number of display options. Both AutoCAD and
AutoCAD LT use dimension styles to contain groups of settings that control
the appearance of dimensions. Dimension styles tell AutoCAD or AutoCAD
LT how the dimension lines, extensions lines, dimension text, and arrow-
heads should be displayed for any dimension that is created in a drawing.
Dimensions that reference a dimension style are updated when a change is
made to the style, unless an override has been applied at the dimension
object level.

Working with the Dimension Style Manager

Dimension styles are stored in a drawing file and are referenced by the
dimensions that are created in the drawing. Each dimension that is created
can reference a different dimension style. Dimension styles are created, mod-
ified, and managed through the Dimensions Style Manager dialog box (see
Figure 2-3), which is displayed with the DDIM command.
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To start the DDIM command and display the Dimensions Style Manager
dialog box, follow one of the methods outlined below:

4 Format or Dimension menu: Choose Format or Dimension=
Dimension Style.

4 Styles or Dimension toolbar: Click the Dimension Style button on the
Styles or Dimension toolbar.

4+ Keyboard input: Type DDIM and press Enter.
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Creating a dimension style

Dimension styles can only be created from an existing style that already
exists in the drawing; by default, each drawing contains either a dimensions
style called Standard (imperial units) or ISO-25 (metric units). The Dimension
Style Manager is used to create the new dimension style and then allows you
to make any necessary property changes to the dimension style that was just
created. The following procedure creates a new dimension style:

1. Use one of the previously mentioned methods to open the Dimension
Style Manager dialog box.
2. In the Dimension Style Manager dialog box, click New.

The Create New Dimension Style dialog box (see Figure 2-4) is displayed.

Figure 2-4:
Creating
anew
dimension

style.

™ Create New Dimension Style 2]
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Conlife l Cancel ] l Help

3. In the Create New Dimension Style dialog box, enter a name in the
New Style Name text box for the dimension style that you are creating.

The name entered is used to set the dimension style current when you
want to create new dimensions using that dimension style.

4. Select the dimension style that you want to base the new dimension
style on from the Start With drop-down list.

The dimension style that you base the new dimension style on will be
identical to the one you are creating until you make changes to the new
dimension style.

5. Select All Dimensions from the Use For drop-down list.

The Use For drop-down list allows you to create substyles for a dimen-
sion style. Substyles allow you to define specific characteristics for cer-
tain types of dimensions that can be created using a single dimension
style. Substyles are used when the parent dimension style is used.

6. Click Continue.

The New Dimension Style dialog box is displayed and allows you to
change the settings of the new dimension style.

7. In the New Dimension Style dialog box, adjust the properties of the
dimension style or the substyle as necessary.



Figure 2-5:
The Lines
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the New
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dialog box.
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8. Click OK.

The New Dimension Style dialog box closes and the dimension style is
saved in the drawing.

9. In the Dimension Style Manager dialog box, click Close.

The Dimension Style Manager dialog box closes.

The New Dimension Style dialog box

The New Dimension Style dialog box allows you to define how dimensions in
a drawing look when they are created. The New Dimension Style dialog box is
divided up into seven tabs, which help to organize the properties of a dimen-
sion style. As you change the properties for the dimension style, the preview
of the dimension style in the upper-right corner of the dialog box is updated.

The Lines tab

The Lines tab (see Figure 2-5) allows you to define the display of dimension
and extension lines. On the Lines tab, you can specify the color, linetype,
lineweight, which extension and dimension lines are suppressed, and some
spacing/offset values that help to define what a dimension should look like
when assigned the dimension style.
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The Symbols and Arrows tab

The Symbols and Arrows tab (see Figure 2-6) allows you to define the char-
acteristics of the terminators and symbols for dimensions. On the Symbols
and Arrows tab, you can specify the type of arrowheads that are used, how
center marks are drawn, the symbol that should be used for arc length
dimensions, and the jog angle for jogged radial dimensions.
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The Text tab
The Text tab (see Figure 2-7) allows you to define how dimension text is
placed along the dimension line and how it appears. On the Text tab, you
can specify the color, text style, background fill color, height, and some other
properties that affect how text is created, placed, and aligned with the
dimension line.
@‘“NG! If you assign a text style that has a specified text height to a dimension style,
S

Figure 2-7:
The Text tab
of the New
Dimension
Style dialog
box.

the text height that is specified on the Text tab is overridden by the value
specified in the text style. For the most control, use a height of 0 (zero) when
defining a text style.
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Figure 2-8:
The Fit tab
of the New
Dimension
Style dialog
box.
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The Fit tab

The Fit tab (see Figure 2-8) allows you to define how dimension text and
arrowheads are placed between extension lines. You can specify how
dimension text and arrowheads are placed in relation to the amount of
space between the extension lines; the scale of dimension text in model
space and on a layout tab; whether dimension text is placed with a leader;
and whether a dimension line should be drawn between the extension lines.
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The Primary Units tab

The Primary Units tab (see Figure 2-9) allows you to define how dimension
text should appear. On the Primary Units tab, you can specify how dimen-
sion text is formatted including decimal separators, rounding factor, meas-
urement units, prefix and suffix for the dimension text, measurement scale
factor, and how leading and trailing zeros are displayed. The settings affect
both linear and angular measurement values for dimensions.

The Alternate Units tab

The Alternate Units tab (see Figure 2-10) allows you to define how alternate
measurements appear as part of the dimension text. The Alternate Units tab
allows you to control whether an alternate measurement value is placed
with the primary measurement value. Typically, alternate units are used
when you want to display dimensions with both imperial and metric values.
The Alternate Units tab contains options that are used for the formatting of
the alternate measurement text and its placement.

Book I
Chapter 2

Bujuoisuaung



222 Using and Creating Dimension Styles

Lines

Linear dimermsots

Sumbols and Anows | Tesl

Fit

Piimany Urits | Allernale Urits | Talersnces

Unit format: Decimal ~
2 ——| 10159 |—
Frecizion 0.0000 [
Fraction fomst: !
11935 5,
T - 2 . 020y
Decimal separator ! Period] _vl 4 + ) Ay
H
Found off: 10,0000 = | . / '6/0 N o
— y
Figure 2-9: Piefi R0.8045—
Th e Pr| ma ry Sulfie Anguar dimenzions
Units tab of Measurement scale Urits foimat: Decimal Degiees v
Secale factor: 1.0000 %
the New [ &ppbs to layout dimensions only Hhecia 0 g
DImenSIOn Zero suppression Zearo suppression
. Leadirg [ Leading
Style dialo A
ty 9 [] Traiing [ Traifing
box.
Lines | Spmbols and Anovs | Test | Fit Pimaty Urits Altemate Urds | Tolejances
Dizplay alternate units
Altemnate unitz
Urit format: Decmal v
e e P '—'—J.I]JSQ (25,201
Frecizsion 0.00 A T 1 ’/\
! 130
— \ L
Multipher for ak urits: 254000 | = 5\)3\037 51,33
Figure 2-10: 3 J el A\
Found distances to; 00000 [ o { e
ROE04S DREM44]

The
Alternate
Units tab of
the New
Dimension
Style dialog
box.

Frefic

Suffic

Zero supprassion
[ Leading

[ Traiing

Placement

(&) After primary valug

(3 Below primary value

The Tolerances tab

The Tolerances tab (see Figure 2-11) allows you to define how tolerances
appear as part of the dimension text. Dimension text tolerances are much
different from the geometric tolerance object, which we talk about later in
this chapter. On the Tolerances tab, you can specify the type of tolerance
that is displayed with dimension text, the format of the tolerance including
precision, upper, and lower limits, and how leading and trailing zeroes are
suppressed. The settings affect both linear and angular measurement values

for dimensions.
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Dimension variables

AutoCAD and AutoCAD LT hide many of their complex workings from the
user in the latest releases, but it has not always been this way. In earlier
releases of AutoCAD, when dimensions were first introduced, you had to
know a number of system variables that were specific to dimension styles.
Even to this day, you can access the system variables that are specific to the
current dimension style and make changes to them through script files as
you are creating dimensions in a drawing. By changing the values of the
dimension system variables in this way, you are creating an override for the
current dimension style that is applied to each new dimension that is cre-
ated in the drawing. You can get a list of the dimension system variables by
doing the following:

1. At the command line or dynamic input tooltip, enter SETVAR and
press Enter. The following prompt is displayed:
Enter variable name or [?]:

2. At the prompt, type ? and press Enter. The following prompt is
displayed:

Enter variable(s) to list <*>:
3. At the prompt, type DIM* and press Enter.

The system variables that are specific to the current dimension style are
displayed in the AutoCAD Text window or AutoCAD LT Text window.

4. Press Enter to continue listing additional system variables that are
related to dimensions.

Book I
Chapter 2

Bujuoisuaung



22 4 Using and Creating Dimension Styles

\\J

Keep pressing Enter until you see the dimension system variable that
you want to change.

5. Press ESC to end the SETVAR command, and then type the dimension
system variable’s name at the command line or dynamic input tooltip.

You are prompted for the new value.
6. Enter the new value and press Enter.

The value is updated accordingly.

If you need help with what values can be used with a dimension system vari-
able, press F1 and the online Help for that system variable opens. This also
works well for commands that are in progress and other system variables.

Setting a dimension style current

Dimension styles need to be set current in order to be used to create new
dimensions. AutoCAD and AutoCAD LT allow you to set a dimension style
current in several different ways. The two most common ways of setting a
dimension style current are

4+ Styles or Dimension toolbar: On the Styles or Dimension toolbar, select
the dimension style that you want to set current from the Dimension
Styles drop-down list.

4+ Dimension Style Manager: Double-click the dimension style under the
Styles list box to set it current, or select the dimension style from the
Styles list box. Select Set Current from the right-click menu or click the
Set Current button.

Modifying a dimension style

At times, you may find that a dimension style needs to be updated. This
could be due to changes to the current CAD standards or even requirements
that dimensions be provided with specific arrowheads or formatting for a
client. You are already familiar with creating a dimension style, so you will
find modifying one isn’t that much different.

Dimension styles are modified through the Dimension Style Manager dialog
box. After the Dimension Style Manager dialog box is displayed, select the
dimension style from the Styles list box and click the Modify button on the
right side of the dialog box. The Modify Dimension Style dialog box is dis-
played, which is just like the New Dimension Style dialog box. Make the
desired changes and then click OK to save the changes to the dimension
style and to close the Modify Dimension Style dialog box.
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Dimension style overrides

Dimension style overrides allow you to make small number of property
changes to the current dimension style without creating a new dimension
style altogether. Style overrides can cause some confusion in a drawing when
creating new dimensions, unless you know that a style override is currently in
use. To create a style override, you can change one of the dimension style vari-
ables, or click the Override button in the Dimension Style Manager dialog box
and make the property changes that you want to be part of the style override.

Only new dimensions that are created with a style override current are
affected, so you could draw dimensions using different text fit options, if
necessary, to accommodate some dimensions in a drawing. Overrides are
best done at the individual dimension object level using the Properties
palette. Selecting a dimension in a drawing allows you to override any prop-
erty of a dimension object through the Properties palette (see Figure 2-12).
This makes it easier to get the correct override that you might want to use
instead of setting it through the Dimension Style Manager dialog box.
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Dimension styles can be merged into the dimension style that they were cre-
ated from by right-clicking over the text <Style Overrides> in the Dimension
Style Manager dialog box, and selecting Save to Current Style. Only one
dimension style override can exist in a drawing at a time, and switching to
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another dimension style discards the style overrides unless they are saved
to the dimension style.

Dimension substyles

Dimension substyles are different from editing dimension styles and style
overrides because the substyle limits which properties you can edit based
on the substyle that is created. Dimension substyles are created just like a
new dimension style is, with the exception that you select one of the types
of dimensions from the Use For drop-down list in the Create New Dimension
Style dialog box, and you don’t need to specify a name for the dimension style.
To modify a dimension substyle, select the substyle below the dimension
style that the substyle is a part of and click the Modify button.

Renaming a dimension style

Only a dimension style can be renamed using the Dimension Style Manager
dialog box or the Rename dialog box, but style overrides and substyles can’t
be. To rename a dimension style using the Dimension Style Manager dialog
box, select the dimension style from the Styles list box and press F2. The in-
place editor appears and allows you to change the dimension style’s name.
You can also right-click over the dimension style name and select Rename to
replace the dimension style’s name.

Deleting a dimension style

Dimension styles, substyles, and style overrides can be deleted from a draw-
ing through the Dimension Style Manager dialog box when they are not being
used. To delete a dimension style, a substyle, or style overrides, right-click
over the item in the Styles list box of the Dimension Style Manager dialog
box and select Delete. When the AutoCAD or AutoCAD LT message is dis-
played, click Yes to confirm the deletion.

The PURGE command can be used to remove any unused dimension styles
from a drawing.

Importing a dimension style

Dimension styles should be created in the drawing template that you start
your new drawing with. At times, you may not want to place a dimension
style in the drawing template that you use, but that doesn’t mean you have
to go through and create the dimension style every time you need it either.
You can use the DesignCenter palette to drag and drop dimension styles
from one drawing to another. For more information on using DesignCenter,
see Chapter 3 of Book VI.
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Creating Dimensions

AutoCAD and AutoCAD LT allow you to create many different types of dimen-
sions to communicate overall design concepts: dimensions in the form of
lengths and widths, hole locations and depths, and others. The important
thing to note about dimensions is which ones you need and how to create
them. This section covers the different kinds of dimensions that you can
create in AutoCAD and AutoCAD LT.

Linear and aligned dimensions

Linear dimensions are the most commonly used dimensions: They are used
to measure an object or two points horizontally or vertically in a drawing.
You use linear dimensions to dimension straight segments such as lines or
polylines, the chord length of an arc, or the diameter of a circle, which can
be created horizontally, vertically, or rotated (see Figure 2-13).

Figure 2-13:
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Linear dimensions are created using the DIMLINEAR command. To start the a

DIMLINEAR command, follow one of the methods outlined below:

|<_,| 4 Dimension menu: Choose Dimension=>Linear.

4 Dimension toolbar: Click the Linear button on the Dimension toolbar.

4+ Keyboard input: Type DIMLINEAR and press Enter.
4+ Command alias: Type DLI and press Enter.

Aligned dimensions are similar to linear dimensions except they are not cre-
ated orthogonally based on the origin points picked. The difference in the
way aligned dimensions are created versus linear dimensions causes them
to measure the actual distance between the origin points selected, instead of
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the horizontal or vertical distance. Aligned dimensions are created using the
DIMALIGNED command, and its command prompts are for the most part
identical to the DIMLINEAR command. To start the DIMALIGNED command,
follow one of the methods outlined below:

+
*
+
<+

Dimension menu: Choose Dimension=>Aligned.
Dimension toolbar: Click the Aligned button on the Dimension toolbar.
Keyboard input: Type DIMALIGNED and press Enter.

Command alias: Type DAL and press Enter.

The following procedure starts the DIMLINEAR command and explains how
to create a linear dimension:

1.

Use any of the four previously listed methods to initiate the
DIMLINEAR command.

The DIMLINEAR command starts and this prompt is displayed:

Specify first extension line origin or <select object>:

. At the prompt, pick a point for the first origin point of the dimension

or press enter to select an object to dimension.

If you select a point, the prompt Specify second extension line
origin: is displayed. If you press Enter, the prompt Select object to
dimension: is displayed.

When specifying points for the origins of dimensions, use object snaps to
make sure that the dimensions are created with the correct measurement.

At the specify second extension line origin prompt, pick a point
for the second origin point of the dimension. At the select object to
dimension prompt, select an object to dimension in the drawing.

The prompt Specify dimension line location or [Mtext/Text/
Angle/Horizontal/Vertical/Rotated] : is displayed.

At the prompt, pick a point to place the dimension or specify one of
the command’s options.

The dimension is placed and the command ends. The options Mtext,
Text, and Angle affect the value of the dimension text or how the dimen-
sion text is rotated. The options Horizontal, Vertical, and Rotated affect
how the dimension is created in the drawing and the measurement value
that is calculated.
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Baseline and continued dimensions

Baseline dimensions allow you to create a string of dimensions (see Figure
2-14) that continue from the first origin point of the previous linear, aligned,
angular, or ordinate dimension. Typically, you place the first dimension and
then follow it up by creating baseline dimensions, but you have the option of
creating baseline dimensions by selecting an existing dimension in a drawing.
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Baseline dimensions Continued dimensions

Baseline dimensions are created using the DIMBASELINE command. To start
the DIMBASELINE command, follow one of the methods outlined below:

4+ Dimension menu: Choose Dimension=>Baseline.

4+ Dimension toolbar: Click the Baseline button on the Dimension toolbar.

4+ Keyboard input: Type DIMBASELINE and press Enter.

4+ Command alias: Type DBA and press Enter.
Continued dimensions allow you to create a string of dimensions that con-
tinue from the second origin point of the previous linear, aligned, angular, or
ordinate dimension. As with baseline dimensions, you commonly place the
first dimension and then follow it up by creating the continued dimensions,
but you have the option of creating continued dimensions by selecting an
existing dimension in a drawing. Continued dimensions are created using the
DIMCONTINUE command, and its options are identical to the DIMBASELINE
command. To start the DIMCONTINUE command, follow one of these methods:

4+ Dimension menu: Choose Dimension=>Continue.

4+ Dimension toolbar: Click the Continue button on the Dimension toolbar.

4+ Keyboard input: Type DIMCONTINUE and press Enter.
4+ Command alias: Type DCO and press Enter.
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The following procedure starts the DIMBASELINE command and explains
how to create a baseline dimension:

1. Use any of the four methods just listed to initiate the DIMBASELINE
command.

The DIMBASELINE command starts and the prompt Specify a second
extension line origin or [Undo/Select] <Select>: is displayed,
or the prompt Select base dimension: is displayed.

2. At the Specify a second extension line origin or [Undo/
Select] <Select> prompt, pick a point for the second origin point of
the dimension or press enter to select an object to dimension.

If you select a point, the prompt Specify a second extension line
origin or [Undo/Select] <Select>: is redisplayed.

3. At the prompt, press Enter twice to exit the command or pick another
point to place another baseline dimension.

After you press Enter once, the prompt Select base dimension: is
displayed, which allows you to select another dimension to start creat-
ing baseline dimensions from.

Angular dimensions

Angular dimensions (see Figure 2-15) allow you to show the angular meas-
urement in a drawing. The angular measurement might be based on the end
points of an arc, the angular relationship between two straight segments, the
center of a circle and another angle, or two vertexes that define an angle.

I*\-\%*
L

Figure 2-15:
Angular
dimensions.
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Angular dimensions are created using the DIMANGLUAR command. To start
the DIMANGLUAR command, use one of these methods:

4+ Dimension menu: Choose Dimension=>Angular.

4+ Dimension toolbar: Click the Angular button on the Dimension toolbar.
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4+ Keyboard input: Type DIMANGULAR and press Enter.
4+ Command alias: Type DAN and press Enter.

The following procedure starts the DIMANGULAR command and explains
how to create an angular dimension based on two lines:

1. Use any of the four methods just listed to initiate the DIMANGULAR
command.

The DIMANGULAR command starts and the prompt Select arc,
circle, line, or <specify vertex>: is displayed.

2. At the prompt, select a line segment.
The prompt Select second line: is displayed.
3. At the prompt, select another line segment.

The prompt Specify dimension arc line location or [Mtext/
Text/Angle] : is displayed.

4. At the prompt, pick a point to place the dimension or specify one of
the command’s options.

The dimension is placed and the command ends.

Arc length dimensions

Arc length dimensions (see Figure 2-16) are similar to angular dimensions,
except instead of measuring an angle, they measure the length of an arc or
an arc segment of a polyline. Based on how an arc needs to dimensioned,
you might use the arc length dimension over an angular or linear dimension.

Figure 2-16:
Arc length
dimensions.
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Arc length dimensions are created using the DIMARC command. To start the
DIMARC command, follow one of the methods outlined below:
4+ Dimension menu: Choose Dimension=>Arc Length.

4+ Dimension toolbar: Click the Arc Length button on the Dimension
toolbar.
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Figure 2-17:
Radius,
diameter,
and jogged
dimensions
along with
center
marks.
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4+ Keyboard input: Type DIMARC and press Enter.
4+ Command alias: Type DAR and press Enter.

Radius, diameter, and jogged dimensions

AutoCAD offers four different types of dimensions that are used to dimension
the radius or diameter of a circle or arc, or place a center mark at the center
point of a circle or arc. Figure 2-17 shows the results of using the commands
DIMRADIUS, DIMDIAMETER, DIMCENTER, and DIMJOGGED on a circle or arc.

Radius dimension Center marks
R1,5000 03, onuaﬂ |
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Diameter dlmensmn Jogged dimension

Radius dimensions

Radius dimensions display an uppercase R prefixed to the measurement value
to designate that the measurement is for the radius and not the diameter of
the arc or circle. When a radius dimension is placed, a center mark is also dis-
played so you know where the center of the object that is being dimensioned
is. Radius dimensions are created using the DIMRADIUS command. To start
the DIMRADIUS command, follow one of the methods outlined below:

4+ Dimension menu: Choose Dimensiont>Radius.

4+ Dimension toolbar: Click the Radius button on the Dimension toolbar.
4+ Keyboard input: Type DIMRADIUS and press Enter.

4+ Command alias: Type DRA and press Enter.

Diameter dimensions

Diameter dimensions are similar to radius dimensions except they are used
to measure the diameter of an arc or circle. The two dimensions look almost
identical, except the diameter dimension displays a diameter symbol in
front of the measurement value. Diameter dimensions are created using the
DIMDIAMETER command. To start the DIMDIAMETER command, follow one
of the methods outlined below:
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4+ Dimension menu: Choose Dimensiont>Diameter.

4+ Dimension toolbar: Click the Diameter button on the Dimension toolbar.
4+ Keyboard input: Type DIMDIAMETER and press Enter.

4+ Command alias: Type DDI and press Enter.

Jogged dimensions

Jogged dimensions allow you to show the radius of an arc or a circle like a
radius dimension does, except instead of the dimension automatically indi-
cating the center of the object, you specify a center override location. When
a jogged dimension is placed, no center mark is displayed, but an angle on
the dimension line is displayed to indicate that the radius isn’t being meas-
ured from the center of the object. Jogged dimensions are created using the
DIMJOGGED command. To start the DIMJOGGED command, follow one of the
methods outlined below:

4+ Dimension menu: Choose Dimension=>Jogged.

4+ Dimension toolbar: Click the Jogged button on the Dimension toolbar.
4+ Keyboard input: Type DIMJOGGED and press Enter.

4+ Command alias: Type DJO and press Enter.

Center marks

Center marks allow you to place a set of lines at the center of an arc or a
circle. The lines that are created are not a single dimension object, but a
bunch of separate line objects. The type of center mark created is based on
the settings under the Center Mark section of the Symbols and Arrows tab of
the New/Modify Dimension Style dialog box. Center marks are automatically
created when you place radius and diameter dimensions, but you want to
place center marks at the center of circles when placing linear dimensions
to indicate that you are dimensioning to the center of the circle. Center
marks are created using the DIMCENTER command. After the DIMCENTER
command is started, select an arc or circle to create the center mark. To
start the DIMCENTER command, follow one of the methods outlined below:

4 Dimension menu: Choose Dimension=>Center Mark.

4 Dimension toolbar: Click the Center Mark button on the Dimension
toolbar.

4+ Keyboard input: Type DIMCENTER and press Enter.
4+ Command alias: Type DCE and press Enter.
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Figure 2-18:
Ordinate
dimensions.

Ordinate dimensions

Ordinate dimensions (see Figure 2-18) allow you to place x and y coordinate
values of features or specific points on a part. Each ordinate dimension
represents an x or y value, but not both. Ordinate dimensions are not a
commonly used type of dimension, but you might find them used on shop
drawings used to manufacture parts.
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Ordinate dimensions are created using the DIMORDINATE command. To start
the DIMORDINATE command, follow one of the methods outlined below:

4 Dimension menu: Choose Dimension=>Ordinate.

4+ Dimension toolbar: Click the Ordinate button on the Dimension toolbar.
4+ Keyboard input: Type DIMORDINATE and press Enter.

4+ Command alias: Type DOR and press Enter.

When you create ordinate dimensions, they are based on the origin of the
current user coordinate system (UCS). (For more information on the User
Coordinate System, see Book V, Chapter 2.) Usually a point on the part is
designated as 0,0. In order to do that, you need to specify a new origin for
the current UCS. To specify a new origin, start the UCS command and then
pick the point in the drawing you want to be the current 0,0 value. To undo
the moving of the origin, use the World option of the UCS command.

The Quick Dimension command

The Quick Dimension (QDIM) command allows you to quickly place a number
of dimensions in a drawing by selecting multiple objects at a time. The QDIM
command allows you to create linear, continuous, staggered, baseline, ordi-
nate, radius, and diameter dimensions. To start the QDIM command, follow
one of the methods outlined below:
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|,§§| 4 Dimension menu: Choose Dimension=>Quick Dimension.

4 Dimension toolbar: Click the Quick Dimension button on the Dimension
toolbar.

4+ Keyboard input: Type QDIM and press Enter.

The QDIM command is not available in AutoCAD LT.

Trans-spatial dimensions

Trans-spatial dimensions are not something you find in a science fiction novel,
but instead a feature of AutoCAD that allows you to dimension objects that
are in model space through a floating viewport. Trans-spatial dimensions
allow you to place dimensions on layouts that measure accurately, but this
brings up the question of where dimensions should be placed.

You should generally do dimensioning in model space (via the Model tab),
but at times, you may find it beneficial to dimension objects that are in
model space through a viewport. One of the main reasons that dimensions
should be placed in model space is so they appear if the drawing is inserted
or referenced into another drawing. In order to dimension objects correctly,
the scale used for the dimension style should be set to a value of 1.

A\
Before you attempt to take on dimensioning on a layout tab, we recommend Book Ill
you stick to dimensioning in model space for a while. Chapter 2
a a e a E
Editing Dimensions :
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Dimensions are edited in slightly different ways depending on what part of ]
the dimension object you want to edit. In this section, we explain some of =)

the common ways to edit dimensions.

Adding overrides to a dimension

At times, you may need to make adjustments to the location of an arrow-
head, change the position and formatting of text, or change the dimension
style of a dimension. The Properties palette allows you to override specific
properties of a dimension object to supersede (or override) the properties
defined by the dimension style that is assigned to the dimension object.
Along with using the Properties palette, you can also select dimensions and
then right-click to access some of the commonly used dimension overrides.
From the right-click shortcut menu, you have the option to flip arrowheads
individually so they are on the inside or outside of an extension line, change
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the precision formatting of dimension text, change the current dimension
style for the dimension object, or even change the position of the dimen-
sion text.

Editing the dimension text

Dimension text can be edited to add a prefix or suffix to a measurement value
to denote a typical dimension or quantity of holes. You can edit the text of a
dimension using the DDEDIT command, or change the Text Override, Dim
Prefix, and Dim Suffix properties with the Properties palette.

If you use the DDEDIT command, you should notice that the measurement
value is displayed with a background fill color. If the measurement text
doesn’t display with a fill color, a text override has been applied. To add the
true measurement value back into the dimension text, add the text <> to the
In-Place Text Editor.

Two commands are specifically for editing dimension text: DIMEDIT and
DIMTEDIT. DIMEDIT allows you to change the placement of dimension text
and change the angle of extension lines. DIMTEDIT is used to move and
rotate dimension text. If you need additional help with the commands,
reference the online Help system.

Using grips to edit dimensions

Grips are a very powerful editing feature and can be used with dimensions.
Using grips to edit dimensions allows you to reposition dimension text,
change the placement of the dimension line along the extension lines, and
move the origin points of a dimension. Moving the origin points can cause
the dimension to become non-associative; however, you can make the
dimension associative again using the DIMREASSOCIATE command which is
mentioned under the section “Associating dimensions.” If you use grips to
stretch both the dimension and the object the dimension is associated to,
the dimension remains associative to the object.

Associating dimensions

Dimensions, at times, can wander off and disassociate themselves from the
original object that they were dimensioned to. Dimensions can become disas-
sociated through the use of the DIMDISASSOCIATE command, or a dimension
might break its associativity after being modified. If a dimension becomes
disassociated, you can try counseling, but usually the DIMREASSOCIATE com-
mand is all that is really needed to correct the problem. The DIMREASSOCIATE
command allows you to re-specify the origin points of selected dimension
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objects, making them once again associative to the objects in a drawing. The
DIMREASSOCIATE command can be used to convert pre-AutoCAD 2002 dimen-
sions to fully associative dimensions.

AutoCAD and AutoCAD LT for the most part do a pretty good job at watching
for changes to objects in the drawing, and to make sure their associated
dimensions are kept up-to-date. If a dimension seems to be confused after
you update an object, you can kick-start it by using the DIMREGEN com-
mand. This forces the dimension object to update.

Leaders

Figure 2-19:
Examples of
leaders.

Leaders are used to point to and call out features or draw attention to some-
thing in a design (see Figure 2-19). A leader typically has an arrowhead at
one end pointing to something in the drawing, whereas the other end has
text, an object, a block, or a tolerance object. The leader can contain any of
the arrowheads that dimensions can, and the leader line can contain as
many straight or spline segments that you want it to have.
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Leaders are created using the QLEADER command. To start the QLEADER
command, follow one of the methods outlined below:

4 Dimension menu: Choose Dimension =>Leader.

4 Dimension toolbar: Click the Quick Leader button on the Dimension
toolbar.

4+ Keyboard input: Type QLEADER and press Enter.

As soon as the QLEADER command is started, it allows you to start creating
a leader right away by selecting points. The number of points that you

can pick are based on the settings of the QLEADER command. The Leader
Settings dialog box (see Figure 2-20) is used to specify the options for the
QLEADER command when creating a new leader. The leader line and arrow-
heads are created as a single object, but any text, block, object, or tolerance
that is placed with the leader is treated as a single object.
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Figure 2-20:
The Leader
Settings
dialog box.
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When using the QLEADER command, follow the prompts at the command line
or the dynamic input tooltip. Leaders can be edited using grips, the proper
editing command based on the type of object inserted with the leader, and the
common modify commands. If you need additional help, reference the online
Help system.

Working with Geometric Tolerances

Figure 2-21:
The
Geometric
tolerance.

Geometric tolerances allow you to create a series of what are called feature
control frames. Feature control frames can contain symbols, tolerance values,
datum references, and projected tolerance zone values (see Figure 2-21).
Geometric tolerances are used for mechanical drawings and vary based on the
standards that you need to follow, such as ANSI (American National Standards
Institute), ISO (International Standards Organization), or JIS (Japanese
Industrial Standards).
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Geometric tolerances are created using the TOLERANCE command. To start
the TOLERANCE command, follow one of the methods outlined below:

4 Dimension menu: Choose Dimension=>Tolerance.

4 Dimension toolbar: Click the Tolerance button on the Dimension toolbar.



Figure 2-22:
The
Geometric
Tolerance
dialog box.
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Working with Geometric Tolerances

4+ Keyboard input: Click TOLERANCE on the Dimension toolbar.
4+ Command alias: Type TOL and press Enter.

When you start the TOLERANCE command, you are prompted for the inser-
tion point of the geometric tolerance object and then the Geometric Tolerance
dialog box (see Figure 2-22) is displayed. In the Geometric Tolerance dialog
box you can specify the tolerances, datum references, symbols, and projected
tolerance zone value. Geometric tolerances can be modified using grips, the
DDEDIT command, and the common modifying commands. If you need help,
reference the online Help system.
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Chapter 3: Hatching
Vour Drawings

In This Chapter

v Adding hatch patterns and fills
v+ Working with gradient fills
v~ Editing hatch patterns and fills

In this chapter, you discover hatch patterns and fills and how to create
and edit them. Hatch patterns and fills are used to communicate a design
concept and help improve the way a flat 2D drawing looks. AutoCAD and
AutoCAD LT offer two different types of hatches: hatch patterns and solid
fills. Hatch patterns are made up of line segments that are stored in pattern
files, whereas solid fills are a single color and are not made up of line seg-
ments. AutoCAD offers an additional hatch type called gradient fills.

Gradient fills are similar to solid fills except they are a blend of one color with
a tint, or two colors, to give the illusion of depth and realism to a 2D drawing.
Hatching allows you to quickly add a visual representation of floor tiles, shin-
gles, or shakes on a roof for an architectural drawing. For a mechanical draw-
ing, you might use a hatch pattern that creates diagonal lines to represent the
part of a model that is shown cut through for a section view.

Hatch objects are created by default as a single object and are associative
like dimensions. Hatch objects are created associative to the objects that
form the closed boundary in which the hatch object is created. Keeping a
hatch object associative allows it to be automatically updated when the
boundary changes. Hatch objects can also be created non-associative,
which keeps the hatch object from being updated when the boundary
changes. Hatch objects can be exploded if they are created with a hatch
pattern other than a solid or gradient fill. Figure 3-1 shows a drawing that
uses hatch patterns and fills to indicate the materials used for the exterior
of a building.
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Figure 3-1:
Hatch
patterns and
fills.
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Adding Hatch Patterns and Fills

Hatch objects are created using the Hatch and Gradient dialog box (see Fig-
ure 3-2), oy, if you are using AutoCAD LT, the Hatch dialog box. The Hatch
and Gradient dialog box allows you to specify which hatch pattern or fill
should be used to hatch a closed boundary (or area). Based on the type of
hatch you are creating, you might need to specify a pattern, scale, and angle.

Figure 3-2:
The Hatch
and
Gradient
dialog box
with the
Hatch tab
active and
expanded.

Many different settings control how a hatch object looks after it is created.
Most of the commonly used settings for creating and editing hatch objects
are displayed by default, but if you want to access some of the more

advanced settings, click the More Options button.
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Adding hatch to a drawing

Adding hatch to a drawing the first few times can be a little bit confusing, but
that is to be expected because many elements in a drawing and the dialog box
can affect how a hatch object is created. When you want to create a hatch
object, make sure that the area you want to hatch is closed — meaning all
lines, arcs, and so on define a boundary either by connecting at the end
points of the objects or by overlapping each other. Hatch objects are created
using the Hatch and Gradient dialog box, which is displayed with the HATCH
command.

To start the HATCH command and display the Hatch and Gradient dialog
box, follow one of these methods:

4+ Draw menu: Choose Draw >Hatch.

4+ Draw toolbar: Click Hatch on the Draw toolbar.
4+ Keyboard input: Type HATCH and press Enter.
4+ Command Alias: Type H and press Enter.

The following procedure starts the Draw command and displays the Hatch
and Gradient dialog box so you can create a hatch object using a predefined
hatch pattern:

1. Use one of the methods just listed to start the Draw command.
The Hatch and Gradient dialog box is displayed.

2. In the Hatch and Gradient dialog box under the Type and Pattern sec-
tion, select Predefined from the Type drop-down list.

The controls that are used with a predefined hatch pattern are enabled.

3. From the Pattern drop-down list, select one of the predefined hatch
patterns.

A preview of the selected hatch pattern is displayed in the Swatch area
below the Pattern drop-down list. You can click the ellipsis button to the
right of the Pattern drop-down list to display the Hatch Pattern Palette
dialog box (see Figure 3-3). The Hatch Pattern Palette dialog box allows
you to select predefined and custom hatch patterns that come with the
software.

4. Under the Angle and Scale section, specify an angle for the hatch pat-
tern by selecting a predefined value from the Angle drop-down list or
entering a value in the text box.
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5. Specify a scale for the hatch pattern by selecting a predefined value
from the Scale drop-down list or entering a value in the text box.
6. Under the Boundaries section, click Add: Pick Points.
You are returned to the drawing window to pick a point inside the
closed boundary. The prompt Pick internal point or [Select
objects/remove Boundaries] : is displayed.
7. At the prompt, click in the drawing window within a closed boundary
to define the boundary for a hatch object.
The boundary is calculated, and you are prompted for additional closed
areas. If the area is not closed or the boundary can’t be calculated, a
message box is displayed (see Figure 3-4).
Boundary Definition Error &
6 Valid boundary not found
H - The boundary is not closed, or a boundary
Flgure 3-4: object is not accessible
The .
Try one of the following:
Boundary - Zoom out until all boundaries are wsible
- - Increase the gap tolerance system variable
Definition (HPGAPTOL).
Error - Cancel the command and make sure all
boundary objects form a closed area.
message
box.
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The system variable HPGAPTOL specifies if a tolerance value is used
when calculating a closed boundary with objects that don’t completely
form a closed boundary. The value can also be specified under the Gap
Tolerance section when the Hatch and Gradient dialog box is expanded.

8. Press Enter to accept the selected boundaries and to return to the
Hatch and Gradient dialog box.

9. In the Hatch and Gradient dialog box, click Preview.
The hatch object is displayed in the drawing.

10. Press ESC to return to the Hatch and Gradient dialog box to make
changes or press Enter to create the hatch object.

The hatch object is created and the command ends.

Hatching and tool palettes

You can create hatch tools on a tool palette that can be used to create new
hatch objects in a drawing. A hatch tool can be created by dragging and
dropping a hatch object from a drawing onto a tool palette. The hatch tool is
created based on the properties of the hatch object. To use the hatch tool,
click the tool and then click inside the closed boundary, or drag and drop
the tool over the closed boundary. For more information on tool palettes,
see Chapter 4 of Book VI.

Hatching and DesignCenter

Hatch objects and hatch tools can be created from the DesignCenter. To
create a hatch object or a hatch tool, browse to the location where the hatch
pattern (.PAT) files are stored with DesignCenter. Double-click the hatch pat-
tern file, and then drag and drop the hatch pattern over a closed boundary
or over a tool palette.

Advanced settings for additional control

The Hatch and Gradient dialog box offers a number of options to control how
a hatch object is created and how the boundary for a hatch object is gener-
ated. These options can be found under the Hatch Origin and Options sections
and under the extended section of the Hatch and Gradient dialog box.

Specifying the origin for a hatch object

The Hatch Origin section allows you to define the base point in the drawing
from which the hatch pattern is calculated. By default, the origin point of
the drawing is used, instead of a point in the closed boundary. The Specified
Origin option allows you to select the point that should be used for the
origin that the hatch pattern of the hatch object should be calculated from.

Book llI
Chapter 3
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Specifying an origin point allows you to make the appearance of hatch
patterns predictable. This is important if you are using hatch patterns for
creating tiles, bricks, and siding on a house; for example, you want to make
sure you have a full run of bricks at the bottom of a house, and not just half
of a run.

Island detection

Island detection is used when calculating the closed boundary for a hatch
object. An island is defined as an interior boundary inside the outer bound-
ary that is calculated. To access the island detection settings, you have to
click the More Options button that is located in the lower-right corner of the
Hatch and Gradient dialog box. Figure 3-5 shows examples of the three island
detection options:

4+ Normal: The outer detected boundary is hatched, but hatch is turned
off for any detected island until another island is detected.

4 Outer: Only the outer detected boundary is hatched; no hatch is applied
to islands inside the boundary calculated.

4+ Ignore: All islands are ignored and the hatch fills the entire area defined
by the outer boundary.

Figure 3-5:
Island
detection
settings.

\\J

The Remove Boundaries button allows you to remove and add islands to
adjust the boundary of a hatch object when it is being edited.

Others settings available for defining a hatch object

Some additional settings allow you to specify a factor that should be used
when defining a boundary that might not be completely closed. Another
setting allows you to create separate hatch objects for each closed bound-
ary that is defined when selecting objects or points to define boundaries.
Another nice feature is to define the order in which the hatch object is
displayed on-screen in respect to the objects that define its boundary. For
additional information on the options of the Hatch and Gradient dialog box,
see the online Help system.
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A new system variable now controls whether object snaps can be used with
hatch objects. If the system variable OSOPTIONS is set to a value of 1 or 3,
object snaps are ignored for hatch objects.

Working with Hatch Patterns and Solid Fills

Hatch patterns and solid fills are the most commonly used types of hatches.
AutoCAD and AutoCAD LT offer three different types of hatch patterns that
you can use when adding hatch to a drawing: predefined, user-defined, and
custom.

Predefined patterns

AutoCAD and AutoCAD LT come with a number of predefined patterns that
are available in the files acad.PAT (acadiso.PAT for metric) and acadlt.PAT
(acadltiso.PAT for metric). To use a predefined hatch pattern or solid fill,
select Predefined from the Type drop-down list. The Pattern drop-down list
is enabled, which allows you to select a pattern from the drop-down list.
Alternatively, click the ellipsis button to the right of the Pattern drop-down
list to select a pattern visually from the Hatch Pattern Palette dialog box.

The system variable MEASUREMENT is used to control which hatch pattern Book IIl
and linetype files are used for imperial or metric drawings. If MEASUREMENT Chapter 3
is set to a value of 0, the imperial files are used; a value of 1 indicates that

the metric files should be used.

User-defined patterns

User-defined hatch patterns are not very common because they just don’t
offer much more than what the predefined hatch patterns offer. When defin-
ing a user-defined hatch pattern, you specify the spacing and angle of lines
that run parallel or perpendicular to each other. One of the nice things about
user-defined hatch patterns is that you specify the actual spacing of the lines
in drawing units instead of a scale factor. To create a user-defined hatch pat-
tern, select User Defined from the Type drop-down list. After User Defined is
selected, set the angle and spacing values and specify whether double lines
should be created.

shuime.q
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Custom hatch patterns

Custom hatch patterns are typically supplemental patterns that offer some-
thing that is not available from the predefined hatch patterns that come with
the application. Custom hatch patterns are usually much more complex than
just a series of lines that can be generated as a user-defined pattern. Custom
hatch pattern files must be placed in one of the support paths defined under
the Files tab of the Options dialog box.
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To use a custom hatch pattern, select Custom from the Type drop-down list
and then click the ellipsis button next to the Custom drop-down list to dis-
play the Hatch Pattern Palette dialog box. The Custom tab is set current and
displays the hatch patterns that AutoCAD or AutoCAD LT automatically
found in the support paths. For more information on custom hatch patterns,
see Chapter 4 of Book IX.

Using Gradient Fills

Gradient fills were added to AutoCAD 2004 to replace the fills that users had
previously been creating with external paint applications. Gradient fills are
created based on a choice of one color and a tint value or two colors, the
direction of the color shift, whether the gradient is centered, and its angle.
Gradient fills are created from the Gradient tab of the Hatch and Gradient
dialog box (see Figure 3-6).

Creating a gradient fill isn’t much different from creating a hatch object that
uses a predefined, user-defined, or custom pattern. After the basic charac-
teristics of the gradient fill have been defined, you define the boundary for
the hatch in the same way you would for creating one of the hatch types
from the Hatch tab.

1 Hatch and Gradient B[]
Hatch | Gradiert Boundaries
Color Add. Pick points
@) One color ) Two colo
—C < [p) || | B passekacta:
Shads Tet 7
| [I I .
Q
I Q,
Optionz
[¥] Bssociative
[ Create sepacats hatches
. H H e
Send behind bourdzey | v

Figure 3-6:
The Hatch
and
Gradient
dialog box
with the
Gradient tab
active.

Orienkation

z] Inherit Properties

[¥] Centered Angle: |0 v
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Gradient fills can’t be applied with AutoCAD LT, but are displayed in LT with
no problem.

If a drawing is saved back to AutoCAD 2002 or earlier versions, gradient fills
are displayed as a solid fill. The color of the solid fill is based on the closest
ACI color to the first color of the gradient fill.

Editing Hatch Patterns and Fills

A\\S

Editing a hatch object is very similar to editing a text object or other objects.

Double-clicking a hatch object starts the HATCHEDIT command, which
allows you to edit a hatch object. Alternatively, you can start the HATCHEDIT
command by selecting and right-clicking a hatch object and choosing Hatch
Edit from the shortcut menu. The HATCHEDIT command displays the Hatch
Edit dialog box, which is identical to the Hatch and Gradient dialog box,
except that some of the options used only for creating a hatch object are
disabled. Make the necessary changes and click OK to apply the changes.

The MATCHPROP command is great for making one or more hatch objects
look the same by copying the properties from one hatch object to another.

Book llI
Chapter 3
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Chapter 1: The LT Difference

In This Chapter

v+ Understanding the limitations of AutoCAD LT

1+ Determining whether AutoCAD LT is right for you

Fis minibook of the AutoCAD & AutoCAD LT All-in-One Desk Reference
For Dummies takes a look at the differences between AutoCAD and
AutoCAD LT. If you are considering purchasing AutoCAD or AutoCAD LT, you
should understand what the strengths and weaknesses of the two programs
are before making your final decision. Or maybe you already have AutoCAD
LT and want to know what you might be missing out on by not having
AutoCAD. In this minibook, we try to give you a good understanding of the
differences between the two programs.

Understanding the Boundaries and
Limitations of AutoCAD LT

AutoCAD LT is a scaled-down version of AutoCAD that is targeted at companies
that create only 2D drawings and can’t (or don’t want to) afford the higher
price of AutoCAD. AutoCAD LT is what Autodesk refers to as an AutoCAD OEM
(Original Equipment Manufacturer) program: AutoCAD OEM is simply the
AutoCAD platform or engine with some features removed and others added to
make a new program without the need to reinvent the wheel — or recreate the
program, in this case. Using AutoCAD as the basis for AutoCAD LT guarantees
that the files that are created in AutoCAD can be read by AutoCAD LT.

AutoCAD LT contains roughly 80 percent of the functionality of AutoCAD for
about 20 percent of the price. Most of the features that don’t make it into
AutoCAD LT are based on project collaboration, 3D, and the ability to create
custom programs — add-ons. Autodesk removes these features from the
program to justify the cost difference between the two programs. For the
price, AutoCAD LT is an outstanding value and ensures that you will be able
to communicate with others who use AutoCAD. However, because you can’t
create or use custom programs for AutoCAD LT, you can’t do much to change
or improve on any drafting workflow that doesn’t already come with the
program through custom add-on programs as you can with AutoCAD.
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So what exactly are the differences between the two programs? The pro-
grams have a number of major and minor differences. Here is a list summa-

rizing many of the differences between the two programs:

4+ User interface: For the most part, the user interfaces of AutoCAD and
AutoCAD LT are identical (see Figure 1-1). Both programs take advantage
of the Windows platform by using common user interface elements that
can be found in most Windows-based applications. These common user

interface elements are

Pull-down menus and shortcut menus

Toolbars
Status bar

Dialog boxes

Floating/dockable windows — palettes

Some of the common AutoCAD-related Ul elements, such as the Text
window, command line window, and dynamic input are present in both
AutoCAD and AutoCAD LT. AutoCAD LT lacks some of the palettes that
are found in AutoCAD only, such as the Dashboard, dbConnect Manager,

Sheet Set Manager, and others.
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For more information on the AutoCAD and AutoCAD LT user interfaces,
see Chapter 2 of Book .

4+ 2D drafting: The foundation of both applications is 2D drafting, so both
programs are very similar in the features and commands that are avail-
able for it. A few features do stand out as being different, however:

AutoCAD supports the ability to create multilines with the MLINE
command, whereas AutoCAD LT has a command called DLINE
instead. Both commands allow you to create parallel lines, but the
DLINE command is much easier to work with.

AutoCAD LT doesn’t support the use of True Colors or Color Book
colors.

Raster images can’t be attached to a drawing as an external reference
when using AutoCAD LT.

The Reference Manager allows you to remap external references
such as drawings, raster images, and .DWF underlays.

Groups are created and managed differently in the two programs.
AutoCAD LT offers a much easier-to-use interface and is dockable,
versus the older dialog box interface that comes with AutoCAD.

For more information on 2D drafting, see Chapters 1 and 2 of Book II; for
more information on external references, see Chapter 4 of Book VI.

4+ Annotation/dimensioning: The annotation and dimension features of
the two programs are very similar, for the most part. A few notable dif-
ferences are

AutoCAD LT lacks the ability to create Gradient fills.

The QDIM command is missing from AutoCAD LT, which helps to
improve productivity by allowing you to place multiple dimensions
at a time quickly in a drawing.

You aren’t able to insert fields in text, multiline text, or attributes
when using AutoCAD LT.
Book IV

For more information on annotating and dimensioning a drawing, see Chapter 1
Book III.

4+ 3D modeling: For the most part, 3D drawing in AutoCAD LT is nonexist-
ent. You are able to create wireframe models, but you can’t create sur-
face or solid models. AutoCAD LT does offer some limited properties
that do allow you to create pseudo-3D objects or objects that appear to
be 3D, such as giving an object thickness or drawing objects at different
Z elevations. The 3D modeling capability is one of the defining features
that makes AutoCAD LT different from AutoCAD.

For more information on 3D modeling in AutoCAD and AutoCAD LT, see
Book V.

aouaseq 179YL
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4+ Viewing/navigation: AutoCAD LT offers very basic ways to view a draw-
ing compared to AutoCAD. Most of the available ways of viewing a draw-
ing in AutoCAD LT are

Realtime zoom and pan, window, extents, previous, and others
Named and preset views

VPOINT and DDVPOINT commands

Toggling between Perspective and Parallel view

AutoCAD allows you to view and navigate a drawing the same way that
AutoCAD LT does, with the added navigation features below:

3D Orbit to rotate the camera around objects in the model
Walk and fly through navigation features

Swivel and adjust the distance from the camera

Camera objects

For more information on viewing and navigating a drawing with AutoCAD
and AutoCAD LT, see Chapter 3 of Book Il and Chapter 4 of Book V.

4+ Visualization/rendering: Visualizing a 3D drawing is rather basic in
AutoCAD LT compared to AutoCAD. AutoCAD LT allows you to display a
drawing in 2D wireframe, shaded, or as a hidden line drawing. AutoCAD
LT doesn’t support rendering or the use of visual styles.

For more information on visualization and rendering of a drawing in
both AutoCAD and AutoCAD LT, see Chapters 3 and 7 of Book V.

4+ Collaboration/sharing: Both AutoCAD and AutoCAD LT can be used to
create drawings for a project, but AutoCAD offers features that allow
better project collaborating or sharing of design ideas. Both support the
ability to open and save files to FTP sites and the project collaboration
site Buzzsaw. You can put drawings on the Web through the Publish to
Web feature and send sets of drawings via eTransmit. Where the two
differ is in the Sheet Set Manager, Publish, and Drawing Security features.

You can’t create 3D .DWF files from AutoCAD LT, nor can you publish
drawings to a named plotter with the PUBLISH command.

The Sheet Set Manager is not part of AutoCAD LT, so you can’t share
projects through this means with AutoCAD and AutoCAD LT users.

Drawings can’t be secured with passwords when using AutoCAD LT.

For more information on publishing drawings and project collaboration
with AutoCAD and AutoCAD LT, see Books VII and VIII.
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4+ Data exchange: If you are working with vendors or clients that use dif-
ferent drafting packages other than AutoCAD or AutoCAD LT, you might
run into exchange problems if you are using AutoCAD LT. AutoCAD LT
doesn’t offer as many file export and import options as AutoCAD does. If
you are using AutoCAD LT, you can’t import or export the following file
formats:

3D .DWF file (export)

ACIS file (import and export)
Stereolithograph file (export)
Encapsulated PS file (export)

3D Studio file (import)

Drawing Exchange Binary file (import)

For more information on exchanging drawings in other file formats other
than .DWG and .DXF from AutoCAD and AutoCAD LT, see Chapter 4 of
Book VIIL

4+ CAD standards: Both AutoCAD and AutoCAD allow you to manage CAD
standards through the use of drawing template files, layers, text styles,
dimension styles, and blocks just to name a few. However, AutoCAD
does supply a few additional tools that are not part of AutoCAD LT to
make sure everyone is following the same standards. These additional
CAD standards tools are

CAD Standards Manager
Batch CAD standards
Layer Translator

For more information on using CAD standards with drawings created in
AutoCAD and AutoCAD LT, see Chapters 1 through 3 of Book VIII.

4 Customization/programming: Outside of 3D modeling, customization
and programming is another key difference between AutoCAD and

AutoCAD LT. Although AutoCAD LT does support customization to a cer- Book IV
tain extent, it doesn’t support programming languages and platforms At
such as AutoLISP/Visual LISP, VB/VBA, and C++/ObjectARX. This makes
it impossible to get the same level of productivity out of AutoCAD LT §
that you can with AutoCAD. Many third-party applications run inside of 5
AutoCAD to help with things like block management, attribute extrac- o
tion, modifying objects, and even programs that connect to external F
data sources. 3
[x]
(5-]

For more information on customizing and programming AutoCAD and
AutoCAD LT, see Books IX and X.
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4+ Additional utilities: AutoCAD offers many features that are improve-
ments to older versions or features that are not available at all in
AutoCAD LT. Some of these features are

dbConnect Manager, which allows you to link objects in a drawing to
a table in a database.

Enhanced Attribute Editor, which is an improved version of the Edit
Attribute dialog box.

Enhanced Attribute Extraction wizard, which is an improved version
of the Attribute Extraction dialog box.

Express Tools, which contains additional tools that help with a vari-
ety of tasks in AutoCAD.

For more information on extracting and editing attributes in blocks,
see Chapter 1 of Book VI; for more information on Express Tools, see
Chapter 4 of Book IX.

4+ Software deployment: AutoCAD allows you to manage installation
through a Network Deployment wizard and software licenses with a
license manager. AutoCAD LT doesn’t offer network deployment and
license management, which can help to control the costs of the soft-
ware. For example, if you have five drafters, but only three are typically
in AutoCAD at a time, you could get away with buying only three net-
work licenses. The license manager hands out licenses until there are no
more to hand out. If no additional licenses are available, the fourth user
gets a message that says all licenses have been checked out. The Network
Deployment wizard allows you to streamline installing AutoCAD by
allowing you to specify settings like user profile names, custom support
paths, and files that should be used by default.

Determining Whether AutoCAD or
AutoCAD LT Is Best for You

Now that you have an idea of what the differences are between AutoCAD and
AutoCAD LT, you have to decide which one is right for you. It really depends
on what you are doing: 2D drafting, 3D modeling, plotting drawings, or doing
review comments. Here are six questions that should help you to determine
whether AutoCAD or AutoCAD LT would work best for you. This list isn’t
comprehensive, but it should be enough to get you going in the right direc-
tion. Keep in mind that you have to consider what your current needs are
versus what your future needs might be:
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1. Are the drawings you create or work with 2D only?
If so, you might think about using AutoCAD LT.

2. Do some of the drawings that you create or work with contain 3D
objects, or will you need to supply renderings to any of your clients?

If so, you might think about using AutoCAD: AutoCAD LT doesn’t support
rendering or the creation of 3D objects.

3. Will you be doing nothing more than some light drafting, plotting, and
reviewing of .DWG files?

If so, you might think about using AutoCAD LT unless you need to plot
renderings.

4. Do you need or want to run third-party applications to extend the
functionality that comes with the program?

If so, you will need to use AutoCAD and not AutoCAD LT because
AutoCAD LT doesn’t support certain forms of customization and pro-
gramming languages.

5. Do you plan on working with a variety of different clients and
vendors?

If so, you need to consider using AutoCAD and not AutoCAD LT.
AutoCAD offers a number of features that make working with vendors
and clients much easier due to the support of CAD standards and Sheet
Sets. If you choose to use AutoCAD LT, you can still work with vendors
and clients, but you might have some additional hurdles that you will
need to plan for. Vendors have a tough time working with the lowest
common denominator, AutoCAD LT in this case, if you are missing out on
productivity features.

6. What is your budget for software?

If you have a small budget and you do only 2D only drawings, the best
choice is AutoCAD LT. Another solution you might consider is to buy a
single seat of AutoCAD and the rest as AutoCAD LT if you are primarily
doing 2D only drawings. This would allow you to at least see what those
with AutoCAD created before they sent you the drawings, and it would
also give you a way to work with vendors that use AutoCAD.

Book IV
Chapter 1

If you have a medium or a large budget, you might consider buying
AutoCAD and using the license manager to allow you to buy fewer
licenses than you have staff. You can then add new licenses later as
needed. If your budget is limitless, you could buy a license of AutoCAD
for each user in your office and be done with it. (And hey, if you feel
extremely generous, we could always use one too!)

aouaseq 179YL
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No matter whether you plan on using AutoCAD or AutoCAD LT, remember
that you will be using the most popular CAD drafting package on the market,
and will be able to communicate using the .DWG file format. Using the .DWG
file is important because almost all the products that Autodesk develops can
either create or read a .DWG file, and many other CAD-drafting packages on
the market can at least read a .DWG file, which makes .DWG a popular
exchange file format.
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In This Chapter

1 Customizing AutoCAD LT

+ Object enabler technology

v~ Utilities available from Autodesk

v+ Companion products from Autodesk

v Third-party custom solutions

Fis chapter takes a look at extending AutoCAD LT. Extending AutoCAD
LT is similar to extending AutoCAD, but the choices you have are more
limited. What exactly do we mean by extending AutoCAD LT? Extending
means adding custom functionality beyond what comes out of the box.
Extending could be creating a custom toolbar, or it could be a way to save
drawing files to a different release without opening AutoCAD LT at all. In this
chapter, we take a look at customizing AutoCAD LT, discover what object
enablers are, and find out what utilities are available from Autodesk and
third-party developers.

Customizing AutoCAD LT

Although it is true that AutoCAD LT lacks some methods of customization
when compared to AutoCAD, it does offer some nice customizations. As pre-
viously mentioned in Chapter 1 of this minibook, AutoCAD LT doesn’t sup-
port programming languages such as AutoLISP/Visual LISP, VB/VBA, VB
.NET, C#, or C++ with ObjectARX. Even without the capability to use pro-
gramming languages to extend AutoCAD LT, you can create script files,
custom linetypes and hatch patterns, blocks, menu customization, and
some other items.

It’s in the script

Script files are ASCII or plain-text files that are created with a text editor

like Notepad. Script files contain command and command option sequences
and are used to reduce the number of repetitive or redundant steps in your
workflow. Script files can be used to do some sort of drawing cleanup after a
drawing is created, or it could be used to do initial drawing setup. Here is an
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example of a script file that creates a layer called Bolt, creates a hexagon
with a radius of 1” at the coordinates 5,5, and then performs zoom extents:

-layer m bolt c 5

polygon 6 5,5 1
zoom e

For more information on creating and using script files, see Chapter 4 of
Book IX.

Linetype and hatch patterns

AutoCAD LT comes out of the box with a variety of linetypes and hatch pat-
terns that are used for architectural and mechanical drawings. Although
quite a few patterns are available, chances are you might need others that
don’t come with the program. Linetype and hatch patterns are stored in
ASCII or plain-text files and can be created or modified with the use of a text
editor like Notepad. The CENTER linetype definition is shown here:

*CENTER, Center _
A,1.25,-.25,.25,-.25

For more information on creating custom linetypes and hatch patterns, see
Chapter 4 of Book IX.

Blocks and DesignCenter

Blocks are one of the most powerful features in AutoCAD LT. Blocks allow
you to create and define geometry once, and reuse it in as many drawings as
you need. The DesignCenter palette (see Figure 2-1) allows you to access and
place blocks in a drawing, as well as access other named objects in previ-
ously created drawings and add them to your current drawing. For more
information on creating and using blocks, see Chapters 1 and 2 of Book VI,
and for information on DesignCenter, see Chapter 3 of Book VI.
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The Tool Palettes window (see Figure 2-2) allows you to organize reusable
content so it can be accessed quickly. Tool palettes can contain blocks and
external references, tools that allow you to create tables and hatch patterns,
and commands. For more information on creating and using tool palettes,

see Chapter 3 of Book VI.
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Changing the user interface with CUI

AutoCAD LT supports the Customize User Interface (CUI) editor, which allows
you to create and modify toolbars, pull-down menus, shortcut keys, double-
click actions, and other user interface elements. For more information on cre-
ating and modifying user interface elements, see Chapter 2 of Book IX.

Book IV
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Diesel

Diesel is an interesting form of customization in AutoCAD LT. It allows you to
display values in the status bar area, and it can be used to create conditional
statements for commands when customizing the user interface with the CUI
editor. AutoCAD LT uses Diesel in several of its own command macros to
determine the current state before running a specific command. As an exam-
ple, when you use the shortcut key CTRL+0, which toggles Clean Screen on
and off, AutoCAD LT looks to see what the current state of Clean Screen is,
on or off, and executes the correct command to change the current state.
For more information on using Diesel with the status bar or menu customiza-
tion, see Chapter 2 of Book IX.

Command aliases

Command aliases are frequently used to quickly execute a command from
the command line. Instead of typing in the command’s full name, you can
type in a few letters to start it instead. Many of the popular commands have
command aliases assigned to them right out of the box, but you can create
or modify command aliases in the ACADLT.PGP file using a text editor such
as Notepad. For more information on creating and modifying command
aliases, see Chapter 1 of Book IX.

Desktop icons

Desktop icons are great for starting an application, but they offer so much
more capability than that. AutoCAD LT allows you to use command line
switches for changing the behavior of AutoCAD LT when it is started from a
desktop icon. For more information on modifying a desktop icon with com-
mand line switches, see Chapter 1 of Book IX.

Object Enabler Technology

Object enablers have been around since AutoCAD R14, but were first sup-
ported in AutoCAD LT with AutoCAD 2000i. Object enablers allow you to
view custom objects that are not part of the product by default. Often, you
hear about object enablers when you work with drawings that are created in
some of the AutoCAD-based vertical products such as Autodesk Building
Systems (ABS) or Architectural Desktop (ADT). An object enabler is a series
of files that AutoCAD LT loads on demand when it detects the use of custom
objects; this allows for the objects to be displayed in their original form and
be plotted correctly.

AutoCAD LT ships with a couple of the commonly used object enablers,
but some need to be obtained and installed separately from Autodesk or a
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third-party developer. Autodesk posts its object enablers on its Web site at
www . autodesk.com/enablers. If an object in a drawing requires an object
enabler and one is not available for the object, it is still displayed in most
cases, but as a proxy graphic. Proxy graphics are a graphical representation
of the original object in a drawing that is displayed in an older release or
when the object enabler is not installed. Proxy graphics were once called
zombies back in AutoCAD R13. (How fitting for a release numbered 13!)

Additional Utilities Available from Autodesk

Even though AutoCAD LT doesn’t allow for the loading of custom applica-
tions directly into the application, Autodesk provides some utilities that run
outside of AutoCAD LT to help with some processes. Some examples are util-
ities that convert drawings from one drawing file format to another, and
others give you the capability to view and mark up .DWF files that you can
create with the PLOT or PUBLISH commands.

DWG TrueConvert

DWG TrueConvert allows you to convert an AutoCAD or AutoCAD-based
drawing file so that it can be opened with AutoCAD R14 and later. DWG
TrueConvert can be used to save drawing files to the latest release or even
save them back to an older version (which comes in handy if you need to
send drawings to a vendor who might still be using an older release). DWG
TrueConvert doesn’t require AutoCAD LT to be installed on the computer
before it can be used because it is a completely standalone application. For
more information on saving drawing files, see Chapter 3 of Book VIII.

Viewers

Autodesk supports two different viewers that allow you to view .DWF and
.DWG files. If you are creating .DWF files, you should look them over before
sending them out. To do this, AutoCAD LT provides a free .DWF viewer called
Autodesk DWF Viewer, which allows you to view both 2D and 3D .DWF files. Book IV
(Autodesk DWF Viewer doesn’t support .DWF markups like its older brother Chapter2
Autodesk Design Review does, but then again, Autodesk Design Review isn’t
a free application.) Both of these viewers allow you to view the .DWF files
that you can create with AutoCAD LT; typically, as an AutoCAD LT user, you
won’t be purchasing Autodesk Design Review, but someone in your office
that reviews drawings might, though. For more information on creating .DWF
files and the two different viewers, see Chapter 4 of Book VIII.
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Companion Products from Autodesk

Autodesk creates a huge portfolio of applications for the design community.
Many of these applications are designed to be integrated solutions with
other applications it sells. AutoCAD LT is no different, and the drawing files it
creates can be used in other applications that Autodesk offers. Autodesk
also offers many software packages that help to improve productivity. Most
of these require the use of AutoCAD and not AutoCAD LT.

Autodesk Symbols 2000

Autodesk Symbols 2000 is a library of blocks that are ready to use in your
drawings. The library contains blocks that are useful whether you do archi-
tectural, mechanical, or electrical drawings. More than 12,000 symbols are
available for use through DesignCenter after the symbols have been installed.
By using a precreated symbol library, you can save yourself a lot of time creat-
ing each symbol from scratch. To find out more information about Autodesk
Symbols 2000, visit the Autodesk Web site at www.autodesk.com/symbols.

Autodesk VIZ 2007

Autodesk VIZ 2007 is a program that allows you to create complex 3D
objects, apply materials to them, add lights, and then generate a rendered
image or an animation. You can use the objects that you create in your 2D
drawings from AutoCAD LT in Autodesk VIZ to create a 3D model for visuali-
zation purposes. If having the ability to create renderings and animations is
important for your business, and you don’t need the ability to create or use
custom add-ons for AutoCAD, you might think about buying AutoCAD LT and
Autodesk VIZ instead of a single copy of AutoCAD. Autodesk VIZ allows you
to create stunning visual effects and photo-realistic renderings. Autodesk VIZ
2007 retails for about $1,900. To find out more information about Autodesk
VIZ 2007, visit the Autodesk Web site at www.autodesk.com/viz.

Third-Party Custom Solutions

Although Autodesk’s portfolio of applications is very large, one of the
company’s keys to success has been its large development community that
builds even more applications on or around Autodesk products. Most of the
applications that are developed by third-party developers are created to

run on top of AutoCAD or one of the AutoCAD-based vertical products and
not AutoCAD LT. Some companies create applications that run outside of
AutoCAD LT that allow you to view .DWG and .DWF files online through Java-
based applications, or to access block libraries. Many of these types of appli-
cations can be found using your Web browser and search engine.
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Block utilities/libraries

One of the most time-consuming things about starting to use AutoCAD LT

is that you have to create your own block libraries. To save time, you can
download block libraries or symbols from the Internet. Many are available —
it is just a matter of finding them.

Table 2-1 lists some of the different Web sites that contain block utilities or
symbol libraries that can be used with AutoCAD LT. Some are free, others
aren’t.

Table 2-1 URLs to Block Utilities/Libraries

Web Site and URL Description

AutoCAD Block

www . autocadblock. com Site lists symbol libraries and utilities that contain

symbols for architectural, landscaping, and mechani-
cal drawings. Some of the symbol libraries are free,
while others start at about $515 up to about $1,125.

CADdepot

www . caddepot . com Site lists a wide range of 2D and 3D symbols for a vari-
ety of industries. Most of the symbols on the site are
free for download after registering on the site; some
symbols and utilities might need to be purchased,
though. The symbols and utilities that are for purchase
are available in a wide range of prices.

CADOPOLIS.COM

www . cadopolis.com Site lists symbols and utilities that contain a wide

range of 2D and 3D symbols for a variety of industries.
There are symbols and utilities that are available for
free and for purchase. The symbols and utilities that are
for purchase are available in a wide range of prices.

CADToolsOnline.com

www . cadtoolsonline.com Site lists symbol libraries for architectural and piping
drawings. Some of the symbol libraries are free, while
others have a price range that starts at about $60 and
up based on the number of users and the type of
library.

Viewers

A number of third-party applications allow you to view .DWG and .DWF

files all in the same application; many allow you to view image and other file
formats as well. Most of the third-party viewers aren’t free, but if you shop

Book IV
Chapter 2
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around, you can find a reasonably-priced version. You can find viewers in all
shapes and sizes: from desktop and server applications to even palmtop or
PDA applications.

Table 2-2 lists some of the different viewers on the market that are available
from third-party developers.

Table 2-2 URLSs to Block Utilities/Libraries

Web Site and URL Description

AutoVue

www . cimmetry.com AutoVue is one of the viewers on the market that sup-

ports the widest range of document and file formats.
You can view AutoCAD drawings, .DXF, .DWF, .PDF,
image files, Office files, and many others. Pricing is
available by request only.

Brava! Viewer

www . bravaviewer.com Brava! comes in different styles and allows you to
view Word, Excel, AutoCAD drawings, .PDF, and .DWF
files plus many others in a single application. It also
supports markups that can be saved in an XML file.
Prices tange from about $30 to $350.

CADViewer

www . cadviewer .com CADViewer is a Java-based CAD viewing tool that
supports AutoCAD drawings files, .DXF, .PDF, and
some other file types. Pricing is available by
request only.

PocketCAD DWFViewer

www . pocketcad.com PocketCAD DWFViewer is an application that runs on
a device running Windows CE 3.0 or higher and allows
you to view .DWF files on the go. Prices range from
about $30 to $260.




Chapter 3: Mived Environments

In This Chapter
v Using AutoCAD LT and AutoCAD in the same office
1~ Exchanging drawing files between AutoCAD LT and AutoCAD

In this chapter, we take a look at issues that you encounter when you use
AutoCAD LT and AutoCAD in the same environment, or when you open
drawings created in AutoCAD with AutoCAD LT. Although AutoCAD LT and
AutoCAD both create .DWG files and are both developed by Autodesk, that
doesn’t mean both see the same things in the same way. If you read the first
two chapters of this minibook, you already know that AutoCAD LT and
AutoCAD have differences. If you exchange drawings between the two pro-
grams, you discover even more differences.

Using AutoCAD LT and AutoCAD in the Same Office

AutoCAD and AutoCAD LT are developed with the needs of many different
users in mind, which sometimes means that an office ends up using both
programs. If you already use AutoCAD in your office and are considering
purchasing copies of AutoCAD LT to control costs, you should pay close
attention to this section.

Budgeting

When it comes to budgeting, the first thing you may think is, “That’s not my
job.” But it is, when you think about it: You are the one who supports or
uses the application. Everyone plays an intricate part in making the best
decision for your department or the company that you work for. Three main
things to consider during budgeting are hardware, software, and training for
AutoCAD and AutoCAD LT. Being on the same release of AutoCAD and
AutoCAD LT can make things run more smoothly than if everyone is on dif-
ferent releases, so you will want to keep in mind how much upgrades will
cost and even new seats that you may need in the upcoming year.

To help make budgeting for upgrades easier, Autodesk offers an annual sub-
scription program. As you upgrade your software, keep in mind that your
hardware needs may change. Having the right hardware is key to ensuring
that AutoCAD runs efficiently. Leasing computers on a two- to three-year
cycle can help with budgeting and ensure that you are always on pretty cur-
rent hardware.
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The final piece of the puzzle is training, which is covered in the next section.

Training

Properly trained drafters help to ensure the creation of quality drawings.
AutoCAD and AutoCAD LT by themselves are not enough to create a good
drawing; it also takes time and a disciplined drafter committed to following
company CAD standards. Training not only helps to ensure quality drawings,
but it can also make sure that drawings are communicated properly to inter-
nal departments and external vendors. Training can be done by an external
company or an internal member of the drafting department. You should not
assume that everyone knows and understands the company’s CAD stan-
dards, or how to communicate designs with internal or external resources.

Communication

Communication is important in every aspect of the drafting process: from
getting the idea of the client on to a drawing to making sure the vendors
have the right information that they need to make a proper bid on the proj-
ect. Properly communicating company CAD standards is vital to making a
mixed office run smoothly because a process that works on AutoCAD might
not necessarily work on AutoCAD LT. Because AutoCAD LT lacks some of the
features of AutoCAD, AutoCAD LT should be used as the basis for any com-
pany CAD standards. In the same way, those who use AutoCAD LT need to
communicate what is not working for them back to those creating drawings
with AutoCAD. A communication breakdown sometimes occurs when
AutoCAD users don’t realize that a certain function isn’t supported by
AutoCAD LT and users of AutoCAD LT don’t report the problem.

Environment

Although AutoCAD and AutoCAD LT are very similar, they are slightly different
in the interfaces and commands that they offer. Just because someone knows
AutoCAD fairly well, don’t automatically assume that they will be proficient on
AutoCAD LT. Some features that they routinely use in AutoCAD might not be
available in AutoCAD LT, which can lead to some frustration by the user.

Customization

AutoCAD and AutoCAD LT share some commonalities when it comes to cus-
tomization. To make sure upgrading and supporting the two programs is as
easy as possible, place all custom files in networked locations so they can be
shared between the two programs. Files like scripts, custom linetypes, and
hatch pattern files are easily shareable between the two programs because
they are not product- or release-specific, whereas CUI files, standard line-
type, and hatch pattern files are specific to each program. Blocks and draw-
ing templates are program neutral, so you can safely create blocks and
drawing templates that can be shared between both programs.
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Deployment/installation

Installing and deploying AutoCAD and AutoCAD LT are somewhat different
based on the type of licensing you have or plan on purchasing. AutoCAD can
be deployed using a license manager to hand out software licenses, which
makes it easy to manage the number of licenses in use. AutoCAD LT doesn’t
support this option. Both AutoCAD and AutoCAD LT support Stand-Alone
and Multi-Seat Stand-Alone installation options. AutoCAD LT doesn’t support
the use of profiles, so you need to manually add or change any support
paths that are necessary so that each one can locate company standard files
such as templates and blocks.

Making the Trip from AutoCAD to AutoCAD LT

Exchanging drawings that are created in AutoCAD with those who use AutoCAD
LT can be a challenge at times, based on which features you are using. If you
use AutoCAD and are sharing drawings with someone who uses AutoCAD LT,
you don’t have to do anything special. However, you might need to show some
restraint in using certain features if it is important for those on AutoCAD LT to
be able to modify your drawings. In the next sections, we have gathered some
of the key areas that you should know about if you are an AutoCAD LT user and
work on drawings created in AutoCAD. We also cover issues for those of you
who use AutoCAD and send out drawings to vendors that use AutoCAD LT.

2D drafting

AutoCAD allows you to create multilines. Multilines are a series of parallel

lines that can have different colors and linetypes for each parallel line seg-

ments that the object is made up of. They are commonly used for streets

showing the main part of the road and any offsets that the municipality or

city requires from the road, and they can also be used for floor and basement

plans of buildings. When a drawing with multilines is opened in AutoCAD LT,

you don’t have any control over the object other than changing its standard

object properties and being able grip edit the object. If you need to make Book IV
changes to the lines themselves, you have to explode the multiline object, Chapter 3
which could be frustrating to the individual who originally sent you the

drawing if you need to send it back to them.

Another issue that you have to deal with is raster images that are referenced
externally. Raster images are displayed in the drawing with their previous
values, but you can’t alter their appearance like you can in AutoCAD. The
raster images are listed in the External References palette (see Figure 3-1)
and can be unloaded or reloaded as necessary, but can’t actually be detached.
For more information on multilines, see Chapter 1 of Book II; for more infor-
mation on raster images, see Chapter 4 of Book VI.
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Figure 3-1:
The External
References
palette.

b %

G-2-a
File References
Ref...

Skatus Sizer

B putoran LT Cpened 50,0 KE

Elllogo T nader 15,048
Unload

Reload &

Details &
Reference M., Logo s
Status Loaded [
Size 15.0 KB
Type PHG
Date 10/27/2005 B:47:43 A
Saved Path C\Documents and Sett
Found At 2 Documents and Sekt
Color Systern RGE L
£ >

<

El ¥ EXTERNAL REFERENCES

3D modeling

The ability to work with drawings that contain 3D solids and surfaces is very
limited in AutoCAD LT. In AutoCAD, you have many different ways to modify
3D solids and surfaces, such as through the use of grips, the SOLIDEDIT com-
mand, and others; these are not available in AutoCAD LT. AutoCAD LT doesn’t
allow you to create and modify 3D solids and surfaces besides using basic
modifying commands such as move, copy, and rotate. You are limited to
changing only general properties of 3D solids and surfaces, such as their
color, what layer they are on, and the other general properties that are avail-
able for the object. However, a 3D solid or surface can be exploded into wire-
frame models that are made up of regions or 2D objects.

If a drawing has a section plane and Live Section is enabled for the section
plane, it won’t look the same in AutoCAD LT as it does in AutoCAD (see
Figure 3-2). The Live Section is not displayed, but the section plane will exist
in AutoCAD LT, so if the drawing is saved and reopened in AutoCAD, it looks
just like it did before it was opened in AutoCAD LT. For more information on
3D solids and surfaces, see Chapters 4 through 6 of Book V.

Figure 3-2:
Live Section
enabled in
AutoCAD,
and how it
looks in
AutoCAD LT.
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Annotation

AutoCAD and AutoCAD LT have very few differences in annotation. The two
main differences that you have to be concerned about when exchanging draw-
ing files between AutoCAD and AutoCAD LT are gradient fills and fields. Both
gradient fills and fields are displayed in AutoCAD LT without any problems,
but they can’t be created or edited. If you use the HATCHEDIT command on a
gradient fill, it turns into a solid fill. If you change the boundary associated to
the gradient fill, it continues to exist as a gradient fill in the drawing.

Fields are used to associate properties of a drawing file or objects in the draw-
ing with a text, multiline text, or an attribute. Fields can help make sure that
information remains in sync when something is changed in the drawing or an
object is modified. Based on the type of field, it either displays the last value
or it updates based on changes in the drawing file. The expression that the
field is created with can’t be modified, but you can replace the field with plain
text. That isn’t recommended. If the field is replaced with plain text, however,
it breaks the functionality that the field provided if the drawing is opened back
in AutoCAD. For more information on hatch in a drawing, see Chapter 3 of
Book III; for more information on Fields, see Chapter 1 of Book III.

Viewing

Cameras are displayed as glyphs in AutoCAD and are accessible from either
the drawing window or the View Manager dialog box. AutoCAD LT doesn’t
display camera glyphs in the drawing, but it does list the camera in the View
Manager dialog box. AutoCAD LT also is missing several properties that are
available for a named view in AutoCAD. These properties are for things like
backgrounds and live sections, which are not supported in AutoCAD LT.

Uisualization

Drawings created with AutoCAD can contain a variety of additional objects
and settings that really don’t do anything in AutoCAD LT: One example is
lights. Lights appear in the drawing and can be selected and modified via
grips, but their properties can’t be altered. Because AutoCAD LT lacks the
ability to do renderings, you won’t be able to use any material assignments
that are on objects or be able to modify the materials that are stored in a
drawing file. This can cause problems if a viewport on a layout tab is set up
to use the Realistic visual style that AutoCAD offers. For the most part, all
visual styles are supported by AutoCAD LT, with the exception of Realistic
(see Figure 3-3). The visual styles can’t be changed, but if they are assigned
to a viewport on a layout tab, they will be displayed correctly.

Book IV
Chapter 3

SJUaWUOIIAUT

PaxiN



2 74 Making the Trip from AutoCAD to AutoCAD LT

Figure 3-3:

Visual styles
saved with a
drawing are
displayed in
AutoCAD LT.

CAD Standards

The CAD Standards feature of AutoCAD uses Drawing Standards (DWS) files
that are associated with the drawing file, but AutoCAD LT doesn’t use or
know about these files. This isn’t a problem with AutoCAD LT because the
feature doesn’t exist in LT, but it can become a nightmare if you work on a
set of drawings and use the eTransmit feature to repackage them up to send
them off to someone else. Because AutoCAD LT doesn’t know about these
types of files, it doesn’t know enough to inform you that they might be miss-
ing or are needed when sending off a set of drawings.

Collaboration/sharing

Collaboration plays a large role in designing a new building, creating a new
machine, or engineering a new bridge. All these things and many more don’t
just happen by themselves: They require collaboration. AutoCAD allows you
to create a Sheet Set of all the drawing files that are related to a project and
maintain links from model views to drawing layouts. AutoCAD LT doesn’t
support the use of Sheet Set (DST) files because it doesn’t have the Sheet
Set Manager palette, so any values that reference part of the Sheet Set file
through fields can’t be updated. If a field value needs to be changed, it must
be replaced with plain text, which causes problems if it is reopened later in
AutoCAD.
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Chapter 1: Introducing
the Third Dimension

In This Chapter

v+ Understanding the different types of 3D models

v+~ Entering coordinates above the x,y plane

Flis book of the AutoCAD & AutoCAD LT All-in-One Desk Reference For
Dummies takes you on a journey to a whole new dimension. No, we are
not talking about space or time travelling to a different location, but rather
giving your drawings some depth. AutoCAD is a very powerful 2D drafting
tool, but it also sports a nice set of tools for 3D modeling. AutoCAD LT, unlike
its older counterpart, has limited 3D drafting, visualization, and viewing
capabilities. Most of what is discussed in the chapters of this book is geared
toward AutoCAD only; but there are some things that apply to AutoCAD LT,
and we point those out to you.

Most of us think best when drafting in 2D, but this is most likely due to a
comfort level that we have from learning 2D drafting first and therefore,
making 3D drafting seem somewhat foreign and difficult. In reality, 3D draft-
ing is not all that difficult — much of what was covered in early chapters
applies to 3D drafting.

AutoCAD allows you to create three types of 3D models: wireframe, solid,
and surface. AutoCAD LT is only capable of creating and editing wireframe
models, but you can use it to view solid and surface models.

Throughout the chapters in this book, you see how to select points above
the x,y coordinate plane, and how to adjust and manipulate the coordinate
system to more easily use drafting commands. After you have mastered
selecting points in the drawing and working with the coordinate system,

we take you on a tour of some of the navigation and viewing commands that
AutoCAD and AutoCAD LT offer for viewing 3D models. After you have the
basics under your belt, we show you how to use many of the different mod-
eling and editing commands that are used with solids and surfaces. To close
out the chapter, we touch on the concepts of creating renderings from
AutoCAD.
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Understanding the Different Types of 3D Models

Figure 1-1:

Wireframe

model of a

cube with a
hole in the

center.

AutoCAD and AutoCAD LT allow you to create and view drawings that are
created as wireframe, surface, or solid models. These different types of
models each have their own strengths and weaknesses.

4 Wireframe model: Wireframe models are created with the use of 2D

objects such as lines, arcs, polylines, and circles with no thickness. The
2D objects are drawings in 3D space using full x, y, and z coordinates,
not just x- and y-coordinate values. Wireframe models are not intended
to be used for visualization, as they do not have any surface area that
allows them to hide objects beyond the geometry that they represent.
Wireframe models provide for a great starting point when creating sur-
face models. Figure 1-1 shows a cube with a hole drawn as a wireframe
model and displayed with the HIDE command. You can think of a wire-
frame model as being much like a wire hanger.

Figure 1-2:
Surface
model of a
cube with a
hole in the
center.

Surface model: Surface models are created from 3D objects called faces.
Faces can be made up of three or four points. Unlike wireframe models,
surface models can be used for visualization. However, based on the
type of visualization such as a hidden line drawing, some clean up might
be necessary to hide the edges of faces that form a surface. AutoCAD
offers several commands that allow you to create and manipulate sur-
faces. Figure 1-2 shows a cube with a hole drawn as a surface model and
displayed with the HIDE command. The HIDE command shows the sur-
faces and edges of the surface model. You can think of a surface model
as being much like a cardboard shipping box: It is hollow on the inside.




Figure 1-3:
Solid model
of a cube
with a hole
in the
center.
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4+ Solid model: Solid models are created from 3D objects called solids
(“primitives”). Solid objects are much more flexible than faces and 2D
objects for creating wireframe and surface models. Solid objects can be
created and modified through a number of commands in AutoCAD.
These commands allow you to create primitive objects such as cubes,
spheres, and cones, and then combine them to form compound objects.
Unlike surfaces, solids do have mass and therefore are not hollow, which
allows you to capture information about them. Solids are much easier to
work with than surfaces. Figure 1-3 shows a cube with a hole drawn as a
solid model and displayed with the HIDE command. The HIDE command
shows the surfaces and edges of the solid model. You can think of a solid
model as being much like a block of solid wood: It is not hollow on the
inside unless you core it out.
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Entering Coordinates above the x,y Plane
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Everything you have done up to this point has been with x- and y- coordinate
values. This is all about to change as you step in a whole new direction with
the z coordinate. Most of AutoCAD’s commands are not true 2D commands;
this means that commands like a PLINE for creating a Polyline can only be
drawn at a single z height (or elevation). Out of what are known as the
traditional 2D commands, only the LINE command allows you to specify

two different z heights for the start and end points for the object that is
being created with the command.

Orthographical (Ortho) mode has been improved for use with 3D drafting
in AutoCAD 2007, and not AutoCAD LT 2007. You are now able to drag the
crosshairs up or down after you specify the first point when orthomode is
enabled, to specify the next point in the z direction. A tooltip is displayed to
tell you which direction from the first point you are moving in.

Manually inputting coordinates

Chapter 6 of Book I explains how to input relative and absolute coordinates
for 2D drafting. Both of these coordinate formats are great for both 2D and
3D drafting. The only difference that you will find when doing 3D drafting is
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the need to enter a z coordinate value. Along with those coordinate input
formats, the relative polar coordinate input is expanded to include two addi-
tional formats called cylindrical and spherical designed for 3D drafting. Of
course, you can use object snaps, point filters, and object snap tracking
when creating and modifying 3D objects.

You can input coordinate values through the use of Direct Distance Entry
and the using of Dynamic Input. Both of these are covered in Chapters 2 and
6 of Book L.

Absolute x, y, and z coordinates

Working with absolute coordinates in 3D drafting is just like you would

input them for 2D drafting, except you add in the z coordinate. You supply
the coordinate input in the format x,y,z. An example of using the LINE com-
mand to drawing a line in 3D space using absolute coordinate entry is shown
below.

Command: line
Specify first point: 0,0,0
Specify next point or [Undo]: 2,3,7.25

Relative x, y, and z coordinates

Working with relative coordinates in 3D drafting is just like when inputting
them for 2D drafting, except you add in the z coordinate. You supply the
coordinate input in the format of @x,y,z. An example of using the LINE com-
mand to drawing a line in 3D space using relative coordinate entry is shown
below.

Command: line
Specify first point: 2.125,7,-3
Specify next point or [Undo]: @0.5,0.125,7

Cylindrical coordinates

Cylindrical coordinates is the first of two coordinate entry formats based on
relative polar coordinate entry for 3D drafting. You supply the coordinate
input in the format of @XYdistance<angle,Z. An example of using the LINE
command to draw a line in 3D space using cylindrical coordinate entry is
shown below. Figure 1-4 shows the results in AutoCAD.

Command: line
Specify first point: 0,0,0
Specify next point or [Undo]: @5<45,2
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Figure 1-4:
Line created
in 3D space
using
cylindrical
coordinate
input.
QNING/ Cylindrical coordinate input doesn’t work very well when Dynamic Input is
¥ enabled. We recommend turning it off by clicking the DYN button on the
status bar area or pressing F12 when wanting to use cylindrical coordinate
input.
Spherical coordinates
Spherical coordinates is the second of the two coordinate entry formats that
is based on relative polar coordinate entry for 3D drafting. You supply the
coordinate input in the format of @XYdistance<angle<anglefromXY. An exam-
ple of using the LINE command to draw a line in 3D space using spherical
coordinate entry is shown below. Figure 1-5 shows the results in AutoCAD.
Command: line
Specify first point: 0,0,0
Specify next point or [Undo]: @5<30<30
@5<30<30
///A\\ e
]
— C}QQQ'Q //
Figure 1-5: A .
Line created 3?
in 3D space
using
spherical -
coordinate =l
input. ~
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Point filters

Point filters can be used for constructing coordinate values based on exist-
ing points on an object whether it is in 2D or 3D space. There are three point
filters that are specific to 3D drafting. These point filters are xy, xz, and zy.
Point filters can be typed in at the command line or dynamic input tooltip,
selected from the Object Snap shortcut menu by pressing and holding down
the Shift key while right-clicking, or right-clicking and choosing the Snap
Overrides. Here is an example of using the LINE command to draw a line in
3D space using the xy point filter entry:

Command: line

Specify first point: specify a point or a coordinate value
Specify next point or [Undol: type .xy and press enter

of specify a point or a coordinate value

(need Z): specify a point or a Z height value

Object snaps

Object snaps are a great way to ensure that you have the precise point in the
drawing that you want. AutoCAD has a toggle that controls whether the z
height of the point you select using an object snap or the current elevation
value is used. (We cover changing the current elevation later in this chapter.)
To switch between these two, follow these steps:

1. Choose Tools=>Options.
The Options dialog box appears.
2. In the Options dialog box, click the Drafting tab.
3. Click the Replace Z Value with Current Elevation check box.

When you check the current elevation check box, AutoCAD substitutes
the z height that was obtained with the object snap for the current ele-
vation. When the check box is unchecked, the z height of the coordinate
that is specified with the use of the object snap is used.

AutoCAD LT does not have the Replace Z Value with Current Elevation option.

Object snap tracking

Object snap tracking can be used above the current x,y plane. Object snap
tracking has been enhanced in AutoCAD 2007 to improve the functionality of
being able to track in the z direction. When using object snap tracking in the z
direction, AutoCAD provides feedback in the form of tooltips when you are
moving in the positive or negative z direction. Figure 1-6 shows an example of
the tooltip displayed in AutoCAD when using object snap tracking in 3D space.
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AutoCAD LT does support the use of object snap tracking in 3D space, but it
doesn’t provide the same level of feedback that AutoCAD does.

Specifying a z height when entering coordinates is not the only way to draw
objects above the X,y plane; you can specify a default z height for all new
objects as they are created. If you are drawing a bunch of objects that need
a specific z height, this can be a very efficient way to ensure they are placed
at the correct height. You use the ELEV command to specify a new z height

don’t use object snaps; if you use object snaps, the z height of the object
snap is used by default. See the previous section “Object snaps” for more

To set a new elevation value, type ELEV at the command line or the dynamic
input tooltip and then enter a new elevation value at the Specify new default
elevation <0.0000>: command prompt. Then, at the Specify new default thick-

Figure 1-6:
Object snap
tracking in
the Z
direction.
Elevation . . . going up
for new objects that are created. The value specified is used only if you
information.
ness <0.0000>: command prompt, press Enter.
A\

Instead of changing the current elevation, you can use a custom UCS (user
coordinate system) to create objects at a specific elevation. We cover using
the user coordinate system and the world coordinate system in the next
chapter.
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Chapter 2: Using the
3D Environment

In This Chapter
v Setting up AutoCAD for 3D
v+~ Understanding what the UCS icon is telling you

1 Changing the coordinate system for 3D drawing

Fe preceding chapter covers the three types of 3D models you can
create with AutoCAD and AutoCAD LT, as well as how to enter coordi-
nates above the xy plane in the z direction. This chapter helps you get a
grasp of the 3D environment in AutoCAD and AutoCAD LT. We take a look

at some of the key settings and features that help you work efficiently with
3D models. Some of these settings are for getting the most out of your com-
puter investment by enabling hardware acceleration if it is available, and
some control the appearance of the grid, background color, and more in the
drawing window.

One of the keys to becoming an efficient drafter with AutoCAD is under-
standing what the UCS icon is indicating, and in 3D drafting that is no differ-
ent. The UCS icon provides you with information on which way is up or
down in your model, and the direction of the X, y, and z axes. Not only can
you get information from the UCS icon about the different directions that
the axes are going in, but you can modify the coordinate system to draw 2D
objects on a different plane. 2D objects are always drawn on the xy plane, so
by changing the direction or elevation of the plane you can draw 2D objects
on a new plane.

Setting Up AutoCAD for 3D

AutoCAD and AutoCAD LT offer various display, hardware, and drafting
options that all play different roles when working with 3D. Properly con-
figuring and understanding all these options can make things go more
smoothly. Because AutoCAD LT doesn’t support the creation of surface and
solid models, many of these options are not available. We point out the dif-
ferences as we go along.
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Figure 2-1:
Customizing
the
appearance
of the
drawing
window

for 3D.

Orienting yourself in the drawing window

The drawing window is where you create, modify, and view your 3D models.
Based on how you are viewing your model, the background color, grid dis-
play, and the crosshairs change in the drawing window. You can customize
the display settings for the drawing window through the Drawing Window
Colors dialog box (see Figure 2-1). The Drawing Window Colors dialog box
can be displayed by clicking the Colors button under the Window Elements
section on the Display tab of the Options dialog box.

T Drawing Window Colors &
Contesxt: Interface element: Color:
20 model space Top of sky background &l Ozo4,211,242 w |
Sheet | layout Background sky harizon r -
30 paralel projection Background ground origin
30 perspective projection Background ground horizon
Block edkor Bottom of 2arth background
Command line Background earth horizon
Plot preview Crosshairs
Grid major lines Restore currerk element
Grid miree lines
Autotrack vector

Autosnap marker
CDrafting tool o

> | Restore al contexts

Preview:

[Lapplymcise | [ cawel | [ meb

In AutoCAD, you have the contexts 3D parallel projection and 3D perspective
projection that are related to 3D drafting. In AutoCAD LT, you have only one
context called hidden that is related to 3D drafting.

The following procedure explains how to adjust the colors of the Crosshairs
interface element under the 2D model space content:
1. Choose Tools=>Options.
The Options dialog box is displayed.
2. In the Options dialog box, click the Display tab.

The Display tab is set to current.
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3. On the Display tab under the Window Elements section, click Colors.
The Drawing Window Colors dialog box is displayed.
4. From the Context list, select 2D Model Space.

The Preview at the bottom of the dialog box updates to show the current
colors that the interface elements are set to, and which interface ele-
ments are available.

5. From the Interface element list, select Crosshairs.

The Color drop-down list displays the current color, and the Tint for

X, Y, Z check box becomes enabled. The Tint for X, Y, Z option is used to
give the crosshairs the colors of red, green, and blue to represent the
different axes. The X axis is always represented by the color red, Y by
green, and Z by blue. The tinting is by default enabled for the different
3D contexts.

6. Click Apply & Close.

The changes are saved and the Drawing Window Colors dialog box is
closed.

7. Click OK.

The changes are saved and the Options dialog box is closed.

The Drawing Window Colors dialog box is an updated version of the Color
Options dialog box.

Customizing crosshairs and dynamic input

You can customize the display of the crosshairs and dynamic input for work-
ing in 3D in AutoCAD only. These changes go beyond being able to change
the size of the crosshairs or even color tinting of the different axes for the
crosshairs. These options allow you to enable the display of labels on the
crosshairs so you know which direction X, Y, and Z are without having to
have the UCS icon displayed. You can also control whether the Z direction is
indicated on the crosshairs as well. If you use Dynamic Input and manually
enter points, you can control the display of a field for entering z-coordinate
values. You can change these options under the 3D Crosshairs and Dynamic
Input sections of the 3D Modeling tab in the Options dialog box.

The 3D Modeling tab of the Options dialog box is new and has a variety of
options that affect the display of the crosshairs, dynamic input, UCS icon,
creation and viewing of 3D objects, and the 3D navigation tools. The 3D
Modeling tab is not available in AutoCAD LT.
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Figure 2-2:
Dashboard
allows for
quick
accesstoa
variety of
different
3D-related
tools.

Using workspaces to switch between
2D and 3D drafting

AutoCAD and AutoCAD LT come with a feature called Workspaces. Workspaces
were introduced in AutoCAD 2006 and can play a role in efficiently switching
between 2D and 3D drafting. You can create a workspace that displays the nec-
essary tools that you need for a particular set of tasks. We talk about creating
workspaces in Chapter 2 of Book IX.

A new workspace called 3D Modeling comes with AutoCAD 2007 but doesn’t
come with AutoCAD LT 2007. This workspace displays the Dashboard
palette; Tool Palettes window; and the Workspaces, Standard, and Layers
toolbars. The layout tabs at the bottom of the drawing window are hidden.

Introducing toolbars and palettes for 3D

AutoCAD comes with a number of toolbars and palettes that contain 3D-
related tools for creating, editing, and navigating your drawings.

4+ The Modeling toolbar contains tools for creating 3D solid objects, and
some of the more common editing tools.

4+ The Solid Editing toolbar contains tools that are used for editing indi-
vidual faces and edges of a 3D solid.

4+ The Dashboard palette, shown in Figure 2-2, enables you to access
many of the different commands for creating, editing, navigating, and
visualizing 3D models.
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Figure 2-3:
Performance
tuning
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rid of that
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AutoCAD provides other toolbars and palettes that are useful for working
with various different aspects of 3D in AutoCAD. Many of these palettes and
toolbars are discussed in later chapters.

The Dashboard palette is new in AutoCAD 2007 and allows you to access
both 2D and 3D drafting commands, along with other 3D features. Dashboard
is not part of AutoCAD LT 2007.

Accelerating your hardware

AutoCAD can use either software or hardware acceleration to display a
drawing to the screen. AutoCAD LT, however, does not support hardware
acceleration. By default, AutoCAD uses hardware acceleration (because
some graphics cards are not designed for CAD applications).

When you first start AutoCAD, the program evaluates your graphics card
and determines whether it can use hardware acceleration. If it can, it informs
you that your hardware is capable of this. At times your graphics card might
not support all features using hardware acceleration, so AutoCAD tweaks its
display settings a little to help optimize regenerations and overall display
quality of the drawing window. This process is called adaptive degradation.

The Adaptive Degradation and Performance Tuning dialog box (see Figure 2-3)
allows you to change the display options and toggle the use of hardware accel-
eration. To open the Adaptive Degradation and Performance Tuning dialog
box, open the Options dialog box and click the Performance Settings under
the 3D Performance section of the System tab. Click Manual Tune to toggle the
use of hardware acceleration and options that are related to using hardware
acceleration, such as Full Shadow and Smooth Line display.

4 Adaptive Degradation and Performance Tuning B[]
Adaptive degradation Hardware and petformance tuning
Tagais PR The current hardwars configuration

5 = i being managed by the
> Performance Tuner.
1) Unicheck ke that should not degrade,
‘% (Cnky a Few recommended)
Degradation arder:
(] view-Dependent Obieck] &
[¥] Line Antialiasing
[¥] Lightng Check for Updates
[¥] Transparency Qualty
[ Ful shadows
[¥] Transparency
[¥] Discard Backfaces
[¥] Ground shadows
[¥] Edae Stles L.
i Leatn about adaptive degradation. i| Learn about perfoemance buning.
ok [ concel | [ Heb
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Understanding What the UCS Icon Is Telling You

Figure 2-4:
UCSicon
displayed
in model
space

with 2D
Wireframe
visual style.

The UCS icon is similar to a tour guide and helps you to stay on track as to
which path you should be following. The UCS icon doesn’t tell you to stay
with the tour and to keep up, but it does help you find the positive x, y, and
z axes. It is important to know which direction these axes are going in for
creating objects. It can get very frustrating when it doesn’t look like your line
is being created when it actually is and you just don’t see it.

Orientating yourself with the UCS icon

The UCS icon can be strange at times depending on how you are viewing the
drawing and whether you are in model or paper space. AutoCAD and
AutoCAD LT display a different UCS icon for several situations; understand-
ing these situations is necessary in order to help maximize the use of the
user coordinate system, which we talk about later in this chapter. The UCS
icon lets you know how the coordinates you type at the command line or
dynamic input tooltip are affected. The appearance of the UCS icon is affected
by the current visual style or whether the current view is displayed as hidden
or shaded. We talk about visual styles, hide, and shade in Chapter 3 of this
book.

Model space and 2D Wireframe visual style

When you are looking straight on at the xy plane, the UCS icon shows the
positive direction for the x and y axes. If the current view of the xy plane is
from an angle like one of the preset isometric views, you will see the x, y, and
z axes called out. Figure 2-4 shows the UCS icon as it would appear when
looking at the xy plane straight on and from an angle. If you don’t see a box
at the intersection of the x and y indicators, this informs you that you are
not looking at the drawing from the world coordinate system.
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Figure 2-5:
UCSiicon
displayed in
model
space with
one of the
3D visual
styles.

Figure 2-6:
UCSicon
displayed on
a paper
space
layout.
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Model space and a 3D visual style

When you are looking straight on at the xy plane, the UCS icon shows the
positive direction for the x and y axes, and the z direction coming toward or
moving away from you. If the current view of the xy plane is from an angle
like one of the preset isometric views, you will see the x, y, and z axes called
out. Figure 2-5 shows the UCS icon as it would appear when looking at the xy
plane straight on and from an angle.

Paper space layout

Paper space layouts display a UCS icon that is a triangle and indicates the
directions of the positive x and y axes only (see Figure 2-6). You cannot
change the display angle of a paper space layout because the paper space
layout is used to represent a virtual piece of paper.

Controlling the display of the UCS icon

The UCS icon by default has a 3D appearance to it and is displayed as a
specific size, color, and location. You can tailor the display of the UCS icon
with the UCS Icon dialog box (see Figure 2-7) and the 3D Modeling tab of
the Options dialog box. To display the UCS Icon dialog box, choose View=
Display=>UCS Icon=>Properties.
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Figure 2-7:
Changing
the
appearance
of the UCS
icon with
the UCS
Icon dialog
box.
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You can control where and if the UCS icon is displayed on-screen by using
the following options.

4+ Hide/Show the UCS icon: You can toggle the display of the UCS icon by
choosing View=>Display=>UCS Icon=>On.

4+ Display the UCS icon at the origin: You can toggle the display of
the UCS icon at the origin of the drawing by choosing View=Display=
UCS Icon=>Origin. If the UCS can’t be displayed at the origin, AutoCAD
places it in the lower-left corner of the drawing window.

4+ Display the UCS icon in 2D or 3D visual styles: You can control whether

the UCS icon is displayed when the model is being viewed with a 2D
or 3D visual style. This option is only available in AutoCAD, and not
AutoCAD LT. To change the display of the UCS icon, display the Options
dialog box, select the 3D Modeling tab, and uncheck the options as
desired under the Display UCS Icon section.

Using the Coordinate System for 3D Drawing

The coordinate system in AutoCAD is very powerful and can be mysterious

at times. When you are drawing in 2D, you don’t worry too much about alter-

ing the coordinate system. When working in 3D, it becomes very important
to know how to properly work with the coordinate system. By altering the
coordinate system, you can draw objects going in different directions or on
the sides of other objects. For example, you can draw an object on the xy
plane and then move/rotate the object into place, but that would take some
effort. By relocating the origin and direction of the coordinate system, you
are able to draw the object as if you were on the xy plane.
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Understanding the coordinate system Book V
AutoCAD has two different coordinate systems called world and user. Both of Chapter2
these coordinate systems are used when creating new objects in a drawing.

X2
World coordinate system (WCS) ge
The world coordinate system (or WCS) is a fixed coordinate system that all § 3
objects in the drawing are stored and defined to. By default in 2D views, the 28

x axis runs horizontal (left and right) and the y axis runs vertical (up and
down). Positive x is to the right and positive y is up. Unlike the user coordi-
nate system, the WCS can’t be moved or redefined.

User coordinate system (UCS)

The user coordinate system (or UCS) is a movable coordinate system and
is much more flexible for creating and editing objects. The UCS affects
coordinate entry, drafting aids (object snap tracking, dynamic input, grid,

\\J

and others), and the orientation of dimensions and text.

Right-hand rule for left-brained people

When you first look at the coordinate system in
3D, you may feel a little overwhelmed. After all,
the UCS can be moved and rotated. So attimes
you may not know which way you are heading
in the z direction or which way is the positive
rotation around an axis. AutoCAD provides a
method called the right-hand rule that you can
apply when you need to figure out the direction
of positive zand the positive rotation.

To identify the positive zaxis with the right-hand
rule, you place the back side of your right hand
towards the monitor so that your palm is facing
you. Take your thumb and pointitin the direction
of the positive x axis, then take your index finger
and extend it out so it forms a right angle with
your thumb. Make sure your index finger points
in the direction of the positive y axis. Bend your
middle finger towards you so it makes a right
angle with your index finger. Your middle finger
now indicates the positive direction of the zaxis.

To identify the direction of positive rotation
around an axis in 3D space, point your thumb on
your right-hand in the positive direction of the
axis and then curl your fingers. The direction that
your fingers curl in indicates the positive direc-
tion of rotation around that axis.

Y axis

Z axis X axis
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Adjusting the UCS

AutoCAD offers a variety of different ways to create and save custom UCSs
for future use. When you want to create a new UCS, you have some options
as to how you want to create it, such as by selecting three points in the
drawing to indicate origin, positive x, and positive y, or selecting an object.
After you specify a new UCS, you can decide to save it for future use by
giving it a name.

Commanding the UCS

The user coordinate system can be changed through the use of the UCS
command. To make it easy to create a new UCS, AutoCAD offers a number

of options that can be selected from the Tools menu under the New UCS
submenu. The New UCS submenu offers a total of 11 possible selections, but
AutoCAD provides a few that are not available from the submenu and are only
available at the command line. We have listed some of the most commonly
used options of the UCS command to get you started. After the option is speci-
fied, follow the command prompts at the command line or the dynamic input
tooltip. For more information on using the UCS options, refer to AutoCAD’s
online Help system.

4+ World: Changes the UCS to match the world coordinate system.
4+ Face: Allows you to align the UCS to the face of a 3D solid.

4+ View: Creates a new UCS by rotating the xy plane to being perpendicular
to your current viewing direction.

4+ 3 Point: Allows you to specify a new origin for the UCS and designate the
positive direction for both the x and y axes.

Using named UCSs

If you find yourself going back to a particular UCS to create or edit objects,
you might consider saving the UCS for future use. To save a UCS that you
created, you use the UCSMAN command which displays the UCS dialog box
(see Figure 2-8). The UCS dialog box lets you save and restore named UCSs
on the Named UCSs tab, customize the distance between the xy plane of the
six orthographic coordinate systems (top, bottom, front, back, left, and right)
on the Orthographic UCSs tab, and control some of the save and display set-
tings for UCSs on the Settings tab.

The following procedure uses the Tools menu to start the UCSMAN command
and save a custom UCS.



Figure 2-8:
Saving a
custom UCS
with the
UCS dialog
box.
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1. Choose Tools=>Named UCS.
The UCS dialog box is displayed.
2. In the UCS dialog box, select Unnamed in the UCSs list.

The Unnamed UCS is the current UCS in the drawing and is listed at the
very top of the list.

3. Right-click Unnamed and select Rename from the shortcut menu.

An in-place editor is displayed that allows you to change the UCSs name.
4. Type a new name for the UCS and press Enter.

The Unnamed UCS is renamed with the name entered.
5. Click OK.

The UCS dialog box closes and the UCS is saved in the drawing. To use a
saved UCS, open the UCS dialog box and then select the saved UCS from
the list and click Set Current.

Using the Dynamic UCS feature

Setting up a UCS takes a bit of effort and can be distracting if you need to
create one just to draw an object on the side of a 3D object. AutoCAD allows
you to create a UCS on the fly using the Dynamic UCS feature. This feature
can save you a great deal of time and is easy to toggle on and off. To toggle
Dynamic UCS on or off, click the DUCS button on the status bar area. For
example, when Dynamic UCS is turned on, you can start the CYLINDER com-
mand and position the crosshairs over one of the faces of a box to draw a
hole in the box. The face that is being tracked is highlighted and when you
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click to start drawing the cylinder, the UCS jumps to the face until you are
finished with the command. Figure 2-9 shows the use of the Dynamic UCS
in action.

Figure 2-9:
Dynamic
UCS makes
creating
objects
directly on
solids easy.

NG
2 Dynamic UCS is a new feature in AutoCAD 2007. This feature is not available
in AutoCAD LT 2007.
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In This Chapter

v~ Establishing a different view of a 3D model
v Orbiting around a 3D model

v~ Navigating a 3D model

+ Adding a touch of visual style to a 3D model

In this chapter, we get immersed in 3D space as we explain how to navi-
gate and view 3D models. AutoCAD and AutoCAD LT offer a number of
ways to view 3D models in drawing files. These include basic preset views
as well as much more sophisticated viewing tools, such as orbit and walk.
After you have the model displayed the way you want, you can apply a
visual style or a shade mode to make the objects appear shaded or hidden
on-screen.

Establishing a Different Point of View

AutoCAD offers a number of ways to view a 3D model, but AutoCAD LT
offers only a few. AutoCAD LT offers a very basic set of navigation tools for
viewing a 3D model; we cover all of them in this section.

Using preset views

Both AutoCAD and AutoCAD LT offer some standard preset views that can
help you view different sides of a 3D model quickly. The presets include
being able to view the 3D model from the top, left, and southeast. If the pre-
sets don’t offer what you need, you can use the Viewpoint Presets dialog
box to get a little more control over the viewpoint.

Specifying a standard view preset

AutoCAD and AutoCAD LT have a total of 10 preset views. Six of these preset
views are parallel to the current UCS — Top, Bottom, Left, Right, Front, and
Back — and four of them are isometric views — SW Isometric, SE Isometric,
NE Isometric, and SW Isometric. The presets are available from the 3D Views
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Figure 3-1:
The
Viewpoint
Presets
dialog box.

submenu under the View menu on the menu bar, from the View Manager
dialog box, or from the View toolbar. Select one of the presets to start the
VIEW command and use the option that matches the selected preset.

Changing with the Uiewpoint Presets dialog box

The Viewpoint Presets dialog box (see Figure 3-1) gives you more control
over the viewing angle than the preset views do. To display the Viewpoint
Presets dialog box, choose Viewr>3D Views=>Viewpoint Presets. To change
the angle, select either the Absolute to WCS or Relative to UCS option to set
the viewing angle. Specify the angle from the x axis by entering a value in the
From: X Axis text box or selecting the angle on the dial itself. After you set
the x axis, specify the angle from the xy plane by entering a value in the
From: XY Plane text box or from the dial on the right. Values above 0 allow
you to look down on the model; values below 0 allow you to look up at the
model as if you were below ground.

T Viewpoint Presets %]

Set Viewing Angles
() Absalute 1o 'WES O Relative to LICS

From: From:
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Set to Plan View
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Finding your way with the compass and tripod

The preset views and the Viewpoint Presets dialog box are nice, but they do
not provide a visual way to set a view. The VPOINT command allows you to
see the current UCS via an axis tripod and a circular display known as the
compass in the upper-right corner of the drawing window (see Figure 3-2).
This allows you to specify the angle from the x axis and xy plane like the
Viewport Presets dialog box does but is a little more visual and interactive.
Although it is visually done on-screen rather than using a dialog box, it can
still be a bit confusing. To select an angle above 0, keep the small crosshairs
in the inner circle, which represents a positive z axis (the outer circle repre-
sents a negative z axis). Where the inner and outer circles meet is 0, or no
change in the z axis direction.
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Cameras
Cameras are similar to named views, with the exception that they have a
graphical representation in a scene and can be updated via the Properties
palette. Along with using the Properties palette, you can also edit a camera
through the View Manager dialog box. The graphical representation is called

NEW Iy a glyph, which allows you to manipulate the view of the camera with grips.

Cameras have been improved with AutoCAD 2007: They are now displayed
and selectable in a drawing.

AutoCAD LT does not support the creation or use of cameras.

Creating a camera

To create a camera, you use the CAMERA command. To start the CAMERA
command, select Create Camera from the View menu on the menu bar or on
the View toolbar. As you create the camera, you specify a location for the
camera and a target location. After the camera is created, you can change its
name, location, height, target, lens, clipping, or switch to the cameras view.
After the camera is created, the glyph is displayed in the drawing.

Adjusting the view of a camera

To adjust a camera, you select its glyph in the drawing and then adjust it
using the grips that are displayed. Using grips, you can adjust the distance
between the camera and target, along with the lens length of the camera.
When a camera is selected, you should see the Camera Preview dialog box
(see Figure 3-3) displayed on-screen, which lets you see what the camera is
seeing without switching to the camera’s view. The Camera Preview dialog
box gives you an idea of what is being seen through the camera. If the
Camera Preview dialog box isn’t displayed when you select a camera in the
drawing, right-click and select View Camera Preview on the shortcut menu.
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I Camera Preview .

Figure 3-3:
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Perspective versus parallel
AutoCAD and AutoCAD LT can display a 3D model in parallel view, which
makes a 3D model appear flat and without depth, or in a perspective view,
which makes a 3D model seem to disappear into the distance. Figure 3-4
shows a rectangle displayed in both parallel and perspective view. When you
look at objects in real life, you see things in a perspective view. To enable
perspective view in a drawing, type PERSPECTIVE at the command line or
the dynamic ToolTip and enter a new value of 1. Perspective view is only
available when a visual style or shade mode other than 2D wireframe is
active. We talk about visual styles and shade mode later in this chapter.

Figure 3-4:

Arectangle

in both

parallel and

perspective

view.

Parallel view Perspective view

Orbiting around a 3D Model

AutoCAD comes with many different commands that allow you to zoom in
and around a 3D model. Being able to rotate the view around a 3D model
allows you to quickly see things from a different angle and make the neces-
sary edits. The ability to rotate the view around the 3D model is called orbit-
ing, like what planets do around the sun. Orbiting is done along a circular



Figure 3-5:
The Free
Orbit
command
is active.
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path; the rotation point is different based on the orbit command you choose
to use. To access the 3D orbit commands, from the menu bar, choose View=
Orbit and then one of the orbit commands.

AutoCAD LT does not support the 3D orbit commands.

Table 3-1 lists the three different 3D orbit commands available in AutoCAD.

Table 3-1

3D Orbit Commands

Ieon

Command

Description

P

3DORBIT

Constrained Orbit sets the target to a stationary point at the
center of the objects that you are viewing when the 3DORBIT
command is started. Dragging horizontally moves the camera
along the current xy plane, and dragging vertically moves the
camera along the z axis.

9

3DFORBIT

Free Orbit sets the target of the view to the center of the arcball
that is displayed. The arcball (see Figure 3-5) controls how the
view is rotated around its center rather than the center of the
objects you are viewing. Dragging inside the arcball allows you
to freely rotate the model, whereas dragging on the outside of
the archall rolls the model perpendicular to the screen. Clicking
and dragging in the left or right quadrants (smaller circles)
causes the model to rotate around the vertical axis of the
archall, and clicking and dragging in the top or bottom quadrants
(smaller circles) causes the model to rotate around the horizon-
tal axis of the arcball.

3DCORBIT

Continuous Orbit is similar to Constrained Orbit in the way it
works, except you can send the model into a continuous spin
on-screen that lasts until you stop it.
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Figure 3-6:
The
Navigation
Modes
menu.

While one of the 3D orbit commands (or any of the other 3D navigation com-
mands that we mention in the next section) is running, you can right-click
and access the Navigation Modes menu (see Figure 3-6). This menu allows
you to switch between Parallel and Perspective view, between different
visual styles, or even to other navigation commands without having to exit
one command in order to start another. You can also switch to a different
navigation command by pressing the number next to it under the Other
Navigation Modes submenu.

Exit
Current Mode: Constrained Orhit

Other Navigation Modes b v Constrained Orbit 1

. F Orbit 2
+ Enable Orbit Auto Target ..ree. o .
Continuous Orbit 3
Animation Settings ... ) )
Adjust Distance 4
Zoom Window Swivel 5
Zoom Extents
N Walk [
Zoom Previous
Fly T
¥ Parallel
Perspective Zaom 8
i Pan 9
Reset View
Preset Views 4

Named Views

Visual Styles ]
Visual Aids ¢

\\3

A\

If you hold down the Shift key first and then press and hold down the middle
mouse button, you can temporarily switch to 3DORBIT. Pressing and holding
the middle mouse button and then pressing the Shift key temporarily places
you in orthogonal pan mode.

If the drawing contains a lot of objects, you can select a small set of the
objects before starting one of the 3D orbit commands. This can help with
performance in larger drawings because only the selected objects appear
while the 3D orbit command is in use.

Navigating a 3D Model

AutoCAD offers other 3D navigation commands besides just the 3D orbit
commands. Both zoom and pan are offered in 3D versions, but you can still
use other zoom options such as window and extents. However, a few addi-
tional commands are used specifically for 3D navigation. These commands
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make it feel like you are right in your drawing. The 3D navigation commands
can be accessed from the View menu on the menu bar, under the submenus
Camerar>Walk and Fly, or on the 3D Navigation toolbar.

AutoCAD LT does not support the 3D navigation commands listed below.

AutoCAD 2007 offers two new 3D navigation commands called 3DWALK and
3DFLY.

Table 3-2 lists the other 3D navigation commands that are available in
AutoCAD.

Table 3-2 3D Navigation Commands

Ieon Command Description

3DPAN Allows you to interactively drag the view vertically, horizon-
tally, and diagonally.

P
[

3DZ00M Allows you to move the camera closer to or farther away
from the target, making objects appear closer or farther
away.

1+

3DDISTANCE Allows you to pull or push yourself in and out of the drawing
by making objects come closer or go farther away from you.

3DSWIVEL Allows you to change the target of the view you are currently
looking at in the drawing. Makes it feel like you are turning
your head around in the drawing to view other objects while
standing in a single spot.

A

3DFLY Allows you to interactively change the view of the drawing as
you “fly” through it. You leave the xy plane to give you the feel
that you are above the drawing.

3DWALK Allows you to interactively change the view of the drawing as
you “walk” through it. You remain on the xy plane to give you
the feel that you are walking through the drawing.

el
L (=]

When using one of the 3D navigation commands, you can right-click and
choose a different navigation mode from the shortcut menu.

Many of the 3D navigation commands and settings can be accessed directly
from the 3D Navigation control panel (see Figure 3-7) of the Dashboard
palette. Some of the settings are hidden at first; if you position the cursor
over the control panel, an icon with double down arrows appears. Click the
double down arrows icon to expand the control panel.
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Figure 3-7:
The 3D
Navigation
control
panel of the
Dashboard
palette.
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Adding Some Color and Style to a 3D Model

N

Looking at drawings that are displayed in 2D and 3D wireframe can make it
rather difficult to visualize what is actually in there. AutoCAD and AutoCAD
LT offer a few options to help you see what all of those lines actually mean.
AutoCAD uses visual styles to display geometry so you only see the objects
that are in front of others. AutoCAD LT doesn’t support visual styles but
instead has a feature called shade modes. Shade modes were available in pre-
vious releases of AutoCAD to hide faces that are not those closest to the cur-
rent viewpoint.

Visual styles in AutoCAD

Visual styles allow you to see your drawing in a hidden, shaded, or semi-
rendered state. Visual styles are available from the Visual Styles Manager
palette or the Visual Style control panel on the Dashboard palette. To display
the Visual Style Manager palette (see Figure 3-8) from the menu bar, choose
Tools>Palettes>Visual Styles. Double-click one of the available visual styles
to set it current. You can also make a custom visual style and make changes
to it by changing its properties at the bottom of the palette. You can set a
visual style current when drawing to give you a sense of what lines you
might want to snap to.

Visual styles are new in AutoCAD 2007, and they make it much easier to get
different looks to a 3D model for presentation purposes.

The Visual Style control panel (see Figure 3-9) on the Dashboard palette con-
tains a variety of controls that allow you to change to a different visual style,
enable x-ray mode to see through faces, control how faces and edges are dis-
played, and even the display of shadows in a scene.
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Shademode in AutoCAD LT

AutoCAD LT doesn’t support the use of visual styles, but you can do a few
things to get a similar effect when viewing a 3D model. AutoCAD LT offers
a command called SHADEMODE, which allows you to view a model in 2D
wireframe or hidden line view. SHADEMODE is similar to a visual style in
most ways, with the exception that it cannot customize its appearance.
AutoCAD LT also offers the SHADE command, which allows you to shade a
3D model based on the colors that the objects are assigned, and you can use
the HIDE command to display a 3D model in a hidden line view. The SHADE
and HIDE commands are available from the View menu on the menu bar.
SHADEMODE must be typed in at the command line or the dynamic input
ToolTip; next, select the option you want to use.
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Chapter 4: Moving from 2D to 3D

In This Chapter

v+ Working with regions

v 3D polylines and helixes
v Creating 3D objects from 2D objects
v Creating 2D objects from 3D objects

v 3D modify commands

A fter you figure out how to get around a drawing, it’s time to create some
objects. First, you start off by creating 2D objects. (Yes, you read that
correctly: 2D objects.) Although the result you want is a 3D model, you don’t
have to create everything using just 3D objects. Taking what you already
know about creating 2D objects and applying that knowledge to 3D modeling
helps you feel more comfortable with using and working in 3D. AutoCAD pro-
vides some tools that can help you create 2D views of the 3D model so you
can generate the necessary shop drawings to get the model built.

At the end of this chapter, we cover some of the common 3D modify com-
mands to help position 3D objects. Most of this chapter applies to AutoCAD
only (not AutoCAD LT) and is designed to give you an overview of the
different commands that allow you to go from 2D to 3D and back again.

(An entire book could be written on just working with AutoCAD 3D alone.)
For more information on the commands in this chapter, refer to the AutoCAD
online Help.

Working with Regions

Regions are 2D objects that are created from closed shapes — or loops.

A loop is a set of objects like lines and arcs that form a closed object but
are not necessarily a closed object themselves, like a circle, polyline, or
spline. You can create a region of polylines, lines, arcs, circles, elliptical
arcs, ellipses, and splines. Regions can be great for creating complex areas
to hatch, and can be used to create 3D objects. You can obtain centroid
(the center point of the mass or volume of a region), moment of inertia (the
value used to calculate distributed loads), and other information about a
region using the MASSPROP command, like you can with 3D solids. For more
information on the MASSPROP command, see the section “Getting more
information about regions.”
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Figure 4-1:
Closed
objects
converted to
regions.

Creating regions

Because regions are created from existing objects in a drawing, you first
must create the closed objects or loops and then use the REGION command
to generate a region out of them. A region is created for each closed object
or loop that is selected. To start the REGION command, you can select
Region from either the Draw menu on the menu bar or the Draw toolbar. An
example of the REGION command follows, along with the objects that were
selected (see Figure 4-1):

Command: _region

Select objects: Select the closed objects or loops
Specify opposite corner: 8 found

Select objects: Press Enter

6 loops extracted.

6 Regions created.

O O
AN
o1

When you use the REGION command (and some of the other commands that
are covered in this chapter), the original objects that you select to create
the region or 3D object from are deleted automatically. To keep the original
objects from being deleted, set the system variable DELOBJ to a value of 0.

Modifying regions

Regions are interesting objects because they are no longer 2D objects, nor
are they 3D objects, so you modify them in a slightly different way. Although
regions are not 3D objects, some of the 3D modify commands can be used on
them. If you want to remove a portion of a region with another region, you
wouldn’t use the TRIM command; instead, you would use the SUBTRACT
command. You can use the EXPLODE command to convert a region back to
2D objects.

Union

Union allows you to combine two or more regions into a single region. This
allows you to create very complex 2D objects that can later be extruded to
create a 3D object. A great example of this is a metal plate that is used to
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keep an object in place, or the side panel of a desk. The UNION command is
available from the Solid Editing submenu under the Modify menu or the
Solid Editing toolbar.

Subtract

Subtract allows you to remove a region from another region that it intersects
or overlaps. This allows you to create holes, slots, or notches in regions before
you extrude them to create a 3D object. The SUBTRACT command is available
from the Solid Editing submenu under the Modify menu or the Solid Editing
toolbar.

Intersect

Intersect allows you to keep only the part of two overlapping or intersecting
regions that intersect. Using intersect is much more common when you are
working with 3D solids. The INTERSECT command is available from the Solid
Editing submenu under the Modify menu or the Solid Editing toolbar.

Getting more information about regions

Regions are complex objects that can be used to construct 3D solids or 2D
objects that can be used to calculate additional information for the design,
such as area and perimeter. The MASSPROP command allows you to obtain
more information about a 2D region or 3D solid than what the LIST command
displays. To start the MASSPROP command, choose Tools=>Inquiry=Region/
Mass Properties. An example of the MASSPROP command is

Command: _massprop

Select objects: Select a region(s)
Specify opposite corner: 1 found
Select objects: Press Enter

———————————————— REGIONS e —
Area: 37.3681
Perimeter: 26.4645
Bounding box: X: 15.9560 -- 24.1580
Y: 6.3739 -- 11.4041
Centroid: X: 19.7700
Y: 9.0755
Moments of inertia: X: 3150.3487
Y: 14801.8030
Product of inertia: XY: 6725.9145
Radii of gyration: X: 9.1818
Y: 19.9025

Principal moments and X-Y directions about centroid:
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I: 68.9979 along [0.9864 0.1644]
J: 199.8441 along [-0.1644 0.9864]

Write analysis to a file? [Yes/No] <N>: Press Enter

3D Polylines and Helives

Figure 4-2:
Helixes can
be used to
create
springs.

Although a line object is not in one sense a 3D object, lines can have a differ-
ent starting and ending z coordinate value, which makes it a 3D command.
The 3DPOLY command allows you to draw 3D polylines, and the HELIX com-
mand allows you to create 2D and 3D spirals. These are not in one sense the
same as a solid or a surface, but they can be created with varying different z
coordinate values without the need to change the current user coordinate
system (UCS). For more information on the UCS, see Book V, Chapter 2.

3D polyline

3D polylines are very similar to the 2D polylines that you are already familiar
with, with the exception that they support only straight segments, and a dif-
ferent z coordinate value can be specified for the start and end point of a
segment. You use the 3DPOLY command to create a 3D polyline, which can
be started by choosing Draw=>3D Polyline, or entering 3DPOLY at the com-
mand line or dynamic input tooltip.

Helix

Helixes can be used to create 2D and 3D spirals, shown in Figure 4-2, that
might be used to represent springs, coils, or even door stops. To create a 2D
helix, use a height value of 0. Use the HELIX command to create a helix. The
HELIX command is started by selecting Helix from the Draw menu on the
menu bar, or entering HELIX at the command line or dynamic input tooltip.

The HELIX command is new in AutoCAD 2007and is not supported in
AutoCAD LT.

()

C
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Creating 3D Objects from 2D Objects
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AutoCAD’s roots started with 2D drafting. That continues to be the primary
focus of the program, but Autodesk has shifted to making sure that 3D is a
key part of the program. Because AutoCAD started off being a 2D drafting
package, you can take your knowledge of 2D drafting to create 3D objects
with it. This section discusses many of the different commands that allow
you to take existing 2D objects and convert them into 3D objects. Some work
with 2D profiles, whereas others might require you to create a region first or
some sort of closed object. Everything in this section applies to AutoCAD
only, with the exception of the Thickness section.

Thickness

Thickness is a property of most 2D objects, such as lines and circles. When
you change the thickness of a 2D object, you are creating a surface out of the
object, or a set of surfaces. These surfaces hide objects behind them, unlike
wireframe models. If you add thickness to a circle, a cylinder is created that
is capped on the top and bottom. Changing the thickness of a pline that has
a width is a quick way to create a 3D wall. Thickness is also a system vari-
able that can be set by typing THICKNESS at the command line or dynamic
input ToolTip and entering a new value. New objects will be given the new
thickness value.

Extrude

Extrude allows you to take an open or closed 2D object and create a solid

or surface out of it. When you extrude a closed 2D object such as a polyline,
spline, ellipse, circle, or region, you create a solid. If you extrude an open 2D
object such as a polyline, spline, line, arc, or elliptical arc, you create a sur-
face. Figure 4-3 shows the results of extruding an open and a closed object.
You can extrude a face on a solid by holding down the Ctrl key and selecting
the face when asked to select objects to extrude.

After you select the objects or faces you want to extrude, you specify a dis-
tance and direction to create the extrusion in. During the extrusion, you can
select a path to extrude along which can be a 2D object or an edge of a solid or
surface. To start the EXTRUDE command, choose Draw=>Modeling=>Extrude.

AutoCAD 2007 allows you to extrude open objects and generate surfaces
from them.

If you want to keep the original object that is used to create the extruded
object, set the system variable DELOBJ to 0.
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Figure 4-3:
The results
of extruding
open and
closed
objects.

Figure 4-4:
The results
of lofting
objects
using cross-
sections
only.

Loft

Loft allows you to create a solid or a surface based on a series of specified
cross-sections. The cross-sections are used to define the profile that is gen-
erated, and you must use a minimum of two cross-sections for the loft. If you
use open objects for the cross-sections, the resulting loft is a surface; if you
use closed objects for the cross-sections, the resulting loft is a solid. You can
loft objects along a path by using guides or just the selected cross sections
(see Figure 4-4). To start the LOFT command, select the Draw menu on the
menu bar, and then choose Modeling=Loft.

The LOFT command is new in AutoCAD 2007.

Y o

Sweep

Sweep is very similar to Loft except you use a single cross-section instead of
two or more. The cross-section is used to define the profile that is generated.
If you use an open object for the cross-section, the resulting sweep is a sur-
face; if you use a closed object for the cross-section, the resulting sweep is a
solid. You sweep the selected objects along a path (see Figure 4-5). To start
the SWEEP command, select the Draw menu on the menu bar, and then
choose Modeling=>Sweep.

The SWEEP command is new in AutoCAD 2007.



Figure 4-5:
The results
of sweeping
objects
along a
path.

Creating 3D Objects from 2D Objects 3 73

Figure 4-6:
The results
of revolving
objects
along an
axis.

Revolve

Revolve allows you to create a solid or a surface based on selected objects
and a specified axis that they should revolve around. If you use open objects,
the resulting revolve is a surface; if you use closed objects, the resulting
revolve is a solid. You revolve the selected objects around an axis and spec-
ify the angle at which you want the objects to be revolved (see Figure 4-6).
To start the REVOLVE command, select the Draw menu on the menu bar, and
then choose Modelingr>Revolve.

Tabulated Mesh

Tabulated Mesh allows you to create a mesh based on a profile (path curve)
and a direction vector. Unlike some of the previously mentioned commands
in this section, such as extrude and loft, a closed profile doesn’t create a
solid. You extrude the selected object (path curve) along a selected path
(see Figure 4-7). To start the TABSURF command, choose Draw=>Modeling=>
Meshes=>Tabulated Mesh.

TABSURF uses the value of the system variable SURFTABI to control the
number of segments that the mesh is created with. The higher the number,
the smoother the mesh looks, and the better it follows the selected object
(path curve). By default, SURFTABI is set to a value of 6.
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Figure 4-7:
The results
of using
TABSURF
on a closed
object.

Figure 4-8:
The results
of using
REVSURF
on a closed
object.

Revolved Mesh

Revolved Mesh is similar to Revolve, except you are only able to select a
single object with Revolved Mesh, and a mesh is created even when a closed
object is selected. After you select the object you want to revolve, you spec-
ify the axis by selecting an object, and then you specify the start and include
angles to revolve the object around the axis (see Figure 4-8). To start the
REVSURF command, choose Drawr>Modeling=>Meshes=>Revolved Mesh.

REVSURF uses the values of the system variables SURFTAB1 and SURFTAB2
to control the number of segments that the mesh is created with. The higher
the number, the smoother the mesh looks and the better it follows the
selected object. By default, SURFTAB1 and SURFTAB2 are set to a value of 6.

Ruled Mesh

Ruled Mesh allows you to create a mesh between two selected objects. You
can use both open and closed objects with the command, but if you use a
closed object, the other object must also be a closed object. Ruled Mesh is
similar to the way loft works because a new object is created based on the
selection of two profiles (see Figure 4-9). To start the RULESURF command,
choose Drawr>Modeling=>Meshes=>Ruled Mesh.
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Figure 4-9: Chapter 4
The results
of using
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RULESUREF uses the value of the system variable SURFTAB1 to control the
number of segments that the mesh is created with. The higher the number,
the smoother the mesh looks and the better it follows the selected object.
By default, SURFTABI is set to a value of 6.

Edge Mesh

Edge Mesh allows you to create a three-dimensional mesh that follows the
edges of four objects. The objects must be open objects, but their end points
must match up with each other. The edges must be selected in a specific
order to properly generate the mesh (see Figure 4-10). To start the EDGESURF
command, choose Draw=>Modeling=>Meshes->Edge Mesh.

Figure 4-10:
The results
of using
EDGESURF
on four
objects.

EDGESURF uses the values of the system variables SURFTAB1 and SURFTAB2
to control the number of segments that the mesh is created with. The higher
the number, the smoother the mesh looks and the better it follows the
selected object. By default, SURFTAB1 and SURFTAB2 are set to a value of 6.

Creating 2D Objects from 3D Objects

AutoCAD allows you to make the transition from 2D to 3D without having to
completely abandon what you already know about 2D drafting. Wouldn't it
be nice to be able to create a 2D representation of the 3D model that you
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Figure 4-11:
The results
of creating
three
different
views from
one model
with
Flatshot.

N

spent numerous hours creating? You're in luck: AutoCAD comes with com-
mands that allow you to take your 3D model and generate a 2D representa-
tion of a given view. After you have a 2D representation of the 3D model,
you can then add any dimensions and notes necessary for construction or
manufacturing.

Flatshot

Flatshot allows you to create a block that contains 2D objects based on the
current view of a 3D model. By creating the 3D model first, you can create a
block that contains only the objects that are visible in that view, or include
the obscured lines in a different color or linetype (see Figure 4-11). Flatshot
looks for all 3D objects that are in the current view and ignores all 2D objects.
To start the FLATSHOT command, select Flatshot from the 3D Make control
panel on the Dashboard palette.

The FLATSHOT command is new in AutoCAD 2007.

T

=

Section Plane

Section Plane allows you to cut a 3D solid without actually altering the object
itself to generate a 2D or 3D object based on the geometry along the defined
plane (see Figure 4-12). This allows you to quickly create different views of a
model to help manufacture it, or even assemble it. Unlike Flatshot, a Section
Plane can go through an object and be able to generate a 2D representation of
the objects that are along the Section Plane. To create a 2D or 3D representa-
tion of the objects along a plane, you first start the SECTIONPLANE command,
and then choose Drawr>Modeling=>Section Plane. After the Section Plane has
been created, you have various different options of how you want to display
the objects around the Section Plane. The options can be accessed from the
right-click shortcut menu or the Properties palette.

The SECTIONPLANE command is new in AutoCAD 2007.



Figure 4-12:
The results
of creating
a2D and 3D
object from
a Section
Plane.

3D Modify Commands 3 17

Figure 4-13:
The results
of using
SOLPROF on
a 3D object.

Solid Draw, Solid View, and Solid Profile

Three older commands called Solid Draw (SOLDRAW), Solid View (SOLVIEW),
and Solid Profile (SOLPROF) work very similar to the Flatshot and Section
Plane commands. These commands allow you to generate views of 3D models,
but only work in a layout with viewports. Solid Profile allows you to create a
profile of a 3D object out of 2D objects, which can be helpful if you want to
create an exploded view of a part for an illustration guide.

Solid View and Solid Draw are used with each other. Solid View is used to
create a viewport with specific layers frozen; after the viewport is created, you
display the 3D objects in the viewport that you want to convert to 2D objects
with the Solid Draw command. Start the Solid Draw command and select the
viewport. All hidden objects are placed on a specific layer along with other
objects and layers that are created from the command (see Figure 4-13). The
SOLDRAW, SOLVIEW, and SOLPROF commands can be found under the Draw
menu on the menu bar. Choose Modeling=>Setup and then Drawing, View, or
Profile.

3D Modify Commands

Surfaces and solids that make up 3D models can be modified using all of the
modify commands that you already know, such as ERASE, MOVE, ROTATE,
and more. However, AutoCAD also offers some special modify commands
that are designed specifically for working in 3D. These specialized 3D
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commands can be used on solids, surfaces, and even 2D objects. All of these
commands are located under the 3D Operations submenu of the Modify
menu on the menu bar.

3D Move

The 3D Move command allows you to move selected objects along the xy
plane and in the z direction. This command uses what is called a grip tool to
allow you to restrict or constrain movement along an axis (see Figure 4-14).
The command prompts are identical to the MOVE command, so using the 3D
Move command should be familiar. The 3DMOVE command can be started
by selecting 3D Move from the 3D Operations submenu under the Modify
menu on the menu bar.

The 3DMOVE command is new in AutoCAD 2007.

Figure 4-14:

The grip tool

for the

3DMOVE

command.
3D Rotate
The 3D Rotate command allows you to rotate selected objects along the x, y,
or z axis. Like the 3D Move command, the 3D Rotate command uses a grip
tool to allow you to restrict or constrain the rotation along an axis (see
Figure 4-15). The command prompts are similar to the ROTATE command,
with one slight difference: You need to pick an axis for rotation, and then a
start and end angle instead of just a rotation angle. The 3DROTATE command
can be started by selecting 3D Rotate from the 3D Operations submenu
under the Modify menu on the menu bar.

Figure 4-15:

The grip tool

for the

3DROTATE

command.

" -
[Pick 2 rotation axis:
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The 3DROTATE command is new in AutoCAD 2007.

Align

The Align command can be used to align 2D and 3D objects based on one,
two, or three pairs of points. Based on the number of pairs of points that you
select and how they are selected, the Align command might move or rotate
the selected objects into place.

3D Align

The 3D Align command is an improved version of the ALIGN command that
includes some additional options, including the ability to copy the selected
objects instead of just moving or rotating them, and the ability to use
Dynamic UCS with the command.

The 3DALIGN command is new in AutoCAD 2007.

Mirror 3D

The Mirror 3D command allows you to mirror objects along the xy plane like
the standard MIRROR command does, but it also allows you to specify the
mirror plane using a number of additional methods to define it. The addi-
tional methods that you can define the mirror plane are by three points, an
existing object in the drawing, a previously defined mirror plane, z axis, the
current view, xy plane, yz plane, and zx plane. The three-point option is the
most common and is the default option.

3D Array

The 3D Array command allows you to array objects along the xy plane (rows
and columns) like the ARRAY command does but also allows you to array

in the z direction (levels). You can create both rectangular and polar arrays
with the 3D Array command just like you can with the ARRAY command. The
3D Array command does not use a nice dialog box like the ARRAY command
does, so entering the correct values can be hard the first few times until you
get used to inputting the values at the command line.

Book V
Chapter 4
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Chapter 5: Working with Solids

In This Chapter

1 Creating solid primitives

v~ Editing solids

In the previous chapter, we covered many of the commands that allow
you to take the knowledge that you already have about 2D drafting and
apply it to 3D. In this chapter, you discover many of the 3D commands that
allow you to create and edit 3D objects. AutoCAD allows you to create 3D
objects known as primitives. Primitives are very basic objects like boxes,
cones, and spheres that can be used to create complex models. You also
find out more about modifying commands that are used to manipulate

a 3D solid.

Creating Solid Primitives

AutoCAD offers a pretty good variety of primitive 3D objects that can be
used to create complex models. The primitive objects help to form the foun-
dation of 3D modeling in AutoCAD: You can combine these primitives with
other primitives or even manipulate a primitive so that it is filleted (with
rounded edges), shelled (hollowed out), and more.

Polysolid

A polysolid is very similar to a 2D polyline, except it has a single uniform
width and a height. Polysolid is great for creating 3D walls to create a con-
ceptual look of a building (see Figure 5-1) or for creating rectangular duct
work. To start the POLYSOLID command, choose Draw=>Modeling=>Polysolid.
After you start the POLYSOLID command, you can draw a polyline-like object
that allows you to create both straight and curved segments. If you already
have lines, arcs, and polylines in your drawing, you are able to convert those
to solid with the Object option of the POLYSOLID command. You are also
able to specify the height, width, and justification for how the new solid
object is created.
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Figure 5-1:
The outline
ofa2D
floor plan
converted
to 3D walls
with the
POLYSOLID
command.

Figure 5-2:
Atable
created
from boxes.

Box

A box is a six-sided object that is either a cube or rectangular. A box could
be used for virtually anything from a table (see Figure 5-2) to a door or even
a building in the background of a conceptual drawing. To start the BOX com-
mand, choose Draw =>Modeling>Box. After specifying the first corner or the
center of the box, you can then finish defining the base of the box by select-
ing the opposite corner, creating a cube, or defining its length. Based on the
option you select, you may need to define the box’s height.

Wedge

A wedge is half of a box diagonally from an upper edge to a lower edge. A
wedge might be useful for creating a ramp, a roof slope, or even a slice of
chocolate cake. Figure 5-3 shows some of the different sizes of wedges that
can be created with the WEDGE command. To start the WEDGE command,
choose Draw=>Modeling=>Wedge. After specifying the first corner or the
center of the wedge, you can then finish defining the base of the wedge by
selecting the opposite corner, creating a cube, or defining its length. Based
on the option selected, you may need to define the wedge’s height.
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Cone
A cone is an object with a circular base that has either a point or a flat top.
The base of a cone can be larger than its top and even be elliptical rather
than circular. You might use a cone for a handle or pull, a cup, or a planter.
Figure 5-4 shows some of the different sizes and types of cones that can be
created with the CONE command. To start the CONE command, choose
Draw=>Modelingm>Cone. After specifying the center of the cone’s base, spec-
ify the radius or diameter of the base and then its height.
Figure 5-4:
Some
different
shapes and
sizes of
cones.
Sphere
A sphere is a full circular object that is created from the very center of the
object. The sphere is one of two types of 3D solids that is created half above
and half below the current XY plane (see Figure 5-5). Torus is the other type
of 3D solid created above and below the current XY plane, which we discuss
later in this chapter in the section called “Torus.” To start the SPHERE com-
mand, choose Drawr>Modeling=>Sphere. After specifying the center of the
sphere, you specify its radius or diameter.
Figure 5-5:

A sphere.
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Figure 5-6:
Different
shapes and
sizes of
cylinders.

Cylinder

A cylinder is a circle or ellipse with height and is commonly created from the
center of the object. Cylinders can be used for a variety of things, like the legs
of a table or chair, glasses, or a shaft for a gear. Figure 5-6 shows some of the
different sizes and types of cylinders that can be created with the CYLINDER
command. To start the CYLINDER command, choose Draw=>Modeling=>
Cylinder. After specifying the center of the cylinder’s base, specify the radius
or diameter of the base and then its height.

!\

Figure 5-7:
Atorus.

Torus

A torus is a 3D donut that is created from the very center of the object.
The torus, like the sphere, is created half above and half below the current
XY plane (see Figure 5-7). To start the TORUS command, choose Drawr>
Modeling=>Torus. After specifying the center of the torus, specify its radius
or diameter, and then the radius or diameter of the tube.

Pyramid

A pyramid is similar to a cone, except instead of a circular base, it has a
polygon-shaped base that can have from 3 to 32 sides and either a point or

a flat top. You might use a pyramid for the top of a building, base of a street
sign, or even a light fixture. Figure 5-8 shows some of the different sizes and
types of pyramids that can be created with the PYRAMID command. To start
the PYRAMID command, choose Draw>Modeling=>Pyramid. After you spec-
ify the center or the edge of the pyramid’s base, specify the radius or use the
inscribed option and then its height.



Editing Solids 3 25

Book V
The PYRAMID command is new in AutoCAD 2007. Chapter 5

Figure 5-8: ‘ ‘
Different

shapes and

sizes of ‘ ‘
pyramids.

Editing Solids

You can edit a solid in many different ways, and some of these ways are not
always easy to recognize. AutoCAD allows you to select a solid and access
grips to modify certain characteristics of the solid, which could be its height,
base size, or some other characteristic. Along with being able to edit solids
directly with grips, you can also manipulate faces and edges of a solid
through the SOLIDEDIT command and by using the Ctrl key when selecting
objects. You can edit solid in many other ways, like using the TRIM and
FILLET command, and other specialized commands used only on solids.

Solid editing

The SOLIDEDIT command allows you to modify a face, an edge, or the entire
body of a 3D solid. Based on how you edit a 3D solid, you have different
options available. Many of the options that are part of the SOLIDEDIT com-
mand are available on the Solid Editing toolbar or are found under the Solid
Editing submenu of the Modify menu on the menu bar.

spijos yim
Bunpopp

Table 5-1 lists the different options of the SOLIDEDIT command and what
they are used for.

Table 5-1 SOLIDEDIT Command Options
Command Option Description
Imprint Edges Imprints a 2D or 3D object onto a 3D solid. The object to
[:',. be imprinted must intersect one or more faces of the 3D
solid that it is to be imprinted on. After the object has

been imprinted onto the solid, you can then extrude the
new face thatis created if the imprinted object creates a
closed area on the 3D solid.

(continued)



32 7 Editing Solids

Table 5-1 (continued)

Command Option

Description

a Color Edges Allows you to specify a different color for an edge on the
) 3D solid.
Copy Edges Allows you to select edges on a 3D solid that you want to

copy. The copied edges resultin 2D objects such as lines
and arcs.

Extrude Faces

Allows you to extrude a selected face away or into the
3D solid that it belongs to.

'.|~ @'{_’ @ @'\

Move Faces Allows you to move a selected face on the 3D solid. This
works great for moving holes or notches in a surface.
Offset Faces Allows you to offset a selected face on the 3D solid.

Delete Faces

Allows you to delete a selected face, fillet, or chamfer on
the 3D solid.

Rotate Faces

Allows you to rotate a selected face on a 3D solid.

Taper Faces

Allows you to taper a selected face on a 3D solid. This
causes the face to flare out or in based on the specified
axis and angle provided.

Color Faces

Allows you to specify a different color for a face on the
3D solid.

Copy Faces

Allows you to select faces on a 3D solid that you want to
copy. The copied edges result in 2D regions being cre-
ated for each face selected.

Clean

Performs a scrubbing of the 3D solid and cleans up any
redundant edges, vertices, and unused geometry.

Separate

Creates separate 3D solid objects based on 3D solids
with disjointed volumes; this doesn’t separate Boolean
objects with a single volume.

|82 | |« L @&

in
W

Shell

Hollows out a 3D solid based on a specified wall thick-
ness. A positive offset distance creates the shell to the
inside of the perimeter, whereas a negative value cre-
ates the shell to the outside of the perimeter.

Q

Check

Performs a validation on the 3D solid object to determine
that it is valid with the ShapeManager.




Figure 5-9:
Grips
displayed on
the selected
cone.
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Using grips to edit solids Bookv_

Grips are a very powerful way to edit objects such as lines and arcs. You can apter

use grips to edit some of the properties of a solid after it has been created

in the drawing. To edit a solid using grips, select the solid with no command

running and then select the grip you want to edit. Some grips allow you to ,E. s

change the overall size of the solid, whereas others allow you to change part : 9;,

of the solid like its base or top in the case of a cone. Figure 5-9 shows a cone %g
(7]

selected and its grips displayed.

The grip editing of solids has been greatly improved in AutoCAD 2007. In
previous releases, you could only use grips to move solids, but now you are
able to modify a solid after it has been created. The Properties palette has
also been updated to allow you to edit a solid after it has been created in the
drawing.

Booleans

3D solids can be unioned together to form a complex object using the UNION
command. Along with being able to union 3D solids, you can also subtract
from them with the SUBTRACT command. A 3D solid can also be created
based on the intersecting of two or more 3D solids with the INTERSECT com-
mand. For more information on these commands, see Chapter 4 of this mini-
book and the online Help system.

Filleting and cham(fering

3D solids can be filleted and chamfered just like 2D objects. You use the
FILLET and CHAMFER commands that you are already familiar with. The
FILLET command allows you to fillet as many edges that you want to on a
solid, whereas CHAMFER must be done face by face. Figure 5-10 shows a solid
that has had its edges filleted and chamfered. To remove a fillet or a chamfer
from a solid, you use the Delete Faces option of the SOLIDEDIT command.
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Figure 5-10:
A 3D solid
before and
after it was
filleted and
chamfered.

Figure 5-11:
A 3D solid
sliced in
half.

Slice

At times, you may only want a portion of the 3D solid for your model. In
these cases, you can use the SLICE command. You can slice a 3D solid using
a planar object like a circle, ellipse, 2D polyline, or a surface, among many
others. You can keep both halves of the solid after it has been sliced, or
whichever side you want to keep. Figure 5-11 shows a solid that has been
sliced in half. To start the SLICE command, choose Modify=>3D Operationst>
Slice. After you specify the 3D solid to slice, you specify the axis or object
you want to use as the cutting plane and then you decide which part of the
resulting objects to keep.

¥ o




Chapter 6: Working with Surfaces

In This Chapter

v Creating surfaces

v Editing surfaces

In the previous chapter, we cover creating and modifying 3D solids. This
chapter takes a similar look at creating and modifying surfaces. Many
commands allow you to create primitives out of surfaces instead of a 3D
solid. Surfaces take a little more planning to create and modify than 3D
solids do, but they do have advantages, depending on what you are trying
to model.

Creating Surfaces

AutoCAD offers a variety of commands that allow you to create primitives
as surfaces, which are similar to the commands that allow you to create 3D
primitives. Just like the primitive 3D solids, surfaces help to form the foun-
dation of 3D modeling in AutoCAD. Surfaces are not as easy to modify as 3D
solids are, but you can deform and change their shapes much more easily
than you can a 3D solid. Most of the primitives that can be created as 3D
solids can be created with surfaces through the use of the 3D command or a
command that is specific to the primitive.

3D face

A surface can be either three- or four-sided. Most of the commands in this
chapter create meshes that are composed of multiple surfaces to create a
primitive. The 3DFACE command allows you to create a single three- or four-
sided surface (see Figure 6-1). As you create a surface with the 3DFACE com-
mand, you can control which sides of the surface are visible when the model
is viewed as hidden, shaded, or rendered. To start the 3DFACE command,
choose Draw=>Modeling=>Meshes=>3D Face. After specifying the first corner,
you specify two more points and then press Enter to create a three-sided
surface, or specify a fourth point to create a four-sided surface. You can con-
tinue to specify additional points to create additional surfaces. As you spec-
ify points, you can toggle the visibility of the edge that is created.
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Figure 6-1:
An open box
created with
surfaces,
and a three-
and four-
sided
surface.

3D mesh

A mesh is a group of vertices that form a particular pattern to create a group
of surfaces based on the number of vertices specified (see Figure 6-2). If a
mesh is exploded, the result is individual surfaces that are created between
the specified vertices. A mesh is commonly created as an open object, but
can be closed through the use of the PEDIT command. To start the 3DMESH
command, choose Draw=>Modelingz>Meshes>3D Mesh. After you start the
3DMESH command, you are prompted to specify the size in the M and N
directions, which determines the number of vertices that you are prompted
for. After the M and N directions have been speci